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Predmluva

Kresleni vektorove grafiky v LibreOffice



Pro koho je tato uzivatelska priruCka urcena?

Tuto knihu jisté oceni kazdy, kdo chce s LibreOffice Draw pracovat svizné, efektivhé
a s prehledem. Neni pfitom ddlezité, zda jde o Uplného zacateénika nebo uZivatele, ktery uz ma
zkuSenosti s jinym programem.

Co je v této uzivatelské prirucce?

Tato kniha predstavuje hlavni funkce LibreOffice Draw. Draw je néstroj pro kresleni vektorove
grafiky, i kdyz mdze také provadét nékteré operace s rastrovou grafikou (pixely), jako jsou
fotografie. Pomoci Draw Ize rychle vytvofrit Sirokou $kalu grafickych obrazkd.

Nékolik priklad(l funkci pro kresby: sprava vrstev, funkce prichytavani a mrizky, zobrazeni kot
a méfitka, spojnice pro vytvareni organizacnich grafl, funkce pro vytvareni trojrozmérnych
kreseb (s texturou a svételnymi efekty), integrace kreshy a stylu stranky a Bézierovy kfivky.

Prirucka Draw neni ucebnici, se kterou je tfeba pracovat od zaCatku do konce. Jedna se spiSe
o referenéni praci, ve které Ize prochazet pokyny k urcitym tématim.

Minimalni poZadavky LibreOffice

Podrobny seznam pozadavk( a podporovanych operacnich systém( najdeme na webu
LibreOffice: https://www.libreoffice.org/get-help/system-requirements.

Jak ziskat LibreOffice

Verze LibreOffice pro Windows, Linux a macOS jsou volné dostupné a Ize je stahnout ze stranky
https://cs.libreoffice.org/download. UZivatelé Linuxu pravdépodobné naleznou kancelarsky balik
LibreOffice jako souast mnoha nejnovéjSich distribuci.

Portable a dalSi verze LibreOffice jsou k dispozici na strance pro stahovani. Linux, Vanilla a dalsi
verze se mohou v nékolika funkcich liSit od popist v této uzivatelské prirucce.

Instalace LibreOffice

Informace o instalaci a nastaveni LibreOffice na réiznych podporovanych operacnich systémech
jsou uvedeny na této strance: https://www.libreoffice.org/get-help/install-howto.

Nastaveni a prizplisobeni LibreOffice

Chceme-li zménit vychozi nastaveni (moznosti) v LibreOffice podle svych preferenci, pfejdeme
v hlavni nabidce na Nastroje > MoZnosti (LibreOffice > Pfedvolby v macOS).

Nastaveni jsou popsana v hapoveédeé LibreOffice a v priru¢ce Za¢iname s LibreOffice. Tyto dva
zdroje poskytuji informace o tom, jak pfizpUsobit nabidky, nastrojové listy a klavesové zkratky
v LibreOffice Draw, pfidat nové nabidky a nastrojové liSty a pfifadit makra udalostem.

6 Tip

Mnoho nastaveni je ur€eno pro pokrocilé uZivatele a programatory. Pokud
nerozumime tomu, co néktera moznost déla, doporucujeme ponechat ji na vychozim
nastaveni, pokud pokyny v této uzivatelské priru¢ce nedoporucuji zmeénit nastaveni.
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RozSifeni a doplnky

v s ~ v

LibreOffice mizeme rozsifit o dalsi funkce pomoci rozsiteni a dopliikd. PFi instalaci LibreOffice je
nainstalovano nékolik rozsiteni a dalsi miiZzeme ziskat v oficialnim GloZisti rozSifeni na strance
https://extensions.libreoffice.org a z dalSich zdrojl. Dalsi informace o instalaci rozsifeni

a doplikd viz pfirucka Za¢iname s LibreOffice.

Kde ziskat pomoc

Tato kniha, ostatni prirucky pro LibreOffice, vestavéna napovéda a podpora uzivateld
predpokladaji, Ze uzivatel méa zakladni znalosti s praci na pocitaci, tj. Ze dokaze spoustét
programy Ci otevirat a ukladat soubory.

Systém napoveédy

LibreOffice je dodavan s rozsahlym systémem napoveédy, ktery Ize pouzit jako prvni linii podpory.
Uzivatelé Windows a Linux si mohou zvolit stazeni a instalaci offline napovédy pro pouziti ve
chvili, kdy nejsou pfipojeni k internetu. Offline napovéda je nainstalovana s verzi LibreOffice pro
MacOS.

Napovédu lze zobrazit stisknutim klavesy F1 nebo zvolenim polozky Napovéda > Napovéda
LibreOffice v hlavni nabidce. Pokud neni offline napovéda nainstalovana v pocitaci, a pocita€ je
pfipojen k Internetu, otevie se dialogové okno s moznosti Cist napovédu online. Vybereme tuto
moZznost a vychozi webovy prohlize€ se otevie na strankach online napovédy LibreOffice na
webu LibreOffice.

Nabidka napovéda obsahuje odkazy na dalSi informace a podporu LibreOffice.

* Co je to? - rychlé tipy ziskame, kdyz umistime ukazatel mySi nad ikonu. Zobrazi se tip
napovédy s kratkym popisem funkce ikony. RozSifené tipy Ize aktivovat v hlavni nabidce
Nastroje > MoZnosti > LibreOffice > Obecné. RozSifené tipy poskytuji stru¢ny popis
nastrojd a prikazd. Chceme-li rozsifeny tip zobrazit, stiskneme Shift+F1 a ukazeme na
prislusné tlacitko nebo prikaz.

+ UzZivatelské pfFiru€ky — otevie vychozi prohlize¢ na strdnce Dokumentace na webu
LibreOffice https://documentation.libreoffice.org/en/english-documentation/. Tato stranka
poskytuje pfistup k uzivatelskym pfiru¢kam LibreOffice a dalSim uziteCnym informacim,
které Ize otevfit ve vychozim prohlizeci. Uzivatelské pfirucky jsou také k dispozici ve
formatu PDF ke stazeni zdarma nebo ke koupi jako tiSténé kopie.

* Zobrazit Tip dne — otevie malé okno s ndhodnou radou, jak pouZivat LibreOffice.

* Poradit se online — otevie vychozi prohlize¢ na strance féra Ask LibreOffice, kde
mlZzeme poloZit ¢i zodpovédét otdzku https://ask.libreoffice.org/en/questions/cs.

* Odeslat zpétnou vazbu — otevie vychozi prohlize€ na strdnce zpétné vazby LibreOffice
https://cs.libreoffice.org/get-help/feedback/. Odtud mdzeme hlasit chyby, navrhovat nové
funkce a komunikovat s ostatnimi v komunité LibreOffice.

* Restartovat v nouzovém rezimu — otevre dialogové okno, ve kterém budeme mit
mozZnost restartovat LibreOffice a obnovit vychozi nastaveni softwaru. Restartovani
v nouzovém rezimu také poskytuje prileZitost obnovit LibreOffice ze zalohy.

» Zapoijte se — otevie vychozi prohlize¢ na webové strance LibreOffice Prfipojte se k nam,
https://cs.libreoffice.org/community/pipojte-se-k-nam. Vyberte si téma, které vas zajima,
a pomozte tak vylepSit program.

* Podpof¥it LibreOffice finanéné — otevie vychozi prohlize¢ na darcovské strance
LibreOffice https://cs.libreoffice.org/donate/.
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* Informace o licenci — otevfe dialogové okno Licenc¢ni a pravni informace s informaci
o licenci, pod kterou je LibreOffice pfistupna.

+ Zkontrolovat aktualizace — otevie dialogové okno a zkontroluje web LibreOffice, zda
neobsahuje aktualizace verze softwaru. Dialog poskytuje pfilezitost stahnout
a nainstalovat jakékoli aktualizace LibreOffice.

* O aplikaci LibreOffice — otevfe dialogové okno a zobrazi informace o verzi LibreOffice
a pouzivaném operacnim systému. Tyto informace budou €asto vyZzadovany, pokud
pozadame komunitu o pomoc nebo asistenci se softwarem (V systému macOS se tato
volba naléza v nabidce LibreOffice).

DalSi volné dostupna podpora na internetu

Komunita LibreOffice kromé vyvoje softwaru poskytuje bezplatnou podporu od dobrovolnikd.
Vice informaci najdeme v tabulce 1 a na webové strance: http://cs.libreoffice.org/get-help/

Uplnou online podporu komunity hledejte v konferencich a na webové strankce Ask LibreOffice:
https://ask.libreoffice.org/en/questions. Kromé toho je od uzivateld k dispozici fada webovych
stranek s bezplatnymi radami a havody.

Tabulka 1: Bezplatna podpora pro uZivatele LibreOffice

Bezplatna podpora LibreOffice

Odpovédi na Casto kladené otazky

Casté otazky https://wiki.documentfoundation.org/Faqg/cs

Podpora od komunity poskytovana siti zkusenych uzivatel(

E-mailove konference https://cs.libreoffice.org/get-help/mailing-lists

Pomoci webové sluzby Ask je poskytovana komunitni podpora zdarma.
Vyhledat podobna témata nebo oteviit nova mizeme na strance

Otazky a odpovédi a https://ask.libreoffice.org/cs/questions

Databaze znalosti SluZba je k dispozici v nékolika dal$ich jazycich; sta¢i nahradit /en/ za cs-
cz, de, es, fr, ja, ko, nl, pt, tr, a mnoho dalSich na vySe uvedené webové
adrese.

Webové stranky LibreOffice v rliznych jazycich
https://cs.libreoffice.org/community/nic/

Podpora v réiznych E-mailové konference pro rlizné jazyky

jazycich https://wiki.documentfoundation.org/Local_Mailing_Lists
Informace o sociélnich sitich
https://wiki.documentfoundation.org/Website/Web_Sites_services

Informace o dostupnych moznostech pro zlepSeni pfistupnosti

Moznosti zpristupnent https://cs.libreoffice.org/get-help/accessibility/

Dalsi forum, které kromé podpory dalSim open-source kancelafskym
Férum OpenOffice balikdim poskytuje podporu i LibreOffice.
https://forum.openoffice.org/en/forum

Placena podpora a skoleni

Podpora a Skoleni je k dispozici prostfednictvim smluv o poskytovani sluzeb od prodejce nebo
poradenské firmy specializujici se na LibreOffice. Informace o certifikované profesionalni
podpofe se nachazi na webovych strankach The Document Foundation:
https://cs.libreoffice.org/get-help/professional-support/
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Mozné vzhledové odchylky

llustrace

LibreOffice Ize instalovat a spoustét v operacnich systémech Windows, Linux a macOS, pfiCemz
kazdy z nich ma nékolik verzi a uzivatelé si je mohou pfizplsobit (pisma, barvy, témata vzhledu,
spravce oken). llustrace v tomto navodu byly vytvofeny v rliznych operacénich systémech a na
rlznych pocitacich. Proto je mozné, Ze nékteré prvky v ilustracich nebudou pfesné takové, jak je
vidime na svém pocitaci.

Né&ktera dialogova okna se mohou lisit i diky rliznym nastavenim samotného LibreOffice. UzZivatel
si totiz mUzZe zvolit, zda chce pouZivat dialogova okna opera¢niho systému (vychozi), nebo okna,
které jsou soucasti programu LibreOffice.

Pokud chceme systémova dialogova okna zaménit za okna LibreOffice:

1) V operacnich systémech Linux a Windows v hlavni nabidce zvolime Nastroje >
MoZnosti > LibreOffice > Obecné, ¢imz se otevie okno s obecnymi nastavenimi.

2) V operacnim systému Mac toto okno otevieme v hlavni nabidce zvolenim LibreOffice >
Predvolby > Obecné.

3) Pro zobrazeni dialogl LibreOffice na displeji naseho pocitace zvolime PouZit dialogy
LibreOffice v sekci Dialogy Otevrit/UIloZit.

4) Klepnutim na OK uloZime nastaveni a okno zavieme.

Ikony

Komunita LibreOffice vytvofila ikony v nékolika sadach, jeZ zahrnuji Breeze, Colibre, Elementary,
Sifr a Tango. UZivatel si mdZe vybrat svoji oblibenou sadu. lkony, které opravdu uvidime ve své
verzi LibreOffice, se mohou liSit od ikon, které jsou zobrazeny v této priruc¢ce. Snimky obrazovky
byly vytvofeny ve standardni instalaci LibreOffice, v niz byla zvolena sada ikon Colibre.

Sadu ikon pouzitou v instalaci LibreOffice mizeme zménit nasledujicim zplsobem:

1) V operalnich systémech Linux a Windows v hlavni nabidce zvolime Nastroje >
MozZnosti > LibreOffice > Zobrazeni, ¢imz se otevie okno pro nastaveni vzhledu.

2) V operacnim systému Mac toto okno otevieme v hlavni nabidce LibreOffice >
Pfedvolby > Zobrazeni.

3) V sekci Styl ikon vybereme z moznosti dostupnych v rozeviracim seznamu Colibre
(SVG).

4) V rozbalovacim seznamu Velikost ikon vybereme Mala pro Nastrojova lista, LiSta karet
a Postranni lista.

5) Klepnutim na OK ulozime nastaveni a okno zavieme.
Poznamky

V nékterych distribucich opera¢niho systému Linux, jako napfiklad v Ubuntu, je
LibreOffice dostupny v uloZzisti softwaru, odkud je také nainstalovan. Sada ikon
Colibre pfitom neni standardné nainstalovana. Tuto sadu ikon Ize stdhnout z Ulozisté
softwaru pro pouzivany operacni systém Linux.

Pouzivani LibreOffice na systému macOS

Nékteré klavesové zkratky a polozky nabidek jsou v systému macOS jiné nez v systémech

MM s

v této priru€ce. Podrobnéjsi seznam se nachazi v napovédé aplikace.
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Tabulka 2: PouZivani LibreOffice na systému macOS

Windows nebo Linux Ekvivalent pro macOS Akce
Nastroje > MoZnosti LibreOffice > Predvolby Oteviou se moznosti nastaveni.
vybér nabidky
Klepnuti pravym Ctrl+klepnuti a/nebo klepnuti Otevre se mistni nabidka
tlaCitkem pravym tlacitkem v zavislosti na
nastaveni pocitaCe
Ctrl (Control) 3 (Command) Pouziva se také s dalSimi
klavesami.
Fi1 F+T Otevre se postranni liSta Styly.

Kdo napsal tuto uZivatelskou pFiru¢ku?

Tato pfirucka byla napsana a preloZzena dobrovolniky z komunity LibreOffice. Zisk z prodeje jeji
tisténé verze bude pouZzit ve prospéch komunity.

Casto kladené otazky

Jakou licenci LibreOffice pouziva?
LibreOffice je Sifen pod licenci Mozilla Public License (MPL), schvalenou organizaci the
Open Source Initiative (OSI). See https://www.libreoffice.org/about-us/licenses/

Je zalozen na kédu z Apache OpenOffice, ktery je k dispozici pod licenci Apache License
2.0, ale zahrnuje také software, ktery se liSi od verze k verzi v ramci fady dalSich open
source licenci. Novy kdd je dostupny pod licenci LGPL 3.0 and MPL 2.0.

Mohu LibreOffice dale distribuovat, rozdavat a Sifit?
Ano

Mohu LibreOffice prodavat?
Ano

Mohu LibreOffice pouzivat pro komeréni ucely a ve své firmé?
Ano.

Na kolik poéita¢i mohu LibreOffice nainstalovat?
Na libovolny pocet.

Je LibreOffice dostupny v mém jazyce?
LibreOffice byl lokalizovan do vice nez Gtyficeti jazyk(, takZze poZzadovany jazyk je
pravdépodobné podporovan. Navic je k dispozici vice nez 70 slovnik{ pro kontrolu
pravopisu, déleni a tezaury pro jazyky a jejich dialekty, do nichz neni lokalizované
uZivatelské rozhrani. Tyto slovniky jsou dostupné na strance LibreOffice:
https://cs.libreoffice.org.

Jak je mozné, Ze program LibreOffice je dostupny zdarma?
LibreOffice vyvijeji a udrzuji dobrovolnici s podporou vice firem.

Vyvijim softwarovou aplikaci. Mohu pouzit zdrojovy kéd LibreOffice v mém programu?
Ano, v rdmci podminek ur¢enych licenci MPL a/nebo LGPL. Pfectéte si licenci:
https://www.mozilla.org/MPL/2.0/.
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Proc ke spusténi LibreOffice potfebuji Javu? Je napsan v Javé?
LibreOffice neni napsan v Javé, je napsan v jazyce C++. Java je jednim z jazykd, které Ize
pouzit k jeho rozsifovani. Béhové prostredi Java (JDK/JRE) je tfeba jen kvdli nékterym
funkcim. Jednou z nich je napfiklad databazovy stroj HSQLDB.

Java je dostupna bezplatné. DalSi informace a odkazy ke staZzeni na pfislusné vydani pro
vas operacni systém najdeme na adrese: https://java.com/en/download/manual.jsp

Poznamka

Pokud maiji byt pouzity funkce LibreOffice, které vyZaduji Javu, je ddlezité, aby 32
bitové nebo 64 bitové verze odpovidala nainstalované verzi LibreOffice. Viz pfirucka
Zaciname s LibreOffice. Pokud neni Java dostupnd, Ize stéle pouzivat témér
v8echny funkce LibreOffice.

Jak mohu k LibreOffice pFispét?
PFi vyvoji a uzivatelské podpore LibreOffice Ize pomoci rliznymi zplsoby Neni k tomu tfeba
byt programator. Chceme-li zagit, podivame se na tuto webovou stranku:
https://cs.libreoffice.org/community/get-involved/

Mohu PDF soubor této pFirucky dale distribuovat, pfipadné jej i tisknout a prodavat?
Ano, pokud jsou spinény podminky alespon jedné z licenci, které jsou uvedeny na zacatku
této prirucky. Neni k tomu tfeba zadné specialni povoleni. Jako pfispévatelé k této pfFirucce
vas vSak Zzaddame, abyste vzali v ivahu mnoZstvi prace, které bylo na jeji psani a preklad
vynaloZeno a abyste se podélili o ¢ast svého zisku.

Prispéjte LibreOffice: https://cs.libreoffice.org/donate/

Co je nového v LibreOffice 7.1?

Poznamky k verzi LibreOffice 7.1 jsou k dispozici na tomto odkazu
https://wiki.documentfoundation.org/ReleaseNotes/7.1

N v s

vice informaci o funkcich, které jsou soucasti LibreOffice.
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Kapitola 1,
Predstavujeme program Draw
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Uvod

LibreOffice Draw je vektorovy graficky kreslici program, i kdyZ ho Ize pouzit také k provadéni
urcitych operaci na rastrové (bodové) grafice. Pomoci Draw Ize snadno a rychle vytvofit Sirokou
Skalu grafickych obrazkd.

Vektorova grafika uklada a zobrazuje obrazek jako sestavu jednoduchych geometrickych prvki,
jako jsou ¢ary, kruhy a mnohouhelniky, spiSe nez soubor pixell (bod( na obrazovce). Vektorova
grafika umoZznuje snaze obrazek ukladat a ménit jeho velikost.

Modul Draw je pIné integrovan do baliku LibreOffice, coz zjednodu$uje vyménu obrazk(

s ostatnimi soucastmi baliku. Obrazek vytvofeny v programu Draw Ize relativné snadno opétovné
pouzit v dokumentu Writer, a to napf. tak, Ze vykres Draw vybereme a zkopirujeme a poté ho
vloZime pfimo do dokumentu Writer. S kresbami mdZeme pracovat také pfimo z programu Writer
nebo Impress pomoci sady funkci a nastrojl z programu Draw.

Moznosti programu LibreOffice Draw jsou znacné. Trebaze nebyl vytvofen jako ndhrada
pokrogilych grafickych programd, obsahuje vice funkci nez nastroje pro kresby, které byvaji
soucasti vétsiny kancelarskych balikd.

Né&kolik priklad( funkci pro kresby: sprava vrstev, mfizka s pfichytavanim, zobrazeni két

a méfitka, spojnice pro vytvareni organizacénich graft, funkce pro vytvareni trojrozmérnych
kreseb (s texturou a svételnymi efekty), integrace kresby a stylu stranky a Bézierovy krivky.

Tato pfirucka k programu Draw neni u€ebnici, kterou by bylo tfeba propracovat se od zacatku do

konce. Jedna se spiSe o referen¢ni praci, kterou Ize prochazet s cilem najit navody ke
konkrétnim zalezitostem.

Tento dokument popisuje pouze funkce spojené s programem Draw. Nékteré koncepty, napriklad
sprava soubori nebo zplsob, jakym funguje prostiedi LibreOffice, jsou zminény pouze stru¢né
a jsou podrobngji popsany v pfiru¢ce Za¢iname s LibreOffice.

Hlavni okno modulu Draw

MM/

Pracovni plocha

Velkéa plocha ve stfedu hlavniho okna modulu Draw (Pracovni plocha) slouZzi k vytvafeni kreseb.
Tato oblast kresleni mliZe byt obklopena nastrojovymi listami a informacénimi oblastmi. Pocet

a umisténi viditelnych nastrojl se lisi podle konkrétniho Ukolu a uzivatelskych preferenci, proto
mdZe pracovni prostor zobrazeny na jiném pocitaci vypadat jinak nez na obrazku 1.

Maximalni velikost stranky vykresu v LibreOffice Draw je omezena nastavenim pocitace
a velikosti stranky, kterou Ize nastavit a pouZit v tiskarné pfipojené k pocitaci.
Ve vychozim nastaveni se pracovni prostor sklada ze tfi vrstev (RozloZeni, Ovladaci prvky

a Kétovaci ¢ary) a zalozky pro tyto vychozi vrstvy se zobrazi v dolni ¢asti pracovni plochy.
Vychozi vrstvy nelze odstranit ani pfejmenovat, ale vrstvy je mozné pfidavat podle potreby.

Panel stranek

Kresby v Draw Ize rozdélit na nékolik stranek. Vicestrankové kresby se pouzivaji zejména pro
prezentace. Panel Stranky v levé ¢asti hlavniho okna programu Draw poskytuje prehled stranek,
které ve vykresu vytvafime. Pokud neni panel Stranky viditelny, pfejdeme na volbu Zobrazit na
listé nabidek a vybereme Panel stranek. Pokud chceme provést zmény v poradi stranek, staci
jednu nebo vice stranek pfetdhnout.
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Obréazek 1: Hlavni okno Draw

Stavovy fadek Vrstvy

Vrstva je pracovni prostor, do kterého miiZzeme vkladat prvky a objekty kresby. Lista Vrstvy se
nachazi ve spodni Casti pracovni plochy a obsahuje tfi vychozi vrstvy pojmenované RozvrZeni,
Ovladaci prvky a Kétovaci ¢ary. Dalsi informace o vrstvach najdeme v kapitole 11, Pokrocilé

techniky kresleni.

Postranni lista

Postranni liSta programu Draw ma pét zékladnich karet. Kartu rozbalime klepnutim na jeji ikonu
nebo na maly trojuhelnik » v zahlavi sekce; patficnou kartu vybereme z rozeviraciho seznamu.
Pokud neni postranni lista viditelna, pfejdeme v hlavni nabidce do Zobrazit > Postranni lista.

Vlastnosti

Obsahuje sekce pro vlastnosti objektu, napfiklad Stranka, Znak, Odstavec, Oblast, Zare,
Stin, Obrazek, Cara a Umisténi a velikost. Dostupné sekce zavisi na vybraném objektu.

Tvary

Poskytuje rychly vybér vétsiny poloZek, které jsou dostupné na nastrojové listg: Cary
a Sipky, Krivky a mnohouhelniky, Spojnice, Zakladni tvary, Tvary symbolii, Blokové Sipky,
Viyvojovy diagram, Bubliny, Hvézdy a cedule a 3D objekty.

Styly

Umozni objekty ve vykresu editovat a uplatnit na né Styly kresby. Pokud styl upravime,
zmeény se automaticky pouziji na vSechny prvky formatované pomoci tohoto stylu.

V aplikaci Draw nejsou Styly prezentace k dispozici.

Hlavni okno modulu Draw | 15



Galerie
Objekty z karty Galerie Ize vlozZit do vykresu bud jako kopii nebo jako odkaz. Galerie je
rozdé&lena do kategorii: Sipky, BPMN (Podnikové procesy), Kulaté odraZky, Diagramy,
Viyvojovy diagram, Ikony, Sit, Tvary a Zvuky. DalSi informace o pouZzivani Galerie najdeme
v kapitole 11, Pokrocilé techniky kresleni.

Navigator
Na postranni listé Navigatoru lze rychle vybrat stranky a objekty ve vykresu. Strankam
a objektlim ve vykresu je vhodné davat smysluplné nazvy, aby byly pfi pouZziti Navigatoru
snadno identifikovatelné.

Pravitka

Pravitka jsou umisténa na horni a levé strané pracovniho prostoru. Pokud nejsou viditelna,
prejdeme v hlavni nabidce do Zobrazit > Pravitka. Velikost vybraného objektu je na pravitkach
zobrazena pomoci dvojité ¢ary (zvyraznéna na obrazku 2). Pravitka mizeme mj. pouzit ke
spravé uchytl objektd a vodicich ¢ar pfi umistovani objektd.

Na pravitkach jsou také zndzornény okraje stranky nachazejici se v oblasti kresby. Okraje
mdzeme zmeénit tak, Ze je pfimo na pravitkach pretdhneme kurzorem. Oblasti okrajli jsou na
pravitkach vyznaceny Sedé, jak je zndzornéno na obrazku 2.

Pro zménu mérné jednotky na pravitku klepneme pravym tlaCitkem na pravitko a vybereme
mérnou jednotku z rozeviraciho seznamu, jak je znazornéno na obrazku 3 pro vodorovné
pravitko. Pro vodorovné a svislé pravitko miZeme nastavit riizné jednotky méreni.
Stavovy fadek

Stavovy fadek (obrazek 4) je ve vSech modulech LibreOffice umistén ve spodni ¢asti pracovni
plochy. Stavovy fadek skryjeme volbou Zobrazit na listé nabidek a zruSime vybér Stavovy
fadek.

Poznamka

Mérné jednotky zobrazené ve Stavovém fadku nastavime pomoci Nastroje >
Moznosti > LibreOffice Draw > Obecné v hlavni nabidce. Tyto jednotky méfeni se
mohou liSit od jednotek mé&feni nastavenych pro pravitka.
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Obréazek 2: Pravitko zobrazujici velikost
objektu
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Obréazek 3: Mérné jednotky pravitka
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Obréazek 4: Stavovy radek

Cislo snimku — zobrazuje &islo vybraného podokna kresleni.
Informacéni oblast — ukazuje, ktera akce se provadi nebo jaky typ objektu je vybrany.

Pozice kurzoru a Velikost objektu — zobrazuje rdizné informace podle toho, zda jsou
objekty vybrany nebo ne.

— Pokud neni vybran zadny objekt, Cisla pozic ukazuji aktualni polohu (soufadnice X
a Y) kurzoru mysi.

— P¥i vybéru objektu a zméné jeho velikosti taZzenim mysi se zobrazuje aktudlni velikost

objektu (Sifka a vyska).

— Pokud je vybran objekt, Cisla pozic zobrazuji soufadnice X a Y levého horniho rohu
a dvojice Cisel velikosti objektll zobrazuje velikost objektu. Tato ¢isla se netykaji
samotného objektu, ale obrysu vybéru, coz je nejmensi mozny obdélnik, ktery mize
obsahovat viditelnou ¢ast nebo €asti objektu. Dalsi informace najdeme v kapitole 3,
Prace s objekty a body objekt(.

— KdyzZ je vybran objekt, kliknutim do kterékoli z téchto oblasti se otevie dialogové okno
Umisténi a velikost. Dal$i informace najdeme v kapitole 4, Zména atribut(l objektu.

Neulozené zmény — oznacuje, Ze soubor je tfeba ulozit; ikona zavisi na nastaveni
pocitaCe. Pokud je soubor novy a dosud nebyl uloZen, kliknutim na tuto ikonu se otevie
dialogové okno Ulozit jako. Pokud byl soubor pfed provedenim zmeén jiz uloZen, kliknutim
na tuto ikonu se po provedeni jakychkoli zmén upraveny soubor automaticky uloZzi.

Digitalni podpis — oznacuje, zda je dokument digitdlné podepsan. Ikona se zobrazi jen
v pfipadé, Ze kresba ma certifikat digitalniho podpisu. Po uloZeni souboru se poklepanim
na tuto ikonu otevre dialog digitalnich podpist. Dalsi informace o certifikatech digitalniho
podpisu najdeme v napovédeé LibreOffice.
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« PFizplsobit snimek aktualnimu oknu — zméni velikost kresby tak, aby se cela
zobrazila v pracovnim prostoru.

* Posuvnik a Mira pfiblizeni — upravuje a oznacuje procento zvétSeni zobrazeného
pracovniho prostoru. Poklepanim na procento pfiblizeni se otevie dialogové okno
Priblizeni a rezim zobrazeni.
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Obrazek 5: Viditelna tlacitka na panelu nastroji
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Nastrojové listy
Chceme-li zobrazit nebo skryt rlizné nastrojové listy Draw, pfejdeme na Zobrazit > Nastrojové
liSty na liSté nabidek a z rozeviraci nabidky poZadovanou nastrojovou liStu vybereme. Napfiklad

ve vychozim nastaveni jsou zobrazeny nastrojové liSty Standardni a Kresba, ale nejsou
zobrazeny nastrojové listy Cara a vypli, Formatovani textu a Moznosti.

Vzhled ikon nastrojli na nastrojové listé zavisi na opera¢nim systému pocitace a vybéru stylu
a velikosti ikony v Nastroje > MoZnosti > LibreOffice > Zobrazeni.

Nastroje dostupné na nastrojové listé jsou oznaceny stinovanym obrysem kolem ikony nastroje
nebo zaskrtnutim, jak ukazuje pfiklad na obrazku 5. Vice informaci o praci s nastrojovymi liStami
se nachazi v prirucce v Za¢iname s LibreOffice.

Ctyfi hlavni néstrojové listy pouZité v Draw jsou nasledujici:

Nastrojova liSta Standardni
Nastrojova lista Standardni (obrazek 6) je stejna pro vSechny komponenty LibreOffice
a neni v této kapitole podrobné popsana. Ve vychozim nastaveni je uzam€ena na pozici
v horni ¢asti hlavniho okna Draw.

Standardni

SRR RN =" o =

L R T
'a Lﬁ |.".: r [___’, - (I ./{; L D

Obréazek 6: Nastrojova lista Standardni

Nastrojova liSta Kresba
Nastrojova lista Kresba (obrazek 7) obsahuje vSechny funkce nezbytné pro kresleni
rliznych geometrickych tvard a tvard od ruky a pro jejich rozlozeni v kresbé. Ve vychozim
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nastaveni je uzamcena na pozici nalevo od hlavniho okna Draw. Podrobné je popséana
v kapitole 2, Kresleni zakladnich tvar.

Kresbha v X
% ﬁvr@v \DO _’v%vlv Ovv@vﬁﬁv@v{‘\(v-v
Obrazek 7: Nastrojova lista Kresba

Nastrojova lista Cara a vypli
Nastrojova lista Céara a vyplfi (obrazek 8) slouZi k Gpravé hlavnich vlastnosti nakresleného
objektu. Néstroje a rozeviraci seznamy se lisi podle typu vybraného objektu. Chceme-li
napfiklad zmeénit styl ¢ary, klepneme na Sipku u nastroje Styl €ary a posunem nahoru nebo
dolli vybereme poZadovany styl.

Cara a vipli

v X
L
Barva | rf NN - 0=~ 4~ A | S
Obréazek 8: Néstrojova lista Cara a vyplii

Funkce nastrojové listy Cara a Vyplii se pouzivaji ke zmé&né barvy, stylu a Sitky nakreslené
cary, barvy a stylu vypIné a dalSich vlastnosti vybraného objektu. Pokud je vybranym
objektem textové pole, je nastrojova lista Cara a vyplii nahrazena néastrojovou listou
Formatovani textu. Dal$i informace najdeme v kapitole 4 Zména atribut(l objektu.

Nastrojova lisSta Formatovani textu
Panel nastroji Formatovani textu (obrazek 9) je podobny panelu nastrojd Format v aplikaci
Writer. Je k dispozici pouze v pfipadé, Ze byl ve vykresu vybran textovy objekt, ktery
nahrazuje nastrojovou listu Cara a Vypli. Dalsi informace najdeme v kapitole 4 Zména
atributd objektu a Kapitola 9 Pfidavani a formatovani textu.

Formatovani textu

Likeration Sans v 1apt [~ AT A&t B T U 5| % X | 8 B A \
v X
-, : = — . . :
AP~ =-=-B===FF =/E~-= L TR

Obréazek 9: Nastrojova lista Formatovani textu
Pridavani a odebirani nastrojii
Vychozi sadu nastrojl na kazdé nastrojové listé Ize upravit pomoci volby Viditelna tlaéitka.
Nastroj na nastrojovou listu prfiddme nebo jej z ni odebereme nasledujicim zplisobem:

6) Klepneme pravym tlacitkem do prazdné oblasti na nastrojové listé nebo na dolli sméfujici
trojahelnik ¥ v ndzvu néstrojové listy a z mistni nabidky vybereme Viditelna tladitka.

7) Klepnutim na nazev nastroje miiZeme nastroj na nastrojovou listu pridat nebo jej z ni
odebrat.
Poznamka

Kdyz nastroj pfidame, je jeho umisténi na nastrojové listé (zleva doprava) stejné jako
jeho poloha v mistni nabidce Viditelna tlacitka.
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Dostupné sady nastrojii

NE&které nastroje na nastrojové listé maji napravo od prislusné ikony doll smértujici trojahelnik v .
To znamena, Ze nastroj ma k dispozici dalsi nastroje. Klepnutim na doll sméfujici trojihelnik v
zobrazime celou sadu néastroji (obrazek 10).

Tuto sadu nastroji je mozné prfeménit na plovouci nastrojovou listu. Klepneme na oblast v horni
¢asti sady nastrojd, jak je znazornéno na obrazku 10, pfetdhneme ji pres obrazovku na vhodné
misto a uvolnime tlaCitko mySi. Pokud chceme plovouci nastrojovou listu zavfit, klepneme na X
vpravo od nadpisu nastrojove listy.

Kliknutim sem a taZenim

vytvafite plovouci nastrojovou listu

/ Viyvojovy diagram X

Do omEB, (0UdS B

DoQOoOuU| i g0 C OVl

CU0Oc®@eg| | OULRR P

X8 AVAD| | X8 AVAD
QB MO Qe ®O

Obrazek 10: Dostupné nastroje a plovouci
nastrojova lista

Poznamka

KdyZ se ze sady nastrojll stane plovouci nastrojova lista, na misté nastroje na pevné
nastrojové listé se zobrazuje nastroj, ktery byl pouzit jako posledni. To znamena, ze
ikona nastroje na obrazovce se mlze liSit od ikony nastroje zobrazené v této
pFirucce.

@ Tip
Po dvojitém kliknuti na nastroj se pfikaz odpovidajici tomuto nastroji stane aktivnim
a zUstane aktivni. Pfikaz nastroje Ize opakovat tak ¢asto, jak je tfeba. Chceme-li

tento rezim ukoncit, klepneme na tlacitko Esc nebo zvolime jiny nastroj. Poznamka:
vySe popsané nemusi fungovat u kazdého néstroje na kazdé nastrojové listé.

Ukotvené a plovouci panely nastroju

Ve vychozim nastaveni jsou pfi otevieni aplikace Draw nastrojové liSty Standardni a Kresba
uzamceny a ukotveny do svych pozic v hlavnim okné Draw. Tyto nastrojové liSty je moZné odpaoijit
a vytvofit z nich plovouci nastrojové lisSty. Jak nastrojovou liStu odpojit a pfeménit v plovouci
nastrojovou listu:

1) PFfesuneme kurzor mySi na Uchyt nastrojové listy, ktery se nachazi Gpiné vlevo (obrazek
11). Kurzor v zavislosti na nastaveni pocitace a operacnim systému zmeéni tvar, obvykle
na symbol seviené ruky.

2) Kliknutim a taZzenim za Uchyt nastrojove listy zaCnheme liStu pfesouvat, dokud se nezméni
v plovouci néstrojovou liStu. Tato funkce plovouci néstrojové listy je spole€na pro vSechny
komponenty LibreOffice.

Plovouci nastrojovou listu ukotvime dvojklikem na jeji ndzev za souCasného stisku klavesy Cirl.
Nastrojova lista se pfesune do dostupného prostoru v horni ¢asti hlavniho okna Draw.
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Alternativni metodou ukotveni nastrojové liSty je kliknout na jeji nazev a pfetahnout nastrojovou
listu na poZzadovanou ukotvenou pozici. MZe to byt pozice horni, dolni nebo jedna ze stran
hlavniho okna Draw.

Manipulatory —__—»r & ~ = A
panelli nastrojil s 4. |5, [

Obrazek 11: Uchyty nastrojové listy

Odemykani a zamykani nastrojovych list
Ve vychozim nastaveni pfi otevieni Draw jsou vSechny ukotvené nastrojové liSty uzaméeny na

pozici. Aby bylo mozZné je pfeménit v plovouci néstrojové listy nebo pfesunout do hlavniho okna
Draw, je tfeba je nejdfiv odemknout.

Chceme-li nastrojovou listu odemknout, klikneme pravym tlacitkem do prazdné oblasti nastrojové
liSty a v mistni nabidce zruSime vybér Zamknout umisténi liSty. V levé ¢asti nastrojové listy se
objevi Uchyt, jak je znazornéno na obrazku 11, coZ znamena, Ze nastrojova lista je odemcena

a je mozné ji pfesouvat.

Chceme-li nastrojovou listu uzamknout na pozici, ukotvime ji na misto, poté klepneme pravym
tlacitkem do prazdné oblasti nastrojove liSty a v mistni nabidce vybereme Zamknout umisténi
nastrojové listy. Uchyty z levé ¢asti nastrojové listy zmizi.

Prizp(isobujeme si nastrojové listy

Nastrojové listy Draw miZeme pfizplsobovat pfidavanim nebo odebiranim nastrojd.
PrizpUsobeni také umoziiuje vytvaret nastrojové listy pro konkrétni Ucely. Prizptsobeni
nastrojovych list dopliiuje moznosti uvedené vyse v ¢asti ,Pfidavani a odebirani nastroji“.

Dal3i informace o pfidavani novych nastrojl, Upravach nebo vytvareni nastrojovych list najdeme
v pfirucce Zac¢iname s LibreOffice.

T I e e
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Obréazek 12: Paleta (liSta) barev

Volba a definovani barev

Barevna paleta

Paleta barev (obrazek 12 ) poskytuje rychly pfistup ke standardni sadé barev, které Ize pouZit
pro vybrané objekty a text ve vykresu.

1) Paletu barev otevieme pomoci tlacditka Zobrazit na li5té nabidek a vybérem LiSta barev.
2) Vybereme objekt nebo text, jehoz barvu chceme zménit.

3) Barvu vypiné objektu nebo textu zménime tak, zZe klepneme levym tlacitkem mysSi na
poZadovanou barvu.
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4) Barvu ohranic¢eni objektu nebo textového pole zménime, kdyz na poZzadovanou barvu
klepneme pravym tlaCitkem mysi.

5) LiStu barev zavieme pomoci tlaCitka Zobrazit na listé nabidek a zruSenim vybéru Lista
barev.

Poznamka

Ramecek s X vlevo dole na listé barev znamena zadna (barva).

Poznamka

Barvy dostupné v paleté barev zavisi na paleté barev, ktera byla dfive na objektu pfi
zméneé barvy pouZita. Napfiklad obradzek 12 zobrazuje standardni paletu barev, ktera
byla dfive pouzita pfi zméné barvy objektu pomoci dialogového okna viastnosti.

Specializované palety barev

Kromé standardni palety barev ma Draw k dispozici nékolik specializovanych palet barev, které
nabizeji vétsi vybér barev: napfiklad palety grafli, materialu, html atd. Po vybéru objektu nebo
textu ve vykresu pouzijeme pro pristup ke specializovanym paletdm barev jeden z nasledujicich
postupd.

* Barva oblasti nebo vypiné — sekce Barvy v dialogu Oblast, Barva vypIné na nastrojove
listé Kresba nebo Cara a vypli nebo Vyplr v sekci Oblast na bo€nim panelu Vlastnosti.

+ Barva ¢ary — stranka Céara v dialogu Céra, Barva &ary na nastrojové listé Kresba nebo
Céra a vypln nebo Barva v sekci Cara na bo¢nim panelu Vlastnosti.

* Barva textu — nastroj Barva pisma na nastrojové listé Formatovani textu nebo Barva
pisma v sekci Znak na bo€nim panelu Vlastnosti.

DalSi informace o vybéru barvy a palety barev pro objekt nebo text najdeme v kapitole 4, Zména
vlastnosti objektu, v kapitole 9, Pfidavani a formatovani textu a v kapitole 11, Pokrocilé techniky
kresleni.

Vlastni barvy

V Draw lIze vytvofit vlastni barvy pomoci dialogu Vybér barvy, konkrétnich hodnot CMYK nebo
specifickych hodnot RGB tak, aby odpovidaly barevnym schématim pouzivanym ve spole¢nosti.

vvvvv

schématech CMYK a RGB najdeme v kapitole 11, Pokrocilé techniky kresleni.

MFizka, prichyceni a pomocné ¢ary

Jako pomcky pro kresleni funguji v Draw mfizky a voditka. Lze je zapnout nebo vypnout
klepnutim na Zobrazit m¥izku nebo Zobrazit voditka na nastrojové listé Cara a vypli nebo
Moznosti. MfiZzka a voditka se zobrazuji pouze na obrazovce a nezobrazuji se na tisténém
vykresu nebo pfi pouZiti vykresu v jiném modulu LibreOffice. Barvu, rozte¢ a rozlieni bod(

mrizky lze individualné zvolit pro kazdou osu.

Pfi pohybu objekt( Ize zobrazit pomocné ¢ary, které se zapinaji a vypinaji klepnutim na Voditka
p¥i pfesouvani na panelu nastrojii Cara a vyplii nebo MoZnosti. Zobrazovani polohy objektu pfi
pohybu usnadriuje umisténi objektu. Pokud je tato funkce aktivovana, budou se pfi pohybu
objektu zobrazovat dvojice svislych a vodorovnych €ar obklopujicich objekt. Tyto ¢ary sahaji az
k okrajlim kreslici oblasti.

Draw také nabizi nékolik funkci uchopeni k pfesnému umisténi objektl ve vykresu.
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DalSi informace o mfiZce, voditkach, uchopovacich funkcich a pomocnych ¢arach najdeme
v kapitole 3, Prace s objekty a body objekt(.
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Kapitola 2,
Kresleni zakladnich tvaru



Uvod

LibreOffice Draw mUZe vytvaret 2D a 3D objekty. Tato kapitola ukazuije, jak kreslit jednoduché 2D
objekty. Nasledujici kapitoly popisuji, jak s takovymi objekty pracovat a jak je upravovat. Vice
informaci o 3D objektech najdeme v kapitole 7, Prace s 3D objekty.

M w s

oznaceni v softwaru pro vektorové kresleni.

Nastroje pro kresleni se nachazeji na nastrojové listé Kresba (obrazek 13). Tato nastrojova lista
je obvykle umisténa na levé strané hlavniho okna programu Draw. Pokud neni néstrojova lista
viditelna, aktivujeme ji pomoci volby Zobrazit > Nastrojové liSty v hlavni nabidce

a z dostupnych moznosti vybereme Kresba.

Stejné jako u v8ech komponent LibreOffice Ize nastrojovou liStu Kresba odemknout a umistit na
pracovni ploSe programu Draw jako plovouci nastrojovou listu. Nastrojovou liStu Ize konfigurovat
pridanim, presunutim, skrytim nebo odstranénim nastrojd. Vice informaci najdeme v kapitole 1,

Uvod do programu Draw.

Kdyz je tvar nakresleny, vybereme objekt pro Upravu nebo pfidame do kresby text, informacni
pole ve Stavovém fadku (obrazek 14) odrazi provedené upravy nebo probihajici Upravy. Vice
informaci o Stavovém fadku najdeme v kapitole 1, Uvod do programu Draw.

Kresba w X

E}ﬁvﬁ.ﬁv \DO_'vEgv‘-l_.v Ovv@vﬁﬁv@vﬁv-v

Obrazek 13: Nastrojova liSta Kresba
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Obrazek 14: Stavovy Fadek

Kresleni zakladnich tvaru

Zakladni tvary, v€etné textu, jsou v programu Draw povazovany za objekty. Vychozi sada
nastrojd dostupnych pro kresleni zakladnich tvar(i na nastrojové listé Kresba je zobrazena na
obrazku 13.

Vice informaci o pridani dalSich nastrojd na nastrojovou listu Kresba najdeme v kapitole 1, Uvod
do programu Draw a v prirucce Zac¢iname s LibreOffice. Obrazek 15 zobrazuje nastroje, které
jsou dostupné pro pfidani na nastrojovou liStu Kresba. Nastroje, které jsou jiz na nastrojoveé listé
nainstalovany, jsou oznaceny stinovanym obrysem kolem ikony nastroje nebo zaSkrtnutim.

Né&které ikony nastrojii na nastrojové listé Kresba méni tvar podle posledniho pouzitého nastroje
z vybéru dostupnych nastrojd. Trojihelnik sméfujici dold v, ktery najdeme napravo od ikony
nastroje, znamena, Ze je k dispozici vice nastrojd. Vice informaci o dostupnych nastrojich

AT

najdeme v Céasti ,Kresleni geometrickych tvaru" na strané 41.
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"/ Poznamka
KdyZ je nakreslen zékladni tvar nebo je vybran pro Gpravy, zméni se informacni

oblast na leve strané stavoveho fadku tak, aby odrazela aktualni akci. Napriklad
Vytvorit Céara, Vlybrano Textovy ramec xxyy atd.

: Vlastnosti X
+ Znak Y
Odstavec N

—| Céra F <&
Cara = - - %?’
Sitk -
Barva =/ I ~ (o)
Prihlednost: |0 % =

Styl rohu: Zakulaceny o

Styl zakonceni: |Ploché o
Umisteni a velikost: N

Obrazek 15: Nastroje dostupné pro nastrojovou listu
Kresba

Pocatecni

bod
,L“'"f
b

™
b

Mo

Obrazek 16: Pocatecni bod
cary

Rovné ¢ary

Vytvareni car

Pfimka je nejjednodussi prvek nebo objekt, ktery miizeme v programu Draw vytvorit.
6) K zahdjeni kresleni pfimky pouzijeme jednu z nasledujicich moznosti:

— Na néstrojoveé listé Kresba klepneme na Vlozit ¢aru.

— Klepneme na trojuhelnik ¥ na pravé stran& nastroje Cary a Sipky na nastrojové listé
Kresba (obrazek 13) a z rozeviraciho seznamu vybereme Vlozit €aru.

— Klepneme na VloZit &aru v ¢asti Cara na karté Tvary v postranni listé (obrazek).

7) Umistime kurzor do pocate€niho bodu kresby, poté klepnutim a taZzenim kurzoru
nakreslime pfimku.
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8) Jakmile je dosazeno koncového bodu a je vytvorfena pfimka, uvolnime tlagitko mySi. Na
obou koncich ¢ary se zobrazi uchyty, které znaci, Ze je dany objekt aktuélné vybran.
Ovlada€ vybéru v pocatecnim bodé Cary je o néco vétsi nez ovladac vybéru v koncovém
bodu, jak je znazornéno na obrazku.

9) Chceme-li pfichytit pocate¢ni a koncovy bod ¢ary k mrizce, pouzijeme jednu
Z nasledujicich mozZnosti:

— P¥i kresleni ¢ary podrzime klavesu Ctrl.

— V hlavni nabidce zvolime Zobrazit > Voditka a z nabizenych moznosti vybereme
Prichytit k mfiZce.

— Pokud chceme docasné deaktivovat PFichytit k m¥iZce, kdyzZ je aktivni, drzime pfi
kresleni Cary stisknutou klavesu Ctrl.

Poznamka

Chceme-li zobrazit mfizku, pfejdeme v hlavni nabidce na Zobrazit > Mfizka

a voditka a zvolime Zobrazovat mfizku. Pripadné pfejdeme do Nastroje >
MozZnosti LibreOffice Draw > MFiZka a zvolime Viditelna mfizka.

10) Chceme-li omezit Ghel kresleni ¢ary na nasobky 45 stupiill, pouZzijeme jednu
Z nasledujicich moznosti:

— Drzime pfi kresleni ¢ary stisknutou klavesu Shift.
— Pokud je moznost v Casti Omezit objekty

— Prejdeme do Nastroje > Moznosti > LibreOffice Draw > Mf¥izka a vybereme P¥i
vytvareni nebo presunu objekti v Casti Omezit objekty.

— Pro do¢asnou deaktivaci Pri vytvareni nebo presunu objekt( drzime pfi kresleni ¢ary
stisknutou klavesu Shift.

11) Chceme-li nakreslit ¢aru symetricky smérem ven v obou smérech od stfedu ¢ary,
podrZzime pfi kresleni Cary klavesu Alt.

Formatovani éar

KdyZ je ¢ara nakreslena, méa vlastnosti nastavené na vychozi hodnoty. Chceme-li zménit néktery
z t&chto atributd a naformatovat ¢aru podle potieby, klepnutim ¢aru vybereme a pouzijeme jednu
Z nasledujicich moznosti pro pfistup k formatovani cary:

+ Pfejdeme na kartu Vlastnosti v postranni li3té a otevieme ¢ast Cdra (obrazek 17).

* Klepneme pravym tlacitkem mysi na ¢aru a volbou Cara z mistni nabidky otevieme
dialogové okno Céra (obrazek 18).
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Obrézek 17: Cast Céra na karté Vlastnosti
v postranni listé
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Obréazek 18: Dialogové okno Céra - stranka Cara
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Obréazek 19: Néastrojovad lista Cara a vyplri

Cary a Sipky v X

e Y
Obrazek 20: DilCi nastrojové listy
Cary a Sipky

28 | Pfirucka Draw 7.1



« Pomoci volby Format > Cara v hlavni nabidce otevieme dialogové okno Céra.

« Pouzijeme nastroje Styl &ary, Sitka ¢ary a Barva &ary na nastrojové listé Cary a vypli
(obrazek 19).

Cary a Sipky

Program Draw klasifikuje Cary i Sipky jako Cary a kresli je jako pfimky. Umisténim kurzoru nad
kazdy nastroj v dil¢im panelu Céry a Sipky (obrazek 20) zjistime, jaky typ ¢ary nebo Sipky bude
kazdy nastroj kreslit. V poli ve stavovém Fadku jsou ve vypisu informaci ozna€ovany jen jako
cary.

Nastroje dostupné pro Cary nebo Sipky jsou nasledujici (zleva doprava):

Vlozit ¢aru Cara kon¢i Sipkou Cara se Sipkou/kruznici
Cara se Gtvercem/Sipkou  Céra se Sipkami Cara zacina Sipkou
Céra se Sipkou/kruznici Céra se Sipkou/&tvercem Kotovaci cara

Céra (45°)

"/ Poznamka

Ikona nastroje pro posledni pouzity nastroj jiz bude v nastrojové listé Kresba
vybrana. To usnadinuje opakované pouziti stejného nastroje.
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Obréazek 21: Karta Tvary v postranni listé

Vytvareni ¢ar nebo Sipek
1) K zahajeni kresleni ¢ary nebo Sipky pouzijeme jednu z nasledujicich moznosti:
— Klepneme na maly trojuhelnik v vedle nastroje Cary a Sipky na nastrojové listé
Kresba a dostupnych moZnosti vybereme pozadovany typ ¢ary nebo Sipky.
(obrazek 20).
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— V gasti Céry a Sipky na karté Tvary v postranni list& vybereme pozadovany typ ¢ary
nebo Sipky (obrazek 21).

2) Umistime kurzor do pocatecniho bodu ¢ary nebo Sipky, poté klepneme a pfetahneme
kurzor. Po uvolnéni tlaCitka mySi se v koncovém bodé Sipky nakresli hrot Sipky.

3) Vice informaci o moZnostech kresleni ¢ar a Sipek najdeme v ¢asti ,Rovné Cary" na strané
31.

Formatovani ¢ar nebo sSipek

Po nakresleni ¢ary nebo Sipky se ujistime, Ze je vybrana a ¢aru nebo Sipku naformatujeme podle
potfeby pomoci nasledujicich moZnosti:

* Vice informaci o formatovani ¢as najdeme v Casti ,Rovné ¢ary" na strané 31.
* Formatovani Sipky:

— Volbou Format > Cara v hlavni nabidce nebo klepnutim pravym tlagitkem na Sipku
otevieme dialogové okno Cara. Klepnutim na Styl Sipky otevieme stranku Styl Sipky
(obrazek 22). Z dostupnych moznosti rozeviraciho seznamu Styl Sipky vybereme styl
Sipky. Klepnutim na OK pouzijeme vybrany styl Sipky. Tim zménime oba konce Sipky
na stejny styl.

— Klepneme na Styl Sipky v ¢asti Cara na karté Vlastnosti v postranni list&. tim
otevieme rozeviraci seznam (obrazek 23) a vybereme styl Sipky. Styl Sipky vievo
zméni styl pocatecniho bodu Sipky. Styl Sipky vpravo zméni styl koncového bodu
Sipky.

Cara Stin Styly car Styly Sipek

Organizovat styly Sipek
Nazew: Kratka Sipka Pridat
Styl Sipky: | 4— Krétka Sipka v -
Zménit
Smazat
=

Pridanim zvoleného objektu wytvorite novy styl Sipky.

—r N\AN

ok T PR

Obréazek 22: Dialogové okno Caéra - stranka Styly Sipek
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Obrézek 23: Styly Sipek v &asti Cara na
karté Vlastnosti v postranni listé

Diivéj& obdélniky w X
OO0 = ®

Obrazek 24: Nastrojova lista

Al

Obdélniky nebo ¢tverce
1) K zahajeni kresleni obdélniku nebo ¢tverce pouZzijte jednu z nasledujicich moznosti:
— Klepneme na Obdélnik na nastrojove listé Kresba.
— Vybereme typ obdélniku nebo Ctverce v Casti Zakladni tvary na karté Tvary
v postranni listé.

— Klepneme na trojuhelnik v napravo od Zakladni tvary na nastrojové listé Kresba
a z rozeviraciho seznamu vybereme typ obdélniku nebo &tverce, ktery potfebujeme
(obrazek 34 na strané 42).

vvvvvv

~s i s

liSty v hlavni nabidce a vybereme ji.

2) Umistime kurzor na pocatecni bod obdélniku nebo Ctverce, poté klepneme a tahneme
kurzorem, dokud nebude nebude nakreslen obdélnik nebo ¢tverec poZzadované velikosti.

3) Pokud je vybran nastroj Obdélnik, podrzenim stisknuté klavesy Shift nakreslime Ctverec.

4) Jestlize mame vybran nastroj Obdélnik a chceme nakreslit Etverec od jeho stfedu radéji
nez z pravého dolniho rohu, drzime pfi taZzeni kurzoru stisknuté klavesy Shift a Alt.
Pocatecnim bodem Ctverce bude stfed Ctverce.

5) Pokud chceme nakreslit obdélnik nebo ¢tverec z radéji jeho stfedu nez z pravého dolniho
rohu, drzime pfi tazeni kurzoru stisknutou klavesu Alt. Poc¢atecnim bodem obdélniku
nebo ¢tverce bude stfed obdélniku nebo Gtverce.
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Poznamka

Pokud je vybrana moznost Pri vytvareni nebo presunu objekti v ¢asti Omezit
objekty v Nastroje > MoZnosti > LibreOffice Draw > MfiZka, je funkcionalita
klavesy Shift obracenda. Misto obdélniku je nakreslen ¢tverec. Pokud chceme
nakreslit obdélnik, podrzime kldvesu Shift. Toto obraceni funkcionality klavesy Shift
plati také pfi kresleni elips, kruh(, obloukl a Useci.

Elipsy nebo kruhy
1) K zahajeni kresleni elipsy nebo kruZnice pouZijeme jednu z nasledujicich moZnosti:
— Klepneme na ikonu Elipsa na nastrojové listé Kresba.
— Vybereme typ elipsy nebo kruhu v Casti Zakladni tvary na karté Tvary v postranni listé.

— Klepneme na trojuhelnik ¥ napravo od ikony Zakladni tvary na nastrojové listé
Kresba a vybereme pozadovany typ elipsy nebo kruhu z rozeviraciho seznamu
(obrazek 34 na strané 42).

vvvvvv

~s s

vybereme ji v hlavni nabidce v poloZce Zobrazit > Nastrojové liSty.

2) Umistime kurzor do pocate€niho bodu elipsy nebo kruhu, poté klepneme a tahneme
kurzorem, dokud nenakreslime tvar o poZzadované velikosti.

3) Pokud je vybran nastroj Elipsa, podrZzenim stisknuté klavesy Shift nakreslime kruh.

4) Jestlize mame vybrany nastroj Elipsa a chceme nakreslit kruh od jeho stfedu, radéji nez
z pravého dolniho rohu, drzime pfi tazeni kurzoru stisknuté klavesy Shift a Alt. Kruh
pouziva jako pocatecni bod stfed kruhu.

5) Pokud chceme nakreslit elipsu nebo kruh z jeho stfedu, nikoliv z pravého dolniho rohu,
podrzime pfi tazeni kurzoru klavesu Alt. Elipsa nebo kruh pouzivéa jako pocatecni bod
stfed elipsy nebo kruhu.

Diivé&jE kruhy a ovaly v X

O oOboodsdbo o O

vvvvvv

6 Tip

Pokud chceme rychle vlozit Caru, obdélnik, elipsu nebo text, stiskneme a podrzime
klavesu Ctrl a poté klepneme na jednu z ikon Cara, Obdélnik, Elipsa nebo Text a na
pracovni ploSe se automaticky nakresli vybrany objekt standardni velikosti. Velikost,
tvar a barva maji standardni hodnoty. V pfipadé potfeby mliZzeme tyto vlastnosti
pozdgji zménit. Vice informaci najdeme v kapitole 4, Zména atributd objektu.

Kétovaci ¢ary
Koétovaci ¢ary zobrazuji rozmeéry objektu ve vykresu (obrazek 26). Kétovaci ¢ara nepatfi

k samotnému objektu, ale je umisténa blizko néj. Objekt miZe mit tolik kétovacich ¢ar, kolik je
potfeba k oznaceni velikosti jeho stran, okrajl a vzdalenosti.

Pokud chceme ovladat zobrazeni komponent a vzhledu kétovaci ¢ary pomoci klepnuti pravého
tlaCitka mysi, klepneme na kétovaci ¢aru a volbou Rozméry z mistni nabidky otevieme
dialogové okno Kétovaci Cara (obrazek 27).
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Vkladani kotovacich ¢ar

1) K nakresleni kétovaci ¢ary pouzijeme jednu z nasledujicich moznosti:

— Klepneme na trojuhelnik ¥ napravo od nastroje Cary a Sipky na nastrojové listé

Kresba a z rozeviraciho seznamu zvolime Kétovaci ¢ara.

— Klepneme na Kétovaci &ara v Casti Cary a Sipky na karté Tvary v postranni listé.
2) Umistime kurzor v blizkosti objektu, kde si pfejeme mit poCate¢ni bod kétovaci Cary.

3) Klepnutim a tazenim nakreslime kétovaci Caru. Pfi kresleni kotovaci Cary se kéta zobrazi
a automaticky vypocita.

4) Koétovaci ¢aru mizeme formatovat pomoci moznosti, které jsou k dispozici v dialogovém
okné Kétovaci ¢ara. Vice informaci o moznostech kétovaci ¢ary najdeme v kapitole 11,
Pokrocilé techniky kresleni.

Kotovaci Cara

L: 35 mm J

- 35mm _|

Obrazek 26: Méreni objektu

nomoci katovacich car

A

Desetinna mista:

Cara Legenda
Vzdalenost cary: 2| Umisténi textu
Pfevis voditka: b
Vzdalenost voditka: ®
Levé voditko: 0,00 cm E ~
Pravé voditko: 0,00 cm E Automaticky svisle
L1 Méfit pod objektem Automaticky vodorovné

Rovnobézné s carou
Zobrazit mérné jednotky

Automaticky

127.5mm ,

oK Zrugit

Obréazek 27: Dialogové okno Kotovaci cara
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Poznamka

Mérné jednotky pouzité pro kétovaci €ary Ize zménit v hlavni nabidce v Nastroje >
MoZnosti > LibreOffice Draw > Mfizka vybérem poZadované mérné jednotky
z dostupnych moznosti rozeviraciho seznamu Mérna jednotka.

Oblouky a segmenty

Nastroje pro kresleni oblouk( a Usedi (¢asti kruhl nebo elips) jsou dostupné na nasledujicich
mistech:

vvvvvv

» Nastrojova lista DFiveéjsi kruhy a ovaly (obrazek 25 na strané 37).

+ DilCi nastrojova lista Zakladni tvary (obrazek 34 na strané 42).

+ Cést Zékladni tvary na karté Tvary v postranni listé (obrazek 21 na strané 34).
Oblouk nebo Usec€ nakreslime nasledovné:

1) PoZadovany nastroj vybereme z jedné z vySe uvedenych moznosti.

2) Klepneme na priblizny pocate¢ni bod a tazenim kurzoru zaneme vytvaret oblouk nebo
usec. Jakmile je dosaZzeno poZadované velikosti objektu, uvolnime tla€itko mysi.

3) Presuneme kurzor na misto, kde oblouk nebo Use¢€ zacina a klepnutim zacneme kreslit
oblouk nebo Use€. Uhel ve stupnich je zobrazen ve Stavovém fadku.

4) PFesuneme kurzor na misto, kde oblouk nebo use¢ konéi. Uhel ve stupnich je zobrazen
ve Stavovém fadku.

5) Opétovnym klepnutim dokoncime kresleni oblouku nebo Usece.

Kiivky a mnohothelniky w X
G LBHYNAL Y

Obrazek 28: Nastrojova lista
Krivky a mnohouhelniky

KFivky, mnohouhelniky nebo ¢ary od ruky

Nastroje pro kresleni kfivek, mnohothelnikd nebo ¢ar od ruky jsou dostupné na nasledujicich
mistech:

* Klepneme na trojuhelnik v napravo od KFfivky a mnohothelniky na nastrojové listé
Kresba a z rozeviraciho seznamu vybereme typ kfivky, mnohouhelniku nebo ¢ary od
ruky.

* Vybereme typ kfivky, mnohouhelniku nebo ¢ary od ruky v &asti Krivky a mnohouthelniky
na karté Tvary v postranni liSté.

* Vybereme typ kfivky, mnohouhelniku nebo ¢ary od ruky z nastrojové listy KFfivky
a mnohouhelniky (obrazek 28).

Krivky
1) Klepnutim vytvofime pocate€ni bod kfivky, nasledné tazenim kurzoru z pocatec¢niho bodu
¢aru nakreslime.

2) Uvolnime tlacitko mySi a pokracujeme tazenim kurzoru, abychom ohnuli ¢aru do
poZadovaného tvaru kfivky.

3) Klepnutim nastavime koncovy bod kfivky a umistime k¥ivku do kresby.

4) PokraCujeme v tazeni kurzoru a nakreslime rovné Cary na konci kfivky. Kazdé klepnuti
mysSi nastavi rohovy bod a umozni nakreslit z rohu dalSi pfimku.

5) Poklepanim ukonc€ime kresleni kiivky a pfimych Car.
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Poznamka

KFivka s vyplni automaticky spoji posledni bod s prvnim bodem, aby byl objekt
uzavien a vyplnén vybranou vyplni. Kfivka bez vyplné nebude na konci kresleni
uzavfena.

Mnohouhelniky

1) Klepnutim vytvofime pocatecni bod a taZzenim kurzoru nakreslime ¢aru mezi prvnim
a druhym bodem.

2) Presunem kurzoru nakreslime dalsi ¢aru. Kazdé klepnuti mySi nastavi rohovy bod
a nakresli dalSi ¢aru.

3) Poklepanim ukoncime kresleni mnohouhelniku.

Poznamka

Mnohouhelnik s vyplni automaticky spoji posledni bod s poCatecnim bodem a vyplini
se vybranou vyplni. Mnohouhelnik bez vypIné neni na konci kresleni uzavfen.

Mnohouhelniky 45°

Jsou stejné jako obyc&ejné mnohouhelniky vytvareny z Car, ahly mezi Carami jsou vS8ak omezeny
na 45 nebo 90 stupnid. V pripadé potfeby podrzime pfi kresleni ¢ary stisknutou klavesu Shift
a tim zajistime, Ze je ¢ara nakreslena pod Ghlem 45 nebo 90 stupiid.

Cary od ruky

Nastroj pro kresleni €ar od ruky se pouziva podobné, jako se kresli tuzkou na papiru.
1) Klepneme a pretahneme kurzor a tim vytvofme pozadovany tvar Cary.
2) Uvolnénim tlagitka mySi dokon&ime kresleni ¢ary od ruky.

3) Pokud je vybrana moznost Céara od ruky, vyplnéna, posledni bod se automaticky spoji
s pocCatecnim bodem a objekt je vyplnén vybranou vypini.

Poznamka

Body v kfivkach, mnohouhelnicich a ¢arach od ruky Ize presouvat a upravovat. Vice
informaci najdeme v kapitole 3, Prace s objekty a v kapitole 11, Pokrocilé techniky
kresleni.

Zachytné body a spojnice

Zachytné body

VSechny objekty v programu Draw maji zachytné body, které se za béZnych okolnosti
nezobrazuji. Zachytné body se stanou viditelnymi, kdyZ jsou vybrany Spojnice na nastrojové
listé Kresba nebo je vybran nastroj pro spojnice v &asti Spojnice na karté Tvary v postranni listé.

VétSina objektl ma ¢tyfi zachytné body (obrazek 29). Dal$i zachytné body je mozné pridat
a upravit pomoci nastrojové listy Zachytné body (obrazek 30). Nastrojovou liStu otevieme pomaoci
volby Zobrazit > Nastrojové liSty > Zachytné body v hlavni nabidce.

Zachytné body nejsou totéz jako tchytky vybraného objektu. Uchyty pro vybér slouZi k pfesunuti
nebo zméné tvaru objektu. Zachytné body se pouzivaji k upevnéni nebo pfilepeni konektoru

k objektu tak, aby pfi pohybu objektu zlstal konektor pevné spojen s objektem. Detailni popis
pouziti zachytnych bodU najdeme v kapitole 3, Prace s objekty a body objektd a v kapitole 8,
Spojeni, vyvojové diagramy a organizacni diagramy.
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Obrazek 29: Priklad
Zachytnych bod(

Zachytné body v X
=] & B 4
Obrazek 30: Nastrojova liSta Zachytné body

Spojnice v X
TNaVLVvLNaewLNa\
Obrazek 31: Nastrojova lista Spojnice

Y

I

Obréazek 32: Spojnice mezi dvéma objekt);

Spojnice

Spojnice jsou ¢ary nebo Sipky, jejichz konce se automaticky prichytavaji k zachytnym boddim
objektu. Spojnice nejsou totéz co cary a Sipky. Pokud jsou objekty pfesunuty nebo jinak
usporadany, spojnice zlstavaji pripojeny k zachytnym boddim. Obrazek 32 ukazuje pfiklad dvou
objektd a spojnice.

Program Draw nabizi mnoho rliznych spojnic. Na nastrojové listé Kresba klepnutim na
trojuhelnik v vedle ikony Spojnice otevieme nastrojovou liStu Spojnice (obrazek 31) nebo
vybereme spojnici v Casti Spojnice na karté Tvary v postranni listé. PodrobnéjSi popis pouZziti
spojnic najdeme v kapitole 8, Konektory, vyvojové diagramy a organizacni grafy.

Kresleni geometrickych tvari

Nastroje pro kresleni geometrickych tvar(i najdeme na nastrojové listé Kresba (obrazek 13 na
strané 30) a na karté Tvary v postranni listé (obrazek 21 na strané 34). Pouziti téchto nastrojd
pro geometrické tvary je podobné jako pouziti nastroji pro kresleni obdéInikd a obdélniku nebo
elips a kruh(. Vice informaci najdeme v ¢asti "Kresleni zakladnich tvard" na strané 30.

Ikony nastrojli na nastrojové listé Kresba, které se pouZzivaji pro kresleni geometrickych tvard,
vZzdy zobrazuji posledni kresleny geometrickych tvar a ten nemusi byt stejna jako ikona nastroje
na nastrojové listé Kresba v této kapitole. To také usnadnuje opétovné pouZiti stejného nastroje.
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Klepnuti na trojuhelnik ¥ napravo od ikony nastroje na nastrojové listé Kresba otevre dilCi
nastrojovou listu, kter& ndm zpfistupni sadu nastrojd pro tento tvar. V pfipadé potfeby je mozné
tuto dil&i nastrojovou listu "odtrhnout" a vytvofit tak plovouci nastrojovou liStu.

Kliknutim sem a tazenim

/ vy tvoiite plovouci nastrojovou list
J Vivojovy diagram W X

O0<COomEBE| (OO0 ¢ JmB
L0 0oOvy| o 0C Oy
OCUu®g OU0@ P
XS AVAD| I X AVUAD
CRCR(VEE) QB OO

Obrazek 33: Vytvoreni plovouci nastrojové listy

« Klepneme na te¢kovanou ¢aru v horni ¢asti sady nastrojl (jak je znazornéno na obrazku
33), pfetahneme ji pfes obrazovku na pracovni plochu a pustime tlacitko mysi. Tim
vytvofime plovouci néstrojovou listu.

* Pokud chceme plovouci nastrojovou listu zavfit, klepneme na X vpravo od nadpisu
nastrojové listy.
"/ Poznamka

Ke vS§em témto geometrickym tvarlim je mozné pridat text. Vice informaci najdeme
v kapitole 11, Pokrocilé techniky kresleni.

Zakladni tvary

Klepnutim na trojuhelnik v vpravo od ikony Zakladni tvary na nastrojové liSté Kresba otevieme
diléi nastrojovou liStu Zakladni tvary (obrazek 34). Tato dil¢i nastrojova lista obsahuje také
nastroje pro obdélniky a elipsy, které jsou identické s témi zobrazenymi na nastrojové listé
Kresba. Pripadné vybereme poZzadovany nastroj v ¢asti Zakladni tvary na karté Tvary v postranni
liste.

Zakladni tvary w X
i uREIENFAVECRGRCRO NN
ANSCOOOSOUO6G

Obréazek 34: Nastrojova lista Zakladni
tvary

Tvary symboli

Klepnutim na trojuhelnik v vpravo od Tvary symboltli na nastrojové listé Kresba otevre dil¢i
nastrojovou listu Tvary symbol( (obrazek 35). Pfipadné vybereme poZzadovany nastroj v asti
Tvary symbol( na karté Tvary v postranni liSté.

Tvary symbol w X

OV 7O BT [ ] {} { }

Obrazek 35: Nastrojova lista Tvary symbol(i
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Blokové Sipky

Klepnutim na trojuhelnik v vpravo od ikony Blokové Sipky na nastrojove listé Kresba otevieme
dil¢i nastrojovou listu Blokové Sipky (obrazek 36). Pfipadné vybereme poZadovany nastroj v Casti
Blokové Sipky na karté Tvary v postranni liSté.

Blokové sipky v X

==l leoelarvVYrdhb

DD =a6 R ARG P P
Obréazek 36: Nastrojova lista Blokové Sipky

Vyvojové diagramy

Klepnutim na trojuhelnik ¥ vpravo od ikony Vyvojovy diagram na nastrojové listé Kresba
otevieme dilCi nastrojovou listu Vyvojovy diagram (obrazek 37). Pfipadné vybereme pozZadovany
nastroj v ¢asti Vyvojovy diagram na karté Tvary v postranni listé.

Vytvareni vyvojovych diagram(, organizacnich diagrami a podobnych planovacich nastrojl je
dale popséano v kapitole 8 Pfipojeni, vyvojové diagramy a organizacni diagramy.

Wvojovy diagram w X
oo gmMeElasOody
OUrn®@E XS AVUDAQAS OO

Obréazek 37: Nastrojova lista Vyvojovy diagram

Bubliny

Klepnutim na trojuhelnik ¥ vpravo od ikony Bubliny na nastrojové listé Kresba otevieme dil¢i
nastrojovou listu Bubliny (obrazek 38). Pripadné vybereme poZadovany nastroj v ¢asti Bubliny
na karté Tvary v postranni liSté..

Bubliny w X
miwNoNelslsls

Obréazek 38: Nastrojova
lista Bubliny

Hvézdy a cedule

Klepnutim na trojuhelnik v vpravo od ikony Hvézdy a cedule na nastrojove listé Kresba
otevieme dil¢i nastrojovou listu Hvézdy a cedule (obrazek 39). Pfipadné vybereme pozadovany
nastroj v ¢asti Hvézdy a cedule na karté Tvary v postranni li5té.

Hvézdy a cedule v X

CWwROBHRTOS O

Obrazek 39: Nastrojova lista Hvézdy
a cedule

3D objekty

Klepnutim na trojuhelnik ¥ napravo od ikony 3D objekty na nastrojové listé Kresba otevieme
nastrojovou listu 3D objekty (obrazek 40). Pfipadné vybereme poZadovany néstroj v ¢asti 3D
objekty na karté Tvary v postranni listé.

38 | Pfirucka Draw 7.1



3D objekty w X
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Obréazek 40: Nastrojova lista
3D objekty

Pridavani, vkladani a formatovani textu

V programu Draw mdZeme text v kresbach, objektech a tvarech pridavat, vkladat a formatovat.
Vice informaci o pridavani, vkladani a forméatovani textu v kresbach nebo nakreslenych
objektech najdeme v kapitole 9, Pfidavani a formatovani textu.
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Uvod

Tato kapitola se zabyva nastroji a funkcemi, které vyuzijeme pfi Gpravé existujicich kreseb.
V3echny funkce plsobi na vybrany objekt nebo vybranou skupinu objektd, kterou pozname podle
obrysu a Uchytek obdélnikového vybéru obsahujiciho objekty. Pokud je vybrano nékolik objektd,
je vybér objektll znazornén nejmensim moznym obdélnikem obsahujicim vSechny objekty.
Nazyva se obdélnik vybéru.

Poznamka

Barva a tvar Uchytek vybéru se méni v zavislosti na nastrojich a funkcich, které
pouzijeme ke zméné vlastnosti objektu. Barva Uchytek vybéru také zavisi na
operacnim systému a nastaveni pocitace.

Vybér objekti

Primy vybér
Nejjednodussi zplsob, jak vybrat objekt, je pfimo na néj klepnout. Objekt bez vyplné vybereme
kliknutim na jejich obrys. Vice objektl vybereme, kdyz pfi kliknuti na né drzime stisknutou

klavesu Shift. Vybér objektu zruSime, kdyz klikneme do prazdného mista.

Vybér oramovanim

Vice objektl miizeme najednou vybrat kliknutim a taZzenim kurzoru tak, aby objekty byly ve
vytvafeném obdélniku vybéru. Vybereme jen ty objekty, které zcela lezi v obdélniku vybéru.

Abychom oramovanim mohli objekty vybirat, musi byt na nastrojové listé Kresba aktivni nastroj
Vybrat, jak vidime na obrazku 41.

Kresba w X
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Obrazek 41: Nastrojova lista Kresba

Poznamka

KdyZ pfetdhneme kurzor a vybereme vice objektd, vytvoreny vybérovy obdéinik se
také oznacuje jako ramec.

Vybér skrytych objekti

Objekty je mozné vybrat, i kdyZ jsou umistény za jinymi a nejsou proto viditelné. Kdyz je vybran
skryty objekt, jeho Uchyty pro vybér se objevi skrz objekty, které jej zakryvaji.

+ Windows, Mac nebo Linux — pro vybér a prochazeni vybérem objektd ve vykresu
zméackneme klavesu Tab, zastavime na skrytém objektu a vybereme jej. Chceme-li
prochazet objekty v opacném poradi, stiskneme Shift + Tab.

* Pouze Windows nebo Mac — vybereme objekt pfed skrytym objektem a stiskneme
klavesu Alt a klepnutim vybereme skryty objekt. Pokud existuje nékolik skrytych
predmétd, drzime stisknutou klavesu Alt a klikame, dokud neni dosazeno pozadovaného
objektu. Chceme-li prochazet objekty v opacném poradi, podrzime klavesy Alt + Shift
a klikame.
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Usporadani objektt

M s

preskupit pfesunutim objektu dopfedu nebo dozadu pomoci jedné z nasledujicich metod:

* Vybereme objekt, v hlavni nabidce zvolime Tvar > Uspofadat nebo klepneme pravym
tlacitkem mysi na objekt a mistni nabidky Usporadat vybereme jednu z nasledujicich
MOZNosti:

— Prenést do popredi (Ctrl + Shift + +)
— P¥enést bliz (Ctrl + +)

— Odsunout dal (Ctrl + -)

— Odsunout do pozadi (Ctrl + Shift + -)
— Pred objekt

— Zaobjekt

* Vybereme objekt a poté vyberme jeden z nastroji Usporadat na levém konci nastrojové
listy Cara a vypli (obrazek 42). KdyZz najedeme kurzorem na nastroj, je zobrazena jeho

funkce.
Cara a wplhi
. P h-
2= |.'_]I. | |—|I:I ~ O ——— ~000em 5
v X
- .
.# ~ Barva ~ | rf I ~ O =+ 3 A~ ‘%4’ ﬂ H

Obrézek 42: Nastrojova lista Cara a vyplri

/ Poznamka

Nastrojova lista Cara a vyplii neni ve vychozi instalaci LibreOffice viditeln4. Chceme-
li tuto nastrojovou liStu zobrazit, zvolime v hlavni nabidce Zobrazit > Nastrojové
listy > Cara a vypln.

Umisténi a zarovnani objektl

Pouzivani priblizeni

Pro pomoc s umisténim a Upravou objektli ma program Draw funkci zvétSeni, kterd zmensuje
nebo zvétuje zobrazeni aktualniho vykresu. Pfiblizenim mdizeme napfiklad pfesnéji umistit
objekty na kresbé, oddalenim si mGzeme prohlédnout celou kresbu. Priblizeni se ovlada pomoci

stavového fadku, dialogovym oknem P¥ibliZeni a rezim zobrazeni nebo nastrojovou liStou
Priblizeni.

4 Poznamka

V operacnich systémech Linux a Windows se s pfiblizenim zachazi odliSné. Kresba
uloZzena s faktorem priblizeni 100 % v systému Windows se zobrazi v systému Linux
s vétSim faktorem pfiblizeni.
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Posuvnik priblizeni
Priblizeni v procentech

Obrazek 43: Ovladaci prvky
priblizeni na stavovém radku

Mira pribliZzeni Rezim zobrazeni
) Optimalni Automaticky
) Podle sitky a vyiky Jedna stranka
() Podle sitky Sloupce: |1 =
2 100% ReZim knihy

@ Nastavitelna: 100 % —

Napovéda OK Zrusit

Obréazek 44: Dialogové okno Priblizeni a reZim zobrazeni

Stavovy radek
Ovladaci prvky priblizeni jsou umistény na pravé strané stavového fadku (obrazek 43) a tyto
ovladaci prvky umoznuji rychly a snadny pfistup k pfiblizeni.

+  PrizpUsobit snimek aktualnimu oknu — pfizplsobi vykres otevienému oknu.

* Znaménko minus (-) — snizuje faktor pfiblizeni.

* Znaménko plus (+) — zvySuje faktor pfiblizeni.

» Kliknutim a pfetaZzenim posuvniku pfiblizeni zvétSime nebo zmensime faktor pfiblizeni.

» Klikneme pravym tlaCitkem na procentudlni Cislo pfiblizeni a v mistni nabidce, ktera se
otevre, vybereme faktor pfiblizeni.

* V hlavni nabidce zvolime Zobrazit > P¥iblizeni > P¥iblizeni a otevieme dialogové okno
PFiblizeni a rezim zobrazeni (obrazek 44) nebo poklepeme na procentualni ¢islo
priblizeni a vybereme faktor priblizeni v dialogovém okné Pfriblizeni a rezim zobrazeni.

Dialogové okno P¥iblizeni a reZim zobrazeni

Dialogové okno PribliZeni a reZim zobrazeni poskytuje nasledujici moznosti, jak ovladat zplisob
zobrazeni kresby na monitoru.

» Mira pfiblizeni — nastavi faktor pfiblizeni, pfi kterém se zobrazi aktualni dokument
a vSechny dokumenty stejného typu, které se poté oteviou.

v v

— Optimalni — zméni velikost zobrazeni tak, aby odpovidala Sifce textu v dokumentu.
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— Podle Sitky a vySky — zobrazi celou stranku na obrazovce.

— Podle Sirky — zobrazi celou Sifku stranky dokumentu. Horni a dolni okraj stranky
nemusi byt viditelny.

— 100 % — zobrazi dokument ve skutec¢né velikosti.

— Nastavitelna — zadame procento do pole pro zvétSeni pro zobrazeni dokumentu.

Rezim zobrazeni — slouzi k nastaveni rozloZeni pohledu a neni k dispozici pro kresby.
ReZim rozlozeni se bézné pouziva v textovych dokumentech k zobrazeni U¢inkd rliznych
nastaveni rozlozeni.

PiibliZzeni w X

QQQ@ba@E e

Obrazek 45: Lista nastrojd PribliZzeni

Nastrojova lista Priblizeni

V hlavni nabidce zvolime Zobrazit > Nastrojové liSty > Priblizeni a otevieme nastrojovou listu
Priblizeni (obrazek 45). Nastroje dostupné na této nastrojové listé, zleva doprava, jsou
nésledujici:

PFiblizit — pfi kazdém vybéru nastroje zobrazi vykres dvakrat vétSi nez jeho aktualni
velikost.

Oddalit — pfi kazdém vybéru nastroje zobrazi vykres v poloviné jeho aktualni velikosti.
100 % — zobrazi vykres ve skute¢né velikosti.

Pfedchozi pfiblizeni — vrati zobrazeni vykresu na pfedchozi pouzity faktor pfiblizeni.
Nasledujici pfFiblizeni — zrusi akci pfedchoziho pfikazu pfiblizeni.

Cela stranka — zobrazi cely vykres v pracovnim prostoru.

Sifka stranky — zobrazi celou $itku vykresu. Horni a dolni okraj stranky nemusi byt
viditelny.

Optimalni — zméni velikost zobrazeni tak, aby zahrnovalo vSechny objekty na snimku.
P¥ibliZit objekt — zméni velikost zobrazeni tak, aby odpovidala vybranym objekttim.
Priblizeni a posun — pfriblizi po kazdém kliknuti mysi. Ctrl + kliknuti oddaluje se po
kazdém Kliknuti. Shift + kliknuti umoZznuje posouvani vykresu.

Posun — pfesune vykres v pracovnim prostoru Draw. Umistime kurzor na vykres
a taZzenim pfesuneme vykres.

O

Ay 38| 27y 60 350 4 2

M 4 »r » Rozvrieni Ovladaci prvky Kétovaci cary

Snimek 1z 10 (Rozvrzeni) | Vybrano Tvar | Wychozi| 190,25/2375 *=1425x375

Obrazek 46: Levy konec stavového radku pri praci s objekty
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PFesun a nastaveni velikosti objektu

KdyZ pohybujeme objektem nebo ménime jeho velikost, zkontrolujeme levou oblast stavového
fadku ve spodni €asti pracovniho prostoru (obrazek 46). Zleva doprava tato oblast ukazuje, Ze je
vybran tvar, jeho poloha na vykresu v soufadnicich X/Y a rozméry objektu. Mérné jednotky jsou
definovany v Nastroje > MozZnosti > LibreOffice Draw > Obecné.

Presun objekt

Chceme-li pfesunout objekt (nebo skupinu objektd), vybereme jej a poté klepneme a tahneme
v ramci hranic objektu. BEhem pohybu se objevi prihledny obraz objektu, ktery pomaha

s pfemisténim (obrazek 47). Jakmile objekt dosahne svého nového umisténi, uvolnime tlacitko
mysi.

Nastaveni velikosti objektu

Chceme-li zménit velikost vybraného objektu (nebo skupiny vybranych objektd), pfesuneme
kurzor mysi na néktery z Gchytd vybéru. Kurzor zméni tvar a indikuje smér pohybu pro dany
Gchyt. PFi zméné velikosti objektu se objevi priihledny obrys objektu (obrazek 48). Po dosazeni
poZadované velikosti objektu uvolnime tlacitko mysi.

Vysledky zavisi na tom, ktery Uchyt vybéru pouzijeme. Chceme-li zménit velikost objektu pouze
v jedné ose, pouzijeme bocni, horni nebo dolni tchyt. Chceme-li zménit velikost v obou oséach,
pouZzijeme Uchyt na vrcholu.

0 Poznamka

Stisknutim a podrzenim klavesy Shift pfi zméné velikosti objektu bude zména

velikosti provedena symetricky vzhledem k Sifce a vySce objektu, takZze pomér stran
objektu zlstane stejny. Toto chovani klavesy Shift funguje se vSemi Uchyty vybéru.

Obréazek 47: Presun objektl

Obréazek 48: Uprava velikosti objektu
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Obréazek 49: Upravy oblouk(

Upravy oblouki

Velikost oblouku Ize zménit Upravou pozic pocatecniho a koncového bodu oblouku. Vybereme
oblouk, klikneme pravym tlaCitkem na oblouk a vybereme z rozeviraci nabidky Body nebo
stiskneme klavesu F8. Na zacatku a na konci oblouku se objevi dva Uchyty (obrazek 49).
Kliknutim na jeden z téchto Uchytll a pfetazenim do nové polohy zmé&nime tvar oblouku.

Otoceni a zeSikmeni objektl

Otoceni objekt(i

Chceme-li otocCit objekt (nebo skupinu objektl), vybereme objekt a poté prejdeme do rezimu
otaceni pomoci jedné z nasledujicich metod.

4) Vybereme nebo klikneme na objekt.

5) K pfepnuti do rezimu ota¢eni pouzijeme jednu z nasledujicich metod. Uchyty pro vybér
méni tvar a barvu a ve stfedu objektu se zobrazi indikator stfedu otaceni, jak je
znazornéno na obrazku 50.

— Znovu klikneme na vybrany objekt.

— Klikneme na trojihelnik v napravo od Transformace na nastrojové listé Cara a vypli
a z mistni nabidky vybereme Otogit.

— V hlavni nabidce zvolime Zobrazit > Nastrojové liSty > Transformace. Otevie se
nastrojova lista Transformace (obrazek 51) a vybereme Otodit.

o o)
Obréazek 50: Otaceni objekt(
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Obréazek 51: Nastrojova lista
Transformace

6) Presuneme kurzor nad Uchyty a kurzor zméni tvar. Rohové Uchyty slouZi k otaceni
objektu a horni, spodni a bo&ni tGchyty slouzi ke zkoseni nebo naklonéni objektu.

0 Poznamka

Stfed otaceni je obvykle umistén ve stfedu objektu. Chceme-li zménit polohu stfedu
otaceni, klikneme na stfed otaceni a tahneme, dokud nebude na pozadované pozici.
Stfed otaceni mizZe byt dokonce mimo objekt.

O Poznamka

Otaceni funguje u 3D objektl mirné odlisnym zplsobem, protoZze k nému dochazi
v trojrozmérném prostoru a ne v jedné roviné. DalSi informace najdeme v kapitole 7,
Prace s 3D objekty.

Zkoseni objektii

Chceme-li zkosit objekt, vybereme jej a zapneme rezim otaceni (viz ,Otoceni objektl” vyse).
Klikneme na Uchyty umisténé ve stfednich bodech nahore, dole a po stranach vybraného
objektu. Kdyz je kurzor nad jednim z téchto stfedovych Uchytl, zméni tvar a indikuje smér
zkoseni.

Osa, podle niZ se objekt zkosi, je strana objektu, ktera se nachazi pfimo naproti pouzitému

stfedovému Uchytu. Tato osa zUstava pevné na misté, zatimco ostatni strany objektu se béhem

tazeni vybéru pohybuiji ve vztahu k ni (obrdzek 52). Kliknutim a tazenim kurzoru naklonime

objekt. Objevi se prlhledny obrys objektu a aktualni Ghel sklonu se zobrazi ve stavovém fadku.

O Poznamka

Stisknutim a podrzenim klavesy Shift béhem otaceni nebo naklanéni pfedmétu je
pohyb omezen na 15 stupid. Jedna se o vychozi chovani klavesy Shift. Pokud vSak
byla vybrana volba P¥i vytvareni nebo pFfesunu objektll v Nastroje > MoZnosti >
LibreOffice Draw > M¥izka , chovani klavesy Shift je opacné a otaceni nebo sklon je
pri stisku tlacitka Shift omezen na 15 stupil pohybu.

i

Obrazek 52: Zkoseni objektu
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Umisténi a velikost Otoéeni Naklonéni a polomér rohu
Umisténi

Pozice X: 8,80 cm

Pozice ¥: |6,00 cm =

LAIIE B
—n—a
5 o 0
>—0—0

Zakladni bod:

Velikost
Sitka: 5,00 cm

Vygka:  |5,00 cm =

Bk
—®
o 0O
O—0—0

Zachovat pomér l
Z3kladni bod:
Zamknout Pfizplisobit
O Umisténi Sitka podle textu
[ Velikost Vyska podle textu
Napovéda Obnovit oK Zrusit

Obrazek 53: Dialogové okno Umisténi a velikost

Prfesné nastaveni polohy, velikosti, oto¢eni a zkoseni

Pouziti mySi k umisténi a zméné velikosti objektli neni pfesné. Pokud je pro umisténi a velikost
objektu vyZadovana vétsi pfesnost, doporucuje se pouzit dialogové okno Umisténi a velikost
(obrazek 53) nebo sekci Umisténi a velikost (obrazek 54) na karté Vlastnosti na bocni listé.

* Chceme-li otevfit dialogové okno Umisténi a velikost, vybereme objekt a pouZijeme
jednu z néasledujicich metod:

— V hlavni nabidce vybereme Format > Umisténi a velikost.

— Klepneme pravym tlacitkem na objekt a z mistni nabidky vybereme Umisténi
a velikost.

— Stiskneme klavesu F4.

* Chceme-li otevrit sekci Umisténi a velikost na karté Vlastnosti na boc¢ni listé, vybereme
objekt a klikneme na Vlastnosti na bocni listé a klikneme na Sipku dol vedle zahlavi
Umisténi a velikost, ¢imz otevieme sekci.

Moznosti dostupné v dialogu Umisténi a velikost a sekce Umisténi a velikost na karté Vlastnosti
na postranni listé jsou podobné. Na postrannim panelu vSak nelze zamknout polohu a velikost
objektu nebo objekt pfizplsobit tak, aby se vesel na jakykoli text, nebo nastavit polohu
zakladniho bodu pro polohu a velikost.
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Pozice X: 2,00 cm
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[] Zachovat pomér
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Obréazek 54: Sekce Umisténi a velikost na karté
Vlastnosti na bo¢ni liSté

Umisténi a velikost

Pozice — urCime umisténi vybraného objektu na strance.

— Pozice X — zadame vodorovnou vzdalenost potfebnou k posunuti objektu vzhledem
k zakladnimu bodu vybranému v mfiZce.

— Pozice Y — zadame svislou vzdalenost potfebnou k posunuti objektu vzhledem
k zkladnimu bodu vybranému v mfiZce.

— Zéakladni bod — vybereme zakladni bod v mfiZzce a poté zadame hodnotu potfebnou
k posunuti objektu vzhledem k zakladnimu bodu, ktery je vybran v polich Pozice Y
a Pozice X. Zakladni body odpovidaji Gchytdim vybéru na objektu. Tato moZnost je
k dispozici pouze v dialogovém okné Umisténi a velikost.

Velikost — zaddme hodnotu potfebnou ke zméné velikosti vybraného objektu s ohledem
na vybrany zakladni bod.

— Sitka — zadame $ifku vybraného objektu.
— VWyska — zadame vySku vybraného objektu.
— Zachovat pomér — zachovava proporce pfi zméneé velikosti vybraného objektu.

— Zakladni bod — vybereme zakladni bod v mfizce a poté zadame nove rozmery
velikosti pro vybrany objekt do poli Sitka a Vyska. Tato moznost je k dispozici pouze
v dialogovém okné Umisténi a velikost.

Zamknout — tato moznost je k dispozici pouze v dialogovém okné Umisténi a velikost.
— Pozice — zabrani zménam polohy nebo velikosti vybraného objektu.
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— Velikost — zabrani zméné velikosti objektu.

« PrFizplsobit — uréuje, zda ma byt velikost textového pole upravena tak, aby odpovidala
velikosti zadaného textu. Tato moznost je k dispozici pouze pro textova pole.

w7y

— Sitka podle textu — rozsifuje $itku objektu na Sitku textu, pokud je objekt mensi nez
text.

— Vyska podle textu — zvétSuje vySku objektu na vysku textu, pokud je objekt menSi nez
text.

Jednotky méfeni pouzité pro souradnice X/Y a Sifka a vySka objektu se nastavi v Nastroje >
MozZnosti > LibreOffice Draw > Obecné.

Vychozi umisténi zakladnich bodl pro polohu a velikost je levy horni roh kreslici oblasti. Tento
zakladni bod Ize docasné zménit, aby se umisténi nebo kétovani zjednodusilo kliknutim na pozici
odpovidajici umisténi pozadovaného zakladniho bodu. Tato zména zakladniho bodu je platna
pouze pro jednorazové pouziti a zakladni bod se resetuje na standardni pozici levého horniho
rohu, kdyZ je dialogové okno Umisténi a velikost zavieno.

Umisténi a velikost Otoceni Naklonéni a polomér rohu

Stied otoceni
Pozice X; 11,30 cm = ® 0 0
Pozice¥: 850 cm = i O ,{

Wychozi nastaveni:

Uhel otoéeni

Unhel:  |0,00° E AR
4 .
(| .
L x

/xj. : .l\\

Vychozi nastaveni:

Napovéda Cbnovit oK Zrusit

Obréazek 55: Dialogové okno Umisténi a velikost - stranka Otoceni

Otoceni objekt(

Chceme-li pfesné otocit objekt, klikneme na kartu Oto€eni v dialogovém okné Umisténi

a velikost (obrazek 55). Dostupné moznosti umoznuji definovat Uhel otoCeni a umisténi bodu
otaceni. Pfipadné pouZijeme dostupné moznosti otaéeni v sekci Umisténi a velikost na karté
Vlastnosti na boc¢ni listé.
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* Otocny bod — vybrany objekt se otaci kolem zadaného bodu otaceni. Vychozi bod
otaceni je ve stfedu objektu. Pokud je oto€ny bod nastaven pfili§ daleko za hranice
objektu, mohl by byt objekt oto€en mimo stranku. Tato moznost je k dispozici pouze
v dialogovém okné Umisténi a velikost.

— Pozice X — zadame vodorovnou vzdalenost od levého okraje stranky k bodu otaceni.
— Pozice Y — zadame svislou vzdalenost od horniho okraje stranky k bodu otaceni.

— Vychozi nastaveni — vybereme polohu oto€ného bodu. Vychozi poloha je stfed
objektu. Zména bodu otaceni je platna pouze pro jedno pouZiti. Po zavieni dialogu
Umisténi a velikost se bod otaceni obnovi na vychozi nastaveni.

« Otaceni — zadame pocet stupiill, o které je tfeba vybrany objekt oto&it, nebo klikneme do
miizky otaceni.
— Uhel — zadame pocet stupiili potfebnych k oto¢eni vybraného objektu. Tato moznost
je k dispozici pouze v dialogovém okné Umisténi a velikost.

— Vychozi nastaveni — kliknutim na indikétor objekt otocime. Pocet stupiill se zobrazuje
v poli Uhel pfi ota€eni indikatoru. Tato moZnost je k dispozici pouze v dialogovém
okné Umisténi a velikost.

— Otoceni — kliknutim na indikator oto¢ime vybrany objekt nebo nastavime Ghel
v textovém poli nebo vybereme pfedem urCeny uhel z rozeviraciho seznamu. Tato
moznost je k dispozici pouze v sekci Umisténi a velikost na karté Vlastnosti na bo¢ni
liste.
Naklonéni a polomér rohu

Chceme-li pfesné nastavit polomér rohu nebo Uhel sklonu objektu, klikneme na kartu Naklonéni
a polomér rohu v dialogovém okné Umisténi a velikost (obrazek 56). MoZnosti naklonéni
a polomeéru rohu jsou k dispozici pouze v dialogovém okné Umisténi a velikost.

Umisténi a velikost Otoceni Naklonéni a polomér rohu
Polomeér rohu Zkoseni

Polomér: 0,00 cm ~  Uhel: 0,00° =
Ovladaci bod 1 Ovladaci bod 2

X: 0,00 cm —H X 0,00 cm =

Y: 0,00 cm = ' 0,00 cm =

Obrazek 56: Dialogové okno Umisténi a velikost - stranka Naklonéni
a polomér rohu

& Poznamka

Chceme-li nastavit Polomér rohu, je tfeba pouzit obdélniky a ¢tverce dostupné ve
DrivéjSich obdélnicich. Tato nastrojova lista je volitelna a otevira se v hlavni nabidce

vs e
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* Polomér rohu — tato moznost je k dispozici pouze pro rohy obdélnikového nebo

je tato Cast zaSedla, polomér rohu nelze nastavit.

— Polomér — zadame polomér kruhu, ktery méa byt pouZit k zaobleni rohtl. Cim vétsi je
hodnota nastaveného poloméru rohu, tim zaoblenéjsi rohy obdélniku nebo Ctverce
budou.

* Zkoseni — nakloni vybrany objekt podél spodniho okraje objektu.

— Uhel — zadame uhel osy sklonu. Uhel zkoseni udava, do jaké miry se objekt odchyluje
od své bézné svislé polohy.

* Ovladaci bod 1 a 2 — zadame hodnotu pro nastaveni soufadnic X a Y v levém hornim
rohu objektu. Pokud jsou tyto ¢asti zaSedlé, pak nelze nastavit souradnice.

PouZziti mfizky a funkce prichyceni

V Draw mohou byt objekty umistény presné a konzistentné pomoci bodl miizky, chopovych
bod{ a ¢ar, ramci objektl, jednotlivych bodd na objektech nebo okrajll stranky. Tuto funkci
nazyvame Pfichyceni.

Funkci pfichyceni je snazSi pouZit pfi nejvySsi praktické hodnoté pfiblizeni kresby. Sou¢asné Ize
pouzit dvé rlizné funkce prichycen. Napfriklad pfichyceni k vodici ¢are a okraji stranky.
Doporucuje se vSak aktivovat pouze ty funkce pfichyceni, které jsou skutecné vyzadovany.

LibreOffice Miizka
Jazykova nastaveni | y5 i oing miizka

B &®

= LibreOffice Draw
Obecné RozliSeni Podruzné rozdéleni
Zobrazeni Vodorovné: |1,00 cm = Vodorovné: |10 > mezery
M l'.-l-.k E Y L
: |_ r|.7_ - Svislé: 1,00 cm - Svislé: 10 ~ | mezery
Tisk
LibreOffice Base [J Synchronizovat osy
Grafy Pichytit Omezit objekty
Internet LI K voditkam LI Pii vytvafeni nebo presunu objektd
K okrajim stranky Rozsifit hrany
LI K rémecku objektu (1 Pii otaceni: | 15,00° =

4

1K bodiim objektu Redukce bod(: [1500° =

Oblast pfichyceni: |5 pixeld =

s

Obréazek 57: MoZnosti dialogového okna MriZka LibreOffice Draw

MozZnosti v X

L)V E |+ IE| Lo 08 T4 B [ L] el ) [ 2] 5

Obréazek 58: Nastrojova lista MoZnosti

Nastaveni mfizky a funkce pfichytavani

Chceme-li nakonfigurovat funkce mfizky a pfichyceni v kresbé, zvolime v hlavni nabidce
Nastroje > MoZnosti > LibreOffice Draw > Mfizka, ¢imZ zobrazime dialogové okno Mrizka
(obrazek 57). Funkce mrizky a pfichytavani lze také zobrazit a zapnout nebo vypnout pomoci
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tohoto dialogu, kliknutim pravym tlacitkem na kresbu a pomoci moZnosti v mistni nabidce nebo
pomoci ikon na nastrojove listé Moznosti (obrazek 58). Pokud neni nastrojova lista MoZnosti
oteviena, zvolime v hlavni nabidce Zobrazit > Nastrojové liSty > MoZnosti.

MfFiZka — urCuje nastaveni konfigurovatelné mfizky na strankadch dokumentu. Tato mfizka
pomaha uréit pfesnou polohu objektd. Tuto mfizku Ize také nastavit v souladu

s magnetickou mrizkou. Pokud je aktivovana mfizka, ale chceme se pohybovat nebo
vytvéret jednotlivé objekty bez pozic pfichyceni, ponechdme stisknutou klavesu Shift

a tim deaktivujeme tuto funkci.

N

— Prichytit k miiZce — stanovi, zda se pfesun ramcU, nakreslenych objektd a ovladacich
prvkl déje jen mezi body mrizky. Chceme-li zménit stav prichytavani k mfizce jen pro
aktudlni akci, stiskneme klavesu Ctrl a pfemistime objekt.

— Viditelna mfiZzka — ur€uje zobrazeni mfizky.

Rozliseni

— Vodorovné — definuje vzdalenost bod{ mfizky ve sméru osy X.

— Svislé — definuje vzdalenost bod mfizky ve sméru osy Y.

PodruZné rozdéleni

— Vodorovné — uréuje pocet mezilehlych bodl mezi body mfizky ve sméru osy X.

>~

— Svislé — urCuje pocet mezilehlych bodd mezi body mfizky ve sméru osy Y.

Synchronizovat osy — vybrané znamen4, Ze nastaveni jedné osy se tyka i osy druhé.
Rozliseni a podruzné rozdéleni obou os zlistava stejné.

PFichytit

— K voditkiim — po uvolnéni tla¢itka mysi pfichyti okraj taZzeného objektu k nejblizsimu
voditku. Toto nastaveni Ize také definovat pomoci volby PFichytit k voditkim na
nastrojové listé Moznosti.

— K okrajim stranky — uruje, zda se ma obrysova ¢ara grafického objektu zarovnat
k nejblizSimu okraji stranky. Kurzor nebo obrysova ¢ara grafického objektu musi byt

v dosahu zachyceni. K této funkci Ize pfistupovat také pomoci voleb PFichytit
k okrajim stranky na nastrojové listé MoZnosti.

— K ramecku objektu — urCuje, zda se okraj grafického objektu zarovnéa k okraji
nejbliz§iho grafického objektu. Kurzor nebo obrysova ¢ara grafického objektu musi byt
v dosahu zachyceni. K této funkci Ize pfistupovat také pomoci volby Pfichytit
k ohrani€eni objektu na nastrojové listé MozZnosti.

— K bodim objektu — ur€uje, zda se okraj grafického objektu zarovna k boddim
nejblizsiho grafického objektu. Kurzor nebo obrysova ¢ara grafického objektu musi byt
v dosahu zachyceni. K této funkci Ize pfistupovat také pomoci volby PFichytit
k bodlim objektu na nastrojové listé MoZnosti.

— Oblast prichyceni — definuje vzdalenost pfichytavani mezi ukazatelem mySi a obrysem
objektu. Pfichyti se k bodu pfichyceni, pokud je kurzor blize nez vybrana vzdalenost.

Omezit objekty

— Pri vytvareni nebo presunu objektl — pfi vytvareni nebo presunu jsou grafické objekty
omezeny na pohyb svisle, vodorovné nebo po Ghlopfi¢ce (45 stupiid). Toto nastaveni
Ize doCasné deaktivovat stisknutim klavesy Shift.

— R) —urcuje, Ze se Ctverec vytvori na zakladé delSi strany obdélniku, kdyZ je stisknuta
klavesa Shift pfed uvolnénim tlaCitka mysi. To plati také pro elipsu (kruh je vytvofen na

zakladé nejdeliho priiméru elipsy). KdyZ neni vybrana volba Rozsifit hrany, vytvori
se Ctverec nebo kruh na zakladé kratsi strany nebo priiméru.
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— Pri otaceni — urCuje, ze grafické objekty Ize otacet pouze v rdmci vybraného Ghlu
otoCeni. Chceme-li objekt otocit mimo definovany uhel, stiskneme pfi otaCeni klavesu
Shift. Po dosazeni pozadovaného uhlu oto¢eni klavesu uvolnime.

— Redukce bodUl — definuje Uhel pro redukci bodu. Pfi praci s mnohouthelniky to mlize
byt uziteEné pfi snizovani bod Uprav.

Pfichyceni k mfiZce

PouzZivame prichyceni k mriZzce

Pouziti volby PFichytit k m¥iZce presune objekt pfesné na bod mfizky v kresbé. Funkci miZzeme
zapnout/vypnout nasledujicimi zplsoby:

+ Jdeme do nabidky Zobrazit > Voditka > PFichytit k m¥iZce.

* Klepneme pravym tlacitkem na kresbu a vybereme z mistni nabidky Voditka > PFichytit
k mfiZce.

+ Klikneme na nastroj Pfichytit k mfiZce na néastrojové liSté Moznosti.

Zobrazeni mrizky
Zobrazeni nebo vypnuti mfizky v kresbé se provadi pomoci jedné z nasledujicich metod:

oy

* V hlavni nabidce zvolime Zobrazit > MfiZzka a voditka > Zobrazovat mfizku.
* Na nastrojové listé Moznosti klikneme na Zobrazovat m¥izku.

v

* Klepneme pravym tlacitkem na kresbu a z mistni nabidky vybereme Mfizka a voditka >
Zobrazit mfizku.

* V dialogovém okné MoZnosti mfizky LibreOffice Draw vybereme Viditelna mfizka.

Zména barvy bodil mFiZky

Ve vychozim nastaveni a v zavislosti na displeji a nastaveni poc€itaCe jsou body mfizky Sedé
a neni vZdy snadné je vidét. Chceme-li zménit barvu bodd mrizky, prfejdeme na Nastroje >
MozZnosti > LibreOffice > Barvy aplikaci, ¢imz otevieme dialogové okno Barvy aplikaci

(obrazek 59). V Casti Kresbalprezentace vybereme z vybalovaciho seznamu pro mrizku
vhodnéjsi barvu.

Voditka

Na rozdil od mfizky Ize zachytné Cary a zachytné body vloZit béhem umisténi objektu do urcité
polohy na kresbé. Voditka — zachytné ¢ary — mohou byt vodorovné nebo svislé, jsou zobrazeny
c¢arkované. Zachytné body se zobrazuiji jako kfizeni ¢arkovanych Car. Voditka se netisknou.
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= LibreOffice Barevné schéma
UZivatelské ddaje ] ]
. Schéma: |Kresba LibreQOffice A UloZit: Smazat
Obecne | = U000 om0 ] mee
Zobrazeni Viastni barvy
Tisk
Cesty ipnc Prvky ufivatelského rozhrani Nastaveni barev
e
Pisma Inteligentni znacky - Automaticka v °
Zabezpedeni
- ,p ) Stiny P Automaticka -
Pfizplsocbeni
I Barvy aplikaci Textovy dokument
Zpfistupnéni
Pokrocilé Miizka B Cervena v
OpenCL
Naéitani/ukladani Stinovani polf | Automaticka v
Jazykova nastaveni . .
LibreOffice Draw Stinovani rejstfiku a tabulky I:l Automaticka hd
LibreOffice Base Indikator skriptu - Automaticka b
Grafy
Internet Hranice sekci [ | Automaticka v v
MNapovéda Obnovit PouZit 0K Zrusit

Obréazek 59: Dialogové okno MoZnosti barev aplikaci LibreOffice

Umisténi Typ
X: 10,00 cm | E Bod

Y: 10,00 cm = E| Svisly

F| Vodorovny

Népovéda oK Zrusit

Obréazek 60: Dialogové okno Novy zachytny
objekt

VloZeni zachytnych bodi a ¢ar
Chceme-li vloZzit zachytny bod nebo zachytnou ¢aru, zvolime v hlavni nabidce Vlozit > Voditko.
Otevrie se dialogové okno Novy zachytny objekt (obrazek 60).
» V Casti Umisténi nastavujeme polohu zachytného bodu nebo ¢ary vzhledem k levému
hornimu rohu snimku.

— Osa X — zadame velikost pozadovaného prostoru mezi zachytnym bodem nebo ¢arou
a levym okrajem stranky.
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— Osa Y — zadame pozadovany prostor mezi zachytnym bodem nebo €arou a hornim
okrajem stranky.

* Typ — urCuje typ vkladaného zachytného objektu.
— Bod - vloZzime zachytny bod.
— Svisly — vloZime svislé voditko.
— Vodorovny — vlozime vodorovné voditko.

Zobrazeni zachytnych bodti a ¢ar
Zobrazeni nebo vypnuti zachytnych bod( a ¢ar v kresbé Ize provést pomoci jedné z téchto
metod:

* V hlavni nabidce zvolime Zobrazit > Voditka > Zobrazit voditka.

* Na nastrojové listé Moznosti klepneme na tlaCitko Zobrazit voditka.

* Klepneme pravym tlaitkem na kresbu a vybereme Voditka > Zobrazit voditka.

Upravy zéchytnych bodt a éar

Chceme-li upravit zachytny bod, klepneme pravym tlacitkem na zachytny bod a z mistni nabidky
vybereme Upravit zachytny bod. Otevie se dialogové okno Upravit zachytny bod (obrazek 61).
Zadame nové nastaveni souradnic X a Y pro zachytny bod a klikneme na tlacitko OK. Pfipadné

pfetdhneme zachytny bod uchopeni do nové polohy na kresbé.

Chceme-li upravit voditko, klepneme pravym tlacitkem na voditko a z mistni nabidky vybereme
Upravit voditko. Otevie se dialogové okno Upravit voditko (obrazek 62). Zadame nové
nastaveni soufadnic X pro svisla voditka nebo nové nastaveni soufadnic Y u vodorovnych
voditek a klikneme na tla€itko OK. Pfipadné pretahnéte voditko na novou pozici v kreshé.

Umisténi
X: |5,00cm =
Y: 5,00 cm =

Napovéda Smazat oK Zrudit

Obrazek 61: Dialogové okno Upravit zachytny bod

Umisténi
X: (3,00 cm =

Y

MNapovéda Smazat OK Zrudit

Obrazek 62: Dialogové okno Upravit voditko
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Smazani zachytnych bodii a voditek

Chceme-li odstranit zachytny bod, pfetahneme jej zpét na pravitko nebo na néj klepneme pravym
tlaCitkem mysi a z mistni nabidky vybereme Smazat zachytny bod. Chceme-li odstranit voditko,
pfetdhneme jej zpét na pravitko nebo na néj klepneme pravym tlacitkem a z mistni nabidky
vybereme Smazat voditko.

Nastaveni oblasti pfichyceni
Nastaveni oblasti pfichyceni, kdy se objekt pfichyti na umisténi

1) V hlavni nabidce zvolime Nastroje > MoZnosti > LibreOffice Draw > Mfizka a otevie se

dialogové okno MoZnosti LibreOffice mfizky.

2) Zadame pocet pixell a v poli Oblast pfichyceni nastavime vzdalenost, kdy se objekt
prichyti na pozici. Vychozi nastaveni je 5 pixel(.

3) Kliknutim na OK ulozime novy rozsah a zavieme dialog.

R

| 1 2 1 4

- -

L}

Obrazek 63: Voditka pfi presouvani

LibreOffice Zobrazeni
MNacitanifukladani Viditelnd pravitka
Jazykova nastavent [ Voditka pii presouvani
= LibreOffice Draw - )
Obecné [ V8echny ovlddaci body pfi Upravach Bézierovych kiivek
e Obrysy viech jednotlivych objektd
MiiZka
Tisk
LibreOffice Base
Grafy

Internet

Obrazek 64: MozZnosti LibreOffice Draw, dialogové okno Zobrazeni
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Pouzivani voditek

Voditka je funkce v Draw, kterd pomaha pfi umistovani objektd. Voditka Ize zobrazit b&hem
pfesunu objektu. Probihaji od okrajl objektu k pravitkim na horni a levé strané vykresu a nemaiji
funkci prichyceni (obrazek 63).

7 w7z

Chceme-li pouzit vodici ¢ary, zvolime v hlavni nabidce Nastroje > MoZnosti > LibreOffice Draw
> Zobrazeni, ¢imz otevieme dialogové okno Moznosti LibreOffice Draw Zobrazeni (obrazek 64)
a vybereme volbu Voditka pfi presouvani nebo klikneme na néastrojové listé na tlacitko Voditka
pri presouvani.

Zména tvaru objektu

Pravidelné tvary

Pri kresleni urcitych pravidelnych tvar(l se pfi vybéru objektu zobrazi jedna nebo vice teek v jiné
barvé, nezZ jsou Uchyty vybéru. KdyZ se kurzor umisti nad jednu z téchto teCek, zméni tvar.
Kliknutim a pretazenim na jednu z téchto te¢ek upravime tvar objektu. Napfiklad zvétSenim
poloméru rohu zaobleného obdélniku nebo ¢tverce zménime Ghly oblouku atd.

Tyto tecky plni rlizné funkce podle zvoleného tvaru. Tvary s teckami ménicimi tvar a jejich funkce
jsou uvedeny v nasledujicich sekcich.

Poznamka

Pravidelné tvary Ize také zménit po pfevodu na kfivku nebo mnohouhelnik a tpravé

bodd. Vice informaci viz ,Kfivky a mnohouthelniky* na strance 70 a ,Upravy bodd* na
strance 70.

Zakladni tvary

Zakladni tvary w X

S EETYee <~ AL ee e mE Lo

Obrazek 65: Dilci nastrojova lista Zakladni tvary
Viz obrazek 65 k identifikaci nasledujicich tvar(i s nastavovacimi teCkami.
» Zakulaceny obdélnik — pohybem bodu ménime polomér zaobleného rohu obdélniku
nebo Ctverce.

» Zakulaceny ¢tverec — bod vyuZijeme pro zménu poloméru kfivky, ktera nahradi pravé
ahly v rozich Ctverce.

*  Rovnobéznik — pohybem bodu ménime vnitfni Ghly.

* Lichobéznik — pohybem bodu ménime thel bocnich stran a zakladen v lichobé&zniku.

* Kruhova vyse¢ — pohybem dvou bod( po kruznici ménime Uhel stran kruhové vysece.

* Oblouk — pohybem bodu ménime vnitfni polomér a Ghel stran oblouku.

* Rovnoramenny trojuhelnik — pohybem bodu ve vrcholu trojuhelniku ménime jeho tvar.

+ Sestithelnik — pomoci bodu ménime vniténi Ghly stran Sestithelniku.

* Osmiuhelnik — pohybem bodu ménime velikosti stran osmiuhelniku.

» Valec — pomoci bodu ménime perspektivu.

* Krychle — pohybem bodu ménime perspektivu.

* Zahnuty roh — pohyb bodu méni velikost zahnutého rohu.

* KfF¥iz — pohybem bodu ménime tloustku ramen kfize.
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Ramec — bod pouzijeme pro zménu Sitky rdmce.
Prsten — pohybem bodu ménime vnitfni primér prstenu.

Symboly

Tvary symbold w X

OVR IO Q@GS [ ] {3 {1}

Obrazek 66: Dil¢i nastrojova lista Tvary symbol(i

Viz obrazek 66 k identifikaci nasledujicich tvar(i s nastavovacimi teCkami.

Smajlik — bod pouZijeme ke zméné usmeévu.

Srdce — pomoci bodu ménime tvar symbolu.

Slunce — pohybem bodu ménime tvar symbolu.

Mésic — pohybem bodu ménime tvar symbolu.

Zakaz — pohybem bodu ménime tlouStku mezikruzi a Sikmé Cary.
Zkoseny ¢tverec — pohybem bodu ménime Sitku zkoseného okraje.
Zkoseny osmitihelnik — pohybem bodu ménime tloustku zkoseni.
Zkoseny kosoctverec — pohybem bodu ménime tloustku zkoseni.
Dvojita zavorka — pohybem bodu ménime zakfiveni zavorky.

Leva zavorka — pohybem bodu ménime zakfiveni zavorky.

Prava zavorka — pohybem bodu ménime zakfiveni zavorky.

Dvojita slozena zavorka — pohybem bodu ménime zakfiveni zavorky.

Leva sloZena zavorka — pohyby bod( ménime zakfiveni zavorky a polohu bodu spojeni
krivek.

Prava sloZzena zavorka — pohyby bodd ménime zakfiveni zavorky a polohu bodu spojeni
kfivek.

Blokové Sipky

Blokové Sipky w X

=] o aLPTVTPHFPLDD==200d0beeSn

Obrazek 67: Dilci nastrojova lista Blokové Sipky

Viz obrazek 67 k identifikaci nasledujicich tvar(i s nastavovacimi teCkami.

Sipka doprava — bodem ménime tvar a tloustku Sipky.

Sipka doleva — pomoci te¢ky zmé&nime tvar a tloustku Sipky.

Sipka dol(i — bodem mé&nime tvar a tloustku Sipky.

Sipka nahoru — bodem ménime tvar a tloustku Sipky.

Sipka doleva a doprava — bodem ménime tvar a tloustku Sipky.

Sipka nahoru a dolii — pohybem bodu ménime tvar a tloustku Sipky.
Kruhova Sipka — obsahuje dva body, kterymi ménime tvar a tloustku Sipky.
Ctyfsmérova Sipka — ma dva body, jimiZ ovliviiujeme tvar a 3itku Sipek.
Tvar V — bodem ménime Uhel Sikmych stran a tvar.

Pétithelnik — pohybem bodu ménime Ghel Sikmych stran.

Pruhovana Sipka doprava — bod méni tvar a tloustku Sipky.
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Sipka nahoru, doprava a dolt — dvéma body m(izeme zmé&nit tvar a tloustku Sipky.
Sipka doprava se zafezem — bodem ménime tvar a tloustku 3ipky i zafezu.

Sipka nahoru a doprava — jejimi body ménime tvar a tloustku Sipky.

Sipka doprava s bublinou — ma tfi body, kterymi ovliviiujeme velikost bubliny a tvar

i tloustku Sipky.

Sipka doleva s bublinou — ma tfi body, kterymi ovliviiujeme velikost bubliny a tvar

i tloustku Sipky.

Sipka dolt s bublinou — ma tfi body, kterymi ovliviiujeme velikost bubliny a tvar

i tloustku Sipky.

Sipka nahoru s bublinou — ma tfi body, kterymi ovliviiujeme velikost bubliny a tvar

i tloustku Sipky.

Sipka doleva a doprava s bublinou — ma tfi body, kterymi ovliviiujeme velikost bubliny
a tvar i tloustku Sipky.

Sipka nahoru a dolil s bublinou — ma tfi body, kterymi ovliviiujeme velikost bubliny

a tvar i tloustku Sipky.

Ctyismérova Sipka s bublinou — ma tfi body, kterymi ovliviiujeme velikost bubliny a tvar
i tloustku Sipky.

Sipka nahoru a doprava s bublinou — ma tfi body, kterymi ovliviiujeme velikost bubliny
a tvar i tloustku Sipky.

Bubliny

Bubliny v X
winkeR=Ral ks

Obrazek 68: Dil¢i nastrojova
lista Bubliny

Pro vSechny bubliny (obrazek 68) pouzijeme ke zméné délky, polohy a Uhlu ukazatele
nastavovaci body.

Hvézdy a cedule

Hvézdy a cedule w X

Cove O g R & O

Obréazek 69: Dilci nastrojova liSta Hvézdy
a cedule

Viz obrazek 69 k identifikaci nasledujicich tvar(l s nastavovacimi teGkami.

Ctyfcipa hvézda — pohybem bodu nastavujeme tloustku a tvar cipll hvézdy.
Osmicipa hvézda — pohybem bodu nastavujeme tloustku a tvar cipt hvézdy.
24cipa hvézda — pohybem bodu nastavujeme tloustku a tvar cipl hvézdy.
Svisla role — bodem nastavujeme Sitku a tvar role.

Vodorovna role — bodem nastavujeme Sifku a tvar role.
Jmenovka — bodem nastavujeme polomér vnitfniho zakfiveni rohd.
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Obrazek 70: Viytvareni riiznych tvarG zménou
teCny

KFivky a mnohouhelniky

Bézierovy kFivky
Upravy kfivek a mnohouhelnikl zavisi na matematice Bézierovych kivek®. Vysvétleni

Bézierovych kfivek jde nad ramec rozsahu této kapitoly. DalSi informace o kresleni a manipulaci
s Bézierovymi kfivkami najdeme v kapitole 11, Pokrocilé techniky kresleni.

Uprava Bézierovy kfivky spo&ivéa v principu pohybu bod( nebo teen prochéazejicich t&émito body.
Kazda te¢na ma na kazdém konci jeden fidici bod a spojovaci bod, kde se setkava s kfivkou.
Relativni ahel a vzdalenost mezi kontrolnimi body ur€uji tvar kfivky. Obrazek 70 ukazuje, co se
stane se zakladnim &tvercem, kdyZz se méni pouze jeden bod na &tverci.

Prevod objekt(l na kfivku nebo mnohouthelnik

Pri zméné tvaru objektu a pfed Upravou bodll na objektu je nutné jej prevést na kfivku nebo
mnohouhelnik. V zavislosti na tom, jaky je poZzadovany druh tvaru a efektu, pouZijeme jednu
z nasledujicich metod k vytvoreni kfivky nebo mnohouhelniku:

* Po vybéru objektu pfejdeme v hlavni nabidce na Tvar > Pfevést a vybereme KFivku
nebo Mnohouhelnik.

» Klikneme pravym tlaCitkem na objekt a vybereme z mistni nabidky Pfevést > Na kfivku
nebo Mnohouhelnik.

Upravy bodt

Pfesunem samotného bodu nebo jednoho ¢&i obou Gchopovych bodd na obou koncich teény Ize
vytvofit mnoho rliznych tvard, jak je znazornéno na obrazku 70. Body Ize pfidavat, mazat nebo
ménit typ bodl pomoci nastrojli dostupnych na nastrojové listé Upravit body (obrazek 71). Po
pfevedeni tvaru na kfivku nebo mnohothelnik se body objektu upravi nasledujicim zplsobem:

Upravit body v X

AlAACIATINEA X

Obrazek 71: Nastrojova lista Upravit body

1) Vybereme objekt a pomoci jedné z nasledujicich metod prfepneme do rezimu Gprav bodd.
— V hlavni nabidce zvolime Upravit > Body.

1 Bézierovy krivky vynalezl Pierre Bézier, ktery tuto techniku vyvinul v 60. letech a pracoval jako inzenyr
ve spolupraci s vyrobcem automobilll Renault. Tato technologie méla usnadnit modelovani povrchu
vozidel.
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— Klikneme na nastroj Body na nastrojové listé Standardni.
— Klikneme pravym tlaCitkem na pfevedeny objekt a z mistni nabidky vybereme Body.
— PouZijeme klavesovou zkratku F8.

Poznamka

Po prepnuti do rezimu Gprav bod( se z Gchytl vybéru stanou body. Pocet bod( se
mUZe zvysit nebo snizZit. Tato zména poctu zavisi na tvaru objektu a jedna se
0 normalni chovani.

2) Kliknutim na bod objektu zménime tvar objektu. Otevie se panel nastrojii Upravit body
a nastroje se aktivuji, kdyZ je vybran bod. TeCny se také zobrazi pfipojené k vybranému
bodu.

3) Pomoci réznych nastrojli na panelu nastroji Upravit body miZzeme pridat, odstranit nebo
zZmeénit typ bodu.

4) Kliknutim na bod a jeho pfetazenim bod pfesuneme a zménime tvar objektu.

5) Pokud je vybranym objektem kfivka, klepneme a pfetdhneme kulaté body na konci te¢ny,
abychom provedli dal8i zmény tvaru objektu.

6) Pokud jsme spokojeni s tvarem, kliknutim mimo objekt zrusime reZim Gprav bod(
a zavieme nastrojovou liStu Upravit body.

Typy bodu

Dostupné nastroje na nastrojové listé Upravit body zavisi na objektu a typu vybraného bodu
objektu.

« Presunout body — aktivuje rezim umoziiujici pohyb bodd. Klikneme a pfetahneme
vybrany bod do jiného umisténi. Hranice objektu nasleduje pohyb na obou stranach
vybraného bodu k dalSimu bodu na kazdé strané vybraného bodu.

« Vlozit body — aktivuje rezim vkladani a umoznuje vkladani bodd. Body Ize také
presouvat. Bod se vloZi na vybrany objekt pokazdé, kdyZ klikneme na tlaCitko mysSi
a objekt zmeéni tvar tak, aby zahrnoval novy bod do ohranieni objektu. VloZeny bod je
hladky bod.

¢ Smazat body — slouzi k mazani bodi z vybraného objektu. Vybereme Smazat body
a poté kliknutim na bod jej smazeme. Chceme-li odstranit nékolik bod(, podrzime
stisknutou klavesu Shift a poté klikneme na Smazat body.

+ Prevést na kfivku — prevadi kfivku na pfimku nebo pfimku na kfivku. Pokud je vybran
jeden bod, bude pfevedena kfivka prfed bodem. Pokud jsou vybrany dva body, kfivka
mezi obéma body bude prevedena. Pokud jsou vybrany vice nez dva body, bude pfi
kazdém kliknuti na tuto ikonu pfevedena jina ¢ast kfivky. V pfipadé potfeby se kulaté
body pfevedou na rohové body a rohové body se pfevedou na kulaté body.

Pokud je Casti kfivky pfimka, maji koncové body Cary kazdy maximélné jeden kontrolni
bod. Nelze je upravit na kulaté body, pokud pfimka neni pfevedena zpét na kfivku.

« Uzavfit Beziérovu kFivku — uzavfe ¢aru nebo kfivku. Céra je uzaviena spojenim
posledniho bodu s prvnim bodem, oznaCenym zvétSenym Ctvercem.

* Rozdélit kfivku — vybereme bod nebo body, kde bude kfivka rozdélena, a poté klikneme
na Rozdélit kFivku.

+ Uhlovy bod — pfevede vybrany bod nebo body na thlové body. Uhlové body maji dva
pohyblivé kontrolni body, které jsou na sobé nezavislé. Kfivka tedy neprochazi rovné
Uhlovym bodem, ale tvofi roh.
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Chceme-li vytvorit Ghlovy bod, musime nejprve viozit hladky nebo symetricky bod a poté
pfevést na Uhlovy bod kliknutim na Uhlovy bod.

* Plynuly pfechod — pfevede Uhlovy bod nebo symetricky bod na hladky bod. Oba Fidici
body uhlového bodu jsou zarovnany paralelné a Ize s nimi pohybovat pouze soucasné.
Kontrolni body se mohou lisit v délce, coZ umozniuje odchylky ve stupni zakfiveni.

* Soumérny piechod — prevede Uhlovy nebo hladky bod na bod symetricky. Oba Fidici
body uhlového bodu jsou zarovnany paralelné a maji stejnou délku. Lze s nimi
pohybovat pouze sou€asné a stupen zakfiveni je v obou smérech stejny.

* Ubrat body — oznaci vybrané body k odstranéni. To se stane, pokud je bod umistén na
pfimce. Pokud prevadime kfivku nebo mnohouhelnik pomoci Pfevést na kfivku do
primky nebo zménime kfivku pomoci kurzoru tak, aby bod leZel na pfimce, je vybrany
bod odstranén. Vychozi Uhel, od kterého se ma provést redukce bodu, je 15 stupnd.

TeCny

Pfed pouzitim te€en na objektu je nutné objekt pfevést na kfivku. TeCny se pouzivaji pouze na
kfivkach. Pokud byl objekt pfeveden na mnohouhelnik a je pfidana te¢na, bude objekt
automaticky preveden na kfivku.

O Poznamka

Uhel, ktery svira te¢na ke tvaru objektu Ize zménit kliknutim na jeden z Fidicich bodd
teCny na konci teCny a pohybem kurzoru. Pfi zméné Ghlu te¢ny se tvar objektu méni.

Soumérny prechod

Soumérny pfechod pfevede Uhlovy nebo hladky bod na symetricky bod. TeCny maji stejnou délku
a jsou zarovnany v pfimce, jak je znazornéno na obrazku 72. Te€ny lze posunout pouze
soucasné a stupen zakfiveni je v obou smérech stejny.

1) Pfevedeme objekt na kfivku nebo mnohouhelnik.

2) Prepneme vybrany objekt do rezimu Uprav bod( a otevieme nastrojovou listu Upravit
body.

3) Vybereme bod, ktery chceme zménit na symetricky bod.

2

Obrazek 72: Soumérny pfechod

4) Na nastrojové listé Upravit body klikneme na Soumérny pfechod. Pfimka na kazdé
strané soumérného pfechodového bodu se pfevede na krivku.

5) Klepnutim a pretazenim jednoho z ovladacich tchytd te¢ny mizeme zménit zakfiveni
a tvar objektu. Jakakoli zména jedné tecny se pfenasi symetricky k druhé tecné.
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Plynuly prechod

Plynuly pfechod pfevede uhlovy nebo symetricky bod na bod hladky. Te€ny jsou zarovnany
v pfimce a Ize je posunout pouze soucasné. TeEny mohou mit rlizné délky, pficemz zakfiveni
fizené nejdelSi te€nou je nejvétsi zakfiveni, jak je znazornéno na obrazku 73.

1)
2)

3)
4)
5)

Obréazek 73: Plynuly prechod

Pfevedeme objekt na kiivku nebo mnohouhelnik.

Pfepneme vybrany objekt do rezimu Uprav bod( a otevieme nastrojovou listu Upravit
body.

Vybereme bod, ktery chceme zménit na symetricky bod.
Na nastrojové listé Upravit body klikneme na Plynuly pfechod.

Kliknutim a pfetazenim jednoho z ovladacich tchytli teény mdzeme zménit tvar objektu.
Tim se vytvofi asymetricka teCna s nejvétSim zakfivenim na nejdelSi strané tecny.

Uhlovy bod

Pfrevede vybrany bod nebo body na Ghlové body. Uhlové body maji dva pohyblivé kontrolni bodly,
které jsou na sobé nezavislé. Je mozné nezavisle zménit thel na kazdé strané te¢ny pomoci
stfedového bodu tecny jako Uhlového bodu, jak je zndzornéno na obrazku 74.

1)
2)

3)
4)
5)

Obrézek 74: Uhlovy bod
Pfevedeme objekt na kiivku nebo mnohouhelnik.

Pfepneme vybrany objekt do rezimu Uprav bod( a otevieme nastrojovou listu Upravit
body.

Vybereme bod, ktery chceme zménit na symetricky bod.
Na nastrojové list& Upravit body klikneme na Uhlovy bod.

Kliknutim a taZzenim na konci jedné z teCen zménime Ghel. Kazdou te€nu Ize samostatné
posunout a vytvorit SpiCky a prohlubeniny ve tvaru objektu.
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Body

Presun bodi

Pri pfesunu bodU sleduje hranice objektu na obou stranach bodu pohyb bodu, ktery méni tvar
objektu.

1)
2)

3)
4)
5)

Pfevedeme objekt na kfivku nebo mnohouhelnik.

Prepneme vybrany objekt do rezimu Uprav bod( a otevieme nastrojovou listu Upravit
body.

Vybereme bod, ktery chceme zménit na symetricky bod.
Na nastrojové listé Upravit body klikneme na Pfesunout body.

Umistime kurzor na vybrany bod, poté kliknutim a tazenim vytvofime novy tvar. Obrazek
75 ilustruje, jak Ize z kruhu vytvofit jiny tvar pfetazenim levého bodu doleva.

Obrézek 75: Piresun bodd

Vkladani bodii

Pfi kazdém kliknuti na tlaCitko mySi se na vybrany objekt vloZi bod. Kliknutim do ohrani¢eni
objektu zméni objekt tvar tak, aby zahrnoval novy bod do ohrani€eni objektu, jak je znazornéno
na obrazku 76. VloZeny bod je hladky bod.

Body Ize také presouvat v rezimu vkladani bod(. Umistime kurzor na bod, dokud nezméni tvar,
poté kliknutim a tazenim bodu zménime tvar objektu.

1)
2)

3)

Obrazek 76: Vkladani bodi
Pfevedeme objekt na kfivku nebo mnohouhelnik.

Pfepneme vybrany objekt do reZimu Uprav bod( a otevieme nastrojovou listu Upravit
body.

Na nastrojové listé Upravit body klikneme na Vlozit body.
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4) Kliknutim na ohrani€eni objektu vloZime bod v poZzadované poloze na ohraniceni.

5) Alternativné miZzeme klepnutim dovniti ohrani¢eni objektu vloZit bod. Objekt automaticky
zmeéni tvar tak, aby zahrnoval novy bod do ohrani¢eni objektu.

Mazani bod (i

Obrazek 77 ukazuje, co se stane, kdyZ jsou z kruhu odstranény tfi body vlevo. Levy obrazek je
cely kruh a pravy obrazek je misto, kde byly odstranény tfi body, které vytvareji novy tvar.

Obrézek 77: Mazéani bodt

1) Prevedeme objekt na kfivku hebo mnohouhelnik.

2) Prepneme vybrany objekt do rezimu Gprav bodd a otevieme nastrojovou listu Upravit
body.

3) Chceme-li odstranit jeden bod, postupujeme nasledovné:
a) Vybereme bod pro odstranéni.
b) Na nastrojové listé Upravit body klikneme na Smazat body.
4) Chceme-li vymazat nékolik bod(l souasné&, postupujeme nasledovné:
a) Podrzime klavesu Shift.
b) Vybereme vSechny body k odstranéni.

¢) Na nastrojové listé Upravit body klikneme na Smazat body.

Ubrani bod(

Nastroj Ubrat body na néstrojové listé Upravit body funguje pouze na Carach s vice body. Tyto
cary se vytvori, kdyZ se krivka pfevede na ¢aru pomoci nastroje Pfevést na kfivku. Priklad
vytvoreni pfimky a ubrani bodd je uveden na obrazku 78.
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1)
2)
3)

4)
5)
6)

7

Kfivka /ﬂ/
prevedena

Vymazané /D\
body na an j\r

Obrazek 78: Prevod krivky na ¢aru a ubrani bod(

Prevedeme kfivku na kfivku nebo mnohouhelnik.

Pfepneme kfivku do reZimu Uprav bodid a otevieme nastrojovou listu Upravit body.
Vybereme kfivku s vice body a prfevedeme ji na pfimku, viz ,Pfevod kfivek nebo ¢ar”
nize.

Vybereme bod nebo body na Care k ubrani. Vybrany bod je zvyraznén.

Na nastrojové listé Upravit body vybereme Ubrat body.

PFesné umistime kurzor na vybrany bod, poté klikneme a pretahneme vybrany bod. P¥i
taZzeni kurzoru se mezi sousednimi body vytvofi teCkovana Cara.

Kdyz se tato teCkovana ¢ara bude jevit jako pfimka mezi sousednimi body, uvolnime
tlaCitko mysi. Vybrany bod je vylou€en a mezi sousednimi body nyni existuje pfimka.

Prevod krivek nebo c¢ar

KFivky a €ary Ize snadno pfevést pomoci nastroje Pfevést na kfivku na nastrojové listé Upravit
body. Kdyz se kfivka pfevede na pfimku, vytvofi se pfimka mezi vybranymi body na kfivce. Kdyz
se Cara prevede na kfivku, vytvori se kfivka mezi vybranymi body na pfimce. Pfiklad prevodu
kfivky na pfimku je uveden na obrazku 78.

1)
2)
3)
4)

Pfevedeme objekt na kfivku nebo mnohouhelnik.
Pfepneme objekt do rezimu Gprav bod( a otevieme nastrojovou liStu Upravit bodly.
Vybereme body pro pfevod z kfivky na pfimku nebo z pfimky na kfivku.

Na nastrojové listé Upravit body klikneme na Prevést na kfivku. Mezi vybranymi body je
kfivka prevedena na pfimku nebo ¢ara na kfivku.

Rozdéleni objektu

1)
2)

Pfevedeme objekt na kfivku nebo mnohouhelnik.
Pfepneme objekt do rezimu Uprav bod( a otevieme nastrojovou listu Upravit body.

Zména tvaru objektu | 67



Q)

Obréazek 79: Rozdéleni objekt(

3) Vybereme bod nebo body na objektu, kde ma byt rozdélen. Pfi vybéru vice nez jednoho
bodu ponechame stisknutou klavesu Shift.

4) Chceme-li rozdélit nebo vyjmout hranici objektu ve vybraném bodé klikneme na
nastrojové listé Upravit body na Rozdélit kiivku. Pokud je objekt vyplnén, bude
vymazan, protoze hranice objektu jiz neni uzavfena, jak je znazornéno na obrazku 79.

5) ZruSime vybér objektu, poté pfetdhneme vyjimany segment a posuneme jej od
ptvodniho objektu.

o Poznamka

Bod, kde byl objekt rozdélen, je nyni vétsi nez zbyvajici body viditelné na objektu.

Zavirani objekt(
1) Vybereme otevieny objekt (obrazek 80).
2) Prepneme objekt do rezimu Uprav bod( a otevieme nastrojovou listu Upravit body.

3) Vybereme bod, kde byl objekt rozdélen. Po&atecni bod objektu je vétSi nez ostatni body
viditelné na objektu.

4) Na nastrojové listé Upravit body klikneme na Uzavfit Beziérovu kfivku a objekt
uzavieme. Pokud byl otevieny objekt plivodné uzavienym a vyplnénym objektem, vyplni
plvodni barva pfi zavieni objekt.

LIS

Obrazek 80: Zavirani objektt
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Obrazek 81: Deformace objekt(l

Deformovani objektl

1) Vybereme objekt a prepneme do rezimu Uprav bod(, aby se body na objektu zobrazily.
Tim se také otevie nastrojova liSta Upravit body.

2) Vybereme jeden z bod(l na objektu a pfetazenim do nové polohy objekt deformujeme
(obrazek 81).
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Formatovani car

V LibreOffice oznaguje termin Céra samostatnou tsecku (¢aru), vnéjsi okraj tvaru (ohraniceni)
nebo Sipku. Ve vétsiné pripadd Ize upravit vlastnosti ¢ary, jako je jeji styl (plna, preruSovana,
neviditelna atd.), Sitka, barva a typ hrotu Sipky.

6 Tip

Po najeti kurzorem na ikonu nastroje na nastrojové listé nebo na postranni listé se
zobrazi nazev nastroje.

4 Poznamka

Dalsi informace o pouziti barvy pfi formatovani Car, styll ¢ar, Sipek a styld Sipek
najdeme v Casti ,Prace s vyplnémi oblasti“ na strané 98.

Nastrojova lista Cara a vypli
Céru upravime nasledujicimi zplisoby pomoci nastrojové listy Cara a vyplii (obrazek 82):
1) Ujistime se, Ze je na kresbé vybrana Cara.
2) V rozeviracim seznamu Styl €ary vybereme pozadovany styl ¢ary.
3) Do textového pole Sitka éary zadame 3ifku Gary nebo ke zméné Sitky Gary pouZzijeme
Sipky nahoru a dold.

4) Klikneme na maly trojuhelnik ¥ vpravo od tlacitka Barva ¢ary a vybereme barvu z jedné
z dostupnych barevnych palet.

5) Klikneme na maly trojuhelnik ¥ vpravo od tlaCitka Styl €ary a vybereme styl ary z jedné
Z moznosti v rozeviracim seznamu.

Cara a wpli
P i F—
2ilE T |.'_| 155 HE &~ O —— ~000cm 5

- : .

Z - EE | IEEPYErTE

Obréazek 82: Néastrojova lista Cara a vyplri

Postranni lista

Nasledovné zforméatujeme &aru pomoci sekce Céra na karté Vlastnosti na postranni listu
(obrazek 83):

1) Ujistime se, Ze je na kresbhé vybrana Cara.
2) V postranni listé klepneme na Vlastnosti a otevieme kartu Vlastnosti.
3) Kliknutim na Sipku dold v vlevo od titulkového pruhu Céra otevieme sekci Céra.

4) V poli Céra vybereme z rozeviraciho seznamu Styl Sipky typ hrotu Sipky pro kazdy
konec Cary a tim zménime Caru na Sipku. Levy rozeviraci seznam pfida na zaCatek Cary
hrot Sipky. Pravy rozeviraci seznam pfida na konec Cary hrot Sipky.
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5)
6)

7)

8)
9)
10)

! Vlastnosti b

+l Znak =
+ Odstavec =

—| Céra M <&
Céra: - - Ay
Sitka: ~ L
Barva: < - (o)
Prihlednost: |0 % =

Styl rohu: Zakulaceny ~

Styl zakonéeni: |Ploché ~
+/iUmisténi a velikost: =

Obrazek 83: Sekce Céra na postranni listé na
karté Vlastnosti

V poli Céra vybereme poZzadovany typ &ary z rozeviraciho seznamu Styl &ary.
V poli Sitka vybereme $ifku Fadku z rozeviraciho seznamu Sifka nebo zadame $ifku do

e

textového pole Vlastni Sitka Cary.

V poli Barva klikneme na maly trojuhelnik v vpravo od tlacitka Barva €ary a vybereme
barvu z jedné z dostupnych barevnych palet.

Do pole Prihlednost zadame procentudlni hodnotu prdhlednosti ¢ary.
V poli Styl rohu vybereme z rozeviraciho seznamu styl rohu.
V poli Styl zakon¢eni vybereme z rozeviraciho seznamu styl zakonceni.

Dialogové okno Cara.
Chceme-li Gpln& zménit vzhled &ary, pouZijeme dialogové okno Céra.

1)

2)

3)

Vybereme ¢aru v kresbé a jednim z nasledujicich zplsobU otevieme dialogové okno

Céara (obrazek 84):

— V hlavni nabidce zvolime Format > Cara.

— Klepneme pravym tlagitkem na €aru a z mistni nabidky vybereme Cara.

— Klikneme na ozubené kolec¢ko Dal$i moZnosti vpravo od nazvu sekce Céra na
postranni listé.

K formatovani ¢ary pouZijeme moznosti dostupné na strankach dialogového okna Céara.
Jedné se o tyto stranky: Céara, Stin, Styl &ar a Styly Sipek. MoZnosti jsou vysvétleny

v nasledujicich ¢astech. Okno nahledu v dolni ¢asti dialogového okna zobrazuje vliv
zmeén na Caru.

Klepnutim na tlacitko OK uloZzime zmény a zavieme dialogové okno.
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Cara Stin Styly car Styly Sipek

Vlastnosti éary Styly rohu a zakonéeni
Styl: ————— Spojita v Styl rohu: Zakulaceny v
Barva: I Cervens - Styl zakonceni: ‘Ploché ™ ‘
Sitka: 000cm =
Prihlednost: |0 % =

Styly sSipek
Styl zacatku: |-ﬂ— Dlouha 3ipka ~ Styl konce: ‘—h‘- Dlouha 3ipka A
Sitka: 050cm = Sitka: 020cm =

[] Na stied (] Na stied

L] Synchronizovat zakonceni

- - A

Napovéda Obnovit OK Zrusit

Obréazek 84: Dialogové okno Céra — strénka Céra

Stranka Cara

Na strance Cara v dialogovém okné& Céra se nastavuji zakladni parametry ¢ary. Je rozdélena do
tfi nasledujicich oddild.

Vlastnosti ¢ary

Pomoci sekce Vlastnosti ¢ary mizeme nastavit nasledujici parametry:

» Styl -z rozeviraciho seznamu vybereme styl ¢ary.

* Barva — vybereme preddefinovanou barvu z jedné z dostupnych barevnych palet.

+ Sitka — uréuje tloustku ary.

« Prihlednost — nastavi prihlednost ¢ary. Obrazek 85 ukazuje G¢inky rliznych
procentudlnich Grovni prihlednosti na ¢ary pfi umisténi nad objekt.
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Obrézek 85: Prihlednost ¢ar
(0 %, 25 %, 50 %, 75 %)

Styly Sipek
Pomoci Styll Sipek miZeme pfi vytvareni Sipek na kresbé nastavit nasledujici parametry.

Styl zacatku a Styl konce — z rozeviraciho seznamu vybereme styl Sipky nebo hrotu Sipky
pro zacatek a konec Cary.

+ Sitka — uréuje tloustku zakon&eni Sipek.

Na stred — presune stfed zakonceni Sipky do koncového bodu &ary. Obrazek 86 ukazuje
acinky vybéru této moznosti.

* Synchronizovat zakon¢eni — €ini oba konce Car identickymi.

-
b—>

Obrazek 86: Vychozi Sipka nahore;
vystredéna Sipka dole

& Poznamka

Sipky Ize pouzit pouze na ¢ary. Nemaji zadny vliv na hranici objektu.

Styly roh( a zakoncéeni

Styly rohti a zakonéeni urcuji, jak bude vypadat spojeni mezi dvéma segmenty. Chceme-li zjistit
rozdil mezi témito styly, zvolime styl tlusté ¢ary a sledujeme, jak se zméni nahled.

Styl rohu — vybereme tvar, ktery se pouzije v rozich ¢ary. U ostrych ahll je pokosovy tvar
nahrazen tvarem ukosovym.

Styl zakonceni — vybér stylu zakonCeni Car. ZakoncCeni je pouzito i pro vnitfni ¢arky
carkovanych car.
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Cara Stin Styly éar Styly Sipek

Vliastnosti Nahled
Pouzit stin

O

J
—

Barva: I Cervena v

0

o)
®—0—0

Vzdélenost: |0,60 cm

Rozostfeni: |0 pt

ALe(AE

Prdhlednost: |0 %

Obréazek 87: Dialogové okno Céra — strénka Stin

Stranka Stin

Stranka Stin (obrazek 87) dialogového okna Cara poskytuje moznosti pfidani a formatovani stinu
na vybranou ¢aru. Nastaveni na této dialogové strance jsou stejné jako nastaveni pro stiny
aplikované na jiné objekty, a jsou popsané v €asti ,Stiny" na strané 113.

Rychly zplsob, jak aplikovat stin na ¢aru, je pouziti nastroje Stin na nastrojové listé Cara

a vyplii. Nevyhodou pouziti nastroje Stin je, Ze vytvofeny stin pouziva nastaveni stinu pro
vychozi graficky styl.

Styly Car

Styly ¢ar jsou v kresbé uzite¢né pri pridavani nékolika ¢ar podobnych typd. Tim se sniZi potfeba
forméatovéni jednotlivych Car. LibreOffice poskytuje standardni styly Car, které Ize pouZzit v kresbé.
Styly Car Ize také vytvéret, ukladat a odstranovat.

Vytvareni styl( ¢ar
1) Vytvofime €aru v kresbé.
2) Otevieme dialogové okno Céra a kliknutim na kartu Styly &ar otevieme kartu Styly &ar
(obrazek 88).

3) V rozeviracim seznamu Styl Cary vybereme styl Cary podobny stylu, ktery ma byt
vytvoren. Pfiklad vybraného stylu Cary se zobrazi v dolni ¢4sti dialogové stranky. Tento
pfiklad se méni pfi zménach stylu Cary.

4) Klikneme na tlacitko PFidat a v otevieném dialogovém okné zadame nazev nového stylu
cary a poté klikneme na tlacitko OK. Nazev nového stylu se zobrazi v poli Styl Cary.
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Cara Stin Styly car Styly gipek
Viastnosti
Styl cary: Pridat
Typ: Cérka v | [Tecka ~
P ‘ | ‘ Zménit
Pocet: 1 = o =
Y = Smazat
Délka: 100 % = - -
Vzdalenost: 100 % =
Pfizplisobit 3ifce cary
= | =
>
,*”o ‘e
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* + -
MNapovéda Obnovit OK Zrusit

Obrézek 88: Dialogové okno Céra — strénka Styly ¢ar

5) V rozeviracich nabidkach Typ vybereme Te€ku nebo Carku. Chceme-li pro fadek pouzit
pouze jeden typ, vybereme stejny typ v obou polich Typ. Chceme-li v ramci jedné Cary
stfidat dva typy ¢ar, vybereme ve dvou polich Typ rlizné typy.

6) V polich Pocet zaddme pocet kazdého typu Cary vybraného v poli Typ.

7) V polich Délka zadame Délku Cary v procentech fadku. Volba Délka neni pro Te¢ku
k dispozici.

8) V poli Vzdalenost zadame rozte€ mezi pomi¢kami a teckami v procentech ¢ary. MoZnost
Vzdalenost neni k dispozici, pokud je vybrana moznost Prizplsobit Sifce ¢ary.
9) V pripadé potreby vybereme moznost Prizplsobit Sifce ¢ary, aby novy styl odpovidal
Sifce Cary pfi jejim vytvareni v kresbé.
10) Vytvoreni nového stylu ¢ary pouze pro aktualni kresbu:

d) Kliknutim na PFidat otevieme dialogové okno Nazev a zadame jedinecny nazev
nového stylu ¢ary.

e) Kliknutim na OK uloZime novy styl Cary a zavieme dialogové okno Nazev.
11) Uprava stavajiciho stylu ¢ary a vytvoreni nového stylu Gary pouze pro aktualni kresbu:

a) Kliknutim na Zménit otevieme dialogové okno Nazev a zadame jedine¢ny nazev
nového stylu Cary.

b) Kliknutim na OK uloZime novy styl Cary a zavieme dialogové okno Nazev.

12) Kliknutim na OK zavieme dialogové okno Céra a novy styl €ary je pouze v aktualni
kresbé pfipraven k pouZiti.
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Poznamka

PFi vytvareni stylu ¢ary se doporucuje pouZit jedinecny nazev stylu ¢ary. Tim se
zabrani prepsani nékterého ze standardnich styll ¢ar v LibreOffice, které by
zpUsobilo problémy s formatovanim v jinych kresbach nebo dokumentech, které
pouzivaji standardni styly Car.

Poznamka

Chceme-li novy styl Cary pouzit v jinych kresbach, je tfeba styl Cary ulozit pomoci
moznosti UloZit styly ¢ar. Dal$i informace nalezneme v ¢asti ,UloZeni styl( Car*
nize.

UloZeni styl( ¢ar
UloZeni stylu ¢ary umozZiuje pouzit nove vytvoreny styl ¢ary v jinych kresbach LibreOffice.

1)
2)

3)
4)

Vytvorime novy styl ¢ary, jak je popsano vyse v ¢asti ,Vytvareni styld ¢ar, ale nezavieme
dialogové okno Céra.

Kliknutim na ikonu UloZit styly €ar v pravém dolnim rohu stranky Styly €ar otevieme
okno prohlizece soubor( ve spravném umisténi pro styly ¢ar.

Do pole Nazev zadame jedine€ny nazev souboru s pfiponou .sod pro styl Cary.

Kliknutim na UloZit uloZime styl ¢ary a zavieme okno prohlize¢e soubor(. Novy styl ¢ar
je nyni k dispozici pro pouziti v novych kresbach a dokumentech.

Nacitani stylt ¢ar
LibreOffice po instalaci do pocitace poskytuje standardni styly ¢ar. Kompatibilni styly ¢ar vSak Ize

nacist a pouzivat v LibreOffice. V8echny styly Car nactené do LibreOffice musi pouZzivat pfiponu
souboru . sod.

1)
2)

3)
4)
5)

6)

Vytvofime Caru v kresbé.

Otevieme dialogové okno Céara a kliknutim na kartu Styly &ar otevieme kartu Styly &ar
(obrazek 88).

Kliknutim na ikonu Nadist styly fadkd v pravém dolnim rohu karty Styly €ar otevieme
okno prohlizece soubor(l ve spravném umisténi pro styly Car.

Vybereme styl ze seznamu uloZenych styl( v okné prohlizece soubor(l. Pfipona souboru
pro styly Car je . sod.

Kliknutim na Otev¥it nacteme styl €ar do LibreOffice. Styl ary je k dispozici i pro dalSi
kresby a dokumenty LibreOffice.

Kliknutim na tla¢itko OK zavieme dialogové okno Céra a uloZime provedené zmény.

Mazani styl( ¢ar

1)
2)

3)
4)

5)

Vytvofime €aru v kresbé.

Otevieme dialogové okno Céara a kliknutim na kartu Styly &ar otevieme kartu Styly &ar
(obrazek 88).

Z rozeviraciho seznamu Styl ¢ary vybereme styl Cary, ktery chceme odstranit.

Klikneme na Odstranit a v otevieném potvrzovacim dialogu potvrdime odstranéni
kliknutim na Ano.

Kliknutim na tlagitko OK zavieme dialogové okno Céra a uloZime provedené zmény.
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o Poznamka

Pred odstranénim styld ¢ar se ujistime, Ze dany styl ¢ar neni pouZit v jiné kresbé
nebo dokumentu.

Styly Sipek

Na strance Styly Sipek (obrazek 89) v dialogovém okné Cara miizeme vytvariet nové styly Sipek,
upravovat stavajici styly Sipek nebo nacitat dfive uloZené styly Sipek.

Q Poznamka

Cést tvaru potfebna pro hrot Sipky musi byt v horni €asti vytvofeného tvaru.
V pfipadé potfeby tvar oto€ime, dokud se bod nenaché&zi v horni ¢asti tvaru. Pokud
je tvar jiz kfivkou, neni k dispozici moznost prevodu Na kFivku.

Vytvareni styl( Sipek
1) Nakreslime tvar, ktery chceme pouZzit pro hrot Sipky, nebo vytvofime tvar pomoci
nékterého ze zakladnich tvard, které jsou k dispozici v aplikaci Draw.
2) Vybereme tvar a pomoci jedné z nasledujicich metod jej pfevedeme na kfivku:

— Klikneme na tvar pravym tlacitkem mySi a z mistni nabidky vybereme mozZnost
Pfrevést > Na kfivku.

— V hlavni nabidce zvolime Tvar > Prevést > Na kfivku.

Céra Stin Styly car Styly Sipek

Organizovat styly Sipek
Nazev: Kratka sipka —
Styl Sipky: | 4— Krétka Sipka . =
Zménit
Smazat
= || &

Pridanim zvoleného objektu vytvorite novy styl Sipky.

—r AN

Napovéda Obnovit QK Zruéit

Obrazek 89: Dialogové okno Céra — stranka Styly Sipek

3) S vybranym tvarem otevieme v dialogovém okné& Cara stranku Styly Sipek.
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4) Klikneme na Pfidat a v otevieném dialogovém okné Nazev zadame jedinecny nazev
nového stylu Sipky.

5) Klikneme na tlacitko OK a novy styl hrotu Sipky se zobrazi v nahledovém poli
dialogového okna Cara.

6) Kliknutim na OK uloZime zmény a zavieme dialogové okno Céara. Novy styl Sipky se
zobrazi v dolni Casti rozeviraciho seznamu Sty/ Sipky na strance Styly Sipky
v dialogovém okné Cara.

Poznamka

Nékteré tvary nelze pouZit jako hrot Sipky. To je indikovano obdélnikovymi bloky,
které se objevuiji na obou koncich fadku v okné nahledu na strance Styly ¢ar
v dialogovém okné Cara.

Poznamka

PTi vytvareni stylu Sipky se doporu€uje pouzit jedine€ny nazev stylu Sipky. Tim se
zabrani prepsani jednoho ze standardnich styl( Sipek v LibreOffice, coz by zplsobilo
problémy s formatovanim v jinych kresbéach, které pouzivaji standardni styly Sipek.

Poznamka

Vytvoreny novy styl Sipky je k dispozici pouze pro pouziti v aktualni kresbé. Chceme-
li novy styl Sipky pouzit v jinych kresbach, je tfeba styl Sipky ulozit pomoci moznosti
Ulozit styly Sipek.

UloZeni styli Sipek

UloZeni stylu Sipky umoZziuje pouZiti nové vytvofeného stylu v jinych dokumentech LibreOffice.

1) Vytvofime novy styl Sipky, jak je popsano vySe v ¢asti ,Vytvareni styld Sipek, ale
nezavieme dialogové okno Céra.

2) Kliknutim na ikonu UloZit styly Sipek v pravém dolnim rohu stranky Styly Sipek
otevieme okno prohliZzece souborll ve spravném umisténi styl( Sipek.

3) Zadame jedineCny nazev souboru s pfiponou . soe pro styl Sipky.
4) Kliknutim na UloZit uloZime styl Sipky a zavieme okno prohliZze¢e soubord. Novy styl
Sipky je nyni k dispozici pro pouziti v novych dokumentech.
Nacitani stylt Sipek
LibreOffice po instalaci do pocitace poskytuje standardni styly Sipek. Kompatibilni styly Sipek

vSak Ize naCist a pouzivat v LibreOffice. VSechny styly Sipek nactené do LibreOffice musi
pouZzivat pfiponu souboru . soe.

1) Vytvofime Sipku nebo ¢aru v kresbé.

2) Otevieme dialogové okno Cara a kliknutim na kartu Styly Sipek otevieme stranku Styly

Sipek (obrazek 89).

3) Kliknutim na ikonu Nacist styly Sipek v pravém dolnim rohu stranky Styly Sipek
otevieme okno prohlizece soubord ve spravném umisténi pro styly Sipek.

4) Ze seznamu ulozenych styl( v okné prohliZzece souborl vybereme styl Sipky.

5) Kliknutim na tlacitko Otevfit nateme styl Sipky do kresby. Styl Sipky je k dispozici i pro
dalSi dokumenty LibreOffice.

6) Kliknutim na tlagitko OK zavieme dialogové okno Cara a uloZime provedené zmény.
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Mazani styl(i Sipek
1) Vytvofime Sipku nebo ¢aru v kresbé.

2) Otevieme dialogové okno Cara a kliknutim na kartu Styly Sipek otevieme stranku Styly
Sipek (obrazek 89).

3) V rozeviracim seznamu Sty Sipky vybereme styl Sipky pro odstranéni.

4) Klikneme na Odstranit a v otevieném potvrzovacim dialogu potvrdime odstranéni
kliknutim na Ano.

5) Kliknutim na tlagitko OK zavieme dialogové okno Cara a uloZzime provedené zmény.

0 Poznamka

Pred odstranénim styld Sipek se ujistime, Ze styl Sipky neni pouZzit v jiné kresbé nebo
dokumentu.

Formatovani vyplné oblasti

Termin vypli oblasti oznacuje vnitfek objektu. Vyplii oblasti mize byt Zadna, jednolita barva,
prechod, Srafovani, bitmapa nebo rastr, jak je znazornéno na obrazku 90. Také vypln oblasti
mUze byt ¢astecné nebo zcela priihledna a mlze vrhat stin.

Pfechod

Srafovani

4 Rastr

Vzorek

Obrazek 90: Priklady typl vypini oblasti
Nastrojova lista Cara a vyplii
Nastroje na nastrojové listé Cara a vypli (obrazek 82 na strané 85) poskytuji fadu vychozich
vyplIni, které jsou snadno dostupné pro rychlé formatovani grafickych objektd. Pokud se tento

panel nastrojli nezobrazuje, zvolime v hlavni nabidce Zobrazit > Nastrojové listy > Cara
a vypli. Formatovani oblasti objektu:

1) Vybereme objekt tak, aby se zobrazily dchyty vybéru.

2) Klikneme na Styllvypli oblasti na nastrojove listé Céraa vypli a vybereme pozadovany
typ vyplné z rozeviraciho seznamu (Zadna, Barva, Pfechod, Srafovani, Rastr, VVzorek)
(obrazek 91).

3) Vybereme jednu z dostupnych moznosti pro poZzadovany typ vyplné oblasti.
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— Barva (obrazek 92) — vybereme paletu barev z dostupnych moZznosti v rozeviracim
seznamu a poté vybereme barvu. Dalsi informace o barvach vyplnich najdeme v ¢asti

N T

.Barvy vyplné“ na strané 98.

— Pfechod (obrazek 93) — vybereme z rozeviraciho seznamu pozadovany pfechod.
DalSi informace o pfechodech najdeme v Casti ,\VypIn pfechod” na strané 101.

— Srafovani (obrazek 94) — vybereme pozadované Srafovani z rozeviraciho seznamu.
DalSi informace o Srafovanich najdeme v ¢asti ,Vypli Srafovanim* na strané 110.

— Rastr (obrdzek 95) — z rozeviraciho seznamu vybereme poZzadovany rastr. DalSi
informace o rastrech nalezneme v ¢asti ,Rastrové vyplné“ na strané 105.

— Vzorek (obrazek 96) — vybereme pozadovany vzorek z rozeviraciho seznamu v Casti
Oblast na karté Vlastnosti na postranni listé. DalSi informace o vzorcich naleznete
v Céasti ,VypIné vzorkem* na strané 108.

4) ZruSenim vybéru objektu uloZzime zmény v objektu.

Prechod
Srafovani
Rastr
Vzorek

Obréazek 91: Typy vypini oblasti
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Obrazek 92: Barevné vypiné oblasti
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Obrazek 93: Vyplnéni oblasti pfechodem
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Obrazek 96: Viyplnéni oblasti vzorkem v sekci
Oblast na karté Vlastnosti na postranni listé

Postranni lista

Oblast objektu naformatujeme pomoci postranni listy (obrazek 96) nasledujicim zplisobem:

1) Ujistime se, Ze je objekt vybran v kresbé.

2) Klikneme na Vlastnosti na postranni listé a poté kliknutim na hrot Sipky dol v vlevo na

titulnim panelu Oblast otevieme Cast Oblast.

3) K formétovani oblasti objektu pouZijeme mozZnosti v rozeviracich seznamech Vyplri
a Prihlednost. Dalsi informace nalezneme v ¢asti ,Prace s vyplnémi oblasti“ na strance

98.

4) ZruSenim vybéru objektu ulozime zmény.

Dialogové okno Oblast

Pomoci dialogového okna Oblast (obrazek 98) miizeme vypliné oblasti formatovat s vétsi

kontrolou takto:

1) Ujistime se, Ze je objekt vybran v kresbé.

2) Pomoci jedné z nasledujicich metod otevieme dialogové okno Oblast:

— V hlavni nabidce vybereme Format > Oblast.
— Klikneme na tla¢itko Oblast na nastrojové list& Cara a vypli.

— Klikneme pravym tlaCitkem mysSi na vybrany objekt a z mistni nabidky vybereme

moznost Oblast.

— Klikneme na Dal$i moznosti vpravo od nazvu sekce Oblast na postranni listé.
3) Kliknutim na kartu Oblast otevieme stranku Oblast. DalSi informace nalezneme v Casti

.Prace s vyplnémi oblasti“ na strance 98.
4) Z moznosti vybereme typ vypIné oblasti.
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5) Z moznosti, které jsou k dispozici pro vybrany typ vypIné oblasti vybereme styl vypIné.
6) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZime zmény.

Oblast Stin Prihlednost
| Zaana | | Bava | | prechod Rastr Vzorek | Srafovani
Barvy Aktivni Nova
Paleta'|standard b |
EEEEREEEO L
e aEEEEEEEn
(N I R [114 R (114 =
(NS REEEnEE | =
e [ [T T e G 153 6 19 [
(D eeEEEEEEn B 207 B |07 [2
e EEEEEEEs -
PEEEEEEEEEEE HTML |729fcf HTML |729fcf
SEEEEEEEEEEE
EEEEEEEEEEEE Vybrat
Posledni barvy
[
Vlastni paleta
Pridat Smazat
MNapovéda Obnovit OK Zrusit

Obréazek 97: Dialogové okno Oblast — stranka Barva

Prace s vyplnémi oblasti

Barvy vyplné

Vybér barvy vypiné

Nasledu1|C| postup vybéru barvy pro vypli oblasti pouziva dialogove okno Oblast. Pouziti
nastrojl na nastrojové listé Cara a vypli a sekce Oblast v nabidce Vlastnosti na postranni listé je
podobny postup, ale dostupné moZznosti jsou omezené. VSechny barevné vyplné jsou
jednobarevné.

1) Ujistime se, Ze je objekt vybran v kresbé.

2) Otevieme kartu Oblast v dialogovém okné Oblast a kliknutim na Barva (obrazek 97)
otevieme moznosti dostupné pro barevnou vyplin.

3) V poli Barvy vybereme pozadovanou paletu z dostupnych moznosti v rozeviracim
seznamu Paleta.

4) Klikneme na pozadovanou barvu. V okné nahledu Aktivni se zobrazi aktualni barevna
vypli vybraného objektu. Po vybéru nové barvy se v okné Nova zobrazi ndhled vybrané
barvy.

5) Prfipadné zadame hodnoty RGB nebo Hex barvy do textovych poli Nova.
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Obréazek 98: Dialogové okno Vyberte barvu

6) Pripadné kliknutim na Vybrat otevieme dialogové okno Vyberte barvu (obrazek 98).
Barvu vybereme jednim z nasledujicich zplsob:

— Zadame hodnoty RGB, Hex, HSB nebo CMYK pro barvu a kliknutim na tlacitko OK
zavieme dialogové okno Vyberte barvu a v nahledovém poli Nova se zobrazi vybrana
barva.

— Klikneme na barevny rozsah ve svislém barevném pruhu a poté kliknutim
a pfetazenim malého kolecka v barevném poli vybereme barvu. Kliknutim na tlacitko
OK zavieme dialogové okno Vyberte barvu a v ndhledovém poli Nova se zobrazi
vybrana barva.

7) V pripadé potfeby a pro navrat k ptivodni barvé klikneme na tla¢itko Obnovit a vSechny
provedené zmény se odstrani.

8) Klepnutim na tlaitko OK zavieme dialogové okno Oblast a uloZime zmény. Ve vybraném
objektu se pak zméni barva.

o Tip

Pokud byla barva pouzita dfive, zobrazi se v ¢asti Posledni barvy. Z barev
dostupnych v Posledni barvy ji Ize vybrat a znovu pouZzit.
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Vytvareni vliastnich barev pomoci dialogového okna Oblast

Chceme-li vytvofit vlastni barvu tak, aby byla k dispozici i pro jiné vykresy nebo dokumenty, je
tfeba pouzit zalozku Barvy v dialogovém okné Oblast.

1)
2)

3)
4)

5)
6)

7

Vybereme vyplnény objekt a vytvofime barvu.

V dialogovém okné Oblast otevieme stranku Oblast a kliknutim na tlaCitko Barva
otevieme dostupné moZznosti.

Zadame hodnoty RGB nebo Hex vlastni barvy do textovych poli Nova.

Pripadné kliknutim na Vybrat otevieme dialogové okno Vyberte barvu. Barvu vybereme
jednim z nasledujicich zplsob:

— Zadame hodnoty vlastni barvy do poli¢ek pro hodnoty RGB, Hex, HSB nebo CMYK
a poté kliknutim na tladitko OK zavieme dialogové okno Vyberte barvu a barva se
zobrazi v nahledovém poli Nova.

— Klikneme na barevny rozsah ve svislém barevném pruhu a poté kliknutim
a pfetazenim malého kole€ka v barevném poli vybereme barvu. Kliknutim na tlagitko
OK zavieme dialogové okno Vyberte barvu a v nahledovém poli Nova se zobrazi
vybrana barva.

Na strance Barva oblasti v dialogovém okné Oblast klikneme v ¢asti Viastni paleta na
Pridat a otevieme dialogové okno Nazev.

Do textového pole zadame jedinecny nazev a klikneme na tla€itko OK. Nova vlastni
barva se pak zobrazi ve Vlastni paleté.

Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZzime zmény. Nova vlastni
barva se zobrazi jako vypli vybraného objektu a je k dispozici pro pouziti v jinych
kresbach nebo dokumentech.

Vytvareni vlastnich barev pomoci dialogového okna Vyberte barvu

Pokud ma byt vlastni barva pro kresbu pouZzita pouze v této kresbé, pouzijeme dialogové okno
Viyberte barvu k vytvoreni vilastni barvy. Vlastni barva pomoci nasledujici metody neni pro jiné
kresby nebo dokumenty k dispozici.

1)
2)

3)

4)

Vybereme vyplnény objekt a vytvofime barvu.

Dialogové okno Vyberte barvu (obrazek 98) otevieme jednim z nasledujicich zptsobU:

— Klikneme na tlaCitko Vybrat na strance Barvy dialogového okna Oblast.

— Klikneme na trojihelnik v vedle polozky Barva vyplné na nastrojové listé Cara
a vypln.

— Klikneme na trojuhelnik v vedle polozky Barva vyplné v ¢asti Oblast na karté
Vlastnosti na postranni listé.

Vytvorime vlastni barvu pomoci jedné z nasledujicich metod.

— Zadame hodnoty vlastni barvy do poli¢ek pro hodnoty RGB, Hex, HSB nebo CMYK.

— Klikneme na barevny rozsah ve svislém barevném pruhu a poté kliknutim
a pfetazenim malého kole€ka v barevném poli vybereme barvu.

Kliknutim na tlaCitko OK zavieme dialogové okno Vyberte barvu a uloZime zmény. Nova
vlastni barva se zobrazi jako vypln vybraného objektu a je k dispozici pouze pro pouziti
ve vytvarené kresbé.
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Mazani viastnich barev

Pomoci dialogového okna Oblast Ize odstranit pouze vlastni barvy, které jsou k dispozici ve
vlastni paleté. Barvy, které jsou k dispozici v paletach barev poskytovanych aplikaci LibreOffice,
nelze odstranit.

1) Vybereme vyplnény objekt, ktery pouziva barevnou vypli pro odstranéni.
2) Pomoci jedné z nasledujicich metod otevieme dialogové okno Oblast:
— V hlavni nabidce vybereme Format > Oblast.
— Klepneme pravym tlacitkem na objekt a vybereme z mistni nabidky Oblast.
— Klikneme na DalSi moZnosti vpravo od nazvu sekce Oblast na postranni liSté.
3) Klikneme na Oblast a poté kliknutim na Barvy otevieme stranku Barvy.
4) Na strance Barvy vybereme z rozeviraciho seznamu Paleta moznost Viastni.

5) Vybereme barvu, kterou chceme odstranit, a klikneme na tlacitko Smazat. Smazani
nevyzaduje potvrzeni.

6) Klepnutim na tlagitko OK ulozime zmény a zavieme dialogové okno Oblast.

Vypln pfechod

Pfi instalaci LibreOffice je k dispozici nékolik pfeddefinovanych prechod(l. Doporuéujeme vytvorit
vlastni prechody, které odpovidaji poZadavk(m, a nikoli trvale upravovat nainstalované
preddefinované pfechody. Pfeddefinované pfechody mohly byt pouzity v jinych objektech na
kresbé nebo v jinych dokumentech.

Vlastni pfechody by mély byt uloZzeny s jedineCnym nazvem, ktery umozni jejich pouZiti v jinych
kresbach nebo dokumentech. Vlastni pfechody jsou umistény na konec pfechodUll zobrazenych
v poli Pfechod na strance Pfechod dialogového okna Oblast (obrazek 99).

Vybér a uprava prechodt

Nasledujici postup vybéru pfechodu pro vyplii oblasti pouziva dialogové okno Oblast. Pouziti
nastrojll na nastrojové listé Cara a vypln a sekce Oblast v nabidce Vlastnosti na postranni listé je
podobny postup, ale dostupné moZznosti jsou omezené.

1) Ujistime se, Ze je objekt, ktery méa byt vyplnén, vybran v kresbé.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Pfechod.
3) V poli Pfechod vybereme pozadovany pfechod. Vybrany pfechod se zobrazi v Nahledu.
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Obrazek 99: Dialogové okno Oblast — stranka Prechod

4) V pfipadé& potfeby zmé&nime hodnoty v polich Typ, Pririistek, Stfed, Uhel, Ohrani¢eni, Od
barvy a Do barvy, abychom upravili pfechod podle pozadavkd. Pfi provadéni zmén se

méni také pfecho

d zobrazeny v ramecku Néahled, ktery ukazuje, jak bude vypadat. DalSi

informace o moZnostech pfechodu najdeme v ¢asti ,Tabulka 5: MoZnosti pfechodu” nize.

5) Pokud je to nutné

, zruSime pfi provadéni zmén hodnoty Prirdstek vybraného prechodu

vyb&r moznosti Automaticky a zadame hodnotu pfirlistku do textového pole.

6) Pokud je to nutné

a chceme se vrétit k plvodnimu pfechodu, klikneme na Obnovit

a vSechny provedené zmény se odstrani.

7) Klepnutim na tlac
objektu se pak zo

& Poznamka

itko OK zavieme dialogové okno Oblast a uloZzime zmény. Ve vybraném
brazi prfechod.

Vybér a Uprava pfechodu vySe uvedenou metodou umoznuje pouziti pfechodu
pouze ve vytvarené kresbé. Pokud ma byt upraveny prechod pouzit v jinych
kresbach nebo dokumentech, vytvofime vlastni pfechod a ulozime jej s jedineCnym
nazvem. Viz ,Vytvareni a ukladani vlastnich pfechodd* nize.

Tabulka 5: MoZnosti prechodu

Vlastnost pifechodu

Vyznam

Linearni pfechod

Barva prechazi z po¢atecni barvy do koncové barvy v pfimé linii.

Axialni pfechod

Barva prechazi od pocatecni barvy ke koncové barvé od stfedu objektu
k jeho okrajlim ve dvou protilehlych smérech.
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Vlastnost prechodu

Vyznam

Radialni pfechod

Barva pfechazi z poCatecni barvy do koncové barvy v kruhovém vzoru.

Ovalny prechod

Barva prechazi z po¢atecni barvy do koncové barvy eliptickym vzorem.

Krychlovy pfechod

Barva prechazi od pocatecni barvy ke koncové barvé od okrajl objektu ke
stfedu objektu ve Ctyfech smérech.

Ctvercovy pfechod

Barva pfechazi od pocatecni barvy ke koncové barvé od okrajd objektu ke
stfedu objektu ve Ctvercovém vzoru.

Zadame pocet krokd pro prolnuti dvou barev prechodu. Ve vychozim

Prirtstek nastaveni je tato moznost nastavena na hodnotu Automaticky.
Stred X Pro radialni, ovalné, Ctvercové a krychlové prechody upravime tyto
hodnoty tak, abychom nastavili horizontalni posun stfedu pfechodu.
Stied Y Pro radialni, ovalné, Ctvercové a krychlové prechody upravime tyto
hodnoty tak, abychom nastavili vertikalni posun stfedu pfechodu.
Uhel U vSech typl prechodu upravuje Ghel osy pfechodu.
Ohrani€eni Pokud tuto hodnotu zvySime, bude gradient za€inat dale od okraje tvaru.
Od bar Pocéatecni barva pfechodu. Do editacniho pole zadame intenzitu barvy: 0
vy % nebo odpovida Cerné barveé, 100 % plné barve.
Koncova barva pfechodu. Do editaniho pole zadame intenzitu barvy: 0 %
Do barvy

nebo odpovida cerné barve, 100 % pIné barvé.

Vytvareni a ukladani viastnich prechodt

Chceme-li pouzit v jinych vykresech nebo dokumentech upraveny pfechod, je tfeba uloZit vlastni
pfechod s jedineCnym nazvem.

1) Ujistime se, Ze je objekt vybran v kresbé.

2) V dialogovém okné Oblast otevieme stranku Oblast a poté kliknutim na Pfechod
otevieme dostupné moznosti.

3) Vybereme pfechod a upravime jej pomoci moznosti uvedenych vySe v ,Tabulka 5:
Moznosti pfechodu®. Pfi provadéni zmén se méni také prechod zobrazeny v ramecku
Néahled, ktery naznacuje, jak bude vlastni pfechod vypadat.

4) Klepnutim na Pfidat otevieme dialogové okno Nazev.

5) Zadame jedine€ny nazev nového pfechodu a kliknutim na tlacitko OK zavieme dialogové
okno Nazev. Vlastni pfechod se umisti na konec pfechodu zobrazeného v ramecku
nahledu Prechod a je k dispozici pro pouziti v dalSich kresbach a dokumentech.

6) Klepnutim na tlagitko OK zavifeme dialogové okno Oblast a uloZzime zmény.

Uprava vlastnich pFfechod(

Pouziti moznosti Zménit na strance Pfechod v dialogovém okné Oblast trvale zméni pfechod
a nelze ji vrétit zpét. Doporucujeme upravovat pouze vlastni pfechody, nikoli pfeddefinované
pfechody, které byly nainstalovany s LibreOffice.

1) Ujistime se, Ze je objekt vybran v kresbé.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Pfechod.

3) V poli Pfechod vybereme vlastni pfechod. Vlastni pfechody se zobrazi pod 15
preddefinovanymi gradienty v poli Pfechod.

4) Provedeme potfebné zmény v moznostech uvedenych vySe v ¢asti ,Tabulka 5: Moznosti
prechodu“. Pri provadéni zmén se meéni také pfechod zobrazeny v ramecku Nahled, ktery
naznacuje, jak bude vlastni pfechod vypadat.
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5) Pokud je to nutné a chceme se vrétit k plivodnimu prechodu, klikneme na Obnovit
a vSechny provedené zmeény se odstrani.

6) Kliknutim na Zmeénit trvale zménime vybrany vlastni pfechod. Pfi Gpravé viastniho
pfechodu neni poZadovano Zadné potvrzeni.

7) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZime zmény.

Odstranéni vlastnich prechodt
1) Vybereme objekt, ktery pouziva vypln pfechodem.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Plocha.
3) V poli Prechod vybereme vlastni pfechod, ktery chceme odstranit.

4) Klikneme na prfechod pravym tlacitkem mysi a z mistni nabidky vybereme moZznost
Smazat. Smazani potvrdime kliknutim na Ano.

5) Klepnutim na tlacitko OK ulozime zmény a zavieme dialogové okno Oblast.

./ Poznamka

DoporuCuje se odstrafiovat nebo pfejmenovavat pouze vytvorené vlastni pfechody.
Odstranéni nebo prejmenovani nékterého z preddefinovanych prechodd, které jsou
nainstalovany v LibreOffice, mize zplsobit problémy v kresbach a dokumentech,
které néktery z prechod(l pouzivaji.

Pokrocilé ovladaci prvky prechodu
LibreOffice poskytuje pokrocilé ovladaci prvky pro pfechody na nastrojové listé Transformace
(obrazek 100).

1) Ujistime se, Ze je objekt vybran v kresbé.

2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Pfechod.

3) V hlavni nabidce zvolime Zobrazit > Nastrojové liSty > Transformace nebo klikneme
na nastroj Transformace na nastrojové listé Cara a vypln a otevieme nastrojovou listu
Transformace.

Transformace w X

(A & 520

[ Otocit

A Preklopit

48 V3D rotaénim objektu

= Umistit na kruZnici (perspektivné)

[=] Umistit na kruznici (zkosit)
I Deformovat

M Nastroj prahlednosti

I Nastroj prechodu

Obréazek 100: Nastrojova lista
Transformace
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Obréazek 101: Vlybrany
nastroj Interaktivni
nastroj prfechodu

4) Klikneme na Interaktivni nastroj prechodu na nastrojové listé Transformace. Tim se
zobrazi pferuSovand Céra spojujici dva barevné Ctverce (obrazek 101). Barvy zobrazuiji
Od barvy a Do barvy, které jsou pouzity pro vybrany pfechod.

5) Z moznosti v rozeviracim seznamu Typ vybereme typ pfechodu pro objekt. Viastnosti,

které Ize upravit, zavisi na vybraném typu pfechodu, jak je vysvétleno nize. Pohyb
¢tvercll bude mit rlizné efekty v zavislosti na typu prechodu.

— Linearni — posunutim ¢tverce odpovidajiciho Od barvy zménime misto, kde gradient
zacina (hodnotu okraje). Pfesuneme Ctverec odpovidajici Do barvy, abychom zménili
orientaci (hodnota uhlu).

— Axialni — pfesunutim Do barvy zménime Uhel i vlastnosti ohrani¢eni pfechodu. Pouze
Ctverec odpovidajici Do barvy lze pfesunout.

— Radialni — pfesunutim Od barvy upravime vlastnost ohrani¢eni a nastavime Sifku
kruhu pfechodu. Pfesunem Do barvy zménime bod, kde prechod kon¢i (hodnoty
Stred X a Stred Y).

— Ovalny — pfesunutim Od barvy upravime vlastnost ohrani¢eni a nastavime velikost
ovalu prechodu. Pro zménu Ghlu osy ovalu a samotné osy pfesuneme Do barvy.

— Krychlovy a Ctvercovy — pfesunutim Od barvy upravime vlastnost ohraniceni
a nastavime velikost Ctverce nebo obdélniku a Uhel tvaru pfechodu. Pfesunutim Do
barvy zménime stfed pfechodu.

6) Klepnutim na tlagitko OK uloZime zmény a zavieme dialogové okno Oblast.

Rastrové vyplné

Pfi instalaci LibreOffice do pocitace je k dispozici nékolik pfeddefinovanych rastrd. Obsah
dodanych rastrd nelze upravovat, ale Ize ménit nastaveni zobrazeni a importovat dalsi rastry
z jinych zdrojd. GIF je prikladem grafického obrazového souboru s rastrem.

Vybér rastri
Nasledujici postup vybéru rastru pro vyplii oblasti pouziva dialogove okno Oblast. PouZiti
nastrojl na nastrojové listé Cara a vypli a sekce Oblast v nabidce Vlastnosti na postranni listé je
podobny postup, ale dostupné moZznosti jsou omezené.

1) Ujistime se, Ze je objekt vybran v kresbé.

2) V dialogovém okné Oblast otevieme stranku Oblast a poté kliknutim na Rastr otevieme
mozZnosti dostupné pro vypli rastrem (obrazek 102).

3) Vybereme pozadovany rastr z pole Rastr. VVybrany rastr se zobrazi v poli Nahled.
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Oblast Stin Prahlednost

Zadna Barva Pfechod

Rastr
Il-

Vzorek Srafovani

MozZnosti Nahled
~ | Styl:

Dlazdice [~

Velikost:

Sitka: 1,00 cm
Vyska: [1,00 cm
[ Skélovat

Umisténi:

[l a0n]

Uprostred |~

Umisténi dlaZzdic:
Odchylka X: |0 %
Odchylka Y: [0 %
Qdstup dlaZdic:
L Radek v 0%
IR

A4

1k

Pridat/importovat

Napovéda Cbnovit _ OK Zrusit

Obrazek 102: Dialogové okno Oblast — stranka Rastr

4) V pfipadé potieby zménime hodnoty v polich Styl, Velikost, Umisténi, Umisténi dlaZdic
a Odstup dlaZdic, abychom rastr upravili podle pozadavkd. Dal$i informace o moZnostech
rastrd nalezneme v ¢asti ,Tabulka 6 nize.

5) Pokud je to nutné a chceme se vratit k pdivodnimu rastru, klikneme na Obnovit
a vSechny provedené zmény se odstrani.

6) Klepnutim na tlacitko OK zavifeme dialogové okno Oblast a ulozime zmény. Ve vybraném
objektu se pak zobrazi rastrova vypln.

Tabulka 6: MoZnosti rastru

MoZnost rastru Vyznam
Styl — Vlastni Pokud je tato mozZnost vybrana, lIze zadat polohu rastru v objektu a jeji
umisténi/velikost velikost.

Pokud je tato moznost vybrana, rastr se rozdéli na dlazdice, aby vyplnil
Styl — Dlazdice oblast. Velikost rastru pouzitého pro dlazdice je ur¢ena nastavenim
v poli Velikost.

Pokud je tato mozZnost vybrana, rastr se roztahne tak, aby vyplnil

Styl - Roztahnute oblast objektu.

s sy

Nastavi Sifku rastru. Napfiklad 100 % znamena, Ze rastr je zmensen
Velikost — Sitka tak, aby zabiral celou Sitku vyplné, 50 % znamena, Ze Sifka rastru je
polovi¢ni oproti Sifce oblasti vyplné.
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MoZnost rastru

Vyznam

Velikost — vyska

Nastavi vysku rastru. Napfiklad 100 % znamena, Ze rastr je zmensen
tak, aby zabiral celou vySku vyplné&, 50 % znamena, Ze vyska rastru je
polovi¢ni oproti oblasti vypIné.

Velikost — Skalovat

Pokud je tato moznost vybrana, velikost rastru se udava v procentech
pro Sitku a Vysku. Pfi zruSeni vybéru je uvedena skute¢na velikost
rastru v polich Sitka a Vyska.

Umisténi

Urcuje kotevni bod rastru.

Umisténi dlazdic —
odchylka X

Nastavi posunuti Sifky rastru v procentech. Posun o 50 % znamena, Ze
Draw umisti stfedni ¢ast Sitky rastru do kotevniho bodu a zacne
skladat dlazdice od tohoto bodu.

Umisténi dlazdic —
odchylka Y

Nastavi posunuti vysky rastru v procentech. Posun o 50 % znamena,
Ze Draw umisti stfedni ¢ast vysky rastru do kotevniho bodu a zatne
skladat dlazdice od tohoto bodu.

Odstup dlazdic

Posune sloupce dlazdicovych rastr(i o procento zadané v poli tak, aby
dva po sobé nasledujici sloupce rastrii nebyly zarovnany.

\ . .
D LIUrEOﬁlce Original bitmap

Width and height 25% scaled
Anchor to top left corner
No offset

Width and height 25% scaled
Anchor to top right
Row offset 50%

Obrazek 103: Priklady vypini rastri

Upravy rastrovych obrazki
1) Ujistime se, Ze je v kresbé vybran objekt obsahujici rastrovou vypln.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Rastr.
3) Vybereme rastr z pole Rastr. Vybrany rastr se zobrazi v poli Nahled.

4) Zménime hodnoty v polich moZnosti Styl, Velikost, Umisténi, Umisténi dlaZdic a Odstup
dlaZdic podle pozadavk(. Dalsi informace o moznostech rastril nalezneme v ¢asti
»1abulka 6“ vySe. Priklady rastrovych vyplni a pouZitych vlastnosti jsou uvedeny na

obrazku 103.

5) Pokud je to nutné a chceme se vratit k ptivodnimu rastru, klikneme na Obnovit
a vSechny provedené zmeény se odstrani.

6) Klepnutim na tlagitko OK ulozime zmény a zavieme dialogové okno Oblast.

Poznamka

Dodané rastry nelze upravovat, ale nastaveni zobrazeni pro umisténi a dlazdice Ize

ménit.
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Pridani nebo import rastri

1)
2)
3)
4)

5)
6)

7

Ujistime se, Ze je objekt vybran v kresbé.
V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Rastr.
Klikneme na P¥idat/importovat a otevieme okno prohlizece soubord.

Pfejdeme do adresare obsahujiciho soubor rastry, vybereme soubor a klikneme na
Oteviit.

V dialogovém okné Nazev zadame jedinecny nazev nového rastru.

Kliknutim na OK zavieme dialogové okno Nazev. Importovany rastr se pfida na konec
rastrd v poli Rastr.

Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast. Ve vybraném
objektu se zobrazi importovany rastr.

Poznamka

Obrazky rastr(i Ize importovat a pouzivat jako vypIné ploch.

Mazani rastrovych obrazkd

1)
2)
3)

4)

Ujistime se, Ze je v kresbé vybran objekt obsahuijici rastrovou vypln.
V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Rastr.

Klikneme pravym tlacitkem mySi na odstrariovany rastr a z mistni nabidky vybereme
mozZnost Smazat. Smazani potvrdime kliknutim na Ano.

Klepnutim na tlacitko OK uloZzime zmény a zavieme dialogové okno Oblast.

Poznamka

Doporucuje se odstranovat nebo pfejmenovavat pouze rastry, které byly pridany
nebo importovany. Odstranéni nebo piejmenovani jedné z rastrll nainstalovanych
v LibreOffice miiZe zpUsobit problémy v kresbach a dokumentech, které néktery
z rastrli pouzivaji.

Vyplné vzorkem

Pri instalaci LibreOffice do pocitace je k dispozici nékolik pfeddefinovanych vzorkd vypini.
V LibreOffice Ize také vytvaret a upravovat vlastni vzory.

Vybér vzorkovych vyplni
Nasledujici postup vybéru vzorku pro vypli plochy pouZziva dialogove okno Oblast. Pouziti

nastrojll na nastrojové listé Cara a vypln a sekce Oblast v nabidce Vlastnosti na postranni listé je
podobny postup, ale dostupné moznosti jsou omezené.

1)
2)

3)
4)

5)

Ujistime se, Ze je objekt vybran v kresbé.

V dialogovém okné Oblast otevieme stranku Oblast a poté kliknutim na Vzorek
otevieme moznosti dostupné pro vypli vzorkem (obrazek 104).

V poli Vzorek vybereme pozadovany vzorek a ten se zobrazi v poli Nahled.

V pripadé potfeby zménime barvy popredi a pozadi nebo samotny vzorek, coz je
popséano v ¢asti ,Vytvareni vlastnich a ukladani vzor(“ nize. Pfi provadéni zmén se méni
i vzor zobrazeny v poli Nahled, ktery ukazuje, jak bude vypadat. VeSkeré zmény se

projevi pouze u vypliiovaného objektu.

Pokud je to nutné a chceme se vratit k plvodnimu vzoru, klikneme na Obnovit a vSechny
provedené zmény se odstrani.
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6) Klepnutim na tlaitko OK zavifeme dialogové okno Oblast a uloZime zmény. Vzorek

vypIné se pak zobrazi ve vybraném objektu.

Oblast Stin Prdhlednost

Zadna Barva Prechod Rastr Vzorek Srafovani

Vzorek MoZnosti Nahled

L Editor vzorkd:

RGUEELEELECCRCN
RRGCEULCELECCRN
ERSGURRRREECCEEN
RRGCEULCELECCRN
ERSGURRRREECCEEN
RRUEELEELECCEN
RRGCEULCELECCRN
ERSGURRRREECCEEN

L

Barva popfedi:
B Cervena v
Barva pozadi:
[ ] Zta A
Napovéda Obnovit oK Zrusit

Obrazek 104: Dialog Oblast — stranka Vzorek

Vytvareni viastnich a ukladani vzort

1)
2)
3)

4)
5)
6)
7
8)

9)

Ujistime se, Ze je objekt vybran v kresbé.
V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Vzorek.

V poli Vzorek vybereme pozadovany vzorek, ktery chceme pouzit jako vychozi bod,
a vybrany vzorek se zobrazi v poli Nahled.

VoliteIn& miZzeme vybrat rlizné barvy pro Barvu popiedi a Barvu pozadi. Vzor z(istava
stejny, ale barvy se méni.

Volitelné mizeme v Editoru vzorki kliknutim na jednotlivé ¢tverce zménit barvu z Barvy
popredi na Barvu pozadi nebo z Barvy pozadi na Barvu popfedi a vytvofit novy vzorek.

Klepnutim na P¥idat otevieme dialogové okno Nazev.

Zadame jedine€ny nazev nového vzorku a kliknutim na tlacitko OK zavieme dialogové
okno Nazev. Vlastni vzorek se umisti na konec vzorkd zobrazenych v poli Vzorek a je
k dispozici pro pouziti v dalSich kresbach a dokumentech.

Pokud je to nutné a chceme se vratit k pivodnimu vzoru, klikneme na Obnovit a vSechny
provedené zmény se odstrani.

Klepnutim na tlac¢itko OK zavieme dialogové okno Oblast a uloZime zmény.
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Poznamka

Chceme-li upraveny vzor pouzit v jinych kresbach nebo dokumentech, musi byt
vlastni vzor uloZen s jedine¢nym nazvem.

Uprava viastnich vzorkd

Pouziti mozZnosti Zménit na strance Vzorek v dialogovém okné Oblast trvale zméni vzor a nelze
ji vratit zpét. Doporucujeme upravovat pouze vlastni vzory, nikoli pfeddefinované vzory, které byly
nainstalovany s LibreOffice.

1)
2)
3)

4)
5)
6)

7)

Ujistime se, Ze je objekt vybran v kresbé.
V dialogovém okné Oblast otevieme strdnku Oblast a klikneme na Vzorek.

Vybereme v poli Vzorek vlastni vzorek a ten se zobrazi v poli Nahled. Vlastni vzorky se
nachazeji pod preddefinovanymi vzorky v poli Vzorek.

V okné Editor vzork( klikneme na kazdy Gtverec pro zménu barvy z Barvy popredi na
Barvu pozadi nebo z Barvy pozadi na Barvu popredi a upravime vybrany vzorek.

Pokud je to nutné a chceme se vratit k plvodnimu vzoru, klikneme na Obnovit a vechny
provedené zmény se odstrani.

Kliknutim na Zménit trvale zménime vybrany vlastni vzorek. Pfi Gpraveé vlastniho vzorku
neni pozadovano Zadné potvrzeni.

Klepnutim na tlaCitko OK zavieme dialogové okno Oblast a uloZime zmény.

Odstranéni vlastnich vzort

1)
2)
3)
4)

5)

Vybereme objekt, ktery pouZziva vlastni vzorek jako vyplfi oblasti.
V dialogovém okné Oblast otevieme stranku Oblast a klikneme na Vzorek.
V poli Vzorek vybereme vlastni vzorek, ktery chceme odstranit.

Klepneme pravym tlagitkem na vzorek a z mistni nabidky vybereme Smazat. Smazani
potvrdime kliknutim na Ano.

Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno Oblast.

Poznamka

Doporucuje se odstranovat nebo pfejmenovavat pouze vytvorené vlastni vzorky.
Odstranéni nebo prejmenovani nékterého z preddefinovanych vzorkd, které jsou
nainstalovany v kancelaiském baliku LibreOffice, mize zplsobit problémy

v kresbach a dokumentech, které pouZzivaji néktery z vzork(.

Vypln Srafovanim

Srafované vyplné jsou podobné vzorkovym vypinim, ale misto &tvercll pouzivaji ¢ary. PFi instalaci
LibreOffice do pocitace je k dispozici nékolik pfeddefinovanych Srafovacich vyplni. Lze také
vytvaret a upravovat vlastni Srafovaci vypiné.

Vybér srafovacich vyplni

Nasledujici postup vybéru Srafovani pro vyplii plochy pouziva dialogove okno Oblast. Pouziti
nastrojd na nastrojové listé Cara a vypln a sekce Oblast v nabidce Vlastnosti na postranni listé je
podobny postup, ale dostupné moznosti jsou omezené.

1)

Ujistime se, Ze je objekt vybran v kresbé.
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Oblast Stin Prdhlednost

Zadna Barva Prechod Rastr Vzorek
Srafovani Moznosti Nahled
~ | Vzdalenost:
0,10 cm -
Uhel:
I e B
Typ cary:
|Jednoduché w
Barva &ary:
B Cemns -
[0 Barva pozadi
Svétle modra 2 w
W
Pridat Zménit
Néapovéda Cbnovit oK Zrusit

Obréazek 105: Dialogové okno Oblast — zaloZka Srafovani

2) V dialogovém okné Oblast otevieme stranku Oblast a poté kliknutim na Srafovani
otevieme moznosti dostupné pro Srafovaci vypli (obrazek 105).

3) V poli Srafovani vybereme pozadované Srafovani a vybrané Srafovani se zobrazi v poli
Néhled.

4) V pfipadé potfeby zménime barvy nebo jiné moznosti, jak je popsano v ¢asti ,Vytvoreni
a“ nize. Pfi provadéni zmén se méni i Srafovani zobrazené v poli Nahled.

5) V pripadé potfeby a pro navrat k ptivodnimu Srafovani klikneme na tlacitko Obnovit
a vSechny provedené zmény se odstrani.

6) Klepnutim na tlaitko OK zavieme dialogové okno Oblast a uloZime zmény. Ve vybraném
objektu se pak zobrazi Srafovani.

Vytvoreni a uloZeni vlastniho Srafovani
1) Ujistime se, Ze je objekt vybran v kresbé.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na tlagitko Srafovani.

3) Jako vychozi bod vybereme pozadované rafovani v poli Srafovani a vybrané Srafovani
se zobrazi v poli Nahled.

4) Zmeénime hodnoty v polich moznosti Vzdalenost, Uhel, Typ ¢ary, Barva ¢ary a Barva
pozadi a upravime Srafovani podle pozadavkl. Dalsi informace o moznostech Srafovani
najdeme v ¢asti ,Tabulka 7“ nize.
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5) Klepnutim na P¥idat otevieme dialogové okno Nazev.

6) Zadame jedine€ny nazev nového Srafovani a kliknutim na tlaCitko OK zavieme dialogové
okno Nazev. Vlastni Srafovani se umisti na konec Srafovani zobrazeného v poli Srafovani
a je k dispozici pro pouziti v dalSich vykresech a dokumentech.

7) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZime zmény.
Tabulka 7: MoZnosti Srafovani

MoZnost Srafovani Vyznam

UrCuje rozestup mezi dvéma fadky Srafovaci vyplné. Pfi zméné hodnoty

Vzdalenost se aktualizuje okno nahledu.

) Pomoci mini mapy pod &iselnou hodnotou mizeme rychle nastavit Uhel
Uhel tvoreny ¢arou s nasobky 45 stupiili. Pokud poZadovany thel neni
nasobkem 45 stupiill, zadame poZadovanou hodnotu do editaéniho pole.

Typ Cary Pro styl Srafovani nastavime jednoduchy, kfizovy nebo trojity typ cary.
Barva Cary Pomoci seznamu vybereme barvu €ar, které budou tvofit Srafovani.
Barva pozadi Po vybéru prid4 barevnou vypln za Cary pouzité pro Srafovani.

Uprava viastniho Srafovani

PouZiti moZnosti Zménit na strance Srafovani v dialogovém okné Oblast trvale zméni Srafovani
a nelze ji vratit zpét. Doporucujeme upravovat pouze vlastni Srafovani, nikoli pfeddefinované
Srafovani, které bylo nainstalovano s LibreOffice.

1) Uijistime se, Ze je objekt vybran v kresbé.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na tlacitko Srafovani.

3) Vybereme vlastni Srafovani v poli Srafovani a vybrané Srafovani se zobrazi v poli Nahled.
Vlastni Srafovani se nachazi pod preddefinovanymi Srafovanimi v poli Srafovani.

4) Chceme-li upravit $rafovani, zmé&nime hodnoty v polich moznosti Vzdélenost, Uhel, Typ
cary, Barva ¢ary a Barva pozadi. DalSi informace o moznostech Srafovani najdeme
v Casti ,Tabulka 7“ vySe.

5) V pfipadé potfeby a pro navrat k ptivodnimu Srafovani klikneme na tla¢itko Obnovit
a vSechny provedené zmeény se odstrani.

6) Kliknutim na tlacitko Zménit trvale zménime vybrané vlastni Srafovani. Pfi Gpravé
vlastniho Srafovani neni pozadovano zadné potvrzeni.

7) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a ulozime zmény.

Odstranéni viastniho Srafovani
1) Vybereme objekt, ktery pouziva Srafovaci vypln, kterou chceme odstranit.
2) V dialogovém okné Oblast otevieme stranku Oblast a klikneme na tlagitko Srafovani.
3) V poli Srafovani vybereme vlastni Srafovani, které chceme odstranit.

4) Klikneme pravym tlacitkem mySi na Srafovani a z mistni nabidky vybereme moznost
Smazat. Smazani potvrdime kliknutim na Ano.

5) Klepnutim na tlacitko OK ulozime zmény a zavieme dialogové okno Oblast.

Poznamka

Doporucuje se odstranovat nebo pfejmenovavat pouze vytvorené vilastni Srafovani.
Odstranéni nebo prejmenovéani nékterého z preddefinovanych Srafovani
nainstalovanych v LibreOffice mlize zplsobit problémy v kresbach a dokumentech,
které pouzivaji néktery ze Srafovani.
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Oblast Stin Prdhlednost

Vlastnosti Nahled
Pouzit stin

(», O O

i P i
Barva: B Seda hd
Vzdélenost: 0,60 cm =
Rozostieni: |0 pt =
Prihlednost: |25 % =

Obréazek 106: Dialogové okno Oblast — stranka Stin

Stiny

Vychozi stinovani
Chceme-li na objekt rychle pouZit stin, vybereme objekt a klikneme na Stin na nastrojové li5té

Céra a vyplii. Stin pouZity na objekt pomoci této metody je nastaven dle vychoziho nastaveni
v LibreOffice.

o Poznamka

Chceme-li mit vétsi kontrolu nad pouzitim stind na objekt, pouZzijeme stranku Stin
v dialogovych oknech Oblast nebo Céara. Nasledujici text popisuje pouZiti stranky
Stin v dialogovém okné Oblast (obrazek 106), ale Ize jej pouZit i pro strAnku Stin
v dialogovém okné Cara.

Formatovani stint

Chceme-li mit vétsi kontrolu nad pridavanim stinti k objektu, pouZzijeme stranku Stin
v dialogovém okné Oblast (obrazek 106) nasledujicim zplisobem:

1) Ujistime se, Ze je objekt vybran v kresbé.

2) Otevieme dialogové okno Oblast a kliknutim na Stin otevifeme stranku Stin.

3) Chceme-li, aby se mozZnosti stinovani aktivovaly, vybereme moznost PouZit stin.

4) Vybereme kotevni bod pro smér vrzeného stinu vzhledem k objektu.

5) V poli Barva vybereme paletu barev a barvu poZzadovanou pro stin.

6) Do pole Vzdalenost zadame vzdalenost, kterou chceme nastavit mezi objektem a stinem.
7) Do pole Rozostreni zadame hodnotu pro zmékéeni okrajl stinu.

8) Do pole Prihlednost zadame procento prihlednosti stinu.

9) Klepnutim na tlagitko OK zavieme dialogové okno Oblast a ulozime zmény.

Prihlednost

Prlhlednosti Ize pouZzit na vyplné oblasti i na stiny a Cary.
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 Dalsi informace o pouziti priihlednosti na ¢ary nalezneme v ¢asti ,Formatovani ¢ar na
strané 85.

« Dalsi informace o pouziti prihlednosti ve stinech nalezneme v ¢asti ,Stiny* vyse.

Pouziti prdhlednosti na vyplii plochy objektu pomoci dialogového okna Oblast (obrazek 107) je
nésledujici:
1) Ujistime se, Ze je objekt vybran v kresbé.

2) Otevieme dialogové okno Oblast a kliknutim na Priihlednost otevieme stranku
Prlhlednost a ziskame pristup k dostupnym moZnostem.

3) Chceme-li vytvorit rovnomérnou prihlednost, vybereme Prihlednost a do textového pole
zadame procento.

4) Chceme-li vytvorit pfechodovou prihlednost, aby se oblast postupné stala prihlednou,
vybereme Prechod a v rozeviracim seznamu vybereme typ prihlednosti pfechodu:
Linearni, Axialni, Radialni, Ovalny, Krychlovy nebo Ctvercovy. Dalsi informace o typech
prfechodd najdeme v ¢asti ,Tabulka 5 na strance 102.

5) Nastavime parametry pro typ prihlednosti pfechodu vybraného vyse. Popis vlastnosti
najdeme v ¢asti ,Tabulka 8“ niZze. Dostupné parametry zavisi na typu priihlednosti
pfechodu vybraném vyse.

6) Klepnutim na tlacitko OK zavieme dialogové okno Oblast a uloZime zmény.

Oblast Stin Prihlednost

ReZim prihlednosti oblasti
) Neprahledné
() Prihlednost: 50 % =
® Prechod

Tvp: |

Stred X: |14 % =

Stred Y: 84 % 2

Uhel: |48° s

Hranice: 0% =
Poéateéni hodnota: 24 % 2]
Koncové hodnota: |43 % =

Obrazek 107: Dialogové okno Oblast — stranka Priihlednost
Tabulka 8: Parametry prihlednosti

Parametry prihlednosti Vyznam
. Pro Radialni, Ovéalné, Kvadratické a Ctvercové piechody. Hodnoty
Stfed X . . P .
pro nastaveni vodorovného odsazeni stfedu pfechodu.
. Pro Radialni, Ovéalné, Kvadratické a Ctvercové piechody. Hodnoty
Stied Y P pag. .
pro nastaveni svislého posunuti stfedu prfechodu.
Unhel Pro Linearni, Axiélni, Ovalné, Kvadratické a Ctvercové piechody.
Ur€uje thel osy pfechodu.

100 | PFirucka Draw 7.1




Parametry prihlednosti Vyznam

Tuto hodnotu zvySime, pokud chceme, aby pfechod zacinal dale od

Ohraniceni okraje objektu.

Hodnota pro pocateéni prfechod priihlednosti. 0 % je zcela

Pocatecni hodnota neprdhledné, 100 % znamena zcela prihledné.

Hodnota pro koncovy pfechod prihlednosti. 0 % je zcela

Koncova hodnota neprdhledné, 100 % znamena zcela prdhledné.

Styly kresby

Predpokladejme, Ze na sadu objektdl ma byt pouzita stejna vypln plochy, tloustka ¢ary

a ohraniCeni. Opakované nastavovani vlastnosti Ize vyrazné zjednodusit tim, Ze pouZijeme styly.
Styly umoziiuji definovat forméat a poté jej pouZit na vice objektl. Dalsi informace o stylech
nalezneme v Prirucce Writer.

Poznamka

Styly kresby, které jsou soucasti LibreOffice Draw, nelze odstranit ani pfejmenovat.
VSechny styly kresby vSak Ize upravit podle pozadavki. Styly kresby Ize také skryt,
pokud nejsou vyZadovany, s vyjimkou styl( kresby, které byly pouZity v kresbé.

Kategorie stylU

» VSechny styly — zobrazi vSechny styly kresby, které jsou k dispozici pro pouZziti v aplikaci
Draw.

* Pouzité styly — zobrazi styly kreshy, které byly pouzity ve vybraném vykresu.

* Hierarchické styly — zobrazi styly kresby v hierarchickém seznamu (znamém také jako
propojené styly nebo styly rodic¢/dité). Chceme-li zobrazit styly v poddrovni, klikneme na
trojuhelnik » vedle nazvu stylu a zobrazi se seznam styl dostupnych v podurovni, jak je
znazornéno na obrazku 108.

* Vlastni styly — zobrazi vSechny uzivatelem vytvorené styly kresby, které jsou k dispozici
pro pouZziti v aplikaci Draw.

» Skryté styly — zobrazi vSechny styly kresby, které uzivatel skryl.

Poznamka

Hierarchické styly se pouzivaji u vice objektl, které se lisi napriklad barvou, ale jinak
jsou stejné formatované. Vytvorime nadfazeny styl pro objekty véetné okrajd, vypiné
oblasti, pisma atd. Pak vytvofime hierarchické nebo podfizené styly, které se lisi
pouze atributem barvy vypIné. Pokud je tfeba zménit velikost pisma nebo tloustku
ramecku, staCi zménit nadfazeny styl a podle toho se zméni vSechny podfizené
styly.

@ Tip
V dolni ¢asti karty Styly na postranni liSté se nachazi rozeviraci seznam umoZznujici

vybér kategorie stylu. K dispozici jsou tyto kategorie styl(i: Hierarchicky, VSechny
styly, Skryté styly, PouZité styly a Vlastni styly.
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| styly x
7 A A

= Obrazek

Cary
= Tvary
S obrysem

@ g & O [H]

= S vyplni

Cervend wplii

Modra vypli

Zelena vyplni
Zluta vypli

Text

Obrazek 108: Karta Styly v postranni listé

Vybér styll
Styly Ize vybrat a pouZit na objekty pouze pomoci nabidky Styly na postranni listé (obrazek 108).
1) Vybereme objekt pro aplikaci stylu.

@ Poznamka

PFi umisténi objektu do kresby se automaticky pouzije Vychozi styl kresby.

2) Pomoci jedné z nasledujicich metod otevieme kartu Styly na postranni listé:

— V hlavni nabidce zvolime Zobrazit > Postranni liSta a poté klikneme na Styly na
pravé strané postranni listy.

Klikneme na ikonu Zobrazit postranni lidtu Styly na nastrojové listé Cara a vypln.
V hlavni nabidce zvolime Zobrazit > Styly.

PouZijeme klavesovou zkratku F11.
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Text Animace textu Kétovani Spojnice Zarovnani Asijska typografie Tabulatory Zvyraznéni
Organizator Cara Oblast Stinovani Prihlednost Pismo Efekty pro pismo Odsazeni a rozestupy

Styl

Mazev: |Vychozi styl kresby

Rodicovsky:

E Upravit styl

Kategorie: |"Jlastr‘.t' styly b |

Obsahuje

Spojitd + 0,0 cm + 0,2 cm + 0,2 cm + Nevystiedéno + Newystfedéno + Spojita + Stin vypnuto + Barva stinovani + Odstup
stinu X 0,2 cm + Odstup stinu ¥ 0,2 cm + Vzdalenost ramce textu vievo 0,25 cm + Vzdalenost ramce textu vpravo 0,25 cm +
Vzdalenost ramce textu nahore 0,12 cm + Vzdalenost ramce textu dole 0,12 cm + Vodorovné ukotveni textu PouZit celou
3ifku + o + Odsazeni vleve 0,0 cm, Qdsazeni vpravo 0,0 cm + Shora 0,0 cm, Zdola 0,0 cm + Jednoduché + Automaticka +
Liberation Sans + 18 pt + norméalni + Bez podtrZeni + Bez preskrinuti + Bez kurzivy + Bez obrysu + Bez stinovani + Parowy
keming + Microsoft YaHei + Arial + 18 pt + 18 pt + normalni + normalni + Bez kurzivy + Bez kurzivy + Zadny + Bez reliéfu +
Bez nadirzeni + Zadn3

Obrazek 109: Dialogové okno Grafické styly — stranka Organizator

3) Vrozeviracim seznamu v dolni ¢asti nabidky Styly vybereme kategorii styl(.
4) Na karté Styly dvakrat klikneme na pozadovany styl pro vybrany objekt.

5) V pfipadé potfeby vytvofime novy (vlastni) styl nebo upravime vybrany styl podle
pozadavkd, jak je popsano nize.

@ Poznamka

Doporucujeme vytvaret nové (vlastni) styly, nikoli upravovat styly kresby
nainstalované v LibreOffice. Uprava styl( kresby nainstalovanych v LibreOffice miize
zpUsobit problémy, pokud byl styl pouZit v jinych vykresech.

Vytvareni novych nebo viastnich styll

Po vytvofeni nového nebo vlastniho stylu se tento styl umisti do kategorii VSechny styly
a Vlastni styly na karté Styly na postranni liSté. Pokud je vlastni styl pouZit na objekt, zobrazi se
také v Casti Pouzité styly.
PouZivani karty Styly
1) V postranni listé pfejdeme na kartu Styly.

2) Klikneme pravym tlaCitkem mysi na styl pozadovany jako vychozi bod pro vytvoreni
vlastniho stylu a vybérem moznosti Novy z kontextové nabidky otevieme dialogové okno
Grafické styly (obrazek 109).

3) Kliknutim na kartu Organizator otevieme stranku Organizator v dialogovém okné
Grafické styly.

4) Do textového pole Nazev zadame jedinecny nazev stylu.

5) Pokud ma novy styl zdédit nastaveni z existujiciho stylu, vybereme styl z rozeviraciho
seznamu Rodi¢ovsky.

6) K formatovani a kategorizaci nového stylu pouzijeme moznosti na rliznych strankach
dialogového okna Grafické styly.

— Organizator — obsahuje prehled stylu a jeho hierarchickou pozici.

— Pismo, Efekty pro pismo, Odsazeni a rozestupy, Zarovnani a Tabulatory —
nastavuje atributy textu vloZzeného do textového pole nebo grafického objektu.

— Kétovani — nastavuje styl kétovacich Car objektu.
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— Text, Animace textu, Spojnice, Cara, Oblast, Stinovani, Zvyraznéni
a Prahlednost — nastavuje atributy formatu objektu.

7) Po dokonceni klikneme na tlacitko OK, ¢imZ uloZime novy styl a zavieme dialogové okno
Grafické styly.
PouZiti nového stylu z vybéru

Pouziti Novy styl z vybéru umoZznuje nejprve provést veskeré formatovani objektu a poté z néj
vytvorit styl kresleni.

1) Vybereme objekt, ze kterého chceme vytvofit novy styl, nebo vytvofime novy objekt
v kresbé.

2) Formatujeme objekt pomoci nastrojii a moznosti z nasledujicich dialogovych oken
a panelll nastrojl:

— Dialogové okno Grafické styly.
— Dialogové okno Oblast.
— Dialogové okno Céra.
— Vlastnosti na postranni listé.
— Nastrojova lista Cara a vypln.
3) Pomoci jedné z néasledujicich metod vytvofime novy styl:

— Otevieme kartu Styly na postranni listé a klikneme na Novy styl z vybéru v pravém
hornim rohu karty.

— V hlavni nabidce zvolime Format > Styly > Novy styl z vybéru.

4) V otevieném dialogovém okné Vytvorit styl zadame jedinecny nazev nového stylu. Toto
dialogové okno také zobrazuje existujici vlastni styly.

5) Kliknutim na tlagitko OK uloZime novy styl a zavieme dialogové okno Vytvofit styl.

Uprava styl(
Doporuduje se upravovat pouze vytvorené styly. Uprava styl(i nainstalovanych v LibreOffice
mUze zpUsobit problémy v jinych dokumentech, které néktery z téchto styll pouZzivaji.
1) Vybereme objekt na vykrese.
2) Jednim z nasledujicich zplsob( otevieme dialogové okno Grafické styly:
— V hlavni nabidce zvolime Format > Styly > Upravit styl.

— Klikneme na objekt pravym tlacitkem mySi a z mistni nabidky vybereme moznost
Upravit styl.

— Klikneme pravym tlaCitkem mysi na styl objektu, ktery je zvyraznén v baliCku Styly na
postranni list€, a z mistni nabidky vybereme mozZnost Upravit.

3) K Uprave stylu objektu pouzijeme moznosti na strdnkach dialogového okna Grafické styly.
4) Klepnutim na OK ulozime zmény a zavieme dialogové okno Grafické styly.

Uprava hierarchickych nebo rodi¢ovskych stylii

Pokud objekt v kresbé pouziva styl, ktery je propojen s hierarchickym nebo rodi€ovskym stylem,
je mozné tento hierarchicky nebo rodi¢ovsky styl upravit.

1) Vybereme objekt ve vykresu, ktery pouziva propojeny styl.

2) Otevieme dialogové okno Grafické styly a kliknutim na Organizator otevieme stranku
Organizator.
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3) Zkontrolujeme, zda je nazev stylu v textovém poli Rodi¢ovsky hierarchickym nebo
rodiGovskym stylem pro Upravy, a pro Upravy stylu pouzijeme rlizné moznosti na
strankéch v dialogovém okné Grafické styly.

4) Pokud styl hierarchicky nebo rodi¢ovsky styl NENi pozadovany:

a) Klikneme na Upravit styl napravo od textového pole Rodicovsky, dokud se nezobrazi
nazev stylu.
b) K Upravé stylu pouzijeme réizné moznosti na strankach v dialogovém okné Grafické
styly.
5) Klepnutim na OK ulozime zmény a zavieme dialogové okno Grafické styly.

Poznamka

Doporucujeme vytvaret vlastni hierarchicke styly, nikoli upravovat stavajici
hierarchické styly dostupné v LibreOffice. Uprava hierarchickych stylt
nainstalovanych v LibreOffice m{ze zpUsobit problémy, pokud byl styl pouZit v jinych
kresbach.

Aktualizace stylU

Pouziti Aktualizovat styl umoZiuje nejprve provést veskeré formatovani objektu a poté
aktualizovat styl kresby pouzivany objektem.

1) Vybereme objekt a upravime styl kresby, ktery objekt pouziva.

2) Pomoci réznych nastrojll a moznosti formatujeme objekt z nasledujicich dialogovych
oken a nastrojovych list:

— Dialogové okno Grafické styly.
Dialogové okno Oblast.
— Dialogové okno Céra.
— Vlastnosti na postranni liste.
— Nastrojova lista Cara a vypln.
3) Pomoci jedné z nasledujicich metod aktualizujeme styl kresby. Pfi aktualizaci stylu kresby
se nevyzaduje zadné potvrzeni.

— Otevieme kartu Styly na postranni listé a klikneme na tlaCitko Aktualizovat styl
vpravo nahore.

— V hlavni nabidce zvolime Format > Styly > Aktualizovat vybrany styl.

Poznamka

Ujistime se, Ze aktualizujeme pouze vytvorené vlastni styly. Aktualizace styl(, které
jsou soucasti vychozi instalace LibreOffice, by mohla zplsobit problémy v jinych
dokumentech, které pouzivaji styly kresby LibreOffice.

Pouzivame styly
Styly kresby se na objekt aplikuji pomoci nabidky Styly na postranni liSté takto:

1) Vybereme objekt, na ktery chceme pouZit styl kresby.
2) Klikneme na Styly na nastrojové list& Cara a vyplii nebo na Styly na postranni list&.
3) Dvojklikem na nazev stylu pouzijeme styl kresby na vybrany objekt.

Styly kresby | 105



Odstranovani styl(

Pfeddefinované styly v LibreOffice nelze odstranit, i kdyZ se nepouZivaji. Odstranit Ize pouze
uZivatelsky definované (vlastni) styly. Pfed odstranénim vlastniho stylu v3ak doporu€ujeme
zkontrolovat, zda se styl kresby nepouziva, a to v seznamu styll kresby v kategorii PouZité styly.

1) Chceme-li oteviit seznam styl(, pouzijeme jednu z nasledujicich metod:
— Klikneme na Styly na nastrojové list& Céara a vypli.
— Klikneme na Styly na postranni listé.

2) V rozeviracim seznamu v dolni ¢asti karty Styly na postranni listé vybereme moznost
PouZité styly.

3) Klikneme pravym tlac¢itkem mySi na nazev stylu v seznamu styld a z mistni nabidky
vybereme moznost Smazat.

4) Pokud je styl pouZit na objektu, zobrazi se varovna zprava, Ze se vybrany objekt vrati
k vychozimu stylu kresby. Vyb&rem moznosti Ano potvrdime odstranéni stylu.

5) Pokud se styl nepouziva, vybérem moznosti Ano potvrdime odstranéni stylu a Zzadna
potvrzovaci zprava se nezobrazi.

Specialni efekty

Kromeé zakladnich akci, jako je pfesunuti objektu a zména jeho velikosti, Ize na objekty v aplikaci
Draw pouzit také fadu specialnich efektll. Nékteré z téchto efektll jsou snadno dostupné na
nastrojové listé Transformace. Pokud neni zobrazena néstrojova lista Transformace (obradzek
100 na strané 104), vybereme ji z nabidky Zobrazit > Nastrojova lista > Transformace.

Nastroje na nastrojové listé Transformace jsou popsany v nasledujicich kapitolach s vyjimkou
nastroje V 3D rotacnim objektu, ktery je popsan v kapitole 7, Prace s 3D objekty.

Otoceni objektl

Otéaceni objektu Ize provadét ru¢né nebo pomoci specialniho dialogového okna. Je to podobné
jako zména polohy nebo velikosti objektu.

Rucni otaceni
1) Vybereme objekt pro otaCeni tak, aby se zobrazily dchyty vybéru.

2) K prepnuti vybraného objektu do rezimu ota€eni pouZijeme jednu z nasledujicich metod.
V rezimu otaceni meéni Uchyty vybéru tvar a barvu (obrazek 110).

— Znovu klikneme na vybrany objekt.

— Klikneme na trojihelnik ¥ vpravo od tlagitka Transformace na nastrojové listé Cara
a vypln a z mistni nabidky vybereme Otogit.

— Pokud je zobrazena nastrojova lista Transformace, klikneme na Otocit.
3) Presuneme kurzor nad jeden z rohovych tchytd a kurzor zméni tvar.
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Obrazek 110: Ruc¢ni otaceni objekti

4) Klikneme na objekt a pretahneme jej ve sméru otaceni. Objekt miZzeme otacet pouze
rohovymi achytkami.

5) Chceme-li omezit Ghly otageni na nasobky 15 stupndl, stiskneme a podrZzime pfi otaceni
objektu klavesu Shift. To je velmi uzite¢né pro otaceni objektl o 90 stupiil, napriklad
z polohy na vysku do polohy na Sifku.

6) Jsme-li s Upravou spokojeni, uvolnime tlacitko mysi.

7) Ve vychozim nastaveni je oto€ny bod otaceni malym kruhem ve stfedu vybraného
objektu. Chceme-Ili zménit stfed otaceni objektu, klikneme na oto¢ny bod a pfetdhneme
jej do nové polohy. Tato poloha otoéného bodu mdze byt mimo vybrany objekt.

Otoc¢eni v postranni listé
1) Vybereme objekt pro otaceni tak, aby se zobrazily Gchyty vybéru.
2) Otevieme sekci Umisténi a velikost v nabidce Vlastnosti na postranni listé (obrazek
111).

3) Objekt otoCime pomoci jedné z nasledujicich moznosti:
— Klikneme na ukazatel Otoceni a pfetdhneme jej.
— Do textového pole Otoc¢eni zadame Uhel natoceni.

4) Pokud jsme spokojeni, kliknutim mimo objekt zruSime jeho vybér a zruSime rezim
otaceni.
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Obrazek 111: Sekce Umisténi a velikost v nabidce
Vlastnosti na postranni listé
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Umisténi a velikost Otogeni Naklonéni a polomér rohu

Stied otodeni

Pozice X: 420 cm

PoziceY: 7,20 cm =

L

o S—
50
5>—o0—o

Uhel otoéeni
. ~ |
Uhel: 0,00° 2 N
- —
7 Pt Y
Vychozi nastaveni:
MNapovéda Obnovit OK Lrusit

Obrazek 112: Dialogové okno Umisténi a velikost — stranka
Otoceni

Dialogové okno Umisténi a velikost
1) Vybereme objekt pro otaeni tak, aby se zobrazily achyty vybéru.
2) Dialogové okno Umisténi a velikost (obrazek 112) otevieme jednim z nasledujicich
zpUsobU:
— Stiskneme klavesu F4.
— V hlavni nabidce vybereme moZnost Format > Umisténi a velikost.

— Klepneme pravym tlacitkem na objekt a z mistni nabidky vybereme Umisténi
a velikost.

3) Kliknutim na Oto€eni otevieme stranku Otoc€eni.
4) Objekt oto€ime pomoci jedné z nasledujicich metod:
— Do textového pole Uhel zadame poZzadované stupné oto&eni.
— Klikneme na indikator ota€eni v poli Viychozi nastaveni a posuneme jej.
5) Kliknutim na OK ulozime zmény a zavieme dialogové okno Umisténi a velikost.

Preklapéni objektl

Rychlé preklopeni
1) Vybereme objekt k pfeklopeni tak, aby se zobrazily dachyty vybéru.
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2) K preklopeni objektu na vySku nebo na Sifku pouZijeme jednu z nésledujicich metod:

— Klikneme na objekt pravym tlaCitkem mySi a z mistni nabidky vybereme moZznost
Preklopit > Vodorovné nebo Preklopit > Svisle.

— V Casti Umisténi a velikost karty Vlastnosti na postranni listé klikneme na Preklopit
svisle nebo Preklopit vodorovné.

— Na nastrojové listé Cara a vypli klikneme na polozku Svisle nebo Vodorovné.
— V hlavni nabidce zvolime Tvar > Pfeklopit > Svisle nebo Vodorovné.

Nastroj preklopeni

Pomoci nastroje Preklopit na nastrojové listé Transformace Ize zmeénit polohu a thel pod kterym
se objekt pfevrati, coZ je zndzornéno na obrazku 113.

1) Vybereme objekt k preklopeni tak, aby se zobrazily uchyty vybéru.

2) Klikneme na nastroj Preklopit na nastrojové listé Transformace a uprostfed objektu se
zobrazi osa symetrie jako pferuSovana Cara. Objekt se otocCi kolem této osy symetrie.

3) Kliknutim a pretazenim jednoho nebo obou konct osy symetrie nastavime orientaci osy.
4) Umistime kurzor nad jeden z Uchytl pro vybér objektu, dokud se nezméni jeho tvar.

5) Klikneme na objekt a pretahneme jej na druhou stranu osy symetrie, dokud se objekt
neobjevi pfevraceny. Uhel a poloha prevraceni zavisi na Uhlu a poloze osy symetrie.

6) Uvolnime tlacitko mySi a objekt se otodi.
{_/ Poznamka

Stisknutim a podrzenim klavesy Shift pfi pohybu osou symetrie Ize otacet po 45

stupnich.
¢
. @
Vybran Posunuta
nastroj ogq :
Prekiopit soumeérnosti
@
& ' ¢
Vysledek
preklopeni
a O O

m]

O a (]
Obrazek 113: Priklad pouZiti nastroje Preklopit
Zrcadlové kopie

V soucasnosti neni v programu Draw k dispozici pfikaz pro zrcadleni. Zrcadleni objektu vSak lze
napodobit zkopirovanim a prevracenim objektu nasledujicim zptsobem:
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1) Vybereme objekt, jehoz zrcadlovou kopii chceme vytvorit, a zkopirujeme jej do schranky.
2) Obijekt preklopime pomoci postupll uvedenych vyse v ¢asti ,Preklapéni objektl“.
3) Kliknutim do prazdné oblasti na vykrese zruSime vybér objektu.

4) Vlozime kopii pdivodniho objektu zpét do jeho plvodniho umisténi, ¢imz vytvofime
zrcadlovou kopii.

5) V pfipadé potfeby vybereme oba objekty a zarovname je pomoci jedné z nasledujicich
metod:

— V hlavni nabidce zvolime Tvar > Zarovnani objektl a pouzijeme jednu z moznosti
zarovnani.

— Klikneme pravym tlaCitkem mySi na vybrané objekty a v mistni nabidce vybereme
moznost Zarovnani objektl a poté jednu z moznosti zarovnani.

Deformace obrazku

TTi nastroje na panelu nastroji Transformace umoZniuji tazenim za rohy a hrany objektu
deformovat obrazek.

Pfred deformaci objektu je tfeba objekt prevést na krivku. Kliknutim a pfetazenim jednoho
z Uchytd objektu dosdhneme poZadovaného efektu. Priklady deformaci jsou uvedeny na
nasledujicich obrazcich.

O Poznamka

Transformace objektu na kfivku je bezpecna operace, kterou vSak nelze vratit zpét
jinak nez kliknutim na Upravy > Vratit zpét v hlavni nabidce.

Umisténi na kruZnici (perspektivné)

Vybereme objekt a klikneme na Umistit na kruznici (perspektivné) na nastrojové listé
Transformace. Po prevodu na kfivku klikneme a pretahneme jeden z Uchyt vybéru (obrazek
114).

u Ll
i ' 3 : i
L L ]

Obrézek 114: Priklad pouZiti nastroje Umistit na
kruZnici (perspektivné)

Umistit na kruZnici (zkosit)

Vybereme objekt a na nastrojové listé Transformace klikneme na Umistit na kruznici (zkosit).
Po prevodu na kfivku klikneme a pretahneme jeden z tchytll vybéru (obrazek 115).
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o o
Obrazek 115: Priklad pouZiti nastroje Umistit
na kruZnici (zkosit)

[m}

Obrazek 116: Priklad deformace pomoci uchytu
pro vybér rohu

a [m}

Obrazek 117: Priklad deformace pomoci
vertikalniho uchytu

ol

Obrazek 118: Priklad zkresleni pomoci horizontalniho dchytu
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Deformace

Vybereme objekt a na nastrojové listé Transformace klikneme na Deformovat. Po pfevedeni na
kfivku klikneme na uchyt vybéru a pfetdhneme jej, abychom objekt roztahli. Rohové Uchyty
deformuiji rohy objektu (obrazek 116), svislé tuchyty deformuji objekt vodorovné (obrazek 117)

a vodorovné uchyty deformuji objekt svisle (obrazek 118).

Dynamické prechody

Pfechody prihlednosti se ovladaji stejnym zplsobem jako barevné pfechody a oba typy
prechodd Ize pouzivat spole¢né. V priihledném pfechodu se v jeho sméru méni mira
prihlednosti barvy vyplné objektu, a to od neprihledné po priihlednou. V barevném prechodu se
méni vyplii z jedné barvy na jinou, ale mira prdihlednosti zlistava stejna.

Obrazek 119: Priklad dynamického pfechodu

Dvé ikony na nastrojové listé Transformace dynamicky ovladaji prihlednost a barevné prechody.
| kdyZ objektu s barevnou vyplni neni pfifazena priihlednost, Ize ji ovladat kliknutim na

Interaktivni nastroj priihlednosti. Tim se definuje pfechod prihlednosti a na objektu se objevi
prerusovana ¢ara spojujici dva ¢tverce. Pfesunutim dvou ¢tvercli upravime pfechod. Definujeme
smeér prechodu (svisly, vodorovny nebo pod libovolnym (ihlem) a misto, kde prihlednost zac¢ina.

Stejnym zplsobem je definovan i pravidelny barevny prechod. Vybereme objekt a poté vybereme
prechodovou vypln oblasti (dalsi informace nalezneme v ¢asti ,Vypli pfechod” na strané 101).
Na néastrojova listé Transformace je nyni aktivni nastroj Interaktivni nastroj prechodu. Po
kliknuti na Interaktivni nastroj pfechodu se na objektu objevi pferuSovana cara spojujici dva
Ctverce, stejné jako v pfipadé prfechodu prihlednosti.

V pripadé prechodu prihlednosti i vyplné pfechodem nastavime prechod kliknutim mimo objekt.

V prikladu na obrazku 119 je jeden barevny objekt a pfechod priihlednosti, ktery pokryva ¢ast
podkladového objektu. Tuto priihlednost pfechodem Ize dynamicky upravovat. Smér prihlednosti
se méni posunutim bilého ¢tverecku a vzdalenost, na kterou se aplikuje, posunutim zeleného
CtverecCku.

Poznamka

Presouvani ¢tverct ma rlizné Gc¢inky v zavislosti na typu pfechodu. Napfiklad
u linearniho pfechodu budou poc¢éatecni a koncové Etverce prechodu vzdy umistény
na obé strany od stfedu objektu.
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Seskupovani objektt

Seskupeni objektl si Ize predstavit jako vioZeni objektli do krabice. Objekty Ize pfesouvat jako
skupinu a globalni zmény Ize aplikovat na objekty ve skupiné. VZdy Ize skupinu zrusit a s objekty,
které ji tvorily, opét pracovat samostatné.

Docasné seskupeni

Docasné seskupeni je takové, kdy je vybrano nékolik objektd. Veskeré zmény parametr(l objektu
se pouziji na vSechny objekty v ramci docasné skupiny. Napfiklad do¢asnou skupinu objektl Ize
celou otoCit.

Doc€asnou skupinu vytvofime jednou z nasledujicich metod:

« Klikneme a pfetahneme kurzor nad nékolik objektd, zobrazi se vybérovy obdélnik (tento
vybérovy obdélnik se také nazyva ramecek). Jakmile jsou vybrany vSechny objekty
poZadované pro docasnou skupinu, uvolnime tla¢itko mysi.

» Klikneme na prvni objekt, pak podrzime klavesu Shift a klikneme na zbyvajici objekty
doCasné skupiny.

Chceme-li zrusit doGasnou skupinu objektd, staci kliknout mimo Gchyty vybéru zobrazené kolem
objektd.

Seskupeni

Pokud jsou objekty seskupeny, vSechny operace Uprav provedené ve skupiné se pouziji na
vSechny objekty ve skupiné. Kliknutim na jeden objekt ve skupiné se vybere cela skupina.

Objekty ve skupiné si zachovavaji své individualni vlastnosti a Ize je upravovat nezavisle. Dalsi
informace nalezneme v ¢asti ,Uprava jednotlivych objektl skupiny* na strance 133.

6) Pomoci jedné z nasledujicich metod vybereme objekty pro skupinu. Kolem vSech objekt(
vybranych pro skupinu se zobrazi uchyty vybéru (obrazek 120).

— Klikneme postupné na kazdy objekt a drzime pfitom stisknutou klavesu Shift.

— Ujistime se, Ze je na panelu nastroji Kresba vybrana moznost Vybrat, a nakreslime
pomoci kurzoru obdélnik vybéru kolem objektd pozadovanych pro skupinu.

7) Pomoci jedné z nasledujicich metod vytvofime skupinu vybranych objekt(:

— Klikneme na skupinu pravym tlacitkem mysi a z mistni nabidky vybereme moznost
Skupina.

— V hlavni nabidce zvolime Tvar > Seskupit > Seskupit.

— Pouzijeme klavesovou zkratku Ctrl + Shift + G.

Obréazek 120: Seskupovani objekt(
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ZruSeni seskupeni
1) Vybereme skupinu objektl a kolem objektll ve skupiné se objevi Gchyty pro vybér
(obrazek 120).
2) Seskupeni skupiny objektl zrusime pomoci jedné z nasledujicich metod:

— Pravym tlacitkem mysSi klikneme do skupiny a z kontextové nabidky vybereme Zrusit
skupinu.

— V hlavni nabidce zvolime Tvar > Seskupit > Zrusit skupinu.
— PouZijeme klavesovou zkratku Ctrl + Alt + Shift + G.

Uprava jednotlivych objektti skupiny
Objekt ve skupiné Ize upravovat samostatné, aniZ by bylo nutné objekty rozdélit.

1) Vybereme skupinu a jednim z nasledujicich zplsobd ji mdZeme upravit. Po vstupu do
skupiny nelze objekty mimo skupinu vybrat k Gpravam.

— Klepneme na skupinu pravym tlacitkem mysi a z mistni nabidky vybereme moznost
Upravit skupinu.

— V hlavni nabidce zvolime Tvar > Seskupit > Upravit skupinu.
— PouZijeme klavesovou zkratku F3.
— Poklepeme na vybranou skupinu.

2) Jakmile se ocitneme uvnitf skupiny, kliknutim na libovolny objekt jej vybereme
a samostatné upravime (obrazek 121).

3) Po provedeni zmén v jednotlivém objektu ukoncime jednou z nésledujicich metod Gpravu
skupiny:

— Klikneme na skupinu pravym tlacitkem mysi a z mistni nabidky vybereme moZznost
Opustit skupinu.

— V hlavni nabidce zvolime Tvar > Skupina > Ukon¢it skupinu.
— Pouzijeme kldvesovou kombinaci Ctrl + F3.
— Dvakrét klikneme mimo skupinu.

Obrézek 121: Uprava objekti v ramci skupiny
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Vnofené skupiny

Lze vytvofit skupinu skupin, ktera se béZzné oznacuje jako vnofend skupina. P¥i vytvareni
vnofenych skupin zachovava Draw hierarchii jednotlivych skupin a pamatuje si pofadi, v jakém
byly skupiny vybrany. To znamena, Ze posledni vybrana jednotliva skupina bude nad vSemi
ostatnimi skupinami v ramci vnofené skupiny. Rozdéleni do skupin a vstup do vnorené skupiny
funguje UplIné stejné jako u jednotlivych skupin.

Skladani objektt

SlozZeni objektll znamena jejich trvalé slouceni, pfi némz se vytvori novy objekt. Pivodni objekty
jiz nejsou k dispozici jako jednotlivé objekty a nelze je upravovat jako jednotlivé objekty. Jakakoliv
Uprava sloZzeného objektu ovlivni vSechny objekty, které byly ve skupiné pouzity.

Kombinace

1) Vybereme nékolik objektd, které chceme slozit.
2) Vybrané objekty slozime do jednoho objektu pomoci jedné z nasledujicich metod:

— Klikneme na vybér pravym tlacitkem mySi a z mistni nabidky vybereme mozZnost
Tvary > Slozit.

— V hlavni nabidce zvolime Tvar > Slozit.
— Pouzijeme kombinaci klaves Ctrl + Shift + K.
Na prvni pohled se vysledky mohou zdat ponékud pFekvapivé, ale nasledujici body vysvétluji, jak
kombinovani objektl funguje.
» Atributy (napfiklad vypln plochy) vysledného objektu jsou atributy objektu, ktery je nejvice
vzadu. Na obrazku 122 je to elipsa a na obrazku 123 je to zZluty obdélnik.

» Pokud se objekty prekryvaji, je prekryvajici se oblast bud vyplnéna, nebo prazdnéa podle
toho, zda je prekryti sudé, nebo liché. Obrazek 123 ukazuje, Ze tam, kde je Cislo prekryti
sudé, vznikne prazdné misto a tam, kde je Cislo pFekryti liché, vznikne vyplnéna oblast.

Grouped Combined
Obrazek 122: Kombinovani objektt

@ Tip
Objekty Ize preskladat tak, aby byly v pofadi usporadani dale vzadu nebo dale
vpfedu. Klikneme na objekt pravym tlaCitkem mySi a z mistni nabidky vybereme
moznost Usporadat a vybereme jednu z dostupnych moZnosti. DalSi informace

O it

nalezneme v ¢asti ,Usporadani objektl” na strance 141.
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Prekryvajici se objekty pred slozenim Slozené prekryvajici se objekty
Obrazek 123: Priklad vypInéni plochy pfi kombinovani piekryvajicich se objekti

Rozdéleni kombinovanych objektl

Obijekt, ktery byl spojen z nékolika objektd, Ize rozdélit na jednotlivé objekty. Plvodni objekty si
vSak zachovaji formatovani kombinovaného objektu a nevrati se ke svému plvodnimu
formatovani.

Vybereme kombinovany objekt a pouzijeme jednu z nasledujicich metod pro rozdéleni
kombinovaného objektu:

* V hlavni nabidce zvolime Tvar > Rozpojit.

* Pouzijeme kldvesovou zkratku Ctrl + Alt + Shift + K.
Na obrazku 124 je leva grafika s plivodnim pfikladem pfekryvajicich se vypini oblasti pred

spojenim. Prava grafika je vysledkem rozdéleni kombinovaného objektu. Jednotlivé prekryvajici
se objekty pfevzaly formatovani objektu v zadni Easti prekryvajicich se objektd.

Prekryvajici se objekty pfed sloZzenim Vysledek rozdéleni slozenych
prekryvajicich se objektl

Obrazek 124: Priklad rozdéleni kombinovaného objektu

Rozpojeni kombinovanych objekt(

Pokud je objekt spojen z nékolika objektd, Ize spojeny objekt rozdélit na jednotlivé ¢asti pomoci
pfikazu Tvar > Rozpojit v hlavni nabidce. To znamen4, Ze plvodni objekty jsou rozdéleny na
jednotlivé ¢asti; napfiklad obdélnik je rozdélen na Ctyfi samostatné Cary a plocha se ztrati, jak
ukazuje pravy graf na obrazku 125.
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SloZené objekty Rozpojené sloZené objekty
Obrazek 125: Priklad rozpojeni kombinovaného objektu
Spojovaci ¢ary
Césti objektu Ize spoijit tak, Ze vybereme viechny &asti objektu a v hlavni nabidce zvolime Tvar >

Spojit. Tim se Casti spoji dohromady a objekt se uzavie, ¢imZ se oblast vyplni vyplni, kterou
méla pfed rozpojenim objektu.

Slucéovani, odecitani nebo priinik objekti

Po vybéru vice nez jednoho objektu se zpfistupni funkce slouceni, odeéteni a prinik. To
umoZznuje vytvofit novy objekt s novym tvarem.
Slouéeni

Pri sluGovani objektll se vytvori novy objekt, jehoz tvar kopiruje tvar slu¢ovanych objekt(. Vypli
plochy slou¢eného objektu je urena vyplni plochy objektu, ktery je v zadni ¢asti vSech ostatnich
objektd, jak je znazornéno na obrazku 126.

Po vybéru nékolika objektd pouzijeme ke slouceni objektll jednu z nasledujicich metod:

* V hlavni nabidce zvolime Tvar > Sloucit.

» Klikneme pravym tlacitkem my3i na vybrané objekty a z mistni nabidky vybereme
moznost Tvary > Sloudit.

Obrazek 126: Sluc¢ovani objektt
Odcitani
Pri odecitani objektl se objekty vpredu odeditaji od objektu vzadu. Zlistane tak prazdné misto po

odecitanych objektech a vytvofi se novy tvar, jak ukazuje obrazek 127. Po vybéru nékolika
objektd, které se vzajemné prekryvaji, pouzijeme k odeéteni objektl jednu z nasledujicich metod:

* V hlavni nabidce zvolime Tvar > Odecist.

* Klikneme pravym tlacitkem mySi na vybrané objekty a z mistni nabidky vybereme
moznost Tvary > Odecist.
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Obréazek 127: Odecitani objektt
Prinik
Pfi priiniku objektd se odstrani predni objekty a odkryta oblast objektu vzadu. Tim se vytvori

novy objekt z oblasti objektu v zadni ¢asti, ktera byla zakryta objekty v pfedni ¢asti, jak ukazuje
obrazek 128.

Po vybéru nékolika objektl, které se vzajemné prekryvaji, pouzijeme k jejich priniku jednu
z nasledujicich metod:

* V hlavni nabidce zvolime Tvar > Prtinik.
+ Klikneme pravym tlacitkem mySi na vybrané objekty a z mistni nabidky vybereme Tvary

> Prunik.

Obréazek 128: Prinik objekt(

Prakticky pfFiklad

Nasledujici pfiklad ukazuje, jak pomoci funkci slougit, odecist a prlinik vytvorit niiz s dievénou
rukojeti.

Nakreslime elipsu a poté obdélnik prekryvajici
polovinu jeji Sitky.

Vybereme oba tvary, klikneme pravym
tlacitkem mySi a z mistni nabidky vybereme
pfikaz Tvary > Odedcist.

Nakreslime dalsi obdélnik a umistime ho
k horni poloviné elipsy.
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Vybereme oba tvary, klikneme pravym
tlacitkem mySi a z mistni nabidky vybereme
pfikaz Tvary > Odedist.

Nakreslime malou elipsu pokryvajici pouze 7
pravy dolni roh. v

Vybereme oba tvary, klikneme pravym
tlaCitkem mysSi a z mistni nabidky vybereme
pfikaz Tvary > Odedist. Tvar Cepele noze je
nyni dokoncen.

Chceme-li vytvofit rukojet, nakreslime obdélnik
a elipsu.

Spojime tvary dohromady.

Umistime rukojet na Cepel. Vybereme rukojet
a Cepel a poté je seskupime, abychom vytvorili

1k

kresbu noze.

Duplikace a prechod tvart

Duplikovani

Duplikace vytvafri kopie objektu a na duplikaty aplikuje sadu zmén (napfiklad barvu nebo
otoceni).

1)

2)
3)

4)

5)

Vybereme objekt nebo skupinu objektd a pomoci jedné z nasledujicich metod otevieme
dialogové okno Duplikovat (obrazek 129):

— V hlavni nabidce zvolime Upravy > Duplikovat.

— V hlavni nabidce zvolime Tvar > Duplikovat.

— Pouzijeme klavesovou zkratku Shift + F3.

Vybereme pocet kopii, umisténi, zvétSeni a po€atecni a koncovou barvu pro duplikaty.

Klikneme na tlaCitko OK a vytvofi se duplicitni kopie. Pfiklad duplikace je uveden na
obrazku 130. Kazdy duplicitni objekt je samostatny objekt.

Chceme-li duplicitni objekty seskupit do jedné skupiny, viz ,Formatovani Car" na strané
85.

Chceme-li spojit duplicitni objekty do jednoho objektu, viz ,Skladani objektl“ na strané
134.

PTi pouziti dialogového okna Duplikovat jsou k dispozici nasledujici moznosti:

Pocet kopii — zadame pocet poZadovanych kopii.

Umisténi — nastavi polohu a nato¢eni duplikovanych objektl vzhledem k pdvodnimu
objektu.

— Osa X — zaddme vodorovnou vzdalenost mezi stfedy vybraného objektu
a duplikovanych objektl. Kladné hodnoty posunou duplikovany objekt doprava
a zaporné hodnoty posunou duplikovany objekt doleva.

— Osa Y — zadame svislou vzdalenost mezi stfedy vybraného objektu a duplikovanych
objektd. Kladné hodnoty posouvaji duplikovany objekt smérem doll a zaporné
hodnoty smérem nahoru.
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— Uhel — zadame Ghel (0 aZ 359 stupiid) potfebny pro otoceni duplikovaného objektu.
Kladné hodnoty otaceji duplikované objekty ve sméru hodinovych rucic¢ek a zaporné
hodnoty proti sméru hodinovych rucicek.

Pocet kopif: |10 | @
Umisténi
Osa X: 0,50 cm =
Osa Y: 0,50 cm =
Uhel: 10,00° =
Zvétieni
Sitka: 0,00 cm E
Vyika: 0,00 cm =
Barvy
Zacatek | Cervena v
Konec: - Zelena v
Napovéda Vyichozi oK Zrusit

Obréazek 129: Dialogové okno Duplikovat

Obrazek 130: Priklad duplikace

« ZvétSeni — nastavi velikost duplikovanych objektd.
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— Sitka — zadame hodnotu, o kterou se zvé&tsi nebo zmensi Sitka duplikovanych objektd.
— Vyska — zadame hodnotu pro zvétSeni nebo zmenseni vysky duplikovanych objektd.

* Barvy — nastavi barvy pro vybrany objekt a duplicitni objekty. U vice nezZ jedné kopie tyto
barvy definuji pocate€ni a koncovy bod barevného pfechodu.

— Zacatek — vybereme barvu pro vybrany objekt.

— Konec — vybereme barvu pro duplikovany objekt. Pokud vytvafime vice nez jednu

kopii, pouZije se tato barva na posledni kopii.

Pfechod tvaru

Prechod tvarll transformuije jeden tvar objektu na jiny tvar. Vysledkem je nova skupina
jednotlivych objektl, kterd obsahuje pocatecni a koncové objekty. Mezikroky ukazuji transformaci
z jednoho tvaru objektu na jiny tvar objektu. Pfechod tvarl se provadi od prvniho vybraného

objektu k druhému vybranému objektu.

1) Vybereme dva objekty a v hlavni nabidce zvolime Tvar > Pfechod tvar(, ¢imz otevieme

dialogové okno Prechod tvarli (obrazek 131).
2) Vybereme pocet prirlstkl pro transformaci.

3) V pfipadé potfeby vybereme Atributy pfechodu tvard a Stejny smér.

4) Kliknutim na tlacitko OK vybrané objekty prolneme a zavieme dialogové okno Pfechod
tvard. Na obrazku 132 je zobrazen pfiklad pfechodu tvarli se zruSenym vybérem Stejny

smér. Vytvoreny objekt je skupina objektd.

5) Chceme-li tuto skupinu objektd zrusit a pouzivat jednotlivé objekty, viz ,Zruseni

seskupeni“ na strané 133.

MNastaveni
Prirtistky:

Stejny smér

Napovéda

16

-

-

Atributy pfechodu tvard

OK

Zrusit

Obréazek 131: Dialogové okno Prechod

tvart

Obrazek 132: Priklad prechodu
tvart

V dialogovém okné Prechod tvar( jsou k dispozici nasledujici moznosti:
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Prirtistky — zadame pocet krokd, které se maji vytvofit mezi vybranymi objekty.

Atributy pfechodu tvarl — aplikuje pfechod tvar(i na vlastnosti ¢ar a vyplni vybranych
objektd. Pokud jsou napfiklad vybrané objekty vyplnény rliznymi barvami, pouzije se
barevny pfechod mezi obéma barvami.

Stejny smér — pouzije plynuly pfechod mezi vybranymi objekty.

Umist'ovani objektl

Usporadani objektu
Pfi kombinovani, slu¢ovani, odecitani nebo prliniku objektd se kone¢ny vysledek lisi podle toho,
ktery objekt je vpfedu a ktery vzadu. Kazdy novy objekt umistény na vykres se automaticky stane

prednim objektem a vSechny ostatni objekty se posunou v poradi umisténi dozadu. Usporadani
objektll méni pofadi ve skupiné& objektd.

Chceme-li zménit umisténi objektu, vybereme jeden nebo vice objektli a pouzijeme jednu
z nasledujicich metod.

Klikneme pravym tlacitkem mySi na vybrané objekty a z mistni nabidky vybereme
moznost Uspofadat a jednu z dostupnych moznosti.

Kliknutim na maly trojuhelnik v vpravo od tlacitka Usporadat na Standardni nastrojové
listé se otevie panel nastroji Umisténi (obrazek 133).

Klikneme na jeden z nastrojl pro uspofadani na nastrojové listé Cara a vypli.
Klikneme v hlavni nabidce na Tvar > Usporadat a vybereme moznost usporadani.

Pouzijeme nastroje Usporadani v ¢asti Umisténi a velikost na karté Vlastnosti na
postranni listé.

Pouzijeme nize uvedenou klavesovou zkratku.

Umisténi w X

=] | =
i e R B I i~

Obréazek 133: Nastrojova lista
Umisténi

K dispozici jsou nasledujici moznosti usporadani:

Pfenést do popfiedi (Shift + Ctrl + +) — pfesune vybrany objekt na popredi skupiny
objektd.

Pfenést bliz (Ctrl + +) — pfesune vybrany objekt o jeden krok dopFedu.
Odsunout dal (Ctrl + —) — odsune vybrany objekt o krok zpét.

Odsunout do pozadi (Shift + Ctrl + —) — odsune vybrany objekt do pozadi skupiny
objektd.

Pfed objekt — pfesune vybrany objekt pfed jiny vybrany objekt.
Za objekt — pfesune vybrany objekt za jiny vybrany objekt.

Prohodit — zméni poradi vybranych objektd. Tento nastroj je zasedly, pokud je vybran
pouze jeden objekt.

Poznamka

Nastroje pro usporadani Ize zménit na plovouci nastrojové listé kliknutim na horni

Céast vyskakovaciho okna na nastrojové listé Standardni a pfetazenim na novou

pozici na vykrese, jak ukazuje obrazek 133.

124 | Pfirucka Draw 7.1



Zarovnani objekti

Aby kresba vypadala profesionalnéji, Ize objekty vzajemné zarovnat. Vybereme jeden nebo vice
objektll a pouZijeme jednu z nasledujicich metod zarovnani objekt:

» Klikneme pravym tlacitkem mySi na vybrané objekty a z mistni nabidky vybereme
Zarovnani objektl a jednu z dostupnych moZnosti.

*  Kliknutim na maly trojihelnik ¥ napravo od Zarovnat na nastrojove listé Standardni
nebo Cara a vyplii otevieme panel nastroju.

« V hlavni nabidce zvolime Tvar > Zarovnani objektl a vybereme poZzadované zarovnani.

* Pouzijeme nastroje Zarovnani v ¢asti Umisténi a velikost na karté Vlastnosti na
postranni li5té.

K dispozici jsou nasledujici nastroje pro zarovnani:
« Vlevo — zarovna levé okraje vybranych objektl. Pokud je vybran pouze jeden objekt, je
levy okraj objektu zarovnan k levému okraji stranky.
* Na stfed — horizontalné vystfedi vybrané objekty. Pokud je vybran pouze jeden objekt, je
jeho stfed zarovnan na vodorovny stfed stranky.

e Vpravo - zarovna pravé okraje vybranych objekt(l. Pokud je vybran pouze jeden objekt,
zarovna se pravy okraj objektu k pravému okraji stranky.

« Nahoru - vertikalné zarovna horni okraje vybranych objektd. Pokud je vybran pouze
jeden objekt, zarovna se horni okraj objektu k hornimu okraji stranky.

» Stied — vertikalné vystfedi vybrané objekty. Pokud je vybran pouze jeden objekt, zarovna
se jeho stfed na svisly stfed stranky.

« Dold - vertikalné zarovna spodni okraje vybranych objektl. Pokud je vybran pouze jeden
objekt, zarovna se spodni okraj objektu ke spodnimu okraji stranky.

Zarovnat objekty w X
5 & = 0 s ol

Obrazek 134: Nastrojova
lista Zarovnani objekti

Poznamka

Nastroje pro zarovnani Ize zménit na plovouci panel nastrojd kliknutim na horni ¢ast
vyskakovaciho panelu nastrojl a jeho pretazenim na nové misto na pracovni plose
vykresu, jak je znazornéno na obrazku 134.

Rozmisténi objektu

RozloZeni objektd umoZiiuje rovnomérné rozmisténi tfi nebo vice objektd podél vodorovné nebo
svislé osy. Objekty jsou rozmistény pomoci nejvzdalenéjsich objektd ve vybéru jako zakladnich
bodU pro rozestupy.

Rozmistit vybé&r w X

bb 60 oh dd = = & oF

Obréazek 135: Nastrojova lista
Rozmistit vybér

Vybereme alespori tfi objekty a poté je rozmistime pomoci jedné z nésledujicich metod:
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* Klikneme pravym tlacitkem mySi na vybrané objekty a z mistni nabidky vybereme
moznost Rozmistit vybér a jednu z dostupnych moznosti.

» Kliknutim na maly trojuhelnik ¥ napravo od tlacitka Rozmistit vybér na Standardni
nastrojové listé se otevie panel nastrojl.

* V hlavni nabidce zvolime Tvar > Rozmistit vybér a vybereme moznost rozmisténi.

» Klikneme pravym tlaCitkem mysi na vybrané objekty a z mistni nabidky vybereme
moznost Rozmistit vybér a poté vybereme moznost rozdéleni.

K dispozici jsou nasledujici moznosti rozmisténi:
« Vodorovné vlevo — rozdéli vybrané objekty tak, aby levé okraje objektl byly od sebe
rovnomeérné vzdaleny.

* Vodorovné na stied — rozdéli vybrané objekty tak, aby jejich vodorovné stfedy byly od
sebe rovnomeérné vzdaleny.

* Vodorovné mezery — rozdéli vybrané objekty vodorovné tak, aby byly objekty od sebe
rovnomeérné vzdaleny.

« Vodorovné vpravo — rozdéli vybrané objekty tak, aby pravé okraje objektll byly od sebe
rovnomerné vzdaleny.

» Svisle nahoru — rozdéli vybrané objekty tak, aby jejich horni okraje byly od sebe
rovnomeérné vzdaleny.

e Svisle na stifed — rozdéli vybrané objekty tak, aby svislé stfedy objektll byly od sebe
rovnomeérné vzdaleny.

* Svisle mezery — rozdéli vybrané objekty vertikalné tak, aby byly objekty od sebe
rovnomeérneé vzdaleny.

« Svisle dold — rozdéli vybrané objekty tak, aby byly jejich spodni okraje od sebe
rovhomeérne vzdaleny.

Poznamka

Z distribu¢nich nastrojd Ize vytvorit plovouci panel nastrojl kliknutim na horni ¢ast
vyskakovaciho panelu nastrojd a jeho pfetazenim na nové misto na pracovni plose
vykresu, jak je zndzornéno na obrazku 135.
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Uvod

Predchozi kapitoly této priru¢ky Draw se zabyvaly pouze vektorovou grafikou. Nejastéji
pouzivané typy vektorové grafiky jsou nasledujici:

e SVG (Scalable Vector Graphics) — format vektorovych obrazk( zalozeny na rozsifitelném
znacCkovacim jazyce (XML) pro dvourozmérnou grafiku s podporou interaktivity
a animace.

* EPS (Encapsulated PostScript) — format dokumentu PostScript pouzitelny jako format
grafického souboru. Soubory EPS jsou viceméné samostatné, pfiméfené predvidatelné
postscriptové dokumenty, které popisuji obrazek nebo kresbu a mohou byt umistény
Vv jiném postscriptovém dokumentu.

« Al (Adobe lllustrator) — proprietarni format soubord vyvinuty spolecnosti Adobe Systems
pro reprezentaci jednostrankovych vektorovych kreseb ve formatu EPS nebo PDF.

Draw obsahuje také fadu funkci pro praci s rastrovou grafikou (bitmapami), jako jsou fotografie
a naskenované obrazky, véetné importu, exportu a prevodu z jednoho formatu do druhého.

Program Draw umi &ist vétSinu grafickych formatd. M& podobnou podmnozinu funkci jako
programy pro rastrovou grafiku, jako je Adobe Photoshop nebo Gimp. Rastrova grafika jsou
obecné obrazky, které pouzivaji jeden z nejcastéji pouzivanych nasledujicich format:

*  JPGIJIPEG - zkratka pro Joint Photographic Experts Group, ktera tento forméat vytvofrila.
Je to nejbéznéjsi format obrazkd na webovych strankach a vétsina digitalnich
fotoaparat vytvari obrazky JPEG jako vychozi.

» GIF (Graphics Interchange Format) — GIF je bitmapovy format obrazkd, ktery je oblibeny
diky své Siroké podpore a prenositelnosti.

*  PNG (Portable Network Graphics) — PNG je format rastrového obrazku, ktery podporuje
bezeztratovou kompresi dat a také priihlednost pozadi.

« TIFITIFF (Tagged Image File Format) — format TIFF je flexibilni, pfizplsobivy a umoZiiuje
ukladat obrazova data v bezeztratovém formatu.

*  BMP (BitMaP) — je také zndmy jako bitmapovy obrazovy soubor, ktery je bodovou
maticovou datovou strukturou.

Import obrazkii

Vkladani
Chceme-li do vykresu importovat obrazové soubory, zvolime v hlavni nabidce VloZit > Obrazek

nebo klepneme na Vlozit obrazek na Standardni nastrojové listé. Otevre se dialogové okno
Vlozit obrdzek (obrazek 136).

Aplikace Draw obsahuje importni filtry pro vétSinu grafickych formatd. Pokud ma importovany
soubor graficky format, ke kterému neexistuje importni filtr, doporu€ujeme pouzit néktery
z mnoha bezplatnych program( pro prevod grafiky do formatu, ktery aplikace Draw rozpozna.

Pokud je v dialogovém okné Vlozit obrazek vybrana moznost Nahled, zobrazi se nahled souboru
v rdmecku na pravé strané. To usnadiuje vybér pozadovaného souboru a také slouzi ke
kontrole, zda Draw m{Ze importovat pouzity forméat souboru.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/
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Obrazek 136: Dialogové okno VioZit obrazek

Vkladani

VloZzenim grafiky do kresby se obrazek stane trvalou soucasti kresby. VeSkeré zmény provedené
ve vloZené grafice se zobrazi pouze v kresbé, do které byla grafika vioZzena. Plvodni graficky
soubor neni ovlivnén.

K vloZeni dojde pfi importu grafiky do kresby pomoci jedné z nasledujicich metod:
» Dialogové okno Vlozit obrazek.
» Kopirovani a vloZeni.
» Skenovani grafiky.
* Pretahovani mezi otevienymi soubory.

Hlavni vyhodou vloZeni grafiky do kresby je, Ze grafika je vzdy k dispozici bez ohledu na to,
z jakého pocitace je kresba oteviena.

Hlavni nevyhodou vkladani grafiky je, Ze vytvari velké soubory, coZz nemusi byt Zadouci, pokud je
omezena kapacita pro ukladani pocitacovych soubord. Také pokud je plvodni grafika zménéna,
pak se vloZend grafika neaktualizuje pfi kazdém otevieni vykresu.

O Poznamka

Pokud ma byt grafika vioZzena do kresby LibreOffice, ujistime se, Ze v dialogovém
okné Vlozit obrazek neni vybrana moznost Vlozit jako odkaz.
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nebude uloZen spolu s dokumentem, ale pouze jako odkaz.

Pokud se zméni umisténi nebo nazev souboru, bude obrazek nedostupny. Piejete
si namisto toho obrazek vloZit?

[IiPfi odkazovani na obrazek zobrazit dotaz:

Zachovat odkaz VloZit obrazek

Obrazek 137: Dialogové okno Potvrdit obrazek jako odkazy

Propojeni

Odkaz na plvodni grafiku nevlozi grafiku do kresby, ale vytvori odkaz na misto, kde se v pocitadi
nachazi plvodni graficky soubor. Pfi kazdém otevieni kresby se v ni zobrazi veskera propojena
grafika.

Hlavni vyhodou propojeni grafického souboru pfi umisténi do kresby je, Ze pokud je plvodni
graficky soubor zménén nebo nahrazen grafikou se stejnym nazvem souboru, je verze grafiky

v kresbé vzdy aktualni. Pfi dalSim otevieni kresby se v kresbé otevie také nejnovéjsi verze
grafiky. Také velikost souboru kresby je mnohem mensi a plvodni grafiku Ize snadno upravovat
pomaoci specializovanych externich aplikaci.

Hlavni nevyhodou propojovani grafiky je, Ze pro spravnou funkci propojeni je nutné udrzovat
vazbu mezi kresbou a vlozenym grafickym souborem. Pokud je kresba nebo ptvodni graficky
soubor pfesunut na jiné misto v pocitaci, je tfeba aktualizovat vSechny odkazy tak, aby
obsahovaly nové umisténi.

1) Otevieme dialogové okno VloZzit obrazek.
2) V dialogovém okné Vlozit obrazek vybereme moznost VloZit jako odkaz.

3) Vybereme pozadovany graficky soubor a kliknutim na Otevfit otevieme dialogové okno
Potvrdit obrazek jako odkaz (obrazek 137).

4) Kliknutim na PFipojit propojime soubor a zavieme dialogové okno Potvrdit obrazek jako
odkaz.

5) pokud nema byt soubor propojen, klepneme na Vlozit obrazek a soubor vlozime. Tim se
také zavre dialogové okno Potvrdit obrazek jako odkaz.
~ -
%& Poznamka

PTi propojeni grafického souboru s kresbou LibreOffice se format propojené grafiky
nezmeéni.

Uprava odkazt
Odkazy Ize aktualizovat, upravovat nebo rusit nasledujicim zptsobem:

1) V hlavni nabidce zvolime Upravy > Odkazy na externi soubory a otevie se dialogové
okno Upravit odkazy (obrazek 138).

2) Vybereme odkaz, ktery chceme upravit.
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Prvek:
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Obrazek 138: Dialogové okno Upravit odkazy

3) Podle potfeby klepneme na Upravit, Rozpojit odkaz nebo Aktualizovat.

— Upravit — zméni graficky soubor ve vykresu na graficky soubor, ktery pouziva vybrany
odkaz.

— Rozpojit odkaz — prerusi propojeni mezi vybranym souborem a aktualnim
dokumentem. Verze grafického souboru v kresbé se vlozi do kresby. Otevie se
potvrzovaci dialogové okno s dotazem, zda mé byt odkaz rozpojen. Kliknutim na Ano
potvrdime zruSeni propojeni.

— Aktualizovat — aktualizuje vybrany odkaz tak, aby se v kresbé zobrazovala nejnoveéjsi
verze odkazovaného souboru.

4) Kliknutim na Zavfit ulozZime zmény odkazu a zavieme dialogové okno Upravit odkazy.

Skenovani

U vétSiny skenerl Ize naskenovany obrazek viozit do kresby nebo dokumentu. Naskenované
obrazky jsou vloZeny ve formatu PNG. Ujistime se, Ze je skener nakonfigurovan pro dany pocitac
a podporovan systémem SANE pro operacni systém Linux nebo TWAIN pro operani systém
Windows nebo Mac.

1) Vlozte do skeneru dokument, vykres nebo fotografii a ujistime se, Ze je skener zapnuty
a pfipraveny.

2) Pokud je skener pouzivan s LibreOffice poprvé, zvolime v hlavni nabidce Vlozit >
Multimédia > Skenovat > Vybrat zdroj a vybereme skener. Pokud byl skener jiz dfive
pouzit, zvolime v hlavni nabidce Vlozit > Obrazek > Skenovat > PoZadavek.

3) Dalsi postup zavisi na ovladaci skeneru, rozhrani a operanim systému pocitace.
Obvykle je tfeba zadat moznosti skenovani, jako je rozliSeni, okno skenovani atd. Dalsi
informace nalezneme v dokumentaci dodané se skenerem.
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4) Po naskenovani obrazku jej Draw umisti do kresby. V tomto okamZiku jej Ize upravovat
jako jakoukoli jinou grafiku.

Poznamka

Pokud je k pocitaCi pfipojeno vice nez jedno skenovaci zafizeni, vybere se zafizeni
pfi vybéru zdroje. Tento vybér se stane vychozim zdrojem pfi pouziti pozadavkd na
skenovani, dokud neni jako zdroj skenovani pouzito jiné zafizeni.

Kopirovani a vkladani
Dalsim zplsobem vlozZeni grafiky je kopirovani a vkladani grafiky do kresby. Kopirovana grafika

mUZze byt obrazek jiz viozeny do jiného dokumentu nebo kresby, nebo mdze jit o graficky soubor,
napriklad kresbu, dokument nebo fotografii.

Po zkopirovani vybereme format pro vioZeni grafiky do aplikace Draw pomoci Upravy > VloZit
jinak > Vlozit jinak v hlavni nabidce, ¢imz otevieme dialogové okno Vlozit jinak. Dostupné
formaty pro vkladani zavisi na typu obrazku zkopirovaného do schranky.

Poznamka

Pri kopirovani a vkladani obrazk(l do kresby respektujte autorska prava a licenci
kopirovaného obrazku.

Presouvani pomoci mysi

Dal3i metodou vkladani grafiky do kresby je pfetaZzeni, které Ize pouZit na vloZenou nebo
propojenou grafiku. Zplsob, jakym pfetazeni funguje, zavisi na operacnim systému pocitace.
Chovani pfi pfetahovani se obvykle ovlada pomaci klaves Ctrl nebo Ctrl + Shift v kombinaci

S mysi.

Casto pouzivané objekty a obrazky Ize uloZit do Galerie obrazk(l. Z Galerie Ize kopii objektu nebo
obrazku jednoduse pfetahnout na kresbu. Praci s galerii se vénuje kapitola 11, Pokrocilé techniky
kresleni.

Exportovani obrazk

Exportovani souborti

Ve vychozim nastaveni uklada Draw kresbu ve forméatu * . ODG. Nékteré softwarové programy
neumi otevfit soubory *.0DG. Aby byly kresby k dispozici pro jiné programy, Ize soubor
exportovat v rliznych formatech. PouzZity postup exportu zavisi na nastaveni pocitace a pouzitém
operacnim systému. Nasledujici postup je pfikladem postupu exportu.

1) Otevieme soubor ODG, ktery chceme exportovat.

2) V hlavni nabidce zvolime Soubor > Exportovat a otevieme dialogové okno Export.
Priklad dialogového okna pro export je uveden na obrazku Chyba: zdroj odkazu
nenalezen.

3) Zadame novy nazev exportovaného souboru a prejdeme do sloZky, kam ma byt
exportovany soubor ulozen.

4) Z moznosti v rozeviracim seznamu vybereme poZadovany format souboru.
5) Klikneme na Exportovat a soubor se vyexportuje jako novy soubor ve zvoleném formatu.
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MNazev souboru:

HTML dokument (Draw) (*.html;*htm)
XHTML (*.html;*xhtml)

PDF - Portable Document Format (*.pdf)
BMP - Windows Bitmap (*.bmp)

EMF - Enhanced Metafile (*.emf)

EPS - Encapsulated PostScript (*.eps)
GIF - Graphics Interchange Format (*.gif)

JPEG - Joint Photographic Experts Group (*jpa;*jpea; jfif%jif*jpe)

PNG - Portable Network Graphic (*.png)
SVG - Scalable Vector Graphics (*.svg;*.svgz)
TIFF - Tagged Image File Format (*.tif;*1iff)

WMEFE - Windows Metafile (*wmf)

UloZit jako typ:

PNG - Portable Netwaork Graphic (*.png)

Automaticka pfipona

nazvu souboru

(2] Vybér

UloZit

Zrusit

6) V zAvislosti na zvoleném formatu souboru se mUiZe otevrit dal$i dialogové okno, ve
kterém Ize vybrat moZnosti forméatu exportu.

7) V zavislosti na dal$im dialogovém okné, které se mUze otevrit, klepneme na Exportovat,
Vytvofit nebo OK a soubor se vyexportuje jako novy soubor v novém formatu.

Exportovani objekt(

Export jednotlivych objektl nebo skupiny objektl ze souboru kresby je podobny jako v ¢asti
,Exportovani soubor(“ vyse. Otevieme soubor vykresu a poté vybereme objekt nebo objekty pro
export. V dialogovém okné exportu nezapomene vybrat moznost Vybeér, jak je zndzornéno na
obrazku Chyba: zdroj odkazu nenalezen.

Pomoci této metody Ize importovany obrazek upravit, pfidat k nému poznamky a provést dalsi
zmeény, poté jej vybrat a exportovat pro pouZiti v jiné kresbé nebo dokumentu.

Formatovani obrazkul (rastrovych objektll)

Obrazky (rastrovou grafiku) Ize upravovat a formatovat nékterym z nasledujicich zplsobd. Lze
pridat nebo zménit filtry a upravit vlastnosti barev, ¢ar, ploch a stin(:

« V hlavni nabidce zvolime Format > Obrazek pouzijeme jeden z nastrojll v oteviené

podnabidce.

* PouZijeme néastroje na nastrojové listé Obrazek. DalSi informace naleznete v ¢asti
.Nastrojova lista Obrazek" nize.

* Pouzijeme nastroje dostupné v sekcich Stin a Obrazek na karté Vlastnosti postranni liSty
(obrazek 140 na strané 156).
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* Nekteré rastrové grafiky mohou obsahovat textovy prvek. DalSi informace o formatovani
textu najdeme v kapitole 9, Pfridavani a forméatovani textu.

Rastrova grafika obsazena ve skupiné se pri Upravé a forméatovani vlastnosti skupiny chova jako
ostatni objekty.

Poznamka

Veskeré zmény forméatovani provedené v grafice pomoci nastrojli v LibreOffice se
zobrazi pouze v kresbé, kde byla grafika upravena. Plivodni graficky soubor neni
ovlivnén.

Pojmenovani obrazki

Draw pojmenovava objekty, véetné vlozenych obrazkd, Tvar 1, Tvar 2 atd., v pofadi vioZeni do
kresby. Doporuc¢ujeme prejmenovat objekty, véetné obrazkl v kresbé, pomoci jedine¢ného
nazvu. Nazvy umoziiuji snadnou identifikaci obrazk( a dalSich objektd v Navigatoru.

1) Vybereme obrazek a jednim z nasledujicich zplsobU otevieme dialogové okno Nazev,
kde Ize zadat jedine€ny nazev vybraného obrazku:

— V hlavni nabidce zvolime Format > Nazev.

— Klikneme na obrazek pravym tlacitkem mySi a z mistni nabidky vybereme moznost
Nazev.

2) Do pole Nazev zadame nazev a klikneme na tlacitko OK.

Nastrojova lista Obrazek

Nastrojova liSta Obrazek (obrazek 139) se obvykle zobrazi, kdyz je vybran obrazek nebo
obrazek, ktery je rastrovou grafikou. Nastrojova lista Obrazek mdze byt pevné umisténa v horni
¢asti vykresu nebo jako plovouci nastrojova lista. Vychozi sada nastrojii na Nastrojové listé
Obréazek je nasledujici. DalSi informace o Nastrojove listé Obrazek a dostupnych nastrojich
nalezneme v dodatku B, Nastrojové listy.

* Umisténi a velikost (F4) — otevfe dialogové okno Umisténi a velikost. DalSi informace
nalezneme v kapitole 3, Prace s objekty.

« Zarovnani objekt( — otevre dil¢i panel nastrojl, ktery umoZniuje pfistup k nastrojim pro
zarovnani vybranych objektl vici sobé. Vice informaci nalezneme v kapitole 5,
Kombinace vice objekt(.

* Prenést do popredi (Shift + Ctrl + +) — pfesune vybrany objekt na popredi skupiny
objektd.

* PFenést bliz (Ctrl + +) — pfesune vybrany objekt o jeden krok dopFedu.
* Odsunout dal (Ctrl + —) — odsune vybrany objekt o krok zpét.

* Odsunout do pozadi (Shift + Ctrl + —) — odsune vybrany objekt do pozadi skupiny
objektd.

» Pred objekt — pfesune vybrany objekt pfed jiny vybrany objekt.
* Za objekt — pfesune vybrany objekt za jiny vybrany objekt.

¢ Prohodit — zméni poradi vybranych objektl. Tento nastroj je zaSedly, pokud je vybran
pouze jeden objekt.
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Obrazek 139: Nastrojova lista Obrazek

Styl ¢ary — otevre rozeviraci seznam s rliznymi styly ¢ary pouzitymi pro obrys ramce.
Dalsi informace najdeme v kapitole 4, Zména atribut(l objektu.

Sitka €ary — slouzi ke zméné Sitky &ary. Dalsi informace najdeme v kapitole 4, Zména
atributli objektu.

Barva €ary — slouzi ke zméné barvy ¢éary. DalSi informace najdeme v kapitole 4, Zména
atributli objektu.

Styllvypln oblasti — slouzi ke zméné typu vyplné pouzité ve tvaru. DalSi informace
najdeme v kapitole 4, Zména atributd objektu.

Stin — nastavi vychozi efekt stinu kolem obrazku. Atributy stinu se upravuji v sekci Stin
na karté Vlastnosti na postranni liSté (obrazek 140). DalSi informace nalezneme
v kapitole 4, Zména atributl objektu.

Filtr — otevie nastrojova liSta Filtry obrazku, ktera je popsana v €asti ,Filtry obrazku“ na
strané 161.

Rezim obrazku — zméni zobrazeni grafiky z barevné na ¢ernobilou, ¢ernobilou nebo na
vodoznak. Toto nastaveni ovliviiuje pouze zobrazeni a tisk obrazku; plvodni soubor
obrazku zlstava nezménén. Nastaveni rezimu obrazku Ize zménit také pomoci volby
Barevny reZim v Casti Obrazek v nabidce Vlastnosti na postranni li5té (obrazek 140).

— Vychozi — grafika se zobrazi v nezménéné barve.
— Stupné Sedi — grafika se zobrazi ve 256 odstinech Sedé.
— Cernobila — grafika se zobrazi €ernobile.

— Vodoznak — nastaveni barev, jasu, kontrastu a gama se sniZi, aby bylo mozné grafiku
pouzit jako vodoznak (pozadi). Tato vychozi nastaveni Ize upravit pomoci nastrojové
liSty Barva (obrazek 141).

Ofiznout — ofizne obrazek. Pfi pouziti tohoto nastroje se kolem obrazku zobrazi ofezové
znacky. Pretazenim jedné nebo vice téchto znaCek ofiznéme obrazek na pozadovanou
velikost. Dal$i informace o ofezavani najdeme v ¢asti ,Ofiznuti obrazkd“ na strance 157.

Svisle — oto€i vybrany objekt na vy3ku. DalSi informace najdeme v kapitole 4, Zména
atributd objektu.

Vodorovné — otoci vybrany objekt vodorovné. DalSi informace najdeme v kapitole 4,
Zména atributd objektu.

Transformace — otevie nastrojovou liStu Transformace. DalSi informace najdeme
v kapitole 4, Zména atributli objektu.

Priihlednost — nastavuje stupen prihlednosti obrazku mezi 0 % (nepréhledny) a 100 %
(zcela prihledny). Nastaveni priihlednosti Ize upravit také pomoci sekce Obrazek na
karté Vlastnosti ha postranni listé.
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Obrézek 141: Néastrojova

liSta Barva
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* Barva — otevie nastrojovou liStu Barva (obrazek 141), na které Ize nastavit hodnoty
barev RGB, jasu, kontrastu a hodnotu gama. Tyto Gpravy nemaji vliv na plvodni
obrazek, ale hodnoty jsou ulozeny v aplikaci Draw jako samostatna sada formatovani.
Nastaveni barev Ize upravit také pomoci sekce Obrazek na karté Vlastnosti na postranni
liste.

— Cervena, zelena, modra — vybereme hodnoty od -100 % (Z4dn& barva) do 100 %
(pInd intenzita); 0 % predstavuje pdvodni hodnotu barvy grafiky.

— Jas — vybereme hodnotu mezi -100 % (zcela ¢ernd) a 100 % (zcela bila).
— Kontrast — vybereme hodnotu mezi -100 % (minimum) a 100 % (maximum).

— Gamma - ovliviiuje jas stfednich barevnych ténd. Zvolime hodnotu v rozmezi 0,10
(minimum) az 10 (maximum). Pokud zména jasu nebo kontrastu nepfinese
poZadovany vysledek, Ize tuto hodnotu upravit.

Ofiznuti obrazku

Ofiznuti je metoda skryvani nezadoucich oblasti obrazku nebo zmény velikosti obrazku v kresbé.
Zmeény provedené pfi ofezavani obrazku méni pouze zobrazeni grafiky ve vykresu, nikoli
plvodni graficky soubor.

Rychlé ofiznuti
Po vybéru grafiky ji Ize rychle ofiznout nékterou z nasledujicich metod:

* Na nastrojové listé Standardni nebo Obrazek klepneme na Ofiznout obrazek.
* V hlavni nabidce zvolime Format > Obrazek > Ofiznout.

» Klikneme pravym tlacitkem mySi na obrazek a z mistni nabidky vybereme moznost
Ofiznout.

Kolem vybraného obrazku se zobrazi Gchyty pro vybér (obrazek 142) a obrazek se ofizne
nasledujicim zplsobem:

* Horni, dolni, levy a pravy uchyt vybéru ofizne obrazek pouze v jednom sméru.
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Obrazek 142: Priklad obrazku pripraveného k orfiznuti pomoci
uchytl pro vybér

+  Uchyty pro vybér roh( ofiznou obréazek vertikalné a horizontalné ve dvou smérech.

* Chceme-li zachovat pomér mezi svislymi a vodorovnymi rozméry, podrzime pfi
presouvani tchytu vybéru klavesu Shift.

Dialogové okno Ofiznout

Pro vétSi kontrolu a pfesnost funkci ofezu se doporucuje pouzit dialogové okno Ofiznout(obrazek
143). Po vybéru obrazku zvolime v hlavni nabidce Format > Obrazek > Dialogové okno
Ofiznout, ¢imz otevieme dialogové okno Ofiznout.

« Ofiznout - v této ¢asti mizeme vybranou grafiku ofiznout nebo zmensit, pfipadné pridat
bilé misto kolem grafiky.

N 77

— Zachovat méritko — pfi ofezavani zachova plvodni méfitko grafiky, takze se zméni
pouze velikost grafiky.

— Zachovat velikost obrazku — pfi ofiznuti zachova pdvodni velikost grafiky, takze se

N 2s

zméni pouze méfitko grafiky. Chceme-li zmenSit méfitko grafiky, vybereme tuto
moZnost a do poli s hodnotami ofezu zadame z4porné hodnoty. Chceme-li zvétsit

v v

méfitko grafiky, zadame do poli s hodnotami ofezu kladné hodnoty.
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Ofiznout

® 7achovat méfitko
() Zachovat velikost obrazku

Vlevo: 0,00 cm
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Obréazek 143: Dialogové okno Oriznout

— Vlevo a Vpravo — pokud je vybrana moznost Zachovat méritko, zadame kladnou
hodnotu pro ofiznuti levého nebo pravého okraje grafiky nebo zdpornou hodnotu pro
pridani bilého mista vlevo nebo vpravo od grafiky. Pokud je vybrana moznost
Zachovat velikost obrazku, zadame kladnou hodnotu pro zvétSeni vodorovného

v,

meéfitka grafiky nebo zapornou hodnotu pro zmenseni vodorovného méfitka grafiky.

N 77

— Nahore a Dole — pokud je vybrana moznost Zachovat méritko, zadame kladnou
hodnotu pro ofiznuti horni nebo dolni ¢asti grafiky nebo zapornou hodnotu pro pfidani
bilého mista nad nebo pod grafiku. Pokud je vybrana moznost Zachovat velikost
obrazku, zadame kladnou hodnotu pro zvétSeni svislého méfitka grafiky nebo
zapornou hodnotu pro zmen3eni svislého méfitka grafiky.

s

* MEéfitko — tato Cast slouzi ke zméné méfitka vybrané grafiky na kresbé.
— Sitka — zadanim procentuélni hodnoty zmé&nime $ifku vybrané grafiky.
— Vyska — zadanim procentudlni hodnoty zménime vySku vybrané grafiky.
* Velikost obrazku — tato ¢ast slouzi ke zméné velikosti vybrané grafiky.
— Sitka — zadame hodnotu $itky vybrané grafiky.
— Vyska — zadame hodnotu vySky vybrané grafiky.
« Pulvodni velikost — nad mozZnosti se zobrazi pdvodni velikost grafiky. Kliknutim na tuto

moznost a naslednym kliknutim na tlagitko OK obnovime plvodni velikost vybrané
grafiky.
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Poznamka

V dialogovém okné& Ofiznout jsou Gdaje Sitka a Vyska povazovany za nezavislé
hodnoty. Zména jednoho bez druhého mdze vést k vyraznému zkresleni obrazu a to
nemusi byt to, co je poZadovano.

Export ofiznuté grafiky

Pokud ma byt ofiznuté grafika pouzita v jiné kresbé, pouZijeme po vybéru ofiznuté grafiky jednu
z nasledujicich metod:

* V hlavni nabidce zvolime Soubor > Exportovat, ¢imz otevieme dialogové okno
Exportovat. Pfejdeme do cilové sloZky, zadame nazev souboru, vybereme moznost
Vybér a klikneme na tlacitko Exportovat. DalSi informace nalezneme v Césti
,Exportovani obrazk(“ na strance 152.

* V hlavni nabidce zvolime Format > Obrazek > Ulozit nebo klikneme pravym tlagitkem
mysSi na ofiznutou grafiku a z mistni nabidky vybereme Ulozit. Kliknutim na tla¢itko Ano
ulozime upraveny obrazek a otevieme dialogové okno Export obrazku. Vybereme
pozadovany format souboru, pfejdeme do cilové slozky, zadame nazev souboru
a klikneme na tlacitko Ulozit.

Komprese obrazk

Pokud je do kreshy vlozen velky obrazek a jeho velikost je zménéna tak, aby se veSel do
rozvrzeni kresby, je v souboru kresby ulozen cely pdvodni obrazek v pIné velikosti. Tim se
zachova jeho obsah, coZ mlzZe vést k tomu, Ze soubor bude velky.

Pokud Ize akceptovat urcitou ztratu kvality obrazu, Ize obraz komprimovat, ¢imz se snizi jeho
datovy objem a zaroven se zachové jeho zobrazeni v rozvrZeni stranky;

1) Jednim z nasledujicich zplsobl otevieme dialogové okno Komprimovat obrazek
(obrazek 144):

— Klikneme na obrazek pravym tlaitkem mysi a z mistni nabidky vybereme moZnost
Komprimovat.

— V hlavni nabidce zvolime Format > Obrazek > Komprimovat.
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Komprese Rozliseni
: Zmenéit rozliseni obrazku
I 80 = Sitka: 945 = px
) Komprese PNG VySka: (945 - px
6 B Rozlizeni: 300 ~ | DPI

Interpolace: |Lanczos |

Informace o obrazku
Typ: Obrazek PNG
Skutefné rozméry: 8,00 cm x 8,00 cm (378 x 378 px)
Zdanlivé rozméry: 8,00 cm x 8,00 cm pii 120 DPI
Velikost obrazku: 346 KiB

Vypoditat novou velikost: | 77

Napovéda oK Zrusit

Obrazek 144: Dialogové okno Komprimovat obrazek

2) Vybereme typ komprese a poZadované rozliseni.

3) Kiliknutim na tlacitko Vypodcitat novou velikost aktualizujeme informace o obrazku po
zméneé nastaveni Komprese a RozliSeni.

4) Pokud jsme s novym nastavenim spokojeni, kliknutim na tlacitko OK nastaveni
pouZijeme.

5) Pokud vysledny obrazek nevyhovuje, pouzijeme pro zruSeni zmén a vybér jiného
nastaveni komprese klavesovou zkratku Ctrl + Z.

Filtry obrazku

Draw nabizi jedenact efektl filtri, které pracuji s vybranou grafikou a Ize je kombinovat. Filtry se
vZdy vztahuji na celou grafiku a neni mozné pouzit filtry k Gpravé pouze Casti grafiky.

1) Vybérem rastrové grafiky otevieme nastrojovou listu Obrazek.
2) Pomoci jedné z nasledujicich metod pouZijeme filtr obrazku:

— Kiliknutim na Filtr otevfeme nastrojovou liStu Filtr obrazku (obrazek 145) a poté
vybereme filtr obrazku, ktery chceme pouzit.

— V hlavni nabidce zvolime Format > Obrazek > Filtr a z mistni nabidky vybereme filtr
obrazku.

@ Poznamka

Pokud je grafika vliozena do kreshby, veSkeré obrazové filtry se pouziji pfimo na
vybranou grafiku a plivodni graficky soubor se nezméni. UloZzenim vykresu
zachovame vSechny efekty filtru pouzité na grafiku ve vykresu.
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Obrazek 145: Nastrojova lista Filtr obrazku a dostupné filtry

BN MEIR e

"/ Poznamka

Po uloZeni a zavreni kresby se UcCinky obrazovych filtr(l stanou trvalymi. Pokud
efekty obrazovych filtrd nevyhovuji, pouzijeme Upravy > Zpét v hlavni nabidce
a zrusime pred uloZenim vykresu efekty filtr(.

Na rastrovou grafiku Ize pouzit nasledujici obrazové filtry:

* Prevratit — prevraci hodnoty barev obrazku (podobné jako na barevnému negativu),
nebo hodnoty jasu na obrazku ve stupnich Sedi. Opétovnym pouZitim filtru se vratime
k plvodni grafice (obrazek 146).

Original Inverzni
Obrazek 146: Inverzni filtr obrazu

* Vyhladit — zjemni nebo rozmaZe obrazek pomoci low pass filtru. Tim se sniZi kontrast
mezi sousednimi pixely a obraz se stane neostrym, takze vypada hladsi (obrazek 147).
Ucinek hladkého filtru mdze byt velmi jemny. Nasleduijici pfiklad ukazuje filtr Vyhladit
aplikovany pfi nastaveni Rozsahu vyhlazeni na hodnotu 50, takZe obréazek je vyhlazeny,
ale rozmazany.

Vybérem tohoto filtru se otevfe dialogové okno Vyhladit (obrazek 148), kde se nastavi
parametr rozsahu vyhlazeni.
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Original Vyhlazeni
Obrézek 147: Filtr vyhlazeni

Parametry
Rozsah vyhlazeni:
7.0 =
Napovéda OK Zrusit

Obréazek 148: Dialogové okno Vyhladit

» Zaostf¥it — doostfi obrazek pouzitim vysokofrekvenc¢niho filtru a upravi kontrast mezi

e

sousednimi pixely. Efekt se zvysi, pokud je filtr aplikovan nékolikréat, takze barvy vypadaji
vybledle, jak ukazuje pfiklad na obrazku 149.

Original Zaostieni
Obrézek 149: Filtr pro zaostfeni obrazu

Original Odstranéni Sumu
Obrazek 150: Filtr Odstranit Sum

Odstranit Sum — potlacuje Sum pomoci medianového filtru porovnavajiciho kazdy pixel
s jeho okolim. Filtr nahradi kazdy pixel s extrémnimi odchylkami od stfedni hodnoty
barvy sousednich pixelll pixelem, ktery ma stfedni barevnou hodnotu. MnoZzstvi
obrazovych informaci se pfi kazdém pouZziti filtru nezvySuje. Dochazi vSak k menSim
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zménam kontrastu, coz ma za nasledek, Ze obraz vypada hladsi a efekt je velmi jemny
(obrazek 150).

* Solarizace — solarizace je efekt, ktery vypada jako by béhem vyvolani fotografie bylo
prilis mnoho svétla. Barvy se ¢astecné invertuji. Tmavé oblasti se jevi jako svétlé nebo

svétlé oblasti jako tmavé. V digitalnim svété fotografie vytvari solarizace zménu nebo
obréaceni barev (obrazek 151), podobné jako obrazovy filtr PFevratit.

Vybérem Solarizace se otevie dialogové okno Solarizace (obrazek 152), kde Ize zadat
stupen solarizace (Hodnota prahu). Zadanim hodnoty vySSi nez 70 % se vraci inverzni
efekt na barvy. Vybérem moZznosti Prevratit obratime Ucinek obrazového filtru Solarizace.

Original Solarizace
Obrazek 151: Solarizacni filtr obrazu

Parametry

Hodnota prahu:
80 %

MNapovéda oK Zrusit

Obréazek 152: Dialogové okno
Solarizace

s s

* Ztmavnuti — ztmavnuti vytvafi vzhled, ktery pfipomina fotografie vytvorené v pocatcich
fotografie (obrazek 153). U vSech pixelll se nastavi jejich $edé hodnoty a poté se zelené

a modré barevné kanaly snizi o hodnotu zadanou v poli Stuperi ztmavnuti v dialogovém
okné Ztmavnuti. Kanal Cervené barvy se nezméni.

Vybérem filtru Ztmavnuti se otevie dialogové okno Ztmavnuti (obrazek 154), kde Ize
definovat Stuperi ztmavnuti a vytvofit stary vzhled obrazku.

Original Stmavnuti
Obrazek 153: Filtr ztmavnuti obrazu
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Parametry
Stupen ztmavnuti:
10 % s
Napovéda OK Zrusit

Obrazek 154: Dialogové okno Ztmavnuti

Posterizovat — posterizace shiZuje pocet barev v obrazku. Napfiklad fotografie, kdyz se
snizi poCet barev, bude pravdépodobné vypadat jako malba (obrazek 155).

Vybérem moznosti Posterizovat se otevie dialogové okno Posterizovat (obrazek 156),
kde Ize pro dosazeni poZadovaného efektu definovat pocet barev posterizace.

Original Posterizace
Obrazek 155: Posterizacni filtr obrazu

Parametry
Barvy posterizace:
16 =
Napovéda OK Zrusit

Obréazek 156: Dialog Posterizace

* Pop Art — zméni barvy obrazku a prevede jej do formatu pop-art (obrazek 157).
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Original Pop Art
Obrézek 157: Obréazkovy filtr Pop Art

* Kresba uhlem — zobrazi obrazek jako kresbu uhlem. Obrysy obrazku jsou vykresleny
¢erné a plvodni barvy jsou potlaceny (obrazek 158).

Original Kresba uhlem

Obrazek 158: Filtr obrazku Kresba
uhlem

* Reliéf — vypocita okraje reliéfu obrazku, jako by byl obraz osvétlen zdrojem svétla
(obrazek 159). Vybérem mozZnosti Reliéf se otevie dialogové okno Reliéf (obrazek 160),
ve kterém se vybere poloha Zdroje svétla a vytvori se stiny, které se liSi smérem
a velikosti.

Original Relief
Obrazek 159: Filtr obrazku Reliéf

Parametry
Zdroj svétla:
o o

-
-

Napovéda Zrusit

Obrazek 160: Dialogové okno Reliéf

O—o0—®
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« Mozaika — tento filtr spojuje skupiny pixelll a prevadi je na obdélniky jedné barvy, ¢imz
vytvari obraz, ktery vypada jako mozaika (obrazek 161). Cim vétsi jsou jednotlivé
vytvorené obdélniky, tim méné detailll je v mozaikové grafice.

Vybérem tohoto filtru obr@zkt‘] se otevre dialogové okno Mozaika (obrdzek 162), kde se
nastavi pocet pixell pro Sitku a Vysku dlazdic. Vybérem moZznosti Vylepsit hrany
zvyraznime okraje jednotlivych dlazdic a vytvofime ostfejSi definici.

Original Mozaika
Obrazek 161: Filtr obrazku Mozaika

Parametry
Sitka:
15 pixeld =
\yska:
15 pixeld =
Vylepsit hrany

Napovéda Zrusit

Obrazek 162: Dialogové okno Mozaika

Nahrada barev

Nastroj Nahrada barev umoZiiuje pouze nahradit nebo zménit barvu ve vloZzené grafice za jinou
barvu nebo nastavit barvu jako prihlednou. Najednou Ize vyménit az Ctyfi barvy. K Gpravam
nelze vybrat oblast grafiky, protoZe tento nastroj pracuje pouze s celou grafikou.

Vybér nahradnich barev miiZe byt pouze z jedné z dostupnych palet v LibreOffice. Zde nelze
definovat nové barvy, ale vlastni barvy lze vytvofit pfed pouzitim nastroje Nahrada barev. DalSi
informace o vytvareni barev najdeme v kapitole 11, Pokrocilé techniky kresleni.

@ Poznamka

Funkci Nahrada barev Ize pouZit pouze pro vloZenou grafiku. Pokud je na propojené
grafice pouZzit nastroj Nahrada barev, zobrazi se nasledujici chybova zprava ,Tento
obrazek je vioZen do dokumentu jako odkaz. Prejete si tento odkaz rozpojit, abyste
mohli obrazek upravit?“. Kliknutim na tlacitko Ano zruSime propojeni a vloZime
grafiku.

Dialogové okno Nahrada barev

+ Kapatko — zapne vybér barvy, kdyZ je vybrana.
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* Nahradit — nahradi vybrané zdrojové barvy ve vybraném obrazku barvami zadanymi
v polich Nahradit za.

* Barvy — seznam zdrojovych a nahradnich barev.

— Zaskrtavaci policko Pivodni barva — zaSkrtnutim tohoto policka se aktualni Pavodni
barva nahradi barvou zadanou v poli Nahradit za.

— Tolerance — nastavi toleranci pro nahrazeni zdrojové barvy ve zdrojovém obrazku.
Chceme-li nahradit barvy, které jsou podobné vybrané barvé, zadame nizkou
hodnotu. Chceme-li nahradit SirSi rozsah barev, zadame vySsi hodnotu.

— Nabhradit za — zobrazi seznam dostupnych barevnych palet a nahradnich barev.
* Pradhlednost — nahradi priihledné oblasti ve vybraném obrazku vybranou barvou.

Nahrada barev

1) Dfive neZ néastroj ndhrady barev pouZijeme, vybereme vlioZzeny obrazek.

2) V hlavni nabidce zvolime Nastroje > Nahrada barev, ¢imZ otevieme dialogové okno
Nahrada barev (obrazek 163).

3) Kliknutim na Kapatko v horni Casti dialogu aktivujeme rezim vybéru barvy.

4) Presuneme kurzor nad barvu, ktera ma byt ve vybraném obrazku nahrazena,
a v ramecku vedle pole Kapatko se zobrazi nahled barvy.

5) Klikneme na barvu. Vybrana barva se zobrazi v prvnim nahledovém poli Pdvodni barva
a vedle ni se objevi zaSkrtavaci pole.

6) Chceme-li vybrat jinou barvu, zaSkrtneme policko vedle druhého nahledového pole
Plvodni barva a klikneme na jinou barvu ve vybraném obrazku. V dialogovém okné
Néhrada barev Ize vybrat maximalné Ctyfi barvy.

7) Do poli Tolerance zadame velikost tolerance pozadované pro nahrazeni kazdé vybrané
barvy. Ve vychozim nastaveni je tolerance 10 %.

8) V poli Nahradit za vybereme z rozeviraciho seznamu paletu barev a poté vybereme
poZadovanou barvu. Ve vychozim nastaveni je zadano Prlihledné.

9) Po vybéru az Ctyf barev k nahrazeni klikneme na tlaCitko Nahradit a nahradime barvy ve
vybrané grafice. Pfiklad nahrazeni barvy je uveden na obrazku 164.

10) Neexistuje nahled efektu. Pokud vysledek neni uspokojivy, zvolime v hlavni nabidce
Upravy > Zpét > Nahrada barev a zopakujeme nahrazeni barev.

Barvy
Pivodni barva  Tolerance  Nahradit za...
46% = [ Tmavé #lutozelena 1 ¥
- 51% — | Tmavé modra 1 v
41% = [ |svétle Flutozelena 4 ¥
Izl 73% = [ Svétle oranzova 3 v
O Prahlednost Cerna

Obréazek 163: Dialogové okno Nahrada barev
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Original Nahrada barev
Obrazek 164: Priklad pouZiti nahrady

barev
4/ Poznamka

Pouziti nastroje Nahrada barev nahradi vSechny vyskyty Zdrojové barvy, které se
nachéazeji ve vybraném obrazku.

/ Poznamka

Vychozi volba Prihlednost v polich Nahradit za odstrani vybranou barvu z obrazku
a vytvori v obrazku prihledné oblasti.

Nahrada prahlednych oblasti
Chceme-li nahradit priihledné oblasti v obrazku barvou, pouzijeme nasledujici postup:

1) V hlavni nabidce zvolime Nastroje > Nahrada barev, ¢imZ otevieme dialogové okno
Nahrada barev.

2) Kliknutim na obrazek s prihlednymi oblastmi jej vybereme.

3) V dialogovém okné Nahrada barev vybereme moznost Prihlednost, takze se vedle
poloZky Prlihlednost objevi zaskrtavaci pole.

4) V rozeviracim seznamu vedle polozky Prihlednost vybereme paletu barev a poté
vybereme z vybrané palety barvu.

5) Klikneme na tlac¢itko Nahradit a prihledné oblasti se vyplIni vybranou barvou.

6) Neexistuje nahled efektu. Pokud vysledek nevyhovuje, zvolime v hlavni nabidce Upravy
> Zpét > Nahrada barev.

Prevod

Prevod obrysti

Prevod obrysu prevede vybrany objekt na mnohouhelnik nebo skupinu mnohouhelnikd se ¢tyfmi
rohovymi body. Pokud byl obrazek preveden na obrys, je pfevedeny obrazek nastaven jako
grafika pozadi. Pokud prevod vytvari skupinu mnohouhelnikl (napfiklad obrysovy pfevod
textového objektu), zadame skupinu mnohouhelnikl pfed vybé&rem jednotlivého mnohouhelniku
ve skupiné. DalSi informace o praci se skupinami nalezneme v kapitole 5, Kombinovani vice
objektd.

Po pfevedeni objektu na obrys jiz nelze objekt normalné upravovat. Misto toho se objekt
pfevedeny na obrys upravi pomoci Upravit > Body v hlavni nabidce, aby se upravil jeho tvar.
Dalsi informace o Upravach bodl najdeme v kapitole 3, Prace s objekty.
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Poznamka

Jakékoli Upravy objektu musi byt dokonéeny pfed provedenim konverze obrys,

protoZe dalSi Upravy na pfevedeném objektu nejsou mozné.

1) PrFed pfevedenim na obrys provedeme vSechny potfebné Gpravy objektu.

2) Zkontrolujeme, zda je objekt vybran.
3) Pomoci jedné z nasledujicich metod pfevedeme objekt na obrys:

— V hlavni nabidce zvolime Tvar > Pfevést > Na obrys.

— Klikneme pravym tlaCitkem mySi na vybrany objekt a z mistni nabidky vybereme
moznost Pfevést > Na obrys.

Poznamka

PTi pfevodu na obrys se nezobrazi potvrzovaci dialog.

Pfevod mnohouhelnikt

Konverze mnohouhelnik{ slouzi k pfevodu vybraného obrazku na skupinu mnohothelnikd
vyplnénych barvou. Obrazek je také prfeveden na vektorovou grafiku a Ize ménit jeho velikost bez
ztraty kvality obrazu nebo zkresleni textu.

Po prevodu Ize grafiku rozdélit na skupiny mnohouhelnik{ a poté na jednotlivé mnohouhelniky.
Rozpojeni a déleni umozinuje upravovat nebo odstranovat jednotlivé barvy v ramci grafiky.

Moznosti prevodu a ovladani

Pocet barev — zadame pocet barev, které se maji zobrazit v pfevedeném obrazku.
LibreOffice generuje mnohouhelnik pro kazdy vyskyt barvy v obrazku. Rozsah poctu
barev je 8 az 32.

Redukce bodi — odstrani barevné mnohouhelniky, které jsou mensi nez zadana
hodnota pixelu. Rozsah zmen3eni bodu je 0 az 32 pixeld.

Zaplnit mezery — vyplni prazdné oblasti v grafice, které mohou vzniknout pfi pouziti
redukce bodd.

Velikost dlazdice — zadame velikost obdélniku pro vypli pozadi. Rozsah velikosti
dlazdic je 8 az 128 pixeld.

Zdrojovy obrazek — nahled plvodniho obrazku.

Vektorovy obrazek — nahled pfevedeného obrazku.

Néahled — vytvori nahled prevedeného obrazku v poli Vektorovy obrazek bez pouziti
jakychkoli zmén.

OK - prevede obrazek na vektorovou grafiku slozenou z mnohouhelnikd. Vysledkem je
metasoubor ve formatu SVM (StarView Metafile), ktery pouziva kancelarsky balik
LibreOffice a ktery umoziiuje pfenos prevedeného obrazku do jinych dokument
LibreOffice.

Pievod
1) Vybereme obrazek v kresbé.
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Pocet barev: 32 =
Redukce bod: 15 pixeld =
Zaplnit mezery:
Velikost dlazdice: |8 pixeld =
Zdrojovy obrazek: Vektorovy obrazek:

Napovéda Nahled oK Zrudit

Obrazek 165: Dialogové okno Prevést na mnohouhelnik

2) Pomoci jedné z nasledujicich metod pfevedeme obrazek na mnohouhelnik a otevieme
dialogové okno Prevést na mnohouhelnik (obrédzek 165):

— V hlavni nabidce zvolime Tvar > Prevést > Na mnohouhelnik.

— Klikneme pravym tlacitkem mySi na obrazek a z mistni nabidky vybereme moZznost
Pfevést > Na mnohouhelnik.

3) Vybereme Pocet barev a Redukce bod, které se maji pouZit pfi pfevodu.

4) Chceme-li zabranit tomu, aby se v pfevedeném obrazku objevily prazdné oblasti,
vybereme moznost Zaplnit mezery.

5) Zadame pocet pixeld, které se maji pouZzit pro Velikost dlaZdice.

6) Kliknutim na Nahled zkontrolujeme, jak bude pfevedené grafika vypadat.

7) Provedeme potiebné zmény nastaveni a znovu zkontrolujeme nahled.

8) Pokud prevedeny obrazek spliiuje ocekavané pozadavky, kliknutim na tlacitko OK
prevedeme obrazek na mnohouhelnik a zavieme dialogové okno Pfevést na
mnohouhelnik.

{_/ Poznamka

Pfi pfevodu mnohouhelnikl se nezobrazi potvrzovaci dialog.

Rozpojeni
Po prevodu obrazku na mnohouhelniky Ize vektorizovany obrazek rozdélit na skupiny

mnohouhelnikd. Kazda skupina mnohouhelnikd se sklada z jedné barvy a stava se objektem,
ktery Ize pouZit v jiné kresbé.
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1) Prevod obrazku na mnohouhelniky, viz vySe ,Pfevod".

2) Ujistime se, Ze je vybran pfevedeny obrazek, a poté pouZijeme jednu z nasledujicich
metod pro rozdéleni obrazku na skupiny mnohouhelnikd:

— V hlavni nabidce zvolime Tvar > Rozpojit.

— Klikneme pravym tlaCitkem mysi na obrazek a z mistni nabidky vybereme moznost
Rozpojit.

3) Klikneme na barvu v obrazku a pretazenim skupiny mnohothelnik( vypIinénych touto
barvou z obrazku vytvofime novy obrazek.

4) Pripadné stiskneme Odstranit a barvu z obrazku vymazeme.

Rozdélovani

Po pfevedeni obrazku na mnohouhelniky a rozdéleni obrazku na skupiny mnohothelnik( Ize tyto
skupiny mnohouhelnikl rozdélit na jednotlivé mnohouhelniky.

1) PFevod obrazku na mnohouhelniky, viz vySe ,Pfevod".
2) Rozpojeni obrazku na skupiny mnohouhelnikd, viz vyse ,Rozpojeni*.

3) Vybereme obrazek a poté pouZzijeme jednu z nasledujicich metod pro rozdéleni skupin
mnohouhelnikd na jednotlivé mnohouthelniky:

— V hlavni nabidce zvolime Tvar > Rozpojit.

— Klikneme pravym tlacitkem mysi na obrazek a z mistni nabidky vybereme moznost
Tvary > Rozpojit.

— Pouzijeme klavesovou zkratku Ctrl + Alt + Shift + K.

4) Vybereme jednotlivy mnohouhelnik (nebo nékolik mnohouhelnikd) v obrazku
a pretazenim mnohouhelniku z obrazku vytvofime v kresbé novy obrazek.

5) Prfipadné stisknutim tlacitka Odstranit odstranime vybrané mnohouhelniky z obrazku.

Konverze rastri

VSechny objekty kresby, umisténé do vykresu LibreOffice, jsou vektorovou grafikou a tuto
vektorovou grafiku Ize pfevést na bitmapu (rastrovou grafiku) ve formatu PNG. VeSkeré efekty
prdhlednosti v plvodni vektorové grafice se pfi prevodu ztrati, pfestoze format PNG pouZivany
aplikaci LibreOffice Draw priihlednost podporuje.

K prevodu vektorové grafiky na bitmapu pouzijeme jednu z nasledujicich metod:

* V hlavni nabidce zvolime Tvar > Prevést > Na rastr.

» Klikneme na grafiku pravym tlaCitkem mysi a z mistni nabidky vybereme mozZnost
Konvertovat > Na rastr.

Poznamka

P¥i pfevodu rastrovych map se nezobrazi potvrzovaci dialog.
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Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/


http://documentation.libreoffice.org/en/

Uvod

PrestoZe se Draw nevyrovna funkcim prednich program pro kresleni nebo Upravu obrazka,
dokaZe vytvaret a upravovat 3D vykresy. V aplikaci Draw jsou k dispozici dva typy 3D objektd: 3D
scény a plastické 3D tvary. Na Stavovém Fadku se zobrazi informace o vybéru 3D scény
(obrazek 166). Na Stavovém fadku se zobrazi pouze informace o vybéru tvaru (obrazek 167),
pokud je vybran plasticky 3D tvar.

| Snimek 1 z 22 (Rozvrieni) | Vybrano 3D scéna Wichozi o= 1,96 /10,76 = 5,80 x 5,80 ‘
Obréazek 166: Stavovy radek zobrazujici vybranou 3D scénu

‘ Snimek 1 z 22 (RozvrZeni) | Vybrano Tvar Vychozi =" 2,10/ 340 b= 5,60 x 5,60 ‘

Obrézek 167: Stavovy fadek zobrazujici vybrany tvar

Podle toho, ktery typ je zvolen, existuji rizné moZnosti dalSich Uprav objektu (otaceni, osvétlent,
perspektiva atd.). Plastické 3D tvary se jednoduSeji nastavuji a upravuiji, ale 3D scény umoznuji
vetsi prizplsobeni.

3D objekty se vytvareji jednou z nasledujicich metod:

* 3D objekty — jedna se o hotové 3D objekty a 3D scény vybrané jednou z nasledujicich
metod:

— Klepneme na 3D objekty na nastrojové listé Kresleni (obrdzek 168 na strané 179).
— Zvolime 3D objekt v nabidce 3D objekty na karté Tvary na postranni listé.

« 2D objekt pfevedeme na 3D objekt pomoci nékterého z nasledujicich nastrojd na
nastrojové listé Kresleni:
— Na 3D objekt — vytvofi 3D scénu obsahuijici plasticky objekt.
— Na 3D rota€ni objekt — vytvorfi 3D scénu do rotacniho objektu s pouzitim vychozi osy
otaceni.
— V 3D rotaénim objektu — vytvofi 3D scénu do objektu rotace pomoci uzivatelem
definované osy rotace.

— Prepnout plasti€nost — vytvori 3D tvar protazenim 2D objektu do 3D. Pouze 3D
tvary, které byly protazeny, Ize pfevést zpét na 2D objekt.

Typy 3D objekttl

3D scény

3D scény jsou vytvoreny z objektll s rozméry pomoci soufadnic x, y a z a mohou obsahovat typy
objektd, jako je krychle, koule, plasticky objekt nebo rotacni objekt. Tyto typy objektli neexistuji
mimo 3D scénu.

VA4

Stavovy fadek zobrazuje vybranou 3D scénu, pokud je vybran 3D objekt, ktery byl vytvofen
z 2D objektu pomoci rotace nebo konverze télesa, nebo se jedna o hotovy 3D obijekt, ktery byl
vloZen do vykresu.

3D scéna se chova podobné jako skupina. Stejné jako do skupiny Ize i do 3D scény vstoupit za
Ucelem Upravy jednotlivého objektu v 3D scéné a po dokonceni Gprav ji opustit. Dalsi informace
o zadavani, Upravach a opousténi skupin naleznete v kapitole 5, Kombinace vice objekt(.

Pokud je 3D scéna vytvorena z vybéru vice nez jednoho 2D objektu, automaticky se vytvori
skupina jako jedna 3D scéna. Do této 3D scény Ize vstoupit a ménit, upravovat a otacet
jednotlivé objekty v rdmci 3D scény.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/
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4 Poznamka

Pokud byla 3D scéna vytvorena z vybranych 2D objektd, nelze jednotlivé objekty
seskupit.

3D tvary

3D tvary jsou pevné objekty, které maiji tfi rozméry: délku, Sitku a vySku. Zatimco 2D tvary jsou
ploché, 3D tvary maji hloubku.

3D tvar se vytvori, kdyZ se 2D tvar nebo objekt z Galerie pisem zméni na 3D pomoci pfikazu
Pfepnout plastiénost. Pokud je vybran tento typ 3D objektu, zobrazi se na stavovém fadku
Viybrano Tvar.

3D tvar Ize prohliZzet a upravovat v rezimu 3D nebo 2D. Chceme-li upravovat ve 2D rezimu,
vypneme plastiCnost, provedeme zmény a prepneme zpét do 3D reZimu pomoci Pfepnout
plasti¢nost.

4 Poznamka

Plasti¢nost pomaoci Pfepnout plastiénost Ize pouzit pouze tehdy, je-li vybran 2D
tvar, 3D objekt vytlaCeny z 2D tvaru, nebo objekt z Galerie pisem. Neni k dispozici
pro text, ¢ary, Sipky, kfivky a mnohouhelniky.

Nastrojova lisSta Kresbha

Pred vytvorfenim 3D objektll ve vykresu se doporucuije pfidat 3D nastroje na nastrojovou listu
Kresba (obrazek 168) pomoci volby Viditelna tlacitka anebo dialogového okna Pfizplsobit.

Nastrojové listy a v pfiru€ce Zaciname s LibreOffice.

Po instalaci 3D nastrojli na nastrojovou listu Kresba jsou tyto nastroje k dispozici pouze tehdy,
pokud je ve vykresu vybran 2D objekt.

Kresba V){f
RS Z-B-\N0OOI—=-¥-L-1C-C-<-B-1-7vr-B-19% & @éﬂdb_

Obrazek 168: Nastrojova lista Kresba s pridanymi 3D nastroji

3D objekty w X

FPO®e&HLOC O

Obrazek 169: Nastrojova lista
3D objekty

Vytvareni prostorovych (3D) objektl

Pfipravené 3D objekty

Hotové 3D objekty jsou 3D scény a do vykresu se vkladaji jednou z nasledujicich metod. Vybér
a kresleni 3D objektd je u vSech metod vkladani hotového 3D objektu stejné.

« Klepneme na trojuhelnik v vpravo od 3D objektli na nastrojové listé Kresba a vybereme
3D objekt z panelu nastrojd. Ikona 3D objekty zobrazena na nastrojové listé Kresba
zavisi na dfive vybraném a pouzitém 3D objektu.

* V hlavni nabidce zvolime Zobrazit > Nastrojové liSty > 3D objekty a otevieme
nastrojovou listu 3D objekty (obrazek 169).
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* V hlavni nabidce zvolime Tvar > Vlozit > 3D Objekty.
» V postranni listé zvolime Tvary > Vychozi > 3D objekty a vybereme 3D objekt.

O Poznamka

Hotové 3D objekty Ize pfemistovat, ménit jejich velikost a upravovat je stejné jako 2D
objekty. DalSi informace nalezneme v kapitole 3, Prace s objekty.

Plasticnhost

Plasti¢nost prevede 2D objekt na 3D scénu tak, Ze 2D objekt protdhne smérem k pozorovateli.
Scéna je otocena o 20 stupnid kolem vodorovné osy, aby byl 3D efekt Iépe viditelny. Pfiklady 3D
pfevodu pomoci plasti¢nosti jsou uvedeny na obrazku 170.

Po vybéru 2D objektu ve kresbé jej pomoci pfikazu Na 3D objekt pfevedeme na 3D scénu
pomoci jedné z nasledujicich metod:
* Klepneme pravym tlacitkem mysSi na 2D objekt a z mistni nabidky vybereme mozZnost
Prevést > Na 3D objekt.
* Na nastrojové listé Kresba klepneme na Na 3D objekt.
* V hlavni nabidce zvolime Tvar > Pfevést > Na 3D objekt.
+ V dialogovém okné 3D efekty klepneme na PFevést na 3D (obrazek 176 na strané 184).

Obrézek 170: Priklad pouZiti plasti¢nosti pro 3D konverzi
Otoceni

Na 3D rotacni objekt a Prevést na rotacni objekt

Na 3D rotacni objekt nebo Pfevést na rotacni objekt prevede 2D objekt na 3D scénu otocenim
objektu za pouZziti levého okraje ohraniCujiciho ramecku kolem objektu jako osy otaceni. Priklady
3D pfevodu pomoci nékterého z téchto rotacnich nastrojli jsou uvedeny na obrazku 171.
Skute€né vytvorena 3D scéna zavisi na Uhlu a tvaru otaceného objektu.

Po vybéru 2D objektu na vykresu jej pfevedeme na 3D scénu pomoci rotace jednou
z nasledujicich metod:

* Klepneme pravym tlaCitkem mySi na 2D objekt a v mistni nabidce vybereme moZznost
Prevést > Na 3D rotacni objekt.

* Klepneme na Na 3D rotac¢ni objekt na nastrojové listé Kresba.
* V hlavni nabidce zvolime Tvar > Pfevést > Na 3D rota€ni objekt.
+ V dialogovém okné 3D efekty klepneme na PFevést na rotacni objekt.
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Obréazek 171: Priklady pouZiti rotace pro 3D
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Obrazek 172: Priklad presunu osy otaceni pomoci V 3D
rotacnim objektu

V 3D rotac¢nim objektu
V 3D rota¢nim objektu prevede 2D objekt na 3D scénu otacenim objektu kolem pohyblivé osy
otaceni. Pfiklad posunu osy otaCeni a zmény Uhlu natoceni je uveden na obrazku 172. Skute¢né
vytvorend 3D scéna zavisi také na uhlu a tvaru otaceného objektu.

1) Vybereme 2D objekt na vykresu.

2) Klepneme na V 3D rotaénim objektu na nastrojové listé Kresba.

3) Nastavime polohu a Uhel osy otaCeni. Ta je zndzornéna preruSovanou ¢arou s rotacnimi
body na obou koncich.

4) Klepneme kamkoliv mimo 2D objekt a ten se pfevede na 3D scénu, jak ukazuje obrazek
172.
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Pfepnout plasti€nost

PlastiCnost je proces, pfi kterém se paralelni plochy posouvaji a vytvéareji 3D tvar. V aplikaci
Draw se 2D plocha posune dopfedu mimo Uroven kresby. Sou€asné je objekt mirné naklonén
a je zapnuta centralni projekce, coz vytvari dojem 3D tvaru. Draw pouZziva vychozi hodnotu pro
tuto plasti¢nost (hloubku téla) na zakladé velikosti 2D objektu. Hodnotu Ize zménit po vytvoreni,
viz nize ,Uprava 3D objekt(”.

Prepocet plasticnosti se provadi pomoci Pfepnout plasti€nost. Plasti¢nost funguje pouze

u zakladnich tvar(, tvar symbol(, blokovych Sipek, vyvojovych diagram, bublin, hvézd a ceduli,
které jsou soucasti vychozi sady nastroji na nastrojové listé Kresba nebo na karté Tvary na
postranni listé. PlastiCnost Ize pouzit také na vSechny objekty vytvofené pomoci nastroje
Pismomalba. Pfiklady pfepnuti plasti¢nosti jsou uvedeny na obrazku 173.

1) Vybereme 2D objekt ve vykresu, ktery byl vytvoren ze zakladnich tvar(, tvarti symbold,
blokovych Sipek, vyvojovych diagramd, bublin, hvézd nebo ceduli.

2) Kliknutim na Pfepnout plastiénost na nastrojové listé Kresba pfevedeme 2D objekt na
3D tvar.

3) Chceme-li provést 3D prevod zpét na 2D objekt, vybereme 3D objekt a klikneme na
Pfepnout plasti¢nost na nastrojové listé Kresba.

0 Poznamka

PlastiCnost nelze pouZzit na textové objekty vytvofené pomoci Vlozit textové pole
nebo Vlozit svisly text.

_ | F 2

momalba

Obrézek 173: Priklady prepnuti plasticnosti
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Uprava 3D objekttl

O Poznamka

Pokud byly 3D scény vytvofeny z vice nez jednoho 2D objektu, automaticky se
vytvofi skupina 3D scény. Tuto skupinu 3D scény nelze rozdélit do skupin a veSkeré
provedené upravy ovlivni vSechny 3D objekty ve skupiné. Chceme-li upravit
jednotlivy 3D objekt v ramci této skupiny 3D scén, vstoupime do skupiny. DalSi
informace o praci se skupinami nalezneme v kapitole 5, Kombinace vice objektd.

3D nastaveni w X

fEbE D-F--W-0-

Obrazek 174: Nastrojova lista 3D nastaveni
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Umisténi, velikost a otoCeni

Uprava polohy, velikosti a nato¢eni 3D objekt(i je podobna jako u 2D objektd. Dal3i informace
nalezneme v kapitole 3, Prace s objekty.

3D nastaveni

Chceme-li otevrit nastrojovou lista 3D Nastaveni (obrazek 174), pfejdeme v hlavni nabidce na
Zobrazeni > Nastrojové liSty > 3D nastaveni. Nastrojova liSta 3D nastaveni se aktivuje pouze
tehdy, kdyz je vybran 3D tvar, ktery byl vytvofen z 2D objektu pomaoci vySe uvedené funkce
~Pfepnout plasti¢nost".

K Gpravam 3D tvard jsou k dispozici nasledujici nastroje. Vysledek vSech zmén provedenych
pomoci téchto nastrojll pro Upravy se okamzité aplikuje na vybrany 3D tvar a zobrazi efekt
pouzitého 3D nastaveni.

Naklonit doll — pfi kazdém pouZziti funkce nakloni vybrany objekt o 5 stupfili smérem
dold (otoceni vodorovné osy).

Naklonit nahoru — pfi kazdém pouziti funkce nakloni vybrany objekt o 5 stupiiti nahoru
(otaCeni ve vodorovné ose).

Naklonit doleva — pfi kazdém pouZziti funkce nakloni vybrany objekt doleva (otoCeni
svislé osy) o 5 stupnid.

Naklonit doprava — pfi kazdém pouZziti funkce nakloni vybrany objekt doprava (otoCeni
svislé osy) o 5 stupiid.

Hloubka — otevfe vyskakovaci nabidku, ve které Ize nastavit hloubku protazeni z objektu
pevnou nebo vlastni hodnotou.

Smér — otevie vyskakovaci nabidku, ve které Ize nastavit smér pohledu pro vytvoreni
protaZzeni v perspektivni nebo rovnobézné projekci.

Osvétleni — otevie vyskakovaci nabidku, ve které Ize pfi vytvafeni protazeni nastavit
smeér a intenzitu osvétleni.

Povrch — otevie mistni nabidku, ve které Ize nastavit matny povrch objektu nebo
zobrazeni draténého ramu.

Barva 3D - otevie vyskakovaci nabidku, ve které Ize nastavit barvu pouzitou pro
protaZeni. Tato barva nemusi byt stejna jako barva pouzita pro plivodni 2D objekt.

Obrazek 175 ukazuje pfiklad naklonéni doleva, zvétSeni hloubky protaZzeni a zmény 3D barvy
pomoci panelu nastroji 3D nastaveni.

Poznamka

Dialogové okno 3D efekty nelze pouzit pro 3D tvary vytvofené pomoci funkce
Prepnout plasti¢nost, protoze nebude dosazeno spravnych vysledkd formatovani.
Pokud je dialogové okno 3D efekty pouZito chybné, odstranime nespravné
forméatovani pomoci Format > Vychozi formatovani v hlavni nabidce.
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Obréazek 175: Priklad zmény 3D nastaveni

Geometrie
Zaoblené hrany 10 % B
Skilovana hloubka 100 % ;
Uhel otocent 360,0° 5
Hloubka 1,00 cm 5
Casti
Vodorovné 24
Svislé 16
Normaly

| I
e
-
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Obrazek 176: Dialogové okno 3D efekty - stranka
Geometrie

3D efekty

Dialogové okno 3D efekty (obrazek 176) nabizi Sirokou Skalu moznych nastaveni pro GUpravy
hotovych 3D objektli nebo 3D scén. Toto dialogové okno lze také pouzit k pfevodu 2D objektu na
3D pomoci nastrojli v levém dolnim rohu dialogového okna. Chceme-li otevrit dialogové okno 3D
efekty, klepneme na nastrojové listé Cara a vyplii na 3D efekty nebo pfejdeme v hlavni nabidce
na Format > 3D efekty.

Veskeré 3D efekty pouzité na 3D scénu se provedou az po kliknuti na tlacitko PFifadit v pravém
hornim rohu dialogového okna 3D efekty. To umoZiiuje provést vsechny zmény 3D efektll pred
jejich pouzitim na 3D scénu.
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O Poznamka

Zadné moznosti na strankach dialogového okna 3D efekty, které jsou Sedé, nelze
pro vybrany objekt pouZzit.

3D prevod
V levém dolnim rohu dialogového okna 3D efekty jsou nastroje pro prevod 2D objektu na 3D
scénu a pro zménu projekce pouzité ve 3D scéné.
* Prevést na 3D — prfevede vybrany objekt na 3D scénu. Tento nastroj funguje stejné jako
nastroj ,Plasti¢nost” na strané 180.

+ Prevést na rotacni objekt — pfevede 2D objekt na 3D scénu pomoci rotace télesa. Tento
nastroj funguje stejné jako nastroj ,Otoceni“ na strané 180.

+ Perspektiva zaplvyp — zapne nebo vypne perspektivni projekci pro 3D scénu.
Perspektivni projekce je technika pro vytvofeni linearni iluze hloubky. Jak se objekty
vzdaluji od divaka, zmenSuje se perspektivni kresba konstantnim pomérem.

3D efekty — Geometrie

Kliknutim na Geometrie v dialogovém okné 3D efekty (obrazek 176) otevieme stranku
Geometrie a pomoci dostupnych moznosti zménime geometrii 3D objektu.

* Geometrie — definuje vlastnosti objektu ve 3D scéné.

— Zaoblené hrany — zadame velikost zaobleni roh(i 3D tvaru, jak ukazuje pfiklad na
obrazku 177. Vychozi nastaveni pro zaoblené hrany je 10 %.

10% zaobleni 75% zaobleni
hran (predvoleng) hran

Obrazek 177: Priklad zaoblenych hran

— Skélovana hloubka — zadame hodnotu potfebnou ke zvétseni nebo zmenseni &elni
plochy vybraného 3D objektu. Obradzek 178 ukazuje priklad, kdy byla Skalovana

hloubka zvétSena na 150 % a poté snizena na 50 %. Vychozi nastaveni Skalované
hloubky je 100 %.
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Skalovana hloubka Skalovana Skalovana
100% (pfedvolené) hloubka 50% hloubka 150%

Obrazek 178: Priklad zmény Skalované hloubky

— Uhel oto¢eni — zadame Ghel ve stupnich pro natogeni 2D objektu, ktery byl pfeveden
do 3D pomoci funkce Na 3D rotaéni objekt. Obrazek 179 ukazuje pfiklad 2D
kruznice, u které je Uhel oto¢eni zménén na 150 stupnid.

o &

2D kruh Konvertovan na Uhel otoceni
3D rotagni objekt zménén na 180°

Obrazek 179: Priklad zmény uhlu oto¢eni

— Hloubka — zadame hloubku plasti¢nosti pro vybrany 2D objekt, ktery byl pfeveden do
3D pomoci funkce Na 3D objekt. Obrazek 180 ukazuje pfiklad 2D kruznice
prevedené na 3D valec s hloubkou plasti¢nosti zvétSenou na 3 cm.

2D kruh Konvertovan na Hloubka zvétSena
3D objekt na 3 cm

Obréazek 180: Priklad zvétsujici se hloubky

« Casti — zméni pocet ¢asti, které Draw pouzije pro vykresleni objektu 3D rotace. Cim
vySSi je pocet ¢asti, tim hladsi je povrch objektu. Vysoky pocet segment( vSak mize
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prodlouZzit dobu potfebnou k vygenerovani 3D objektu na displeji. Obrazek 181 ukazuje
rozdil na 3D kouli pfi zvétSeni €¢asti z 10 na 30 horizontalné a vertikalné.

— Vodorovné — zaddme pocet vodorovnych ¢asti pouzitych ve vybraném 3D rotacnim
objektu.

— Svislé — zadame pocet svislych ¢asti pouzitych ve vybraném objektu 3D rotacnim
objektu.

10 ¢asti 30 Casti
Obréazek 181: Priklad casti

* Normaly — upravuje styl vykreslovani 3D povrchu (obrazek 182 a obrazek 183).

— Specifické pro objekt — vykresli 3D povrch podle tvaru objektu. Napfiklad kruhovy tvar
je vykreslen kulovym povrchem.

— Ploché — vykresli 3D povrch jako mnohouhelniky.
— Sférické — vykresli hladky 3D povrch bez ohledu na tvar objektu.

— Prevratit norméaly — pfevracena normala je normala, ktera sméfuje Spatnym smérem.
To pocitaCi fika, Ze vnéjSi strana je ve skutecnosti vnitfni strana, i kdyZ tomu tak neni.
Pokud se jedna o dutinovou konstrukci, Ize uvést obrdcenou normalu, protoZe obé
plochy sméfujici dovnitf a ven jsou ve stejném modelu.

oy

v pfipadé, pokud je vnitfek vykreslen, viz Oboustranné. Jedn& se o nastaveni pro
celou 3D scénu, nikoli pro jednotlivy objekt ve scéné.

Normaly specifické Normaly — Ploché Normaly — sférické
pro objekt
Obrazek 182: Priklady specifickych, plochych a sférickych efekt(i na objekty
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Pfevracené normaly — vypnute Pfevracené normaly — zapnuté
Oboustranné osvétleni — vypnuié Oboustranné osvétleni — vypnuté
Pfevracené normaly — vypnuté Pfevracené normaly — zapnuté
Oboustranné osvétleni — zapnuté Oboustranné osvétleni — zapnuté
Obréazek 183: Priklady prevracenych normal a oboustranného
osveétleni

@ Poznamka

Obrazek 183 demonstruje pouZiti 3D efektu Prevratit normaly ve spojeni s efektem
Oboustranné osvétleni.

— Oboustranné — 3D objekt ma vnéjsi (pfedni) a vnitini (zadni) stranu. Pokud je efekt
Oboustranné vypnuty, vykresli se pouze vngjsi strana objektu. Pfi pohledu zvenci se
zda, Ze objekt je pevny, ale pfi pohledu zevnitf je ¢elni strana prihledna. Pokud neni
vidét na vnitini stranu pro protazeny 3D objekt s pevnou texturou, mél by byt efekt
Oboustranné vypnuty, aby se zlepsil vykon pfi vykreslovani. Jakykoli 3D objekt
vytvofeny pomoci rotace ¢asto umoziiuje vnitfni pohled a doporucuje se zapnout

funkci Oboustranné.

3D efekty - stinovani

Na strance Stinovani dialogového okna 3D efekty (obrédzek 184) jsou k dispozici mozZnosti
nastaveni stinovani, stinu a efektll kamery na vybraném 3D objektu.

« Stinovani — urCuje reZim stinovani aplikovany na 3D objekt (obrazek 185).

— Gouraudovo — tento rezim stinovani je metoda pouZzivana v pocitacové grafice
k simulaci rozdilnych Géink( svétla a barvy na povrchu objektu. V praxi se pouziva
k dosazeni plynulého osvétleni na plochach s malym poétem mnohouhelnik( bez
velkych vypocetnich narok( na vypocet osvétleni pro kazdy pixel.

— Phongovo — tento rezim stinovani je interpolacni technika pro stinovani povrchu, ktera
po&ita normalu jako bod v polygonu interpolaci normal vrchold. Uhel mezi normélou

s w7

a smérem osvétleni urCuje, jak velka ¢ast osvétleni se pouzije k obarveni pixelu.

— Ploché — tento rezim stinovani se tyka zobrazeni vnimani hloubky v 3D modelech
nebo ilustracich pomoci rlizné Urovné tmavosti. Pfifazuje jednu barvu stinovani
jednomu segmentu na povrchu objektu.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/


http://documentation.libreoffice.org/en/

.........

o | O

.....

Stinovani

Rezim

Stin

Kamera

Vzdalenost

B Sklon povrchu

1%

¢

7

Ohniskova vzdalenost | 10,00 cm

B o Q| [ v
Gouraudovo bl
0° =
0,10 cm %

Obréazek 184: Dialogové okno 3D efekty - stranka Stinovani

ReZim
Phongov

Rezim
Gouraudov

Rezim
plochy

Obréazek 185: Priklady reZimu stinovani
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» Stin — pfida nebo odstrani stin z vybraného 3D objektu (obrazek 186). Stin se vytvari
pouze z prvniho zdroje svétla. Zadame Sklon povrchu od zdroje svétla k povrchu
v rozmezi 0 az 90 stupiil pro vrzeni stinu.

0° sklon 50° sklon

stinovani stinovani
Obréazek 186: Priklady thlu povrchu stinu

* Kamera — nastavi moznosti kamery pro vybranou 3D scénu, jako by se kamera
pouzivala k pofizeni fotografie (obrazek 187). Nastaveni ovliviiuje pouze centrélni
perspektivu, nikoli paralelni projekci.

— Vzdalenost — zadame vzdalenost, kterou chceme ponechat mezi kamerou a stfedem
vybrané 3D scény. Vychozi nastaveni vzdalenosti je 2,6 cm.

— Ohniskovéa vzdalenost — zadame ohniskovou vzdalenost objektivu fotoaparatu,
pficemz mal& hodnota odpovida objektivu typu rybi oko a velka hodnota teleobjektivu.
Vychozi nastaveni ohniskové vzdalenosti je 10 cm.

Predvolené nastaveni Vzdalenost 10 cm
Vzdalenost 2,6 cm Ohn. vzalenost 100 cm
Ohn. vzalenost 10 cm

Obréazek 187: Priklad zmény nastaveni kamery

3D efekty — osvétleni

Stranka Osvétleni dialogového okna 3D efekty (obrazek 188) uréuje zplisob osvétleni 3D scény
a nastaveni se vztahuje na vSechny 3D objekty ve scéné. Pro 3D scénu lze zadat smér zdroje
svétla, barvu zdroje svétla a okolni svétlo.

Ve vychozim nastaveni je pfi otevieni stranky Osvétleni jiz vybran jeden zdroj svétla. Pro
osvétleni Ize zvolit vice zdroji svétla. Lze pouZit maximalné osm zdrojl a kazdy zdroj svétla
mUZe mit jinou barvu. Na obrazku 188 jsou zobrazeny tfi vybrané zdroje svétla, pficemz kazdy
zdroj svétla ma jinou barvu.
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Osvétleni

Zdroj svétla

0

g e e @

I svétie éervenohnéda 1 v | @&

Ambientni osvétleni - Svétle modra 1 v | &

Obréazek 188: Dialogové okno 3D efekty - stréanka
Osvétleni

s s o~

1) Vybérem polozky Zdroj svétla zapneme zdroj svétla. Ikona se zméni na svitici Zarovku.
2) Opétovnym kliknutim na vybrany zdroj svétla upravime barvu zdroje svétla.

3) Vybereme barvu svétla z jedné z barevnych palet v rozeviracim seznamu Zdroj svétla.
Pro kaZzdy zvoleny zdroj svétla Ize pouZzit jinou barvu.

4) Vybérem barvy z jedné z barevnych palet v rozeviracim seznamu Ambientni osvétleni
nastavime barvu okolniho svétla.

5) Chceme-li zruSit vybér zdroje svétla, vybereme jiz vybrany zdroj svétla a znovu na néj
klepneme.

Umisténi a barva svételného zdroje jsou zobrazeny v pravém dolnim rohu stranky Osvétleni.

Svisly posuvnik nastavuje Uhel osvétleni a vodorovny posuvnik otaci svétlo kolem objektu.
Pripadné klepneme na svételny bod a pfetahneme zdroj svétla na poZadované misto.

Chceme-li zménit nahled z koule na krychli, klepneme na maly &tvereCek napravo od
vodorovného posuvniku a pod svislym posuvnikem.

Kazdy vybrany zdroj svétla se zobrazi jako mala barevna kulicka v barvé, ktera je pro néj uréena.
VétSi barevna koule oznacuje aktivni zdroj svétla.

3D efekty — textury

Na strance Textury dialogového okna 3D efekty (obrazek 189) Ize nastavit vlastnosti textury
povrchu pro vybrany 3D objekt. Funkce Textury je k dispozici pouze po nastaveni vyplné plochy
3D objektu na Pfechod, Srafovéni, nebo Rastr. Dalsi informace o zméné vypIné oblasti
nalezneme v kapitole 4, Zména atribut(i objektu.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/
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» Typ — nastavuje barevné vlastnosti textury.
— Cernobila — pfevede texturu na ¢ernou a bilou
— Barevna — pfevede texturu na barvu.

5[0 ] [m][e

Textury
Typ =
ReZim &
Projekce X
Projekce Y
v

Filtrovani

Obréazek 189: Dialogové okno 3D efekty - stranka Textury

» ReZim - zobrazi nebo skryje stinovani.

— Pouze textura — aplikuje texturu bez stinovani.

— Textura a stinovani — aplikuje texturu se stinovanim. Moznosti stinovani textury
nalezneme v ¢asti ,3D efekty — stinovani“ vySe.

— Textura, stin a barva — aplikuje texturu se stinem a barvou. MozZnosti stinovani textury
nalezneme v ¢asti ,3D efekty — stinovani“ vyse.

* Projekce X — nastavuje mozZnosti zobrazeni textury podél osy X. Lze vybrat pouze jednu
Z nasledujicich tfi moznosti.

— Specificka pro objekt — automaticky upravi texturu tak, aby co nejlépe odpovidala
tvaru a velikosti objektu. Toto je vychozi nastaveni s vyjimkou plastickych objektd.

— RovnobéZna — aplikuje texturu rovnobézné s vodorovnou osou a zrcadli se na zadni
strané objektu. Jedné& se o vychozi nastaveni pro plastické objekty.

— Kruhova — obtaci vodorovnou osu vzoru textury kolem objektu.

* Projekce Y — nastavuje moznosti zobrazeni textury podél osy Y. Lze vybrat pouze jednu
z nasledujicich tfi moZnosti.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/
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— Specificka pro objekt — automaticky upravi texturu tak, aby co nejlépe odpovidala
tvaru a velikosti objektu. Toto je vychozi nastaveni s vyjimkou plastickych objektd.

— RovnobéZna — aplikuje texturu rovnhobézné se svislou osou a zrcadli se na zadni
strané objektu. Jedna se o vychozi nastaveni pro plastické objekty.

— Kruhova — obt&ci svislou osu vzoru textury kolem objektu.
 Filtrovani — odfiltruje Sum, ktery mdze vzniknout pfi aplikaci textury na 3D objekt.

— Filtrovani zap/vyp — aplikuje filtr jemného zaostfeni, ktery mirné rozostfi texturu
a odstrani nezadouci skvrny.

3D efekty — Material

Na strance Materialy dialogového okna 3D efekty (obrazek 190) Ize zménit vzhled 3D objektu
tak, aby reprezentoval rlizné materialy. Materidly a textury Ize vzajemné& kombinovat a dosahnout
poZadovaného vysledku je otdzkou pokusl a omyld.

* Material — pfifadi barvu z palety barev. DalSi informace o vytvareni vlastnich barev
nalezneme v kapitole 11, Pokrocilé techniky kresleni.

— Oblibené — vybereme typ materialu pro vybrany objekt z rozeviraciho seznamu
Oblibené.

— Barva objektu — vybereme barvu z jedné z barevnych palet v rozeviracim seznamu
Barva objektu.

— Barva osvétleni — vybereme barvu z jedné z barevnych palet v rozeviracim seznamu
Barva osvétleni. Tim se objekt osvétli a ¢asti objektu, které jsou ve stinu, se rozjasni,
takZe se objekt zda byt vice osvétleny.

* Odraz — nastavi vlastnosti odrazu svétla pro vybrany objekt simulujici odrazivost
povrchu. Poloha osvétleného bodu je urena nastavenim prvniho svételného zdroje.

— Barva — v rozeviracim seznamu Barva vybereme z jedné z barevnych palet barvu,
kter4 se ma od objektu odrazet.

— Intenzita — zadame intenzitu zrcadlového efektu v procentech.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/
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Material
Oblibene |Definované ufivatelem ~ |
Barva objektu |- Svétle modra 1 - &
Barva osvétlen( B Cemns v | &
Odraz
Barva [ |ena v | @
Intenzita 15 % =

Obréazek 190: Dialogové okno 3D efekty - stranka
Materialy

» Dialogové okno Barvy — otevie dialogové okno Vybér barvy, ve kterém se definuji
vlastni barvy pomoci dvourozmérného grafického a Ciselného grafu gradientu. V3echny
vytvofené barvy jsou uloZeny ve vlastni paleté. DalSi informace o vytvafeni vlastnich
barev najdeme v kapitole 11, Pokrocilé techniky kresleni.

Q Poznamka

Kovové a sklenéné povrchy nelze dobfe simulovat, protoZe vzhled téchto materiall
je vytvaren pomoci odrazu.

0 Tip

NepouZzivejte pro jednotlivé barvy pfilis vysokou hodnotu jasu. Barvy se skladaji
a snadno se mlize stat, Ze barevna plocha bude bila.

Skladani objektt

Vice 3D objektll nelze kombinovat pomoci Tvar > SloZit v hlavni nabidce nebo klavesovou
zkratkou Shift + Ctrl + K. Nejprve je tfeba vytvofrit vice 2D objektll a poté jeden 3D objekt (vice
informaci o skladani objektl nalezneme v kapitole 5, Skladani vice objekt():

1) Vytvorime vice 2D objektd a provedeme vSechny potfebné Upravy.
2) Uijistime se, Ze jsou vybrany vSechny 2D objekty, abychom vytvofili jeden 3D objekt.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/
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3) Vytvorime jeden 3D objekt kombinaci nékolika 2D objektt pomoci jedné z nasledujicich
metod (priklady prevod( jsou uvedeny na obrazku 191):

— Klepneme na Na 3D objekt nebo Na 3D rota¢ni objekt na nastrojové listé Kresba.

— Klepneme pravym tlacitkem mysSi na vybrané vicenasobné 2D objekty a z mistni
nabidky vybereme moznost Pfevést > Na 3D objekt nebo Na 3D rota¢ni objekt.

— V hlavni nabidce zvolime Tvar > Pfevést > Na 3D objekt nebo Na 3D rotacni
objekt.

e

Vicero 2D objektl SloZeno SloZzeno prevedenim
pomoci 3D na 3D rotacni objekt

Obrazek 191: Priklad vytvoreni jednoho 3D objektu z vice 2D objektl

Skladani 3D objektii

3D objekty, z nichz kazdy tvofi samostatnou 3D scénu, Ize kombinovat nebo skladat do jedné 3D
scény. Priklad postupu sestavovani 3D objektl je uveden na obrazku 192:

1) Vybereme 3D objekt (napfiklad krychli) z nabidky 3D objekty na nastrojové listé Kresba
nebo z karty Tvary na postranni lité a umistime jej do vykresu.

2) Vybereme druhy 3D objekt (napfiklad kouli) z nabidky 3D objekty na nastrojové listé
Kresba nebo z karty Tvary na postranni listé a umistime jej do vykresu.

3) V pfipadé potfeby nastavime vyplf oblasti na Nic a Cary na Souvislé, abychom vytvorili
objekty draténého ramecku. To usnadiiuje umisténi obou objektll do sestavené 3D scény.

4) Vybereme druhy 3D objekt (kouli) a v hlavni nabidce zvolime Upravit > Vyjmout nebo
klikneme na objekt pravym tlacitkem mysSi a z mistni nabidky vybereme Vyjmout.

5) Dvakrat klikneme na prvni 3D objekt (krychli), abychom upravili skupinu nebo v hlavni
nabidce zvolime Tvar > Skupina > Upravit skupiny.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/
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Obrazek 192: Priklad sestaveni 3D objektli

6) V hlavni nabidce zvolime Upravit > Vlozit nebo klikneme pravym tlacitkem mySi na prvni
3D objekt a z mistni nabidky vybereme Vlozit. Koule se nyni objevi uvnitf krychle a je
nyni soucasti stejné skupiny.

7) V pfipadé potfeby upravime jednotlivé objekty nebo zménime jejich pozici ve skupiné.

8) Upravu skupiny ukon&ime dvojklikem mimo sestavenou 3D scénu nebo v hlavni nabidce
zvolime Tvar > Skupina > Opustit skupinu.

0 Poznamka

Po provedeni VloZit se druhy objekt objevi na svém plvodnim misté. Tento objekt
NENI soucasti sestavené 3D scény a v pfipadé potfeby jej Ize odstranit.

Dokumentace LibreOffice je dostupna na strance https://documentation.libreoffice.org/en/
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Spojnice a zachytné body

Spojnice a zachytné body byly struéné predstaveny v kapitole 2, Kresleni zakladnich tvar(. V této
Casti je podrobné popiSeme a vysvétlime, jak je pouZivat.

Spojnice jsou ¢ary nebo Sipky, jejichz konce se automaticky pfipoji ke spojovacimu nebo
zachytnému bodu na okraji objektu. Spojnice jsou ve vykresech uzite¢né, protoze spojovaci Cary
mezi objekty zlstavaji spojeny s objekty, i kdyZ se objekty pfesouvaji nebo méni své usporadani.
Pokud je objekt s pfipojenou spojnici pfesunut nebo je zménéna jeho velikost, pfizplsobi
spojnice automaticky svdj tvar témto zmé&nam.

Napfiklad pfi vytvareni vyvojovych diagramd, organiza¢nich diagram(, schémat nebo diagram
se doporucuje pouZzivat spojnice namisto jednoduchych €ar. PouZitim spojnic se vyhneme
prekreslovani Car mezi objekty.

Kdyz je nakreslena nebo vybrana spojnice, program Draw zobrazi Gchyty pro vybér, které se liSi
od Gchytd pro vybér béZnych ¢ar nebo objektl. Krajni body spojnic jsou v pocateénim

a koncovém bodé kulaté a Ctvercové ve stiedu Car, které tvori konektor, jak ukazuje pfiklad na
obrazku 193. Ctvercové tichyty pro vybér na spojnici slouZi pfipadné& ke zméné sméru spojnice.

-

— TT—
/Zakfivené. spojnice T
.

/
/
f
|
|

Prazdny /
ramec

Spojnice konéicfl &lpkou
Obréazek 193: Priklad spojnic mezi objekty

Spojnice

Program Draw nabizi rozséhly vybér spojnic, které umoZznuji propojit objekty napfiklad ve
vyvojovém diagramu nebo organizacnim schématu. K vychozi sadé spojnic Ize pfistupovat
jednim z nasledujicich zplsobu:

» Klepneme na maly trojuhelnik v vpravo od ikony Spojnice na nastrojove listé Kresba.
Ikona Spojnice méni tvar v zavislosti na posledni pouzité spojnici.
* Spojnici vybereme z dostupnych moznosti v ¢asti Spojnice na karté Tvary v postranni
liSté.
V pfipadé potfeby Ize spojnice na nastrojove listé Kresba zobrazit jako plovouci néstrojovou listu
Spojnice:
9) Klepneme na maly trojuhelnik ¥ vpravo od ikony Spojnice na nastrojové listé Kresba.
10) Klepneme na horni ¢ast zobrazené nastrojové liSty a pfetdhneme ji na pracovni plochu.

11) Uvolnime tlacitko mySi a zobrazena nastrojova lista se stane plovouci nastrojovou listou
Spojnice (obrazek 194).

Spojnice v X
'L\Eﬁ"ul\ah"ul\eh@

Obrazek 194: Plovouci nastrojova lista
Spojnice
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“l.  Spojnice konéi Sipkou = Zakiivena spojnice zacina Sipkou
“. Piima spojnice konéi Sipkou “ Cérova spojnice zacind sipkou
= %akﬁvené spojnice konci Sipkou 1. Spojnice konéi kruznici

5| Crové spojnice kondi Sipkou “. Piima spojnice konéf kruznici

“l. Spojnice = Zakfivena spojnice konci kruZnici
“. Piima spojnice . Cérova spojnice konéi kruZnici
':5 %?mg?"é s-pc-njnice "L Spojnice zacina kruZnici

' Carova spojnice “. Piima spojnice zacina kruZnici

. Spojnice se sipkami = Zakiivena spojnice zacina kruznici
“. Pfima spojnice se Sipkou " Carova spojnice zacina kruZnici
= %akﬁvgné spojnice se Sipkou “L. Spojnice s kruznicemi
AT I “. Piima spojnice s kruZnici

‘L Spojnice zacina sipkou = Zakiivena spojnice s kruZnici
". Piima spojnice zacina dipkou . Carova spojnice s kruZnicf

Obrazek 195: Spojnice dostupné na nastrojové listé Spojnice

Typy spojnic

Uplnou nabidku pfeddefinovanych spojnic ziskame klepnutim na maly trojuhelnik ¥ vpravo
vedle nadpisu nastrojové liSty Spojnice, z mistni nabidky vybereme Viditelna tlacitka (obrazek
195). V zavislosti na pouzitém pocitaCovém systému jsou jiZ nainstalované spojnice na
nastrojové listé oznaCeny bud' zaSkrtnutim u ndzvu, nebo je ikona spojnice zvyraznéna.

Dostupné spojnice se déli do Etyf skupin:

Standardni — nazev spojnice za¢ina slovem Spojnice. Carové segmenty jdou svisle
a vodorovné. Vytvareji spojnice s jednim nebo vice ohyby pod Ghlem 90 stupiid.
Klepneme na zachytny bod objektu, nasledné pfetahneme kurzor k zachytnému bodu
jiného objektu, a tim vytvofime standardni spojnici.

Cara — nazev spojnice zac¢ina slovem Céara Sklada se z ¢arového tseku se dvéma
kratSimi GUseky na koncich, vykresluje se s ohyby blizko zachytnych bodl. Klepneme na
zachytny bod objektu, pfetahneme jej na zachytny bod jiného objektu a tim vytvofime
¢arovou spojnici. Chceme-li upravit délku usecky mezi bodem ohybu a zachytnym
bodem, klepneme na spojnici a pfetahneme bod ohybu.

PFimé — nazev spojnice zacina slovem PFfimé. Je tvofena useckou. Klepneme na
zachytny bod objektu, nasledné pretahneme kurzor k zachytnému bodu jiného objektu,
a tim vytvofime pfimou spojnici.

Zakfiveny — nazev spojnice zacina slovem Zakfiveny. Na zakladé Bézierovych krivek se
zakfivena spojnice ohyba kolem objektll. Vykresluji se jako kfivky. Klepneme na zachytny
bod objektu, pfetdhneme kurzor na zachytny bod jiného objektu, a tim vytvofime
zakfivenou spojnici.

Pridani spojnic
1) Klepneme na maly trojuhelnik v vpravo od ikony Spojnice na nastrojové listé Kresba.

otevieni dostupnych moznosti pro vybér spojnic (obrazek 194 a 195).

2) Vybereme pozadovany typ spojnice. DalSi informace o typech spojnic nalezneme v casti

»TYPY Spojnic" vySe.
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3)

4)
5)

6)

-
.

Obrazek 196: Priklad
zachytného bodu objektu

Po presunuti kurzoru nad jeden z pfipojovanych objektli se kolem okrajli objektu objevi
malé k¥iZzky, obvykle ve stejné poloze jako uchyty pro vybér objektu. Tyto kfizky jsou
zachytné body, ke kterym lze pfipoijit spojnici (obrazek 196). Vice informaci o zachytnych

bodech nalezneme v ¢éasti ,Zachytné body" na strané 203.

Klepnutim na zvoleny zachytny bod ukotvime pocate¢ni bod spojnice, potom klepneme
a pfetazenim kurzoru nakreslime spojnici k jinému objektu.

Kdyz se kurzor nachazi nad zachytnym bodem cilového objektu, uvolnime tlagitko mysSi
a spojnice bude nakreslena. Koncovy bod spojnice je ukotven k zachytnému bodu.

Ctvercové Uchyty pro vybér, které se objevi na konektoru, slouzi k Gpravé drahy
konektoru tak, aby nezakryval zadny jiny objekt ve své draze. Jak zménit trasu spojnice
tak, aby se vyhnula objektlim, pres které prochazi, se dozvime v ¢asti ,Uprava spojnic".

Poznamka

Koncovy bod spojnice je mozné umistit do prazdné ¢asti dokumentu. Po uvolnéni

tlaCitka mysi se nepfipojeny koncovy bod spojnice uzamkne na misté, dokud jej

nepfesuneme na misto jiné.

Poznamka

PocateCni a koncovy bod spojnice neni mozné zamenit, tzn. Ze by se pocate¢ni bod

stal koncovym bodem a koncovy bod pocate¢nim. Pokud chceme zaménit koncové

body, je nutné nakreslit novou spojnici v opacném smeru.

Uprava spojnic

Pokud chceme spojnici rozpojit nebo zménit jeji polohu, klepneme a pretahneme libovolny
kruhovy koncovy bod ¢ary spojnice na jiné misto. Priklad kruhovych koncovych bod{ nalezneme
na obrazku 193 na strané 200.

Chceme-li zménit trasu spojnice mezi objekty tak, aby nepfekryvala Zadné objekty na trase,
klepneme na Ctvercovy ovladaci prvek na linii spojnice a pfetdhneme jej na nové misto. Priklad
¢tvercovych ovladacich bodl nalezneme na obrazku 193 na strané 200.

Pokud chceme spojnici upravit, klepneme pravym tlacitkem my3Si na spojnici a z mistni nabidky
vybereme Spojnice. Tim otevieme dialogové okno Spojnice (obrazek 197). V tomto dialogovém
okné miZeme zmeénit typ spojnice a jeji vlastnosti.

Typ - z rozeviraciho seznamu vybereme typ spojnice. Vice informaci nalezneme v Gasti
“Typy spojnic” na strané 201.
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Typ: ‘Béi'né spojnice o |

Zkoseni cary
Cara 1: 0,00 cm =
Cara 2: 0,00 cm =
Cara 3: 0,50 cm =
Vzdalenost éar

Vodorovny pocatek: 0,50 cm

Vodorovny konec: 0,50 cm

AR AL (A

Svisly pocatek: 0,50 cm
Svisly konec: 0,50 cm
Napovéda oK Zrusit

Obrazek 197: Dialogové okno Spojnice

s vz

» Zkoseni €ary — definuje zkoseni ¢ary spojnice. V nahledu tohoto dialogového okna je
zobrazen vysledek jakychkoliv zmén.

* Vzdalenost ¢ar — nastavuje vzdalenost spojnic.

Vodorovny pocatek — zadani velikosti vodorovného prostoru poZzadovaného na
zaCéatku spojnice.

Svisly pocatek — zadani velikosti svislého prostoru poZzadovaného na zacatku
spojnice.

Vodorovny konec — zadani velikosti vodorovného prostoru pozadovaného na konci
spojnice.

Svisly konec — zadani velikosti svislého prostoru poZzadovaného na konci spojnice.

¢ Oblast ndhledu — zobrazuje nahled pouzitych objektli a konektor(l. Klepnutim levym
tlaCitkem mysi v oblasti ndhledu si nahled priblizime; klepnutim pravym tlacitkem mysi
v oblasti nahledu si ho oddalime.

Zachytné body

Zachytné body nejsou totéZ jako Uchyty pro vybér objektu. Uchyty pro vybér slouZi k pfesouvani
nebo zméné tvaru objektu (vice informaci viz kapitola 3, Prace s objekty a body objekt().

Z&chytné body slouZi k pfichyceni nebo ukotveni spojnice k objektu tak, Ze pfi pfemisténi objektu

k nému zlstava spojnice prichycena.

VSechny objekty maji zachytné body, které se normalné nezobrazuji a zviditelni se pouze pfi
pouZiti jedné z nasledujicich moznosti, obrdzek 196 na strané 202 ukazuje pfiklady zachytnych
bod{ viditelnych na objektu po vybéru spojnice.

* Na nastrojové listé Kresba je zvolen nastroj Spojnice. Ikona Spojnice zobrazena na
nastrojové listé Kresba je typ spojnice, ktery byl naposledy pouZit.

* Typ spojnice je vybran v ¢asti Spojnice na karté Tvary v postranni liSté.
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Zachytné body v X
B B 3 4 [
Obrazek 198: Nastrojova lista Zachytné body

Pokud chceme pridat, upravit nebo odstranit zachytné body, aktivujeme nastrojovou listu
Zachytné body pomoci volby Zobrazit > Nastrojové liSty > Zachytné body v hlavni nabidce
(obradzek 198). Tato nastrojova liSta se zobrazi pouze po pouziti jedné z nasledujicich moZznosti:

Klepneme na Zobrazit funkce zachytnych bodi na Standardni nastrojové listé nebo na
nastrojové listé Kresba.

V hlavni nabidce vybereme Upravit > Zachytné body

Poznamka

Zobrazit funkce zachytnych bod( na nastrojové listé Kresba neni souc¢asti vychozi
sady nastrojl této listy. Pokud chceme takovy néastroj pridat, klepneme pravym
tlaCitkem my3i na prazdné misto na nastrojové listé Kresba a z mistni nabidky
vybereme Viditelna tla€itka > Zachytné body.

Druhy zachytnych bodu

KdyZ se otevie nastrojova lista Zachytné body, je aktivnich pouze pét nastroji umisténych vievo
od nastroje Relativni zachytny bod. Zbyvajicich Sest nastroji v pravé ¢asti se aktivuje, az kdyz
zruSime vybér néstroje: Relativni zachytny bod.

Vlozit zachytny bod — po klepnutim mysSi vlozi zachytny bod na pozici kurzoru v objektu
Vystup doleva — spojnice se k zachytnému bodu pfipojuje zleva.

Vystup nahoru — spojnice se k zachytnému bodu pfipojuje shora.

Vystup doprava — spojnice se k zachytnému bodu pfipojuje zprava.

Vystup dolii — spojnice se k zachytnému bodu pfipojuje zdola.

Relativni zachytny bod — pokud je vybrana tato moznost, zachytny bod se pfi zméné
velikosti objektu pohybuje a zachovava svou polohu vzhledem k hranicim objektu. Je-li je
vybér zruden, je mozné po zmeéné velikosti objektu upravit polohu zachytného bodu.
Kdyz se otevie nastrojova liSta Zachytné body, je tento nastroj zvolen ve vychozim
nastaveni. Nasledujicich Sest nastrojl je aktivnich pouze tehdy, pokud neni vybrana
volba Relativni zachytny bod.

Zachytny bod horizontalné vlevo — pii zméné velikosti objektu zlistane zvoleny
zachytny bod umistén pevné na levém okraji objektu.

Zachytny bod horizontalné uprostied — pfi zméné velikost objektu zlistane zvoleny
zachytny bod umistén pevné na vodorovném stfedu objektu.

Zachytny bod horizontalné vpravo — pii zméné velikost objektu zlistane zvoleny
zachytny bod umistén pevné na pravém okraji objektu.

Zachytny bod vertikalné nahofe — pii zméné velikosti objektu zlistane zvoleny
zachytny bod umistén pevné na hornim okraji objektu.

Zachytny bod vertikalné uprostied — pii zméné velikosti objektu zlistane zvoleny
zachytny bod umistén pevné na svislém stfedu objektu.

Zachytny bod vertikalné dole — pii zméné velikosti objektu zlistane zvoleny zachytny
bod umistén pevné na spodnim okraji objektu.

Spojnice a zachytné body | 179



Poznamka

Kazdy pridany zachytny bod objektu mdze mit pouze jednu vodorovnou a jednu
svislou pozici. Proto miZeme vybrat vZdy jen jeden horizontalni a jeden vertikalni
nastroj.

Pridani zachytnych bod(i
Ve vychozim nastaveni ma vétSina objektd obvykle ¢tyfi zachytné body, jak ukazuje priklad na
obrazku 196 na strané 202. Objektu pfidame zachytné body nasledovné:

1)

2)

3)
4)

5)
6)

7

8)

Nastrojovou liStu Zachytné body zobrazime pomoci volby Zobrazit > Nastrojové listy >
Zachytné body v hlavnim menu.

Ujistime se, Ze neni zvolen Zadny objekt a pomoci jedné z nasledujicich moznosti
otevieme nastrojovou listu Zachytné body:

— Klepneme na Zobrazit funkce zachytnych bodi na Standardni nastrojové listé nebo
na nastrojove listé Kresba.

— V hlavni nabidce vybereme Upravit > Zachytné body
Vybereme objekt a klepneme na Vlozit zachytny bod na nastrojové listé Zachytné body.

Pfesuneme kurzor na poZzadované misto na vybraném objektu a kurzor se zméni na
kfizek (v zavislosti na nastaveni pocitace).

Jednim klepnutim pfidame zachytny bod. Pokud chceme pfidat vice zachytnych bod(,
presuneme kurzor na novou pozici a klepneme.

Po pridani vSech pozadovanych zachytnych bodd pfesuneme kurzor mimo vybrany
objekt a klepnutim na prazdné misto zruSime vybér.

Pfipadné klepneme pravym tlaCitkem mysi na zachytny bod, ktery byl dfive pfidan
k objektu, vybereme z mistni nabidky moZnost Vlozit zachytny bod a poté klepneme
a prfetdhneme novy zachytny bod na poZadované misto.

Z moznosti dostupnych na nastrojové listé Zachytné body zvolime poZzadovany typ
zachytného bodu. Vice informaci nalezneme vyS$e, v ¢asti ,Druhy zachytnych bod(”.

Poznamka

Pokud objekt nema zadnou vypli, je mozné zachytny bod pridat pouze k okraiji
prazdného objektu.

6 Tip

Pro pfidavani, pfesun a tpravy zachytnych bodd doporu¢ujeme pouzit funkci
pfiblizeni, aby se s body lépe pracovalo. Vice informaci nalezneme v kapitole 3,
Prace s objekty a body objektd. Zachytné body mliZzeme prichytavat k mfiZce,
shadnégji se tak umistuiji.

Prizplsobeni zachytnych bodu
Prizplsobit miZeme pouze ty zachytné body, které jsme sami pridali. Vychozi zachytné body
objektll prizplsobit nelze.

PrizpUsobit smér vystupu pro zachytny bod pfidany k objektu mizeme takto:

1)

2)

Nastrojovou listu Zachytné body zobrazime pomoci volby Zobrazit > Nastrojové listy >
Zachytné body v hlavnim menu.

Otevieme nastrojovou liStu Zachytné body:
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3)

4)

Dvojitym klepnutim na zachytny bod, ktery byl pfidan k objektu, zvolime ten bod, jenz
chceme pfizpUsobit.

PoZadovany smér vystupu pro pfipojeni spojnice k zachytnému bodu vybereme pomoci

jedné z nésledujicich moznosti:

— Na nastrojové listé Zachytné body klepneme na smér vystupu.

— Pravym tlacitkem mysSi klepneme na zachytny bod a z mistni nabidky zvolime smér
vystupu.

Vodorovné a svislé umisténi zachytného bodu, ktery byl pfidan k objektu, provedeme takto:

1)

2)
3)

4)

5)

Nastrojovou liStu Zachytné body zobrazime pomoci volby Zobrazit > Nastrojové listy >
Zachytné body v hlavnim menu.

Otevieme nastrojovou liStu Zachytné body:

Dvojitym klepnutim na zachytny bod, ktery byl pfidan k objektu, zvolime ten bod, jenz
chceme prizpUsobit.

Klepnutim na Relativni zachytny bod na nastrojové listé Zachytné body zrusime

oznaceni tohoto nastroje. Odznadit jej miiZzeme také klepnutim pravého tlacitka mysi
a vybérem Relativni zachytny bod z mistni nabidky.

Pomoci jedné z nasledujicich moznosti zvolime vodorovné a svislé polohovaci néstroje
pozadované pro dany zachytny bod. V jednom okamziku Ize pouzit pouze jeden
vodorovny a jeden svisly polohovaci nastroj:

— Klepneme na poZadované vodorovné a svislé zarovnani na nastrojove listé Zachytné
body.

— Pravy tlaCitkem mysi klepneme na zachytny bod a z mistni nabidky vybereme
pozadované vodorovné a svislé umisténi.

Smazani zachytnych bodu
Smazat mizeme jen ty zachytné body, které jsme dfive pfidali. Vychozi zachytné body objekt(
smazat nemiZeme.

1)
2)

Vybereme zachytny bod k odstranéni, ktery jsme dfive k objektu pfidali.
Stiskneme klavesu Delete nebo jdeme do nabidky Upravy > Vyjmout.

Text spojnice

Ke spojnicim Ize snadno pfidavat text a nasledné jej i formatovat, napriklad pro snazsi sledovani
vyvojového diagramu nebo organizacniho schématu. Vice informaci o praci s textem a jeho
formatovanim nalezneme v kapitole 9, Pfidavani a forméatovani textu.

Pridavani textu

1)
2)

3)
4)

Vybereme spojnici a ovladaci body se stanou aktivhimi.

Klepnutim na VloZit textové pole nebo Vlozit svisly text (pokud je pfidan) na
Standardni nastrojové listé (obrazek 199) nebo nastrojové listé Kresba (obrazek 200)
prejdeme do textového rezimu. V blizkosti spojnice se zobrazi blikajici textovy kurzor
a otevie se panel nastrojii Formatovani textu (obrazek 201).

Pripadné mlZeme pro vytvofeni vodorovného textu na vybrané spojnici pouzit
klavesovou zkratku F2.

NapiSeme poZadovany text pro tuto spojnici.

V pfipadé potfeby naforméatujeme text spojnice. Vice informaci o forméatovani a Uprave
textu nalezneme v €ésti ,Formatovani a Gprava textu" nize.
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WIoZit textove pole 41:2] WI0Zit svisly text

Srandardni
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Obrazek 199: Standardni nastrojova lista s pfidanym nastrojem VioZit svisly text
VIoZit textove pole (F2)
Kresba J
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\V [0Z it svisly text
Obrazek 200: Nastrojova lista Kresba s pridanym nastrojem VioZit svisly text
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Formatovani textu
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Obréazek 201: Nastrojova lista Forméatovani textu

5) Po dokonceni pfidavani a formatovani textu pfesuneme kurzor od textu a spojnice
a klepnutim ukonc€ime textovy rezim. Tim také zavieme nastrojovou liStu Formatovani

textu.

O Poznamka

Ve vychozi instalaci LibreOffice neni nastroj Vlozit svisly text na Standardni
nastrojové listé a nastrojové listé Kresba dostupny. Chceme-li pfidat nastroj Vlozit
svisly text na nastrojovou liStu, klepneme pravym tlacitkem mysi na prazdnou oblast

na kterékoliv nastrojové listé, zvolime Viditelna tla€itka a z mistni nabidky

vybereme Svisly text.

Text Animace textu

Text objektu kresby
O Sitka podle textu
[ Vyska podle textu
[ Velikost podle ramce
Vzdilenost k ohraniéeni Ukotveni textu

Vlevo: 0,25 cm 0O

b
|

PIna iitka

»

1
0

3

Vpravo: (0,25 cm

4

3

>—n—n

MNahore: 0,13 cm

4

3

Dole; 0,13 cm

4

Napovéda Obnovit OK Zrusit

Obrazek 202: Dialogové okno Text
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Text Animace textu

Efekt

Viastnosti
U Zaéit uvniti

O Viditelny text pii ukonéeni

Cykly animace: Spojité =
Pirstek: Pixely 1 =
Prodleva: Automaticka =
Napovéda Cbnovit OK Zrusit

Obrazek 203: Dialogové okno Text - strana Animace textu

Formatovani a uprava textu

1)

2)

3)

4)

5)
6)

Vybereme spojnici s pfidanym textem a aktivujeme kontrolni body pro vstup do textového
rezimu. Vice informaci o pfidavani textu na spojnici nalezneme v ¢asti ,Pfidavani textu"
vyse.

K forméatovani textu pouzijeme nastroje dostupné na nastrojové listé Formatovani textu
nebo moZnosti dostupné v hlavni nabidce ve volbé Format > Text.

Klepnutim pravym tlacitkem mySi na text spojnice a vybé&rem Text z mistni nabidky

otevieme dialogové okno Text (obrazek 202) a zménime zplsob zobrazeni textu vedle

spojnice. K dispozici jsou tyto moznosti:

— Text objektu kresby — Velikost podle ramce — zméni velikost textu tak, aby vypinil
celou oblast obdélniku nebo ramecku spojnice.

— Text objektu kresby — Prizplisobit obrysu — pfizplsobi tok textu tak, aby odpovidal
obrys(im vybrané spojnice.

— Vzdalenost k ohrani€eni — ur€uje velikost mezery, ktera ma byt ponechana mezi
konektorem a okraji textu.

— Ukotveni textu — vybereme jednu z deviti moznych pozic pro ukotveni textu
v obdélniku spojnice.

— PIna Sitka — ukotvi text na celou Sitku obdélniku spojnice. Pokud je vybrana horni,
stfedni nebo dolni stfedova pozice, Ize ji pouZit k ukotveni textu.

V pripadé potfeby klepnutim na Animace textu otevieme stranku Animace textu
(obrazek 203) a ziskdme pfistup k moZznostem animace textu. UZiti této funkce vSak
nedoporucujeme, neni-li kresba soucasti prezentace. Vice informaci o animaci textu
nalezneme v priru¢ce Privodce programem Impress.

Klepnutim na OK ulozime zmény atributd textu a zavieme dialogové okno Text.

Pfesuneme kurzor pry¢ od textu a spojnice a klepnutim ukoncéime textovy rezim. Tim také
zavieme nastrojovou liStu Formatovani textu.
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Vyvojovy diagram

v X

D0 0mElo00duVolUdan®aE XS AVUADASOO

oo —
00 =

)G

Vywojovy diagram: Pfedem definovany proces

Vyvojovy diagram:

Vyvojovy diagram:
Vywvojovy diagram:

Interni dloZisté

Dokument

Multidokument

Vyvojovy diagram: Terminator

Vywvojovy diagram:
Vyvojovy diagram:
Vywvojovy diagram:

Priprava
Manualni vstup
Manualni operace

Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:

Vyvojovy diagram:
Vyvojovy diagram:

[ ] Vyvojovy diagram: Proces (] Vyvojovy diagram: Karta

(] vyvojovy diagram: Alternativni proces A Vyvojovy diagram: Dérna paska
<> Vyvojovy diagram: Rozhodnuti B0 Vyvojovy diagram: Sjednoceni
] Vyvojovy diagram: Data Vyvojovy diagram: Nebo

Sbér

Razeni

Extrakce

Spojeni

UloZena data
Zpoidéni
Sekvencni piistup
Magneticky disk

Vywvojovy diagram: Konektor Vyvojovy diagram: Piimy pfistup
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Vyvojovy diagram: Vnéj5i konektor
Obrazek 204: Nastrojova lista Vyvojovy diagram a dostupné tvary vyvojovych diagramd

Vyvojovy diagram: Zobrazeni

Vyvojové diagramy

Pro kresleni vyvojovych diagram( ma program Draw k dispozici plovouci nastrojovou listu
Vyvojovy diagram (obrazek 204), ktera obsahuje velky vybér nastrojd pro tvorbu vyvojovych
diagramd.

1) Klepnutim na maly trojuhelnik ¥ napravo od ikony Vyvojovy diagram na nastrojové listé
Kresba otevieme nabidku pro vyvojové diagramy. VSimneme si, Ze ikona vyvojového
diagramu méni svUj vzhled v zavislosti na poslednim pouZitém nastroji ze sady nastrojl
vyvojovych diagram.

2) Klepneme na horni ¢ast kontextové nabidky Vyvojovy diagram a pretahneme ji na
pracovni plochu.

3) Uvolnime tlacitko mySi a z kontextové nabidky se stane plovouci nastrojova lista
Vyvojovy diagram.

Doporucené zakladni kroky pfi tvorbé vyvojového diagramu:

« Informace potfebné pro pfidavani objekt nebo tvard vyvojového diagramu do
vyvojového diagramu nalezneme v kapitole 2, Kresleni zakladnich tvar(, tam se nachazi
informace o kresleni a zméné velikosti tvard objektd.

* Ke kazdému tvaru vyvojového diagramu pfidame text, abychom objekt vyvojového
diagramu snadno identifikovali. Vice informaci nalezneme v kapitole 2, Kresleni
zakladnich tvar( a v kapitole 11, Pokrocilé techniky kresleni.

¢ Ve vyvojovych diagramech pouzivame spojnice. To umoZziuje pfemistovani objektd ve
vyvojovém diagramu pfi zachovani vazeb na ostatni objekty. Vice informaci nalezneme
v Césti ,Spojnice a zachytné body” na strané 200.

«  P¥i umistovani objektd ve vyvojovém diagramu ndam pomohou funkce pfiblizeni, mfizky
a prichyceni. Vice informaci nalezneme v kapitole 3, Prace s objekty a body objektC.

* Pomoci funkci zarovnani a rozdéleni dodame vyvojovému diagramu profesionalné;jsi
vzhled. Vice informaci nalezneme v kapitole 5, Kombinace vice objektd.

« Pokud potfebujeme vice objektl stejného tvaru a velikost, tak objekty duplikujeme. Vice
informaci nalezneme v kapitole 5, Kombinace vice objektd.
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Obrazek 205: Priklad vyvojového diagramu

Vyvoj

Hardware Software

Obréazek 206: Priklad organizacniho schématu

Organiza€ni schémata

Program Draw nemd nastrojovou liStu pro organiza¢ni schémata, ale tato schémata Ize snadno
vytvaret pomoci zakladnich tvard, vyvojovych diagram( a spojnic. Hierarchie v organizaci se
snadno vyznacuje pomoci stinovani a/nebo barvy. P¥i pouZziti stinovani a barvy v organizacnim
schématu se ujistime, Ze vybér poskytuje dobry kontrast mezi textem a stinovanim, pfip. barvou.
Diky tomu je schéma snadno citelné na displeji poCitaCe nebo v tisténém dokumentu.
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Priklad organizacniho schématu je uveden na obrazku 206. Ten byl nakreslen pomoci zakladni
tvaru obdélniku a spojnic.

1)

2)

3)

4)
5)

6)

Informace potfebné pro pridavani objekt do schématu nalezneme v kapitole 2, Kresleni
zéakladnich tvard, zde jsou dostupné informace o kresleni a zméné velikost tvarl objektd.

Pridanim textu ke kazdému objektu organizacniho schématu usnadnime identifikaci
objektu ve schématu. Vice informaci nalezneme v kapitole 2, Kresleni zakladnich tvar
a v kapitole 11, Pokrocilé techniky kresleni.

V organizacnim schématu pouZzijeme spojnice. Ty umoZzni zmeénit polohu objektu ve
schématu pfi zachovani spojeni s ostatnimi objekty. Vice informaci nalezneme v asti
»Spojnice a zachytné body” na strané 200.

PFi umistovani objektll do schématu nam pomohou funkce pfibliZzeni, mrizky a pfichyceni.
Vice informaci nalezneme v kapitole 3, Prace s objekty a body objektd.

Pomoci funkci zarovnani a rozdéleni dodame organizacnimu schématu profesionalné;jsi
vzhled. Vice informaci nalezneme v kapitole 5, Kombinace vice objekt.

Pokud potfebujeme vice objektl stejného tvaru a velikost, tak objekty duplikujeme. Vice
informaci nalezneme v kapitole 5, Kombinace vice objekt(.
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Uvod

Pokud je text pouzit v kresbéach, je umistén uvnitf objektu nebo v textovém poli. Tato kapitola
popisuje vytvareni, formatovani, pouzivani a odstrafiovani textu. Pojednava také o rliznych
typech textu, které Ize do kresby vlozit. Nakonec poskytuje informace o tom, jak vkladat specialni
formaty textu jako jsou Cislované seznamy, odrazkové seznamy, tabulky, pole, hypertextové
odkazy a pismomalba.

Textovy rezim

Pred zadanim jakéhokoli textu do kresby je potfeba jednim z nasledujicich zplsobU aktivovat
textovy rezim. Nastrojova lista Formatovani textu (obrazek 207) se automaticky otevie a nahradi
nastrojovou listu Cara a vypln.

* Pouze pro vodorovny text zvolime Vlozit > Textové pole v hlavni nabidce.

* Pouze pro vodorovny text pouzijeme klavesovou zkratku F2.

* Klepneme na Vlozit textové pole pro vodorovny text nebo Vlozit svisly text na
Standardni nastrojové listé (obrazek 208) nebo néstrojové listé Kresba (obrazek 209).

Formatovani textu
: _ - -
Liberation Sans ~1opt ~| A At B|I U S5 x* x, § /& A
> S — = - — — = . R
ﬁ**‘?‘.:—':—*::;—:;T—-:I—-:'—. ﬁlﬁ 1]—T
Obréazek 207: Nastrojova lista Formatovani textu
Standardni
3 X B0 - e
[i- . - E - E_-‘ |__|1 = s _:I e 5 - £
v X
F 3, - el [i +’ -y
= & @WEO-EFIBE- =AVPXA::
Viozit textove pole (F2) WloZit swisly text
Obréazek 208: Standardni nastrojova lista s pfidanym nastrojem VioZit svisly text
WloZit textove pole (F2)
|
Kresha J w X
BEREL-8-\NO0 —~-¢-L-0-O-=-B-0-%w-0-14

™,
VIDZit svisly text
Obrazek 209: Nastrojova lista Kresba s pridanym nastrojem VioZit
svisly text

Pokud néstroj VloZit svisly text neni viditelny na Standardni nastrojové li5té nebo nastrojove
listé Kresba, miZeme jej na nastrojovou listu pridat takto:

7) Volbou Nastroje > Moznosti > Jazykova nastaveni > Jazyky v hlavni nabidce
otevieme stranku Jazyky v dialogovém okné MoZnosti.
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8) V okné Vychozi jazyky pro dokumenty vybereme moznost Asijské. Pfijmeme vychozi
nastaveni této moznosti.

9) Klepnutim na OK zavieme dialogové okno MozZnosti a zmeény uloZime.

10) Klepneme pravym tlacitkem mysSi do prazdné oblasti na Standardni nastrojové liSté nebo
nastrojové listé Kresba a z mistni nabidky vybereme Viditelna tlacitka.

11) Zrozeviraciho seznamu moznosti vybereme Svisly text a pfidame nastroj Vlozit svisly
text na Standardni nastrojovou liStu nebo nastrojovou listu Kresba.

Rychla hnéda
liSka preskocila
- liného psa

Rozvrzeni Ovladaci prvky Kotovaci cary

Snimek 1z 1 (Rozvrzeni) | Editor textu: Odstavec 1, Radek 1, Sloupec 7
Obrazek 210: Textové informace ve stavovém radku

Textova pole

Vytvareni textovych poli

PTi pridavani textu do kresby se automaticky vytvoreni textové pole, které text obsahuje. Ve
vychozim nastaveni se textové pole rozSifi vodorovné, aby se do néj veSel jeden fadek

~ s

vodorovného textu nebo se rozsifi svisle, aby se do néj veSel jeden fadek svislého textu.
1) Aktivace textového rezimu, viz , Textovy rezim" vySe.

2) Klepneme na pfiblizné misto v kresbé, kam ma byt textové pole umisténo. Vytvofi se
textové pole s blikajicim textovym kurzorem.

3) Do textového pole napiSeme nebo vloZime text a textové pole se rozSifi bud vodorovné
nebo svisle tak, aby se do néj vesel jeden radek textu. V levém rohu stavového radku je
také zobrazen indikator rezimu Uprav textu a pozice textového kurzoru (obrazek 210).

4) Pokud chceme v textovém poli vytvofrit vice fadkd, pouzijeme jednu z nasledujicich
mozZnosti:

— Pomoci klavesy Enter vytvofime uvnitf textového pole jednofadkové odstavce.

Textové pole se rozsifi tak, aby se do né&j veslo vice rfadkl textu.

— Pred psanim textu klepneme a kurzor pretahneme, ¢imz vytvofime textové pole
s priblizné poZzadovanymi rozmeéry. Po dosaZeni hranic textového pole se text
automaticky zabali dovnitf textového pole a textové pole se pfi jeho zaplnéni rozsifi.

5) Po dokonceni vytvafeni nebo vkladani textu klepneme mimo textové pole a ukoncime
textovy rezim. Nastrojova lista Formatovani textu se automaticky zavre.

6) Textové pole miiZzeme podle potfeby presouvat, ménit jeho velikost, otacet nebo
formatovat. DalSi informace najdeme v nasledujici ¢asti nebo v kapitole 3, Prace
s objekty a body objektd.

7) V pripadé potfeby naformatujeme text pomoci rliznych nastroji na nastrojové listé
Formatovani textu nebo v rliznych ¢astech postranni listy. Dalsi informace o formatovani
textu najdeme v €éasti ,Formatovani textu" na strané 225.
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Poznamka

Textova pole nemohou obsahovat ilustrace, vlioZzené obrazky, vzorce, tabulky nebo

tvary.

Presouvani textovych poli

1)

2)
3)

4)
5)

Klepnutim na text v textovém poli aktivujeme textovy rezim a zobrazi se ramecek
textového pole.

] m|
Rychla hnéda liska
preskoeﬂahnehe pSa-=------ :
" Rychia Hréda figkall>ka

pres@b%%qmaﬁa@@@ psa |
: Rychla hneda liska |

i preskocila liného psa !

__________________________________

Obrazek 211: Pfesunuti textového
pole

Pfesuneme kurzor na ramecek. Kurzor zmeéni tvar na symbol pfesunuti podle nastaveni
pocitace (napfiklad seviena ruka).

Klepneme na ohrani€eni a pfetahneme textové pole na nové umisténi v kreshé. Stin
obrysu textového pole ukazuje, kde bude textové pole umisténo (obrazek 211).

Jakmile je textové pole na poZadovaném misté, uvolnime tlacitko mysi.

Pro pfesné umisténi textové pole pouzijeme dialogové okno Umisténi a velikost nebo
¢ast Umisténi a velikost v postranni listé. Vice informaci nalezneme v kapitole 3, Prace
s objekty a body objekt.

Zmeéna velikosti textovych poli

1)

2)

3)

4)
5)

Klepnutim na text v textovém poli aktivujeme textovy rezim a zobrazi se rAmecek
textového pole.

Umistime kurzor na jeden z Gchytl vybéru. Kurzor zmeéni tvar na symbol zmény velikosti
podle nastaveni pocitaCe (napfiklad oboustranna Sipka). Uchytky vybraného textového
pole méni jeho rozmeéry takto:

— Rohové uchytky méni soucasné Sirku i vySku textového pole.
— Horni a dolni stfedové Uchytky méni vySku textového pole.
— Pravé a leva uchytka slouzi ke zméné Sirky textového pole.

Klepnutim a pfetaZzenim ramecku do nového umisténi zménime velikost textového pole.
Stin obrysu textového pole ukazuje, jak se zméni velikost textového pole (obrazek 212).

Jakmile textové pole dosahne poZadované velikosti, uvolnime tlacitko mysi.

Pro pfesnou zménu velikosti textového pole pouzijeme dialogové okno Umisténi
a velikost nebo ¢ast Umisténi a velikost v postranni listé. Vice informaci nalezneme
v kapitole 3, Prace s objekty a body objekt(.
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Obrazek 212: Otaceni textového
pole
Poznamka

Abychom zachovali pomeér stran textového pole, stiskneme a drzime klavesu Shift pri
préaci s uchytkami. Tlac¢itko mySi musime uvolnit dfive, nez pustime klavesu Shift.
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\ /é;
Q
Rychlé)’};n@da liSka
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Obrazek 213: Otaceni
textového pole

Otaceni textovych poli
1) Klepnutim na text v textovém poli aktivujeme textovy rezim a zobrazi se ramecek
textového pole.

2) Klepneme na ohraniCeni textové pole tak, aby byly viditelné Gchyty pro vybér, coz
znamena, Ze textové pole je nyni v reZimu Uprav.

3) Znovu klepneme na ohraniceni textu a Uchyty vybéru zmeéni tvar a velikost.

4) Klepneme na uchyt vybéru v rohu a taZzenim textové pole otoCime. Zobrazi se stin obrysu
otdCeného textového pole a ve stavovem fadku se zobrazi aktuélni uhel oto€eni (obrazek
213).

5) Jakmile je textové pole v poZzadovaném uhlu natoCeni, uvolnime tlacitko mysi.

6) Pro presné otoceni textového pole pouzijeme kartu Otoceni v dialogovém okné Umisténi
a velikost nebo Cast Umisténi a velikost v postranni liSté. Vice informaci nalezneme
v kapitole 3, Prace s objekty a body objektd.

Poznamka

Horni, doIni a bo¢ni achyty pro vybér nejsou v reZzimu otaceni k dispozici pro otaceni
textového pole, ackoliv jsou viditelné. Textové pole nelze ofiznout, zkosit, pfeklopit
vodorovné nebo preklopit svisle.
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Formatovani textovych poli

S textovymi poli Ize pfi forméatovani vypiné oblasti nebo ohrani€eni pole zachazet stejné jako
s ostatnimi zakladnimi tvary v kresbé. Vice informaci o forméatovani vypiné oblasti nebo
ohraniceni textového pole najdeme v kapitole 4, Prace s objekty a body objekt(.

Formatovani zobrazeni textu v textovém poli:

1) Vybereme textové pole a pomoci jedné z nasledujicich moznosti otevieme dialogové
okno Text (obrazek 214).

— Klepneme pravym tlacitkem mySi na textové pole a z mistni nabidky vybereme
Atributy textu.

— V hlavni nabidce zvolime Format > Atributy textu.

2) Klepnutim na Text v dialogovém okné Text otevieme kartu Text a ziskame pristup
k moznostem forméatovani:

— Text objektu kresby — Sitka podle textu — zvétsi Sitku textového pole na délku textu,
pokud je textové pole mensi nez text.

— Text objektu kresby — VySka podle textu — zvétSi vySku textového pole na vysku
textu, pokud je textové pole mensi nez text.

— Text objektu kresby — Velikost podle ramce — zméni velikost (zkresli) textu tak, aby
se vesel do celé plochy textového pole. Tato moznost neni dostupna, pokud je
vybrana moznost Sitka podle textu a/nebo VySka podle textu.

Text Animace textu

Text objektu kresby
O Sitka podle textu
L] wyska podle textu
[ Velikost podle ramce

Vzdalenost k ohraniéeni Ukotveni textu
Vlevo: 0,25 cm = O O O
Vpravo: 0,25 cm = l @ l
Nahofe: (0,13 cm = l a l
Dole: 0,13 cm = [Pina sitka
Napovéda Obnovit OK Zrudit

Obrazek 214: Dialogové okno Text - karta Text
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Text Animace textu

Efekt

+
Rolovat dokola V| Smér. -
¥

Vlastnosti
L Zaéit uvnitf
O Viditelny text pii ukonceni
Cykly animace: Spojité

4

Piirstek: Pixely 1 =
Prodleva: [l Automaticka =
Napovéda Obnovit OK Zrusit

Obrazek 215: Dialogové okno Text - karta Animace textu

— Vzdalenost k ohrani€eni — ur€uje velikost mezery, ktera ma byt ponechana mezi
textem a okrajem textového pole.

— Ukotveni textu — vybereme jednu z deviti pozic pro ukotveni textu v textovém poli.

— PIna Sitka — ukotvi text na celou Sitfku textového pole. Pokud je vybrana horni, stfedni
nebo dolni stfedova pozice ve volbé Ukotveni textu, pouzije se k ukotveni textu.

3) V pripadé potfeby klepneme na Animace textu a otevieme stranku Animace textu
(obrazek 215), kde mame k dispozici moznosti animace textu. Uziti této funkce vSak
nedoporucujeme, neni-li kresba soucasti prezentace. Vice informaci o animaci textu
nalezneme v prirucce Privodce programem Impress.

4) Klepnutim na OK ulozime zmény atributll textu a zavieme dialogové okno Text.
5) Presuneme kurzor mimo textové pole a naslednym klepnutim ukoncime textovy rezim.

Mazani textovych poli

1) Klepneme na textové pole tak, aby byly viditelné Gchyty pro vybér, coz znamena, ze
textové pole je v reZzimu Uprav.

2) Zmackneme klavesu Delete nebo Backspace. Textové pole se odstranéni bez jakéhokoliv
upozornéni.

Text v objektech programu Draw

Text je mozné pridat do vétSiny objektd programu Draw. Vyjimkou jsou ovladaci prvky, napfiklad
tlacitka, mnohouhelniky, kfivky nebo 3D objekty.

Ve vychozim nastaveni neni objekt pfi prvnim vytvoreni v aplikaci Draw dynamicky a nechova se
jako textové pole. Text uvnitf objektu nezalamuje slova. Chceme-li text udrzet v mezich objektu,

musime pouzit odstavce, zalomeni fadku nebo mensi velikost textu, zvétsit velikost objektu nebo
zkombinovat viechny &tyfi zplsoby.
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Mezalomeny text Text Zalomeny
podle tvaru

Obréazek 216: Priklad pouZiti zalomeni textu

Priklad pfidani textu do objektu aplikace Draw (obrazek 216) a nasledné obtékani textu je
nésledujici:

1) V kreshé vytvofime objekt a ujistime se, Ze je objekt vybran a jsou zobrazeny Uchyty
vybéru.

2) Do textového reZzimu vybraného objektu vstoupime pomoci jedné z nasledujicich
moZnosti:

— Na Standardni nastrojové listé nebo na nastrojoveé listé Kresba klepneme na Vlozit
textové pole pro vodorovny text nebo na Vlozit svisly text pro svisly text.

— V pfipadé vodorovného textu klepneme dvakrat na vybrany objekt.

— Pro svisly text klepneme dvakrat na vybrany objekt a na Standardni nastrojové listé
nebo nastrojové listé Kresba klepneme na VloZit svisly text.

3) Zacneme psat text do vybraného objektu. Pokud text pfesahuje hranice objektu,
pouzijeme odstavce, zalomeni fadkd, mensi velikost text, zvétSeni objektu nebo
kombinaci vSech ¢tyf metod, abychom udrzeli text v hranicich objektu.

Text Animace textu

Text viastniho tvaru
[ Zalomit text podle tvaru
[ Upravit velikost tvaru podle textu

Vzdalenost k ohraniceni Ukotveni textu
Vlevo: |D,25 cm E|

0
)

Vpravo: |D,25 cm E“ @®

MNahofe: |D,13 cm E| ~

Dole: |D,13 cm E“ PIna gitka

Napovéda Obnovit oK Zrusit

Obrazek 217: Dialogové okno Text pro textové atributy
v objektu
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4) Pokud chceme zajistit, aby se text zalamoval a zlstal uvnitf objektu, miiZzeme postupovat
nasledovné:

c) Klepneme pravym tlaCitkem mysSi na text uvniti objektu a vyb&rem Atributy textu
z mistni nabidky otevieme dialogové ono Text pro atributy textu (obrazek 217).

d) Klepnutim na Text otevieme stranku Text.
e) V Text vlastniho tvaru vybereme moZznost Zalomit text podle tvaru.
f) Klepnutim na OK zavieme dialogové okno Text a uloZime zmény.

g) Po dopsani textu klepnutim mimo objekt zruSime textovy rezim a ulozime zmény. Text
uvnitf objektu je nyni zalomeny, jak je zndzornéno na obrazku 216.

5) V pripadé potfeby naformatujeme text uvnitf objektu pomoci rliznych formatovacich
nastroj, které mame k dispozici. Vice informaci najdeme v ¢asti ,Formatovani textu” na
strané 225.

Kopirovani textu

Text Ize do textového pole nebo objektu viozit zkopirovanim textu z jiného dokumentu a vloZzenim
do kresby. VlozZeny text si vS8ak zachovava formatovani ze zdrojového dokumentu a nemusi
odpovidat formatovani textu, ktery jiz byl v kresbé pouzit. V nékterych pfipadech mize odpovidat
formatu textu v kresbé, ale ve vétsiné pripadu je lepsi zaijistit, aby byl format textu v celé kresbé
konzistentni.

{EE& Poznamka

Pokud je zkopirovany text vioZzen pfimo do kreshy a nikoliv do objektu pomaoci
Format > Vlozit v hlavni nabidce nebo pomoci klavesové zkratky Ctrl + V, je text
vloZen jako objekt OLE a nikoliv jako objekt aplikace Draw. Pro vytvoreni textového
objektu v aplikaci Draw je doporu€eno vlozit text do aplikace jako neformatovany

text.

Zdroj: Neznamy zdroj

Vybér
Flat XML format (EditEngine ODF)

Neformatovany text
[Rich text formatting (RTF)

Napovéda oK Zrusit

Obréazek 218: Dialogové okno VioZit
jinak
Je vhodné vkladat text bez forméatovani a formatovani pouzit pozdéji, aby se shodovalo
s formatovanim textu, ktery jiz v kresbé mame.
1) Zkopirujeme text a vlioZzime jej do kresby jako neformatovy text pomoci jedné
z nasledujicich moznosti:
— V hlavni nabidce zvolime Upravit > Vlozit jinak > Vlozit neformatovany text.
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— V hlavni nabidce zvolime Upravit > VloZit jinak > Vlozit jinak a otevieme dialogové
okno Vlozit jinak (obrazek 218). Vybereme moZnost Neformatovany text a klepnutim
na OK dialogové okno zavieme.

— Pouzijeme klavesovou zkratku Control + Shift + V a otevieme dialogové okno Vlozit
jinak. Vybereme moznost Neformatovany text a klepnutim na OK dialogové okno
zavieme.

— Klepneme na maly trojuhelnik ¥ vpravo od nastroje Vlozit na Standardni nastrojové
li5té a z mistni nabidky zvolime Neformatovany text.

2) Neformatovany text se vlozi do textového pole na pozici kurzoru nebo uvnitf vybraného
objektu a naformatuje se podle vychozi stylu pouzitého v kresbé. VlozZeny text
naformatujeme podle pozadavk{ kresby nebo pouzijeme styl kresby. Vice informaci
najdeme v Céasti ,Formatovani textu” nize.

Formatovani textu

Formatovani textu miZze dat kresbé konzistentnéjsi a profesionalnéjsi vzhled bez rusivych prvka.
Nastroje formatovani textu jsou dostupné na nastrojové listé Formatovani textu a v rozeviraci
nabidce Format v hlavni nabidce. Vice informaci o formatovani textu najdeme v pfirucce
Privodce programem Writer.

Pokud je v kresbé nékolik textovych poli a/nebo objektd, které vyzaduiji stejné formatovani textu,
doporucujeme pouzit styly kresby. Vice informaci o pouzivani a tvorbé stylli najdeme v kapitole
4, Zména atributli objektu.

Rychla zména velikosti pisma

Po vybéru textu Ize velikost pisma rychle zvétsit nebo zmensit pomoci nastrojii Zvétsit velikost
pisma (Ctrl + ]) a ZmenSit velikost pisma (Ctr/ + [), které najdeme na néastrojové listé
Formétovani textu. Zména velikosti pisma zavisi na tom, jaké velikosti jsou pro dané pismo
dostupné.

Vybér textu
Text, ktery chceme formatovat, musi byt pfed Gpravou vybran jednim z nasledujicich zpdsobd.
VSechny zmény formatovani se vztahuji pouze na vybrany text.

* Pokud chceme naformatovat vSechen text v textovém poli nebo objektu, klepneme
jednou na okraj textového pole nebo objektu a zobrazime Uchyty pro vybér. VSechny
zmeény formatovani se pak vztahuji na vSechen text v textovém poli nebo objektu.

* Abychom upravili format jen ¢asti textu pole, vybereme jej jednou z nasledujicich metod:

— Klikneme do textu a tazenim kurzoru vybereme text.

— Dvojitym klepnutim na text vybereme celé slovo, pfipadné trojitym klepnutim
vybereme cely odstavec.

— Klepneme do textu, pak stiskneme a podrzime klavesu Shift a pomoci klaves se
Sipkami vybereme text.

Formatovani textu

PFfimo nebo ru¢né formatovat Ize znaky, slova, véty a odstavce. Pfimé formatovani prepise
jakékoli formatovani textu vytvorené pouzitim styl(.
1) Vybereme text, ktery chceme formatovat.
2) Vybrany text zformatujeme jednou z nasledujicich moZnosti:
— Pomoci rliznych nastroji formatovani na nastrojové listé Formatovani textu.
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— Pomoci volby Format v hlavni nabidce a vybérem moZznosti formatovani z rozeviraci
nabidky. Vyb&rem moZnosti formatovani se otevie mistni nabidka nebo dialogové
okno s dalSimi moZnostmi forméatovani , které Ize pouzit na vybrany text.

— PouZijeme moZznosti v dialogovych oknech Odstavec a znakové.
— Pouzijeme moznosti v ¢astech Odstavec a Znak na karté Vlastnosti v postranni liSté.
3) Kliknutim mimo textové pole nebo objekt zru§ime vybér textu.

Dialogové okno Odstavec
Dialogové okno Odstavec (obrazek 219) slouzi k formatovani odstavcl textu.
1) Klepneme na libovolné misto v odstavci, ktery méa byt naformatovany.
2) Pomoci jedné z nasledujicich moznosti otevieme dialogové okno Odstavec.

— Klepneme pravym tlaCitkem mysi na vybrany text a z mistni nabidky vybereme
Odstavec.

— Jdeme do nabidky Forméat > Odstavec.
3) K formatovani textu pouZzijeme rdizné moznosti na kartach dialogového okna Odstavec.
4) Klepnutim na OK ulozime zmény a zavieme dialogové okno Odstavec.
5) Kliknutim mimo textové pole nebo objekt zruSime vybér textu.

Odsazeni a rozestupy Asijskd typografie Tabuldtory Zarovndni
Odsazeni
Pred textem: 0,00 cm =
Za textern: 0,00 cm =
Prvni fadek: 0,00 cm =
L] Automaticky ]
Rozestupy I
Nad odstavcem: 0,00 cm = ]
Pod odstavcem: 0,00 cm =
[ Nevkladat mezeru mezi odstavce stejného stylu
Radkovani
Jednoduché |~ =
MNapovéda Obnovit OK Zrudit

Obréazek 219: Dialogové okno Odstavec - karta Odsazeni a rozestupy

Karta Odsazeni a rozestupy
Karta Odsazeni a rozestupy (obrdzek 219) v dialogovém okné Odstavec ma tfi hlavni ¢asti:
* Odsazeni — urCuje mezeru mezi levym a pravym okrajem snimku a odstavcem.

— Pred textem — zadame velikost mezery poZzadované pro odsazeni odstavce od okraje
stranky. Pokud ma odstavec zasahovat do okraje stranky, zadame zaporné cislo.

— Za textem — zadame velikost mezery pozadované pro odsazeni odstavce od okraje
stranky. Pokud ma odstavec zasahovat do okraje stranky, zadame zaporné cislo.
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Prvni radek — odsadi prvni fadek odstavce o zadanou hodnotu. Aby prvni fadek
zaCinal pfed levym okrajem odstavce (zaporné odsazeni), zadame do pole Pred
textem kladnou hodnotu a zapornou do pole Prvni fadek. Kladného (béZné) odsazeni
prvniho radku docilime zadanim kladné hodnoty do pole Pred textem a vétsi kladné
hodnoty do pole Prvni radek.

Automaticky — je-li vybrano, automaticky odsadi odstavec podle velikosti pisma
a fadkovani. Hodnota zadana v poli Prvni fadek je ignorovana.

* Rozestupy — urCuji velikost mezery mezi odstavci.

Nad odstavcem — zadame velikost poZzadované mezery nad odstavcem.
Pod odstavcem — zadame velikost poZzadované mezery pod odstavcem.

Nevkladat mezeru mezi odstavce stejného stylu — pokud je tato moznost vybrana,
pouzije se pouze mezera pod odstavcem, pokud jsou pfedchozi a nasledujici
odstavec stejného stylu odstavce.

+ Radkovani — uréuje velikost mezery mezi fadky textu v odstavci. MoZnosti dostupné
z rozbalovaciho seznamu jsou nasleduijici:

o Tip

Jednoduché — odstavec bude mit jednoduché fadkovani. Toto je vychozi nastaveni.
1,15 radku — nastavi radkovani na 1,15 fadku.

1,5 radku — nastavi radkovéa na 1,5 radku.

Dvojité — nastavi radkovani na dva radky.

Proporcionalni — po vybéru této moznosti zadame rozestup radkd v procentech,
jednoduchému fadkovani odpovida 100 %.

Nejméné — nastavi minimalni fadkovani na hodnotu zadanou v poli. Pokud jsou

v odstavci pouzity réizné velikosti pisma, fadkovani se automaticky prizplsobi nejvétsi
velikosti pisma. Pokud je poZadovano stejné radkovani pro vdechny fadky, zadame
hodnotu odpovidajici nejvétsi velikosti pisma.

Proklad — nastavujeme vysku mezery, ktera je vklddana mezi dva radky.
Presné — vlozime hodnotu, ktera se pouzije pro fadkovani.

Nastaveni fadkovani na méné nez 100% je dobry zplsob, jak umistit velké mnoZstvi
textu do textového pole nebo objektu, pokud je prostor omezeny. Je potfeba
postupovat opatrné, protoze pfiliS malé fadkovani znesnadriuje Cteni textu.

6 Tip

Vychozi mérnou jednotku zménime v hlavni nabidce pomoci volby Nastroje >
MozZnosti > LibreOffice Impress > Obecné.

Karta Typografie asijskych jazyk(

Karta Typografie asijskych jazyk(d (obrazek 220) je dostupna pouze tehdy, kdyZ je moZnost
Asijské zaSkrtnuta v hlavni nabidce ve volbé Nastroje > Moznosti > Jazykova nastaveni >
Jazyky. Moznosti Zmény fadku jsou tyto:

« PouZit seznam zakazanych znak( na zacatek a konec radky — zabrani znaklim
v seznamu zahdjit nebo ukon it Fadek. Znaky jsou pfemistény bud na pfedchozi fadek,
nebo na dal$i fadek. Potfebujeme-li upravit seznam zakazanych znak( pro zacatek
a konec radky, jdeme do nabidky Nastroje > Moznosti > LibreOffice > Jazykova
nastaveni > Asijské rozvrzeni.
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Povolit zavésenou interpunkci — brani ¢arkam a teCkadm v zalomeni fadku. Misto toho
jsou tyto znaky pfidany na konec fadku, a to i na okraji stranky.

PouZit rozestup znak( mezi asijskym a jinym textem — vlozi mezeru mezi asijské a jiné
nez asijské znaky.

Odsazeni a rozestupy Asijska typografie Tabulatory Zarovnani
Zména fadky
[ PouZit seznam zakazanych znakd na zacdtek a konec Fadky;
[ Povolit zav&ienou interpunkci

PouZit rozestup znakd mezi asijskym a jinym textem

Obréazek 220: Dialog Odstavec — karta Asijska typografie

Odsazeni a rozestupy Asijska typografie Tabulatory Zarovnani

Umisténi Typ Vyplnit znakem ot
_ . ova
® Vlevo/nahoru [ ® Zadny =

L J— .

O Vpravo/dold g Smazat vie
O e

) Na stfed L o__ Smazat
) Znak

) Desetinny x

Znak

Obrazek 221: Dialog Odstavec — karta Tabulatory

Karta Tabulatory

Pomoci karty Tabulatory (obrazek 221) mizeme vytvaret, editovat nebo mazat zarazky
tabulatoru v textovém poli nebo objektu. MoZnosti jsou nasledujici:

Umisténi — vloZena hodnota ur€uje polohu tabulatoru v textovém poli. VSechny jiz
vytvorené tabulatory vidime v nahledu pod polem, kam zadavame polohu tabulator(.

Typ — urCuje typ vytvareného tabulatoru.

Vlevo — zarovna levy okraj textu k tabulatoru, text pokracuje doprava. Je-li v nastaveni
LibreOffice povolena podpora asijskych jazyk, nazyva se tento tabulator
Vlevo/nahoru.

Vpravo — zarovna pravy okraj textu k tabulatoru a text se rozSifuje nalevo od zarazky
tabulatoru. Je-li v nastaveni LibreOffice povolena podpora asijskych jazyk(, nazyva se
tento tabulator Vpravo/dold.

Na stfed — zarovna stred textu na zarazku tabulatoru.

Desetinny — zarovna desetinnou &arku &isla na stfed zarazky tabulatoru. Cislice vlevo
od desetinné Carky jsou zarovnany vlevo od tabulatoru. Cislice vpravo od desetinné
¢arky se zarovnavaji vpravo od tabulatoru.

Znak — zadame znak, ktery se pouzije jako oddélovac desetinnych mist pfi pouziti
desetinnych tabulator(.

Vyplnit znakem — ur€uje znak, ktery bude vklddan mezi misto vloZeni tabulatoru
a tabulacni zarazku.
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— Zadny — mezi bod vloZeni tabulatoru a zarazku tabulatoru nejsou viozeny zadné
znaky. Rovnéz odstrani vSechny existujici znaky vyplné mezi bodem vloZeni
tabulatoru a zaradzkou tabulatoru.

— TecCky ...... — vloZi teCky mezi bod vloZeni tabulatoru a zardzku tabulatoru.
— Pomlicky ----- —vloZi pomiI€ky mezi bod vloZeni tabulatoru a zarazku tabulatoru.
— Céra — nakresli ¢&ru mezi bodem vloZeni tabulatoru a zaradzkou tabulatoru.

— Znak — zadame znak vkladany mezi bod vloZeni tabulatoru a zaradZku tabulatoru.

Vytvareni tabulatort

1)
2)
3)

4)
5)

Textové pole vybereme tak, aby se zobrazily Gchyty pro vybér na okraji textového pole
nebo objektu.

Pravym tlacitkem mysi klepneme na vybrané textové pole nebo objekt a z mistni nabidky
vybereme moznost Odstavec nebo v hlavni nabidce vybereme Forméat > Odstavec,
¢imZ otevieme dialogové okno Odstavec.

V dialogu Odstavec klepneme na kartu Tabulatory, zobrazi se.
Polohu zarazky tabulatoru v textovém poli zadame v poli Umisténi.
Vybereme typ tabulatoru volbou Typ.

Poznamka

Pokud je vybran typ Desetinny, pouzije se vychozi znak pouzivany pro desetinnou
¢arku v nastaveni pocitace. V pfipadé potieby zadadme znak, ktery se ma pouzit jako
desetinna tecka, do pole Znak.

6)
7)

8)
9)

Vybereme znak vypIné v nabidce Vyplnit znakem. Znak vyplné bude vloZzen mezi bod
vloZeni tabulatoru a zaraZzku tabulatoru.

Klikneme na tlaCitko Novy, ¢imZ v textovém poli vytvofime novou zarazku tabulatoru.
Nova tabelani zardZka se objevi v poli ndhledu pod polem Umisténi.

Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno.

Pokud chceme pouzit novou zarazku tabulatoru ve vice nez jednom odstavci v textovém
poli nebo objektu:

— Upravime nebo aktualizujeme styl kresby pouZity pro text.
— Vytvofime vlastni styl kresby a text jim formatujeme.

Upravy tabulatort

1)

2)

3)
4)
5)

6)
7
8)

Textové pole vybereme tak, aby se zobrazily GUchyty pro vybér na okraji textového pole
nebo objektu.

Pravym tlacitkem mysi klepneme na vybrané textové pole nebo objekt a z mistni nabidky
vybereme moznost Odstavec nebo v hlavni nabidce vybereme Format > Odstavec,
¢imZ otevieme dialogové okno Odstavec.

V dialogu Odstavec klepneme na kartu Tabulatory, zobrazi se.
V poli Umisténi v seznamu tabulator(i vybereme tabulator, ktery budeme upravovat.

Pokud chceme zménit pozici tabulatoru, nejprve tabulator smaZzeme a nasledné
vytvofime novy tabulator s potfebnou zménou.

Nastavime potfebné hodnoty pro Typ a Vyplnit znakem pro vybranou tabulacni zarazku.
Klepnutim na tlaitko OK uloZime zmény a zavieme dialogové okno.
V pfipadé potfeby aktualizujeme styl kresby pouzity pro text.
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Smazani tabulatord

1)

2)

3)
4)
5)

6)

Textové pole vybereme tak, aby se zobrazily Gchyty pro vybér na okraji textového pole
nebo objektu.

Pravym tlacitkem mysi klepneme na vybrané textové pole nebo objekt a z mistni nabidky
vybereme moznost Odstavec nebo v hlavni nabidce vybereme Format > Odstavec,
¢imz otevieme dialogové okno Odstavec.

V dialogu Odstavec klepneme na kartu Tabulatory, zobrazi se.
V seznamu tabulatord v poli Umisténi vybereme tabulator pro smazani.

Klepnutim na Smazat odstranime vybrany tabulator nebo klepnutim na Smazat vse
odstranime vSechny tabulatory, které jsou definovany pro vybrané textové pole nebo
objekt.

Klepnutim na tlac¢itko OK uloZzime zmény a zavieme dialogové okno.

Odsazeni a rozestupy Asijska typografie Tabulatory Zarovnani

MozZnosti

(2 Vpravo/dold
) Na stred
2 Do bloku

Posledni fadek: |Zacatek

Rozpit jedno slovo —

[ Prichytavat na textovou mfizku (je-li aktivni)

Svislé zarovnani znaku

Zarovnani: ‘Automaticky b ‘

Vlastnosti

Smér textu: ‘Zleva doprava (LTR) w ‘

MNapovéda Obnovit OK Zrudit

Obréazek 222: Dialog Odstavec — karta Zarovnani

Karta Zarovnani

Pomoci karty Zarovnani (obrazek 222) ur€ime zarovnani textu v textovych polich nebo
objektech:

MozZnosti

— Vlevo — zarovnava text na levy okraj textového pole. Je-li zapnuta podpora asijskych
jazykd, je tato moznost pojmenovana Vlevo/nahoru.

— Vpravo — zarovnava text k pravému okraji textového pole. Je-li zapnuta podpora
asijskych jazykd, je tato moznost pojmenovana Vpravo/dold.

— Na stred — zarovnava text na stfed textového pole.
— Do bloku — zarovnava text k obéma okrajlim textového pole.
Svislé zarovnani znakd

— Zarovnani — poskytuje moznosti zarovnani nadmérnych nebo poddimenzovanych
znak( v textu vzhledem ke zbytku textu.
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¢ Vlastnosti

— Smeér textu — urCuje smér textu pro text, ktery pouziva slozené rozvrzeni textu (CTL)
a je k dispozici pouze v pfipadé, Ze je tato moznost povolena.

* Pole nahledu — zobrazuje nahled textu v textovém poli.

Cast Odstavec na postranni listé

Alternativné miZzeme odstavce formatovat pouZzitim ¢asti Odstavec (obrazek 223) na karté
Vlastnosti postranni liSty. Moznosti formatovani v ¢asti Odstavec jsou omezené, ale jejich pouziti
je podobné mozZnostem formatovani na riznych strankach dialogového okna Odstavec. Jakékoliv
formatovani pouzité na odstavec pomoci postranni lisSty je okamzité.

1) Klepneme na libovolné misto v odstavci, ktery ma byt naformatovany.

! Vlastnosti X
+ Znak =
+ Seznamy M= <>

-
:

T 75 ¥

L
Rozestupy: Odsazeni: @
=0 3= €= =
L 0,00 cm = == 0,00 cm =
T 0,00 cm = = |0,00cm =
= = 0,00 cm -

Obréazek 223: Cast Odstavec karty Vlastnosti
v postranni listé

2) V postranni listé klikneme na ikonu Vlastnosti, otevie se stejnojmenna karta.

3) V pripadé potfeby miiZzeme klepnutim na symbol rozsifeni vievo od nadpisu Odstavec
otevrit ¢ast Odstavec.

4) V Casti Odstavec formatujeme text pomoci réiznych nastrojl. Vice informaci
0 moZznostech forméatovani najdeme v &asti ,Dialogové okno Odstavec" na strané 226.

5) Je-li to nutné, klikneme na ikonu Dal$i mozZnosti na pravém okraji titulniho pruhu, ¢imz
otevieme dialog Odstavec se vSemi moznostmi formatovani textu.

MozZnosti forméatovani textu v ¢asti Odstavec na karté Vlastnosti v postranni liSté jsou nasleduijici.
Vétsina téchto nastrojl je k dispozici také na nastrojové listé Forméatovani textu.

« Zarovnané vlevo, Zarovnat na stied, Zarovnat vpravo, Do bloku — ur€uje, jak bude
text zarovnan k okrajlim textového pole nebo objektu.

» Zleva doprava, Zprava doleva — k dispozici jsou pouze v pfipadé, Ze v Nastroje >
MozZnosti > Nastaveni jazyka > Jazyky jsou vybrany moznosti Komplexni rozvrZeni
textu (CTL).

« Zarovnat nahoru, Svisle na stfed, Zarovnat dolti — zarovna text nahoru, na stfed nebo
doll v textovém poli nebo objektu. Je to podobné jako vertikalni zarovnani dat v burice
tabulky.
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Zvétsit rozestupy mezi odstavci a Zmensit rozestupy mezi odstavci — zvétsuji nebo
zmensuji mezery nad a pod vybranym textem.

Mezera nad odstavcem a Mezera pod odstavcem — zvétSuji nebo zmenSuji mezeru
bud nad, nebo pod vybranym textem. Zadame poZadované odsazeni v textovém poli.

Nastavit fadkovani — nastavuje radkovani vybraného textu. Klepneme na maly
trojuhelnik v napravo od ikony a v rozeviracim seznamu vybereme pozadovany typ
radkovani.

Zvétsit odsazeni, ZmensSit odsazeni — kazdé klepnuti zvétSi nebo zmensi Groven
odsazeni vybraného textu o vychozi hodnotu pro aplikaci Draw. Pokud chceme mérné
jednotky odsazeni, zadame hodnoty do poli Odsazeni pfed textem, Odsazeni za textem
nebo Odsazeni prvniho radku.

Pfedsazeni prvniho fadku — nastavujeme odliSné odsazeni prvniho fadku textu
vzhledem k odsazeni textu celého odstavce takto:

s vz

— Do pole Prvni fadek zadame zapornou hodnotu, abychom zmenSili odsazeni prvniho
radku textu.

s vz

— Do pole Prvni fadek vlozime kladnou hodnotu, abychom zvétSili odsazeni prvniho
fadku textu.

— Prvni kliknuti nastavi zaporné odsazeni prvniho fadku, druhé kliknuti nastavi jeho
kladné odsazeni.

— Tento nastroj je aktivni pouze v pfipadé, kdyZ je nastaveno Odsazeni pred textem.
— Predsazeni prvniho fadku zruSime, zadame-li do pole Prvni radek nulu.

Formatovani znaku

Na jednotlivé znaky a slova lze pouzit pfimé nebo ruéni formatovani znakl. Pfimé formatovani
znakUll prepiSe veskeré formatovani, které bylo pouzito pomoci pfimého forméatovani textu a styll

kresby.
1)

2)

3)

Vice informaci o vybéru znak( pro formatovani najdeme v ¢asti ,Vybér textu" na strané
225.

Znaky forméatujeme jednou z nésledujicich metod.

— Pomoci rliznych nastrojl formatovani na nastrojové listé Formatovani textu.
Formatovani znakd je okamzité.

— Jdeme do nabidky Format. Vybérem moznosti formatovani se otevie mistni nabidka
nebo dialogové okno, kde Ize vybrat dalSi moznosti formatovani.

— Pouzijeme moznosti dialogu Znak. Klepnutim na OK v dialogovém okné pouZzijeme
zmeény formatovani.

— PouZijeme moZznosti dostupné v Casti Znak na karté Vlastnosti v postranni listé.
Formatovani znakl je okamzité.

Kliknutim mimo textové pole nebo objekt zruSime vybér textu.

Dialog Znak

Dialog Znak (obrazek 224) pouzivame k formatovani jednotlivych znaka.

1)

2)

Vybereme znaky pro formatovani a otevieme dialogové okno Znak pomoci jedné
z nasledujicich moznosti:

— Pravym tlaCitkem mysSi klepneme na znaky a z mistni nabidky vybereme Znak.
— V hlavni nabidce zvolime Format > Znak.
K formatovani vybranych znak( pouZijeme moznosti na kartach dialogového okna Znak.
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3) Klepnutim na OK aplikujeme zmény formatovani a zavieme dialogové okno.
4) Kliknutim mimo textové pole nebo objekt zruSime vybér textu.

MozZnosti pisem

Pomoci karty Pismo (obrazek 224) v dialogovém okné Znak vybereme rodinu pisma, fez pisma
(Kurziva, Tu€né atd.), velikost pisma a jazyk. Ukazka pisma se zobrazuje v nahledu ve spodni
¢asti dialogu.

Pokud je v nabidce Nastroje > MoZnosti > Jazykova nastaveni > Jazyky povolena podpora
asijského jazyka nebo Komplexni rozvrzeni textu (CTL), jsou k dispozici také moznosti
formatovani znak( pro Pismo pro asijsky text nebo Pismo pro komplexni rozvrzeni textu
(CTL).

O Poznamka

Pocet dostupnych pisem zavisi na vybrané rodiné pisem.

Pismo Efekty pro pismo Umisténi Zvyraznéni

Pismo: Styl: Velikost:
Liberation Sans Bézné 12 pt
T
Liberation 5ans Narrow Tucné 13 pt

Liberation Serif Kurziva 14 pt

Limousine Tucna kurziva 15 pt

Linux Biolinum G 16 pt

Linux Libertine Display G 18 pt

Linux Libertine G 20 pt

Lissen 22 pt

Lucida Console 24 pt

Lurida Sans Unicode e 26 nt i
Jazyk: Cestina v Vlastnosti...

Stejné pismo bude pouZito na tiskarné i na obrazovce.

LibreOffice

Napovéda Obnovit OK Zrusit

Obrazek 224: Karta Pismo dialogu Znak
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o Tip

Pfi vytvareni kresby ve vice jazycich pouZijeme nastaveni jazyka k vytvoreni styl(,
které se liSi pouze jazykem v atributech nastaveni. To umoZnuje kontrolu pravopisu
celého obsahu kresby bez vlivu na vzhled.

MozZnosti efekti pisma
MoZnosti na strance Efekty pro pismo (obrazek 225) umoziuji pouzit barvu pisma, dekoraci
textu a efekty na vybrany text nebo znaky. UCinek nastaveni efektll se zobrazuje v poli nahledu
ve spodni Casti karty.

* Barva pisma

— Barva pisma — nastavuje barvu vybraného textu. Barvu vybirame z dostupnych palet.
Je-li vybrana Automaticka, je barva textu nastavena na €ernou pro svétlé pozadi a na
bilou pro tmavé pozadi.

— Prdhlednost — nastavuje prihlednost vybraného textu. Do pole zadame hodnotu
v procentech. 100 % znamena zcela prihledny, 0 % neprdhledny.

Pismo Efekty pro pismo Umisténi Zvyraznéni

Barva pisma

Barva pisma: |:| Automaticka hd
Prihlednost: 0% =
Dekorace textu
NadtrZeni: (Zadné) w Automaticka
Preskrtnuti: (Zadné) v
PodtrZeni: (Zadné) e Automaticka

Jednotliva slova

Efekty
Velikost: (Zadne) v|
Reliéf: (Zadny) v| Oobrys Ostin
Znacka zvyraznénic |(Zadnd) v|
Umisténi: Mad textem : |
Rychla
MNapovéda Obnovit oK Zrusit

Obréazek 225: Karta Efekty pro pismo dialogu Znak
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 Dekorace textu

— NadtrZeni — vybereme styl nadtrZzeni z rozeviraciho seznamu a barvu nadtrzeni
z jedné z dostupnych palet. Pokud je vybrdna moznost Automaticka, je barva
nastavena na ¢ernou pro svétlé pozadi a na bilou pro tmavé pozadi.

— Preskrtnuti — vybereme styl pfeskrtnuti pro zvoleny text.
— PodtrZzeni — vybereme styl podtrzeni z rozeviraciho seznamu a barvu podtrZzeni

z jedné z dostupnych palet. Pokud je vybrdna moznost Automaticka, je barva
nastavena na ¢ernou pro svétlé pozadi a na bilou pro tmavé pozadi.

— Jednotliva slova — pokud je vybrana tato moznost, je veSkeré nadtrzeni a podtrzeni
pouZzito pouze na slova a mezery jsou ignorovany.

* Efekty

— Velikost — z rozeviraciho seznamu vybereme efekt psani velkych pismen.

J 74

— Reliéf — pro vybrany text volime efekt reliéfu. Reliéf vytvari dojem, Ze znaky
vybraného textu vystupuji nad plochu stranky. Rytina naopak budi dojem do stranky
zanoreného textu.

— Znacka zvyraznéni — vybereme znak, ktery se ma zobrazovat nad nebo pod
vybranym textem.

— Umisténi — ur€ime, kde se znacky zvyraznéni maji nachazet. Bud nad, nebo pod
vybranym textem.

Pismo Efekty pro pismo Umisténi Zvyraznéni
Umisténi
O Homi index Zvysit/sniZit o 1% - Automaticky
O Dolniindex  Relativni velikost pisma |100 % i
MEéritko
Meritko Sitky 100 % ~| [ Pfizpisobit fadce
Rozestupy
Rozestup znakd 0,0 pt = Parovy kerning

Obrazek 226: Dialog Znak — karta Umisténi

Moznosti polohy

MoZnosti na karté Umisténi (obrazek 226) umoznuje nastavit umisténi, méfitko a rozestupy
vybraného textu.

¢ Umisténi — znakiim mUZeme nastavit polohu horniho nebo dolniho indexu.
— BéZné — odstrariuje forméatovani horni a dolni index.
— Horni index — zmenS§i velikost pisma vybraného textu a zvedne pismo nad Ucafi.
— Dolni index — zmensi velikost pisma vybraného textu a posune text pod ucafi.

— Zvysit/sniZit o — vloZzime Udaj v procentech, o ktery se zvySi nebo snizi vybrany text
vzhledem k Gcafri. 100 % se rovna vysce pisma.

— Relativni velikost pisma — vlozime hodnotu zmenSujici velikost pisma vybraného
textu.
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— Automaticky — zapina automaticky posun vybraného textu nad nebo pod Gcafi.

+ Mé¥itko

NS ~ 7y

v v

— Méritko Sifky — zadame v procentech Sitku pro zGzeni nebo rozSifeni vybraného textu.

* Rozestupy — urCujeme mezery mezi jednotlivymi znaky.
— Rozestup znakd — urcuje Sitku mezery mezi znaky vybraného

~ s

textu. Zadame hodnotu,

o kterou se text v textovém poli nebo objektu rozSifi nebo zuzi. Pro zvétSeni
rozestupu vloZzime kladnou hodnotu, pro ztZeni hodnotu zapornou.

— Parovy kerning — automaticky upravuje rozestupy pro konkrétni kombinace znakad.

Kerning je k dispozici pouze pro urCité typy pisem.

Moznosti zvyraznéni

Moznosti na karté Zvyraznéni (obrazek 227) umoznuji zvyraznit text tak,
barvu nez zbytek textu v textovém poli nebo objektu.

aby znaky mély jinou

* Barvy — vybereme barvu zvyraznéni na jedné z dostupnych palet.
» Aktivni — zobrazuje aktudlni barvu vybraného textu a hodnoty jejich slozek Cervené,

zelené a modré (RGB).

Pismo Efekty pro pismo Umisténi Zvyraznéni

Zadna Barva

Barvy Aktivni Nova

Paleta:|standard b |

Vlastni paleta

Pridat Smazat

O SEEEEEEE™
N R [114 R 114 =
G |159 G 159 =
B |207 B 207 -
HTML |729fcf HTML 729fcf
Vybrat €

Obréazek 227: Karta Zvyraznéni dialogu Znak

* Nova - zobrazuje barvu zvyraznéni textu, kterou jsme vybrali v ¢asti Barvy, a hodnoty
jejich slozek Cervené, zelené a modré (RGB). Barvu Ize vybrat také zménou hodnoty
v polich RGB nebo pomoci dialogového okna Vybér barvy, pokud zvolime moZnost

Vybrat.
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Cast Znak karty Vlastnosti v postranni listé

Jinou metodou forméatovani textu je pouZzit ¢ast Znak (obrdzek 228) na karté Vlastnosti postranni
listy. MozZnosti formatovani dostupné v Casti Znaky jsou omezené, ale jejich pouZiti je podobné
moznostem formatovani, které jsou dostupné na réiznych kartach dialogového okna Znak.
VétSina moznosti je k dispozici také na nastrojové listé Formatovani textu.

1) Vybereme textové pole nebo objekt tak, aby se na okraji zobrazily Gchyty pro vybeér.

2) V postranni listé klikneme na ikonu Vlastnosti, otevie se stejnojmenna karta.

3) Klepnutim na symbol dalSi moznosti na levé strané titulku Znak otevieme dialogové okno
Znak.

4) Text naformatujeme pomoci nastrojli v ¢asti Znak. Vice informaci o moznostech
formatovani najdeme v €asti ,Dialog Znak" na strané 232.

5) V pfipadé potreby klikneme v titulnim pruhu napravo na ikonu DalSi moznosti, ktera
otevie dialog Znak.

Moznosti formatovani textu v ¢asti Znak karty Vlastnosti postranni liSty jsou nasleduijici:
« Nazev pisma a Velikost pisma — z rozeviracich seznam( vybereme rodinu a velikost
pisma.
* Tuéné a Kurziva — pouzije na vybrany text fez pisma tuéné nebo kurziva.

* Podtrzené — podtrhne vybrany text. Klepneme na maly trojihelnik ¥ napravo
a vybereme typ podtrzeni z rozeviraciho seznamu. Klikneme-li na polozku DalSi
moZnosti ve spodni ¢asti seznamu, otevieme dialog Znak.

* Preskrtnuté — nakresli ¢aru pres vybrany text.
* PFepnout stin — pfida/odebere stin vybranému textu.

! Vlastnosti X

— Znak =
Liberation Sans 1|18 pt [~ <>
BIU-S5S A A A
& - 'Jl‘-/) - E‘) & - :’:'I X}

+ Seznamy = H

+/ Odstavec = @

Obrézek 228: Cast Znak karty Vlastnosti
v postranni listé

+ Zvétsit velikost pisma a Zmensit velikost pisma — kazdé kliknuti zvétSuje nebo
zmens3uje velikost vybranych znak( o stejnou hodnotu. Skute¢na velikost zavisi na
nastaveni pocitace.

* Barva pisma a Barva zvyraznéni — klikneme na maly trojahelnik v vpravo od ikon
a z nabizenych palet vybereme barvu.

« Nastavit rozestup znaki — klikneme na maly trojuhelnik v vpravo od ikony nastroje
a vybereme pozadovany typ rozestupu znakl. Nastaveni mezer mezi znaky se nazyva
kerning. Lze také nastavit vlastni hodnotu rozestupu znakd.

* Horni index — zmenSi velikost pisma vybraného textu a zvedne pismo nad Ucafi.
+ Dolni index — zmenSi velikost pisma vybraného textu a posune text pod ucafi.
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Odrazkové nebo Cislované seznamy

V textovych polich a objektech Ize vytvaret seznamy s odrazkami a Cislované seznamy. P¥i
vytvareni seznami v objektech vSak mé&jme na paméti, Ze objekty aplikace Draw nejsou
dynamické a pfi vytvareni seznamu se automaticky nerozbaluiji.

Poznamka

Vytvareni odrazkovych nebo ¢&islovanych seznamd v aplikaci Draw je podobné jako
v aplikaci LibreOffice Writer, ale funkce v aplikaci Draw jsou omezené.

Vytvareni seznamti

Odrazkové nebo Cislované seznamy mizZeme v textovych polich nebo objektech aplikace Draw
vytvaret nasledovné:

1) Vybereme veskery text, ze kterého chceme vytvofit seznam. Automaticky se otevie

2)

3)

nastrojova lista Formatovani textu.

Seznam vytvofime pomoci jedné z nasledujicich moznosti a vychozich nastaveni

seznam:

— Na nastrojové listé Formatovani textu klepneme na Pfepnout odrazkovy seznam
nebo Pfepnout €islovany seznam.

— Klepneme na Pfepnout odrazkovy seznam nebo Pfepnout ¢islovany seznam
v Casti Seznamy na karté Vlastnosti v postranni liSté.

— V hlavni nabidce zvolime Format > Seznamy > Odrazkovy seznam nebo Cislovany
seznam.

Pokud chceme zmeénit format seznamu pfi jeho vytvareni, klepneme na maly trojuahelnik

v napravo vedle ikony sezhamu a z moznosti ve vyskakovacim okné vybereme styl
seznamu (obrazky 229 a 230).

® * [ |

L ] . |

[ ] . |

> Fe X v

-> Fe X v

-> > X v
% Dalsi odrazky...

Obréazek 229: Dalsi odraZkové
seznamy
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Obrazek 230: Dalsi ¢islované

seznamy
! Vlastnosti X
+ Znak P
—/ Seznamy =

Ay
+ Odstavec M~

Obréazek 231: Cast Seznamy na karté Vlastnosti
v postranni listé

Uprava trovné a pozice polozky seznamu

Kazdou polozku v odrazkovém nebo Cislovaném seznamu Ize v rAmci seznamu posunout
o Uroven vys nebo niz nebo ji posunout nahoru ¢i doll v seznamu nasledovné:

1) Klepneme na polozku seznamu, kterou chceme posunout o Uroven vys, o Uroven niz,
presunout nahoru nebo dolu.

2) Pokud chceme polozku seznamu posunout o Uroven niz, pouzijeme jednu z nasledujicich
MOoZNosti:

— PouZijeme klavesu Tab.
— V hlavni nabidce zvolime Format > Seznamy > O Uroven niZz.

— Pouzijeme tlagitko O droven niz v Casti Seznamy na karté Vlastnosti v postranni listé
(obrazek 231).

3) Pokud chceme poloZku seznamu posunout o Uroven vys, pouzijeme jednu nasledujicich
MOoZnosti:

— PouZijeme kombinaci klaves Shift + Tab.
— V hlavni nabidce zvolime Format > Seznamy > O Uroven vys.
— Pouzijeme tlacitko O Groven vys v Casti Seznamy na karté Vlastnosti v postranni
liste.
4) Pokud chceme zménit pozici polozky v seznamu, pouzijeme jednu z nasledujicich
MOoZnosti:
— V hlavni nabidce zvolime Format > Seznamy > Pfesunout dol{.
— Pouzijeme tla¢itko PFesunout doli v ¢asti Seznamy na karté Vlastnosti v postranni
liste.
5) Pokud chceme zménit pozici poloZzky v seznamu, pouZijeme jednu z nasledujicich
MOZNosti:
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— V hlavni nabidce zvolime Format > Seznamy > Pfesunout nahoru.

— PouzZijeme tlacitko Pfesunout nahoru v ¢asti Seznamy na karté Vlastnosti
v postranni listé.

Dialogové okno Odrazky a Cislovani

Pro vétsi kontrolu nad formatem seznamu pouzijeme dialogové okno Odrazky a &islovani

(obrazek 232). Vybereme text v textovém poli nebo objektu a otevieme dialogové okno pomoci
jedné z nasledujicich moznosti:

Jdeme do nabidky Format > Odrazky a Cislovani.

Klepneme pravym tlacitkem mySi na vybrany text a z mistni nabidky zvolime Odrazky
a Cislovani.

V postranni listé na karté Vlastnosti klikneme na ikonu DalS§i moZnosti nachazejici se
napravo Vv titulnim pruhu ¢asti Seznamy.

Klepnutim na DalSi odrazky nebo DalSi €islovani po klepnuti na maly trojuhelnik v
napravo od ikony Pfepnout odrazkovy seznam nebo Pfepnout ¢islovany seznam
v Casti Seznamy na karté Vlastnosti na postranni listé (obrazky 229 a 230).

vr wrs

Klepnutim na DalSi odrazky nebo DalSi €islovani po klepnuti na maly trojuhelnik v
napravo od ikony Pfepnout odrazkovy seznam nebo Pfepnout €islovany seznam na
néstrojové listé Forméatovani textu.

Uroveii Viastnosti Nahled
— |1J i . ‘ 0

2 Barva: || Automaticka - 10

4 Zatit od: 1 =

> Oddélovaé 1)

6 oy .

7 Pred: 1 )
8 Za: )

9 Velikost 1)

—
=]
3

Rel. velikost: | 100 %

—
|
—
=
4

1)
1)

Umisténi

Odsazeni: 0,00 cm

AfR(A]*

Sifka: 0,60 cm
L Relativni 1 )
Zarovnani: = == 1 )
Rozsah
O Stranka 1)
® Vybér
MNapovéda Reset oK Zrusit

Obréazek 232: Dialogové okno OdraZky a cislovani
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V dialogovém okné Odrazky a Cislovani jsou k dispozici nasledujici moznosti.
« Uroveh — vybereme Groveri (Grovné) potfebné k definovani moznosti formatovani
seznamu. Vybrané arovné jsou v nahledu zvyraznény.
* Vlastnosti

— Typ — v rozeviracim seznamu vybereme styl ukazatele seznamu. Je-li jako Typ vybran
Obréazek, vybereme obrazek v souboru nebo z Galerie.

— Znak - je-li jako Typ vybrana OdraZka, vybereme znak z dialogového okna Specialni
znaky, které se otevre.

— Barva — z dostupnych palet vybirame barvu oznaceni poloZzek seznamu.
— Zacit od - je-li jako Typ vybran Ciselny styl seznamu, zadame pocatecni €islo pro
soucasnou uroven €islovani. Vychozi po¢ate¢ni Cislo je 1.
* Oddélovac — tato moznost je dostupna, pokud je jako Typ vybran Ciselny styl seznamu.

— Pred - znak nebo text, ktery se zobrazuje pfed Cislem polozky seznamu. Chceme-li
napriklad vytvofit seznam, ktery pouziva styl (1, zadame do tohoto pole znak (.

— Za - znak nebo text, ktery se zobrazuje za Cislem polozky seznamu. Chceme-li
napriklad vytvofit seznam, ktery pouziva styl A), zadame do tohoto pole znak ).

* Velikost

— Rel. velikost — vkladame vysku oznaceni poloZzky seznamu v procentech vy3Sky pisma
aktualniho seznamu.

— Sitka — parametr dostupny tehdy, je-li jako Typ vybran Obrézek. VloZzime $ifku
obrazku.

— Vyska — parametr dostupny v pfipadé, kdy je vybran Obrazek jako Typ. Vlozime vysku
obrazku.

— Zachovat pomér — parametr dostupny v pripadé, kdy je vybran Obrazek jako Typ.
Zachova pomeér stran obrazku.

*  Umisténi
— Odsazeni — nastaveni velikost odsazeni polozky seznamu a okraje.

— Sitka — nastaveni velikost odsazeni mezi ukazatelem a textem polozky seznamu. Tato
moznost je uziteCna napfiklad v pfipadé, Ze jsou v seznamu pouzita velka Cisla.

— Relativni — tuto volbu vybereme, chceme-li méfit odsazeni vzhledem k nadfazené
arovni polozek, ne vzhledem k okraji.

— Zarovnani — nastavujeme zarovnani odstavce pro oznaceni polozek seznamu.
* Rozsah

— Stranka — zmény se uplatni na kresbu.

— Vybér — zmény se provedou jen na vybraném textu.
* Nahled - zobrazi, jak bude seznam vypadat pfi pouziti zmén formatu.

Tabulky

Tabulky jsou, pokud jsou v kresbé pouzity, Géinnym nastrojem pro rychlé pfedani strukturovanych
informaci. Tabulky je moZné pfidavat pfimo do kresby, takZze neni nutné vkladat tabulku aplikace
Calc nebo textovou tabulku aplikace Writer. Za ur€itych okolnosti vS8ak ma smysl tabulku do
kresby vlozit. Zejména pokud je v tabulce vyZadovéana vétsi funkénost. Tabulky poskytované
nastroji aplikace Draw maji omezenou funk¢nost.
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Nekolik pfeddefinovanych néavrhi tabulek je k dispozici v ¢asti Navrh tabulky na karté Vlastnosti
v postranni listé (obrazek 233). Cast Navrh tabulky je dostupné pouze tehdy, kdyZ je vybrana

tabulka.

Pfi praci s tabulkami v aplikaci Draw se automaticky otevie nastrojova liSta Tabulka (obrazek
234), ktera nabizi nastroje pro vytvareni a forméatovani tabulky. Vychozi poloha nastrojové listy
pfi otevfeni je ukotveni v dolni Casti pracovni plochy. Pokud se néastrojova liSta Tabulka pfi vybéru
tabulky neotevfe, zvolime v hlavni nabidce Zobrazit > Nastrojové liSty > Tabulka.

! Vlastnosti
Znak
Seznamy
Odstavec

— Navrh tabulky

Radek zahlavi
[0 Radek souctu
Pruhované fadky

L] Prvni sloupec
[ Posledni sloupec

L Pruhované sloupce

gl x

—
=

el il

Obrazek 233: Cast Navrh tabulky na karté
Vlastnosti v postranni listé

Tabulka
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Obréazek 234: Nastrojova lista Tabulka
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Obréazek 235: Dialogové okno

Viozit tabulku
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Vkladani tabulek

Pfi praci s tabulkami je uzitecné znat pocet pozadovanych fadkl a sloupct a jejich vzhled.
Tabulky jsou umistény uprostied kresby a nelze je umistit do objekt(i nebo tvar(l. Na rozdil od
textovych poli a dalSich objekt nelze tabulky otacet.

1) Vytvofeni a vlozeni tabulky pomoci dialogového okna Vlozit tabulku (obrazek 235):

a) Pomoci volby Vlozit > Tabulka v hlavni nabidce otevieme dialogové okno Vlozit
tabulku.

b) Zadame pozadovany pocet fadkd a sloupct.
¢) Klepnutim na OK vloZime tabulku do stfedu kresby a zavieme dialogové okno.
| Ld

Tabulka
EREREEN

Dal5i mozZnosti...

Obréazek 236:

MriZka tabulky
2) Pripadné miZeme vytvorit a vlozit tabulku pomoci mrizky tabulky (obrazek 236):
a) Klepnutim na Tabulka na Standardni nastrojove listé otevieme mrizku tabulky.
b) Klepneme a tAhneme kurzor, dokud neni vybran pozadovany pocet sloupcti a radkd,
c) DalSim klepnutim vloZime tabulku do stfedu kresby a zavieme mfizku tabulky.

d) V pripadé potfeby klepnutim na DalSi moZnosti otevieme dialogové okno Vlozit
tabulku, kde vybereme pozadovany pocet radkd a sloupct.

3) Tabulku pfesuneme na misto klepnutim na jeji ohraniCeni a jejim pfetazenim do nového
umisténi.
"/ Poznamka
PTi vkladani tabulky do kresby se tabulka vytvofi s pouzitim vychoziho stylu a jiz

pouzitého nastaveni. V soucasné dobé jsou tyto vychozi hodnoty v LibreOffice pevné
zakddovany. Tabulku Ize po vloZeni naformatovat podle pozadavki kresby.

Formatovani tabulek

Cdst Ndvrh tabulky
Otevfeni a pouziti Casti Navrh tabulky na karté Vlastnosti v postranni listé:

1) Vlozime tabulku do kresby nebo v kresbé tabulku vybereme.
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2)

3)

Klepnutim na Navrh tabulky na karté Vlastnosti v postranni listé otevieme Cast Navrh
tabulky. Nebo klepneme na Navrh tabulky na néastrojové listé Tabulka.

Z dostupnych moZznosti vybereme vzhled tabulky a typy fadka a sloupct.

V Casti Navrh tabulky jsou pro fadky a sloupce nasledujici moznosti:

Radek zahlavi — ve vychozim nastaveni vybrano. Prvni Fadek je obvykle Fadek zahlavi
a ma obvykle odliSné pozadi od zbytku tabulky.

Radek souétu — pokud je vybrano, zméni pozadi posledniho fadku, aby vznikl nad
ostatnimi radky.

Pruhované fadky — vybrano ve vychozim nastaveni. Stfidavé radky maji odliSné pozadi,
coz usnadniuje ¢teni Udaji zadanych do Fadka.

Prvni sloupec — je-li vybran, je prvni sloupec tabulky zvyraznén tmavsSim pozadim.
Posledni sloupec — je-li vybran, zvyrazni se posledni sloupec tabulky tmavsim pozadim.

Pruhované sloupce — je-li vybrano, jsou sousedni sloupce podbarveny stfidavé tmavymi
a svétlymi barvami.

Nastrojova lista Tabulka a Hlavni nabidka formatovani

Po vybéru tabulky se automaticky otevie nastrojova lista Tabulka, ktera obsahuje nasledujici
nastroje pro formatovani tabulky podle pozadavkl kresby. Formatovaci nastroje jsou k dispozici
také v hlavni nabidce pomoci volby Format > Tabulka a vybéru moznosti formatovani

z podnabidky.

Tabulka — vlozZi do kresby novou tabulku pomoci dialogového okna Vlozit tabulku nebo
mrizky tabulky. Vice informaci o vkladani tabulek najdeme vySe v casti ,Vkladani
tabulek”.

Styl ohrani€eni — zméni styl ¢ar ohrani¢eni vybranych bunék. Klepnutim na maly
trojuhelnik v vedle ikony otevieme rozeviraci seznam a vybereme si z fady
preddefinovanych styl(.

Pripadné klepneme na Vlastnosti tabulky nebo klepneme pravym tlacitkem my3i na
vybrané burky a z mistni nabidky zvolime Vlastnosti tabulky nebo v hlavni nabidce
zvolime Format > Tabulka > Vlastnosti. Tim otevieme dialogové okno Vlastnosti tabulky
a zmeénime styl ¢ary pro ohraniceni tabulky.

Barva ohrani€eni — zméni barvu ohrani€eni vybranych bunék. Klepnutim na maly
trojuhelnik v vedle ikony otevieme rozeviraci seznam a vybereme barvu z fady
preddefinovanych barevnych palet nebo vytvofime vlastni barvu.

Pripadné klepneme na Vlastnosti tabulky nebo klepneme pravym tlacitkem mysSi na
vybrané bunky a z mistni nabidky vybereme Vlastnosti tabulky nebo v hlavni nabidce
zvolime Format > Tabulka > Vlastnosti. Tim otevieme dialogové okno Vlastnosti tabulky
a zménime barvu ohraniceni.

Ohranic€eni — vybereme preddefinované konfigurace ohrani€eni pro vybrané buriky.
Klepnutim na maly trojahelnik v vedle ikony otevieme rozeviraci seznam a vybereme
konfiguraci ohraniceni.

Pfipadné klepneme na Vlastnosti tabulky nebo klepneme pravym tlaCitkem mysi na
vybrané buriky a z mistni nabidky vybereme Vlastnosti tabulky nebo v hlavni nabidce
zvolime Format > Tabulka > Vlastnosti. Tim otevifeme dialogové okno Vlastnosti tabulky
a zmeénime styl Cary pro hranice buriky.

Styllvypln oblasti — vybereme buriky, které maji byt vypinény a poté vybereme typ
vyplné z rozeviraciho seznamu: Zadna, Barva, Prechod, Srafovani, Rastr nebo Vzorek.
Rozeviraci nabidka moznosti vyplné se zmeéni a zobrazi vyplné pro jednotlivé typy
oblasti.
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Pfipadné klepneme na Vlastnosti tabulky nebo klepneme pravym tlacitkem mysi na
vybrané buriky a z mistni nabidky vybereme Vlastnosti tabulky nebo v hlavni nabidce
zvolime Format > Tabulka > Vlastnosti. Tim otevieme dialogové okno Vlastnosti tabulky
a zmeénime styl/vyplii pozadi oblasti.

* Sloucit bunky — slouci vybrané bunky do jediné. VSimneme si, Ze obsah slou¢enych
bunék je také sloucen.

Vybrané buriky pripadné slou¢ime klepnutim pravym tlacitkem mysSi na tyto vybrané
bunky a vybérem Sloucit bunky z mistni nabidky nebo volbou Format > Tabulka >
Slougit bunky v hlavni nabidce.

* Rozdélit bunky — rozdéli vybranou bunku na vice bunék vodorovné nebo svisle. Ujistime
se, Ze je kurzor umistén v burice a klepnutim na Rozdélit buriky otevieme dialogové
okno Rozdélit buniky (obrdzek 237).

Pfipadné v hlavni nabidce zvolime Format > Tabulka > Rozdélit burnky.

Rozdélit

Rozdélit bunku na: |2 =
Smér
H vodorovng
[INa stejné asti
M| svisle

Népovéda Zrusit

Obrazek 237: Dialogové okno
Rozdélit bunky

V dialogovém okné Rozdélit buriky vybereme pozadovany pocet bunék pfi rozdéleni
bunky a zda chceme buriku rozdélit vodorovneé nebo svisle. V pfipadé potfeby pfi
vodorovném rozdéleni vybereme moznost Na stejné ¢asti, abychom vytvofili buriky stejné
velikosti. Obsah rozdélené buriky zlstava v plvodni burice — levé nebo horni.

* Optimalizovat — pravidelné usporadéa vybrané radky a sloupce tabulky bud vodorovné,
nebo svisle. Klepnutim na ikonu Optimalizovat otevieme nastrojovou liStu Optimalizovat
(obrazek 238), ktera obsahuje nasledujici nastroje.

Optimalizovat v X
== E ==$=' éEa» % E§->

Obrazek 238: Nastrojova
lista Optimalizovat

— Minimélni vyska radku — pro vybrané fadky urcuje minimalni vysku fadku. Minimalni
vySka fadku zavisi na velikosti pisma nejvétsiho znaku v radku. Pfipadné v hlavni
nabidce vybereme Format > Tabulka > Minimalni vyska fadku.

N2

— Minimalni Sitka sloupce — definuje minimalni Sitku sloupce pro vybrané sloupce.
Minimalni Sifku sloupce urcuje nejdelsi poloZka ve sloupci. Pfipadné v hlavni nabidce

s v

vybereme Format > Tabulka > Minimalni Sifka sloupce.

— Optiméalni vyska radku — pro vybrané rfadky ur€uje optimalni vysku fadku. Optimalni
vySka rfadku zavisi na velikosti pisma nejvétsiho znaku v fadku. Pfipadné v hlavni
nabidce vybereme Format > Tabulka > Optimalni vySka fadku.
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— Optimalni Sirka sloupce — pro vybrané sloupce definuje optimalni Sifku sloupce.
Optiméalni Sifka sloupce zavisi na nejdelSi poloZce ve sloupci. Pfipadné v hlavni
nabidce vybereme Format > Tabulka > Optimalni Sitka sloupce.

— Rovnomérné rozmistit Fadky — upravi vysku vybranych Fadku tak, aby odpovidala
vySce nejvyssiho fadku mezi vybranymi. Pfipadné v hlavni nabidce vybereme Format
> Tabulka > Rovhomérné rozmistit Fadky.

— Rovnomérné rozmistit sloupce — upravi Sitku vybranych sloupcl tak, aby odpovidala
Sifce nejSirSiho sloupce ve vybéru. Celkova Sitka tabulky nesmi pfesahnout Sirku
stranky. Pfipadné v hlavni nabidce vybereme Format > Tabulka > Rovhomérné

rozmistit sloupce.

Zarovnat nahoru, Svisle na stfed, Zarovnat dolli — umoZiiuje nastavit svislé zarovnani
textu ve vybranych bunkach.

Pfipadné v hlavni nabidce vybereme Format > Zarovnani textu a z mistni nabidky
zvolime poZadované zarovnani pro svislé nebo vodorovné zarovnéni textu ve vybranych

burkach.
Viezit
Pocet: 1 =
Umisténi
® Nad wybérem
(2} Pod vybérem

Napovéda Zrusit

Obréazek 239: Dialogové okno
VioZit radky

ViozZit

Pocet: |1 =
Umisténi

® Pred wybérem

) Po vybéru

Napovéda Zrusit

Obréazek 240: Dialogové okno
VioZit sloupce

Vlozit fadek nad, Vlozit Fadek pod, Vlozit sloupec pred, Vlozit sloupec za —
vybereme fadek nebo sloupec a pomoci téchto ¢tyf nastrojd vioZime fadek nebo
sloupec.

Pripadné v hlavni nabidce vybereme Format > Tabulka > Vlozit fadky nebo Vlozit
sloupce a otevieme dialogové okno VloZit Fadek (obrdzek 239) nebo dialogové okno
Vlozit sloupec (obrazek 240). Zvolime pocet fadkl nebo sloupct, pozici viozeni

a klepnutim na OK fradky nebo sloupce vloZzime a zavieme dialogové okno.

Smazat fadek, Smazat sloupec, Smazat tabulku — klepnutim na tyto nastroje
smazeme fadek nebo sloupec, ktery obsahuje vybranou buriku. Pokud chceme odstranit
vice nez jeden fadek nebo sloupec, ozna¢ime buriky v poZzadovaném poctu fadkd nebo
sloupcl a klepneme na Smazat fadek nebo Smazat sloupec. Pokud chceme odstranit
celou tabulku, umistime kurzor do buriky a vybereme moZnost Smazat tabulku.
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Pfipadné klepneme pravym tlaCitkem mySi a v mistni nabidce vybereme Smazat >
Smazat fadek nebo Smazat sloupec nebo Smazat tabulku nebo zvolime Format >
Tabulka > Smazat fadek nebo Smazat sloupec nebo Smazat tabulku v hlavni nabidce.

Vybrat tabulku, Vybrat sloupec, Vybrat fadek — vybereme tabulku, sloupec nebo
fadek, pokud chceme na tabulku, sloupec nebo fadek pouzit stejné atribut.

Pfipadné v hlavni nabidce vybereme Format > Tabulka > Vybrat fadek nebo Vybrat
sloupec nebo Vybrat.

Navrh tabulky — po kliknuti tento nastroj otevira cast Navrh tabulky na karté Vlastnosti
v postranni listé. Vice informaci najdeme v Casti ,Cast Navrh tabulky" na strané 243.
Vlastnosti tabulky — otevie dialogové okno Vlastnosti tabulky.

Pripadné klepneme pravym tlacitkem mysi na tabulku a z mistni nabidky vybereme
Vlastnosti tabulky nebo zvolime Format > Tabulka > Vlastnosti v hlavni nabidce.

Pismo Efekty pro pismo Ohranicenii Stin

Pismo pro zapadni text

Pismo: Styl: Velikost:  Jazyk:
Liberation Sans ~ | |B&Zné v 18pt | v |Ceétina o
Stejné pismo bude poufito na tiskdmé i na obrazovce. Vlastnosti...

Pismo pro asijsky text

Pismo: Styl: Velikost:  Jazyk:
Microsoft YaHei hed ¥ |18pt | ¥ Cingtina (zjedn) hed
Stejné pismo bude pouZito na tiskarmé i na obrazovce. Vlastnosti...

Pismo pro komplexni rozvrZeni textu (CTL)

Pismo: Styl: Velikost:  Jazyk
Arial ~ | lobycejné ~ |18 pt |~ Hindstina e
Stejné pismo bude pouZito na tiskdmé i na obrazovce. Vlastnosti...

_ loremipsum AZ#]MAE navnaqix

Napovéda Obnovit oK Zrusit

Obrazek 241: Dialogové okno Vlastnosti tabulky - karta Pismo

Dialog Vlastnosti tabulky

Dialogové okno Vlastnosti tabulky (obrazek 241) obsahuje pét karet, které poskytuji moznosti
formatovani pro Pismo, Efekty pro pismo, Ohrani€eni, Pozadi a Stin. Dialogové okno
Vlastnosti tabulky otevieme jednim z nasledujicich zplsob(:

Klikneme pravym tlacitkem mySi do tabulky a z kontextové nabidky vybereme Vlastnosti
tabulky.

Jdeme do nabidky Format > Tabulka > Vlastnosti.
Na nastrojové listé Tabulka klikneme na ikonu Vlastnosti tabulky.
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MoZnosti formétovani na kazdé strance dialogového okna jsou nésledujici:

Pismo (obrazek 241) — umoznuje vybrat poZzadované Pismo, Styl, Velikost a Jazyk pro
text v tabulce. V nahledu se zobrazuje ukazka vybraného pisma.

Efekty pro pismo (obrazek 242) — umoznuje vybrat poZzadovanou Barvu pisma,
Dekoraci textu a Efekty pro text v tabulce. V poli nahledu se zobrazuje ukazka
zvolenych efektl pisma.

Ohraniceni (obrazek 243) — umoziuje vybrat pozadované usporadani €ar, ¢aru a okraj
pro ohraniceni tabulky a buriky. Tyto mozZnosti jsou podobné nastrojiim Styl ohraniceni,
Barva ohrani€eni a Ohrani€eni na nastrojové listé Tabulka. Vice informaci o pouZiti Car
pro ohraniceni tabulky a buriky najdeme v kapitole 4, Zména atributl objektu.

Pozadi (obradzek 244) — umoZziuje vybér pozadi jako vypli oblasti tabulky a/nebo
vybranych bunék. Tato karta dialogového okna nabizi stejné funkce jako nastroj
Styllvypli oblasti na nastrojové listé Tabulka. Vice informaci o pouZiti stylu a vyplni
oblasti pro pozadi tabulky a buriky najdeme v kapitole 4, Zména atribut(i objektu.

Stin (obrazek 245) — umozZzniuje pridat do tabulky stin. Moznosti upravuji vzhled a polohu
stinu. Vice informaci o stinech tabulky najdeme v kapitole 4, Zména atribut(l objektu.

Pismo Efekty pro pismo Ohrani¢eni Pozadi Stin

Barva pisma

Barva pisma: |:| Automaticka A
Prihlednost: 0% z
Dekorace textu
Nadtrzeni: ‘(iédné} - ‘ Automaticka
Preskrtnuti: (Zadne) v|
PodtrZeni: (ffédné} Y Automaticka
Jednotliva slova
Efekty
Velikost: (Zadne) v|
Reliéf: (Zadny) | Oobrys Ostin
Znacka zvjraznéni: |(Zadna) ~|
Umisténi: |‘\Jar_: textem |

_ _loremipsum AZ¥ MAZ nawnaqix_

MNapovéda Obnovit Zrusit

Obréazek 242: Dialogové okno Vlastnosti tabulky - karta Efekty pro pismo
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Pismo Efekty pro pismo Ohranieni Pozadi Stin

UspofFadani éar Okraj
Predlohy: | || & || H || H || H | Vlevo: 0,25cm
Definovane uZivatelem: Vpravo: 0,25 cm

Nahore: 0,13 cm

Dole: 0,13 cm

[ Synchronizovat

Obrazek 243: Dialogové okno Vlastnosti tabulky - karta Ohrani¢eni

Pismo Efekty pro pismo Ohraniceni Pozadi Stin

=

‘ Zadna H Barva HgfechodH Rast

| | Vzorek ‘ ‘ §rafovénf|

Piechod

MozZnosti

Typ:

Nahled

Linearni

[<]

Prirlstek:
Automaticky 64
Stied (X a Y):

4 F

3

lo% 2lo%

4

Uhel:

| -
Chraniéeni:

I 0%
QOd barvy:

(D] LD

‘ Pridat H Zménit |

[
| Svétlemodra3 ¥ ‘ ‘100 %

D]

Do barvy:

[*]

‘I:l Svétle modra4 ¥ ‘ 100 %

-

‘ Obnovit

o]

Obréazek 244: Dialogové okno Vlastnosti tabulky - karta Pozadi
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Pismo Efekty pro pismo Ohranié¢eni Pozadi Stin

Vliastnosti Nahled
Pouzit stin

(& C

b
|

Barva: B Cema

Vzdalenost: 0,40 cm

&—o0—0

4

Rozostreni: |0 pt

LR IRIE B RIS B

Prihlednost: |0 %

Obrazek 245: Dialogové okno Vlastnosti tabulky - karta Stin

Umisténi a velikost tabulky

Tabulky se pfi vytvareni umistuji do rameckd a zachazi se s nimi stejné jako s ostatnimi objekty
v kresbé. Pro tabulky vSak Ize pouzit pouze dialogové okno Umisténi a velikost (obrazek 246).
Nékteré moznosti jsou Sedé a nejsou pro tabulky k dispozici. Vice informaci o umisténi a velikosti
najdeme v kapitole 3, Prace s objekty.

Po vybéru tabulky otevieme dialogové okno Umisténi a velikost pomoci jedné z nasledujicich
MOZNosti:
* Klepneme pravym tlacitkem mySi na tabulku a z mistni nabidky vybereme Umisténi
a velikost.
* V hlavni nabidce vybereme Format > Umisténi a velikost.
+ Stiskneme klavesu F4.
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Umisténi a velikost Otoceni Naklonéni a polomér rohu
Umisténi
Pozice X: |1,27 cm = ® O O
Pozice Y: |1,15 cm = l o i
L]
Zakladni bod:
Velikost
Sitka: 14,10 cm = ® O O
Vyika:  [4,68 cm = l fe i
[ Zachovat pomér l ~ l
Zakladni bod:
Zamknout Pfizplisobit
O Umisténi Sitka podle textu
[ velikost Vyska podle textu
Napovéda Obnovit 0K Zrusit

Obréazek 246: Dialogové okno Umisténi a velikost

Umisténi tabulky je mozné ménit taZzenim kurzoru. Velikost textového pole Ize ménit taZzenim
jednoho z Gchytl pro vybér. Vice informaci najdeme v ¢asti , Textova pole" na strané 218.

@ Poznamka

Kdyz se zméni velikost pole tabulky, obsah tabulky a bunék se zvétSi nebo zmensi
tak, aby odpovidal velikosti pole.

Odstranéni tabulky

Cela tabulka
Ujistime se, Ze je tabulka vybrana a Uchyty vybéru jsou viditelné na okraji tabulky. Poté tabulku
odstranime nékterou z nasledujicich moznosti:
* V hlavni nabidce zvolime Format > Tabulka > Smazat tabulku, Smazat fadek nebo
Smazat sloupec.

* Na nastrojové listé Tabulka vybereme Smazat tabulku, Smazat fadek nebo Smazat
sloupec.

* Klepneme pravym tlacitkem mySi a z mistni nabidky vybereme Smazat > Smazat
tabulku, Smazat fadek nebo Smazat sloupec.

Rédek nebo sloupec
Klepneme na buriku tabulky a pomoci jedné z nasledujicich moZnosti odstranime fadek nebo
sloupec. Ujistime se, Ze nejsou zobrazeny Uchyty pro vybér tabulky.
* V hlavni nabidce vybereme Format > Tabulka > Smazat fadek nebo Smazat sloupec.
* Na nastrojové listé Tabulka zvolime Smazat fadek nebo Smazat sloupec.
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* Klepneme pravym tlaCitkem mySi a z mistni nabidky vybereme Smazat > Smazat fadek
nebo Smazat sloupec.

Obsah burniky
Obsah bunék v tabulce odstranime nasledujicim zptsobem:

1) Vybereme buriku nebo buriky.
2) Na klavesnici stiskneme klavesu Delete nebo Backspace.

Pouzivani poli

Pole umozniuji automaticke vkladani textu do kresby. Pole se béZné pouzivaji pfi vytvareni
Sablon a predloh kresby. Vice informaci o Sablonach a pfedlohach kresby najdeme v kapitole 11,
Pokrocilé techniky kresleni.

Vkladani poli

Textove pole se vytvori, kdyZ je pole vioZeno do stfedu kresby a jeho polohu Ize ménit stejné jako
u jinych textovych poli. Vice informaci najdeme v ¢asti ,Textova pole" na strané 218.

1) Jdeme do nabidky Vlozit > Pole a vybereme typ pole.

2) V pfipadé potfeby zménime jeho umisténi a velikost. Vice informaci najdeme v Casti
»1extova pole" na strané 218.

3) V pfipadé potifeby zformatujeme text informujici o poli. Vice informaci o ,Formatovani
textu" najdeme na strané 225.

Typy poli

V aplikaci Draw jsou k dispozici nasleduijici pole:

» Datum (neménné) — vlozi do kresby aktudlni datum jako pole s fixni hodnotou. Datum se
neaktualizuje. Dostupné formaty data zavisi na nastaveni jazyka v Nastroje > MoZnosti
> Jazykova nastaveni > Jazyk. Klepneme pravym tlacitkem mySi na pole data
a z mistni nabidky vybereme pozadovany format data.

* Datum (proménné) — vloZzi do kresby aktualni datum jako pole s proménnou hodnotou.
Datum se automaticky aktualizuje pfi kazdém otevieni souboru. Dostupné formaty data
zavisi na nastaveni jazyka v Nastroje > MoZnosti > Jazykova nastaveni > Jazyk.
Klepneme pravym tlacitkem mySi na pole data a z mistni nabidky vybereme poZzadovany
format data.

« Cas (neménny) — vloZi do kresby aktualni ¢as jako pole s fixni hodnotou. Cas se
neaktualizuje. Dostupné formaty Casu zavisi na nastaveni jazyka v Nastroje > MoZnosti
> Jazykova nastaveni > Jazyk. Klepneme pravym tlagitkem mySi na pole s Casem
a z mistni nabidky vybereme poZadovany format ¢asu.

« Cas (proménny) — vlozi do kresby aktuélni ¢as jako pole s promé&nnou hodnotou. Cas se
automaticky aktualizuje pfi kazdém otevieni souboru. Dostupné formaty Casu zavisi na
nastaveni jazyka v Nastroje > MozZnosti > Jazykova nastaveni > Jazyk. Klepneme
pravym tlaCitkem mysi na pole s Casem a z mistni nabidky vybereme poZadovany formét
casu.

* Autor — vlozi jméno a pfijmeni autora do kresby. Informace se prebira z uzivatelskych
Gdajd uloZzenych v LibreOffice. Zmé&nime je v nabidce Nastroje > MoZnosti >
LibreOffice > Uzivatelské tdaje.
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Cislo stranky — vloZi &islo stranky do aktualni kresby. Pfipadné v hlavni nabidce zvolime
Vlozit > Cislo stranky. Pokud ma byt na kazdou stranku kresby pfidano €islo stranky,
zvolime v hlavni nabidce Zobrazit > Pfedloha a vloZime pole s Cislem stranky.

Nazev stranky — vloZi nazev stranky. Pokud stranka nebyla pfejmenovana, je vychozim
nazvem snimku Strana #.

Pocet stranek — vloZi celkovy pocet stranek v kresbé.

Néazev souboru — vloZi nazev souboru pouZzitého pro kresbu. Nazev souboru se zobrazi
az po jeho ulozeni.

Hypertextové odkazy

PFi vkladani textu, ktery Ize pouZit jako hypertextovy odkaz (napfiklad adresa webové stranky
nebo URL), zformatuje aplikace Draw tento text automaticky, vytvori hypertextovy odkaz
a pouZije barvu a podtrzeni.

6 Tip

Pokud chceme LibreOffice zabranit v automatickém prevadéni webovych adres nebo
adres URL na hypertextové odkazy, zvolime Nastroje > Nastaveni automatickych
oprav > MoZnosti v hlavni nabidce a zruSime vybér volby Rozpoznani URL.

6 Tip

Barvu hypertextovych odkaz(i zménime v nabidce Nastroje > MoZnosti >
LibreOffice > Barvy aplikaci, pfejdeme na Nenavstivené odkazy a/nebo
Navstivené odkazy, zaskrtneme policka, vybereme z barevné palety nové barvy
odkazll a klikneme na OK. VSimneme si, Ze tato zména barvy zméni barvu viech
hypertextovych odkaz( ve vSech ¢astech LibreOffice.

Vkladani hypertextovych odkazi

1)
2)

3)

4)

5)

Klepneme na textové pole na poZzadované misto, kam chceme vloZit hypertextovy odkaz.

V hlavni nabidce pomoci volby Zvolit > Hypertextovy odkaz nebo pouzitim klavesové
zkratky Ctrl + K otevieme dialogové okno Hypertextovy odkaz (obrazek 247).

Vybereme pozadovany typ hypertextového odkazu a pozadované moznosti. Typy
hypertextovych odkazll a dostupné moznosti pro kazdy typ najdeme nize v ¢asti , Typy
hypertextovych odkazd.

Klepnutim na PouZit vloZime hypertextovy odkaz a uloZime naSe volby. Pokud vytvafime
nékolik hypertextovych odkazl, klepneme po vioZeni kazdého z nich na Poutzit.

Klepnutim na OK uloZime zmény a zavieme dialogové okno Hypertextovy odkaz.

Typy hypertextovych odkazti

Na levé strané dialogového okna vybereme jeden ze &tyf typl hypertextovych odkazt. Dialogové
okno se méni podle typu vybraného hypertextového odkazu.

Internet — tuto moznost vybereme, pokud se jedna o odkaz na web nebo FTP. Zadame
poZzadovanou webovou adresu (URL) a pfipadny text.

Posta — zadame pfijemce a pfedmét e-mailu.
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amn) Typ hypertextového odkazu
- Protokol: ®Web O FTP
Internet
URL: 2
Text:
Posta
N Dal3i nastaveni
= Ramec: ~ | Formular:
Dokument )
Nazew:
Novy doku...
Napovéda Obnovit Pouzit QK Zaviit

Obrazek 247: Dialogové okno Hypertextovy odkaz
Dokument

— Zadame cestu k souboru dokumentu nebo klepnutim na Otev¥it soubor otevieme
prohlize¢ soubor(. Pokud odkaz sméfuje na cil ve stejné kresbé&, ponechame tuto
polozku pradzdnou.

— Zadame cil, napriklad konkrétni stranku v kresbé. Klepnutim na Cil v dokumentu
otevieme dialogové okno Cil v dokumentu, kde Ize vybrat cil. Pokud je nazev cile
znam, zadame jej do pole.

— V pfipadé potfeby zadame URL adresu dokumentu. Tyto hypertextové odkazy se
bézné oznacuji jako zalozky.
Novy dokument — vytvori hypertextovy odkaz na novy dokument.

— Vybérem moznosti Upravit nyni miiZzeme nové vytvoreny dokument ihned upravit.
Pomoci volby Upravit pozdéji mizeme vytvofit novy dokument a upravit jej pozdéji.

— Vybereme typ dokumentu, ktery chceme vytvofrit (text, tabulka atd.).

— Klepnutim na Vybrat cestu otevieme prohliZze¢ soubori a prejdeme do slozky, kam
bude novy dokument uloZen.

Cast Dal3i nastaveni v dialogovém okné Hypertextovy odkaz je spole¢né pro viechny typy
hypertextovych odkazd, i kdyZz nékteré moznosti jsou pro nékteré typy odkazl vhodné&;jsi.

Ramec — uréuje zplsob otevieni hypertextového odkazu. Tyka se to dokumentt
oteviranych ve webovém prohliZzeci.

Formulaf — urCujeme, zda je odkaz zobrazen jako text nebo jako tlagitko.
Text — urCuje, jaky text bude pro uZivatele viditelny.

Nazev — pouzitelné pro HTML dokumenty. Ur&uje text pfidany jako atribut NAME v kddu
HTML za hypertextovym odkazem.
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Uprava textli hypertextovych odkazt(i

1) Vybereme hypertextovy odkaz.

2) V hlavni nabidce pomoci volby Upravit > Hypertextovy odkaz otevieme dialogové okno
Hypertextovy odkaz.

3) Provedeme potiebné zmény pomoci dostupnych moZnosti a po dokonceni klepneme na
Pouzit. Pokud chceme upravit nékolik hypertextovych odkazl, klepneme po Upravé
kazdého z nich na tlagitko Pouzit.

4) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno.

Obrazkové mapy

Obrazkova mapa definuje oblasti obrdzku (nazyvané hotspoty, aktivni oblasti) spojené s URL
(webovou adresou nebo souborem v pocitaci). Aktivni oblasti jsou grafické ekvivalenty
hypertextovych odkazl. V aplikaci Draw se klepnutim na aktivni oblast otevie odkazovana
stranka v pfislusném programu (napfiklad vychozi prohlize¢ HTML stranek; LibreOffice Writer
pro soubory ODT; prohlize¢ PDF pro soubory PDF).

Aktivni oblasti je mozné vytvaret v rliznych tvarech, napriklad obdélniky, elipsy a mnohouhelniky
a zahrnout nékolik aktivnich oblasti do jednoho obrazku. Po klepnuti na aktivni oblast se adresa
URL otevie v zadaném okné& nebo ramu prohlizeCe. Lze také zadat text, ktery se zobrazi, kdyz
kurzor najede na aktivni oblast.

Vytvareni obrazkovych map

1) V kreshé vybereme obrazek, které chceme pouzit jako aktivni oblast.

2) V hlavni nabidce pomoci volby Nastroje > Obrazkova mapa otevieme dialogové okno
Editor obrazkovych map (obrazek 248). Hlavni ¢ast dialogu zobrazuje vybrany obrazek,
v némz budou definovany aktivni oblasti.

3) Zikon v horni ¢asti dialogového okna Editor obrazkovych map vybereme poZzadovany typ
aktivni oblasti - Obdélnik, Elipsa, Mnohouhelnik, Mnohouhelnik od ruky.

4) Do vybraného obrazku nakreslime aktivni oblast.
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Obrazek 248: Dialogové okno Editor obrazkovych map

5) Do textového pole Adresa zadame adresu hypertextového odkazu pro aktivni oblast ve

forméatu: file:///<cesta>/nazev_dokumentu#nédzev_kotvy.

6) Kliknutim na ikonu PouZit nastaveni aplikujeme.
7) Klepnutim na UloZit uloZime obrazkovou mapu do souboru a zavieme dialogové okno

Editor obrazkovych map.

Nastroje obrazkovych map

Editor obrazkovych map obsahuje nasledujici nastroje:

PouZit — provede zmény

Otevfit — nahraje do Editoru obrazkovych map existujici obrazkovou mapu ve formatu
MAP-CERN, MAP-NCSA nebo SIP StarView.

Ulozit — ulozi obrazkovou mapu ve formatu MAP-CERN, MAP-NCSA nebo SIP StarView.
Vybrat — umoZnuje vybér aktivni oblasti v obrdzkové mapé pro Upravu.

Obdélnik, Elipsa, Mnohouhelnik, Mnohouhelnik od ruky — nakresli aktivni oblast ve
vybraném obrazku v pozadovaném tvaru.

Upravit body — zména tvaru vybrané aktivni oblasti Gpravou kotevnich bodd.
Pfesunout body — pfesun jednotlivych kotevnich bod{ vybrané aktivni oblasti.
Vlozit body — pfida kotevni bod ve vybraném misté na obrysu aktivni oblasti.
Smazat body - odstrani vybrany kotevni bod.

Zpét — zrusSi predchozi akci.
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* Znovu - znovu provede pfedchozi zruSenou akci.

* Aktivni — pfepina stav vybrané aktivni oblasti mezi aktivni a neaktivni.
* Makro — pfifadi makro, které se spusti po klepnuti na aktivni oblast.

* Vlastnosti — definuje vlastnosti vybrané aktivni oblasti.

* Adresa - zadame URL adresu souboru, ktery se otevie po klepnuti na vybranou aktivni
oblast. Format adresy, ktery se musi pouzit: file:///<cesta>/nazev
dokumentu#nazev_kotvy.

* Text — zadame text, ktery se zobrazi, kdyZ kurzorem najedeme na aktivni oblast. Pokud
neni zadan Zadny text, zobrazi se Adresa.

* Ramec - zadame nazev cilového ramce pro aktivni oblast. Z rozeviraciho seznamu Ize
vybrat standardni nazvy ramct a pouzit je.

— _blank — otevie se v novém okné prohlizecCe.
— _self —vychozi hodnota, odkaz se otevie v aktualnim okné.
— _top — soubor se otevre v hierarchicky nejvysSim rdmci.

— _parent — soubor se otevie v nadfazeném ramci aktualniho snimku. Pokud neni
Zadny nadfrazeny ramec, pouZzije se aktualni.

» Grafické zobrazeni — zobrazi obrazkovou mapu tak, aby bylo mozné vybirat a upravovat
aktivni oblasti.

@ Tip
Hodnota _self pro cilovy snimek bude fungovat ve velké vétsiné pripad(.
Nedoporucuje se pouZivat ostatni hodnoty, pokud to neni nezbytné nutné.

Pismomalba

Pomoci nastroje Pismomalba vytvofime graficky text jako objekt, aby kresba vypadala
atraktivnéji. Pro praci s pismomalbou existuje mnoho rliznych nastaveni (¢ara, oblast, umisténti,
velikost a dalsi), ktera odpovidajici pozadavkim kresby.

Pismomalba je také dostupna v aplikacich Writer, Calc a Impress kancelarského baliku
LibreOffice, ale zplsob, jakym jednotlivé moduly LibreOffice pismomalbu zobrazuji, se trochu lisi.
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Vytvareni pismomalby

1)

2)

3)
4)

5)

Dialogové okno Galerie pismomalby (obrdzek 249) otevieme jednim z nasledujicich
zpUsobd.

— V hlavni nabidce zvolime Vlozit > Pismomalba.

— Klepneme na ikonu Vlozit text pismomalby na Standardni nastrojové liSté.

— Klepneme na ikonu Vlozit text pismomalby na nastrojové listé Pismomalba, pokud
je nastrojova lista viditelna.

V dialogu vybereme styl pismomalby a klikneme na OK. Vybrany objekt Pismomalby se

zobrazi uprostfed kresby a dialogové okno se zavre.

Dvakrat klepneme na Cerny text v objektu Pismomalby a zapneme rezZim Gprav.

Zadame poZadovany text, ktery nahradi Cerny text v objektu Pismomalby, jak je
zndzornéno na obrazku 250.

Zmény provedeme stisknutim klavesy Esc nebo klepnutim mimo vybranou oblast.

Nastrojova lista Pismomalba

Nastrojova lisSta Pismomalba (obrazek 251 bude na pracovni ploSe viditelna a aktivni, kdyz
vybereme objekt Pismomalby. Neni-li nastrojova liSta zobrazena, jdeme do nabidky Zobrazit >
Nastrojové listy > Pismomalba.

Pro upravu objektu Pismomalby jsou k dispozici nasledujici nastroje.

Vlozit text pismomalby — otevie dialog Galerie pismomalby.

Tvar pismomalby — umoZni zménit tvar vybraného objektu. Klepnutim na Tvar
pismomalby otevieme vyskakovaci nastrojovou liStu a z dostupnych moznosti vybereme
tvar pismomalby. Tvary jsou zobrazeny na plovouci nastrojové listé Tvar pisma (obrazek
252).

Stejna vyska pismen pismomalby — upravi vysku znakl ve vybraném objektu
pismomalby. Pfepind mezi normalnim pismem s rliznou vyskou znakl a rezimem stejné
vy$ky vSech znakd.

Zarovnani pismomalby — ur€uje zarovnani textu pismomalby uvnitf ramce. Moznosti
jsou Zarovnani doleva, Na stred, Zarovnani doprava, Do bloku a Roztahnout. Zarovnani
textu se projevi pouze tehdy, zabira-li text aspon dva fadky. V reZimu Roztdhnout jsou
vSechny fadky zcela vyplnény textem.

Rozestup znak{ pismomalby — nastavuje vzdalenosti mezi znaky a pouziti kerningu.
MoZznosti jsou Velmi tésné, Tésné, Normalni, Volné, Velmi volné a Vlastni. Pro viastni
rozestupy zadame procentudlni hodnotu: 100% je normalni rozestup znakl, méné nez
100% je uzsi rozestup znak(l a vice nez 100% je volnéjsi rozestup znakd.

Pfepnout plasti¢nost — pievede objekt pismomalby na 3D tvar pfidanim hloubky znakd.
Vice informaci najdeme v kapitole 7, 3D objekty.

Uprava pismomalby

S objektem Pismomalby Ize zaché&zet jako s jakymkoliv jinym objektem v aplikaci Draw. Lze
ménit jeho velikost, otacet jej, seSikmit, zkosit, prevrétit atd. DalSi informace o Upravach objektu
Pismomalby najdeme v kapitole 3, Prace s objekty, kapitole 4, Zména atribut(l objektu a kapitole

5, Kombinace vice objektd.

Pismomalba je text a a je na néj mozné pouzit jakékoliv formatovani textu popsané v této

kapitole. Pfifadime vlastnosti pouze tém ¢astem pisma, které NEBUDOU prevedeny na 3D efekt

pomaci funkce Pfepnout plasti¢nost. Jinak nebudou viastnosti ¢ar viditelné.
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Neékteré tvary Pismomalby Ize upravit. Napfiklad zménit thel zakladnich tvarli lichobé&zniku nebo
rovnobézniku, posunutim tec€ky, ktera je zobrazena spolu s Uchyty vybéru
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Tisk

Rychly tisk

Pokud chceme dokument rychle vytisknout, klepneme na ikonu Vytisknout pfimo na Standardni
nastrojové listé (obrazek 253) a odeSleme cely dokument na vychozi tiskarnu, kterou mame na
pocitaCi nastavenu.

Tisknout piimo

Standardni /
r
wT-EHQ D& & XD =

r|

> . = — —
QBE-WEQC-BF & O A ¢ %8

Obrazek 253: Standardni nastrojova lista

Poznamka

Akci provadénou klepnutim na ikonu Vytisknout pfimo miizeme také zménit. Na
misto odesilani dokumentu na vychozi tiskarnu naseho pocitace mizeme definovat
tiskarnu pro dany dokument. Toto provedeme v nabidce Nastroje > MoZnosti >
Nacist/Ulozit > Obecné a zvolime moznost S dokumentem nacist nastaveni
tiskarny.

Poznamka

Pokud se polozka Vytisknout pfimo nenachazi na Standardni néstrojoveé liste,
klepneme pravym tlacitkem mysi do prdzdné oblasti na listé a z mistni nabidky
vybereme moznost Viditelna tlaéitka. Ze zobrazeného seznamu nastrojii vybereme
Vytisknout pfimo a nastroj se pfida na Standardni liStu.

Rizeny tisk
Chceme-li mit vétSi kontrolu nad tiskem, otevieme a pouzijeme pomoci jedné z nasledujicich
metod dialogové okno Tisk (obrazek 254 a 255):

* V nabidkové listé pfejdeme do nabidky Soubor > Tisk.
* PouZijeme klavesovou zkratku Ctrl + P.
+ Stiskneme tlacitko Tisk na Standardni nastrojoveé listé.

Poznamka

MozZnosti vybrané v dialogovém okné Tisk se vztahuji pouze na tisk aktualniho
dokumentu otevieného v aplikaci Draw. Chceme-li zadat vychozi nastaveni tisku pro
LibreOffice, pfejdeme v hlavni nabidce na Nastroje > MoZnosti > LibreOffice >
Tisk a otevieme dialogové okno Moznosti tisku LibreOffice.
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O Poznamka

Vzhledem k rdznym nastavenim pocitace a rliznym operacnim systémim se

dialogové okno tisku, které se otevie na monitoru pocitace, mlze lisit od dialogovych
oken zobrazenych na obrazcich 254 a 255. MoZnosti tisku dostupné pro LibreOffice

vSak zUstavaji stejné.

Obecné LibreOffice Draw

Tiskarna

[EPSON L800 Series

e |

Stav: Vychozi tiskarna

297 mm (A4)

Rozsah a kopie
@® Viechny stranky
o Stranky: 1
1 O Vbér

Vlastnosti...

Al Zahrnout: ‘Liché a sudé stranky

210 mm

AL |
II| 1 Iﬁl'} f.-. |||
_ ".-_| l‘ [ ||; It I [H Dalsi
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RozvrZeni stranky

Velikost papiru:  |A4 210mm x 297mm v|

Orientace: ‘Automaticky

Dalsi

[ Nahled | = |71 =

Napovéda

Tisk

Zrusit

Obréazek 254: Dialogové okno Tisk - stranka Obecné

o Poznamka

VSechny moZnosti tisku vybrané v dialogovém okné Tisk z aplikace Draw prepiSou
vychozi nastaveni tiskarny, ktera byla nastavena pomoci Nastroje > Moznosti >
LibreOffice > Tisk a Nastroje > MoZnosti > LibreOffice Draw > Tisk.

Obecné mozZnosti

Nasledujici obecné moznosti jsou prikladem toho, co mdze byt k dispozici na strance Obecné

dialogového okna Tisk (obrazek 254).

» Tiskarna — vybereme tiskarnu, kterou chceme pouzit, z tiskaren dostupnych

V rozeviracim seznamu.
* Rozsah a kopie — vybereme z nasledujicich moznosti:

— VSechny stranky — vytiskne vSechny stranky dokumentu.
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— Stranky — vybereme Cislo stranky (stranek), které chceme vytisknout. Pro vice stranek
pouzijeme format 1, 3, 7 nebo 1 -5, 7, 9 pro vybér Cisla stranky.

— Vybér — vybereme z rozeviraciho seznamu Sudé a liché stranky, Liché stranky nebo
Sudé stranky..

— Strany papiru — vybereme z rozeviraciho seznamu Tisknout jednostranné, Tisknout
oboustranné (dlouhy okraj) nebo Tisknout oboustranné (kratky okraj).

— Pocet kopii — zadame pocet pozadovanych tisténych kopii dokumentu.
— Seradit — sefadi vice vytisténych kopii do samostatnych dokument.

— Poradi — vybereme z moZnosti Viytvorit samostatné tiskové ulohy pro sefazeny vystup
nebo Tisknout v opacném poradi.

* Rozvrzeni stranky — vybereme z nasledujicich moznosti:

— Velikost papiru — z rozeviraciho seznamu vybereme velikost papiru, kterou chceme
pouZit.

— Orientace — vybereme z rozeviraciho seznamu Automaticky, Na vysku nebo Na Sirku.
— Stranek na list — v rozeviracim seznamu vybereme, kolik stranek se vytiskne na jeden

list papiru.
— Poradi — z rozeviraciho seznamu vybereme poradi tisku vice stranek na jeden list
papiru.

— Nakreslit okraj kolem kaZdé stranky — pokud je na jeden list papiru vytiSténo vice
strének, je kolem kazdé stranky nakreslen ramecek.

— Pfirucka — vytiskne dokument tak, aby bylo mozné stranky sloZzit do broZury.

MoZzZnosti LibreOffice Draw

Nasledujici moZnosti jsou k dispozici na strance LibreOffice Draw dialogového okna Tisk
(obrazek 255), kde jsou definovana nastaveni specificka pro aktualni typ dokumentu:

* Obsah — vytiskne na vykres Néazev stranky a/nebo Datum a cas.
+ Barva — vytiskne vykres v Pivodnich barvach, Stupnich Sedé nebo Cernobile.
* Velikost — tiskne vykres pomoci jedné z nasledujicich moznosti:

— Pdvodni velikost — vytiskne vykres v plvodni velikosti.
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Obecné LibreOffice Draw
Obsah

[ Nazev stranky

[ Datum a ¢as

Barva
® Plvodni barvy

297 mm (A4) ) Stupné 3edi
O Cernd a bila

Velikost
® Pivodni velikost
) Piizpsobit stranku rozsahu tisku
) Rozdélit na vice listd papiru
) Naskladat opakované stranky na papir

210 mm

[ Nahled W= |7 =M

Napovéda Tisk Zrusit

Obrazek 255: Dialogové okno Tisk - stranka LibreOffice Draw

— PrizpUsobit stranku rozsahu tisku — velikost vykresu se zméni tak, aby se vesel na
format papiru pouzivany pro tisk.

— Rozdélit na vice listt papiru — pouziva se, pokud je vykres prilis velky na pouzity
format papiru.

— Naskladat opakované stranky na papir — pouziva se k tisku vice kopii vykresu na
stranku.

0 Poznamka
Nasledujici pokyny k tisku jsou pouze priklady. Skute¢ny zplsob tisku se miZe od
prikladd lisit, protoZze zAavisi na operaénim systému pocitace, nastaveni pocitace
a pouzité tiskarné.

Tisk vice stranek na jeden list
Tisk vice stranek vykresu na jeden list papiru:

6) Otevieme dialogové okno Tisk, viz ,Rizeny tisk* na strané 263.
7) Pokud je k pocitaci pfipojeno vice tiskaren, vybereme tiskarnu, kterd se ma pouZzit.
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8) V sekci RozloZeni stranky vybereme z rozeviraciho seznamu Strének na list pocet
stranek, které se maji vytisknout na jeden list papiru. Panel nahledu vpravo ukazuje, jak
budou stranky vypadat na vytisténém listu papiru.

9) V sekci RozloZeni stranky vybereme z rozeviraciho seznamu Poradi zplsob tisku vice
stranek na list papiru.

10) V pfipadé potfeby vybereme moznost Kresleni ramecku kolem kazdé stranky, abychom
odlisili jednotlivé stranky vytisténé na listu papiru.

11) Kliknutim na tlacitko OK vytiskneme dokument a zavieme dialogové okno Tisk.

Vybér stranek k tisku

Jednotliva stranka
1) Otevieme dialogové okno Tisk, viz ,Rizeny tisk* na stran& 263.
2) Pokud je k pocitaci pfipojeno vice tiskaren, vybereme tiskarnu, ktera se ma pouzit.

3) V Casti Rozsah a kopie vybereme moznost Stranky a zadame Cislo stranky, kterou
chceme vytisknout.

4) Kliknutim na tla¢itko OK vytiskneme jednotlivé stranky a zavieme dialogové okno Tisk.

Rozsah stranek
1) Otevieme dialogové okno Tisk, viz ,Rizeny tisk* na stran& 263.
2) Pokud je k pocitaci pfipojeno vice tiskaren, vybereme tiskarnu, ktera se ma pouzit.

3) V sekci Rozsah a kopie vybereme moznost Stranky a zadame Cisla stranek, které
chceme vytisknout, pomoci formétu, napfiklad 1,3,7 nebo 2-5,7,9 pro vybér Cisla stranky.

4) Kliknutim na tlacitko OK vytiskneme stranky a zavieme dialogové okno Tisk.
Vybér tisku

1) Otevieme dialogové okno Tisk, viz ,Rizeny tisk na strané 263.

2) Pokud je k pocitaci pfipojeno vice tiskaren, vybereme tiskarnu, ktera se méa pouzit.

3) V sekci Rozsahy a kopie vybereme moznost Vybér a poté v rozeviracim seznamu
vybereme moZznost Liché a sudé stranky, Sudé stranky nebo Liché stranky.

4) Kliknutim na tlagitko OK vytiskneme stranky a zavieme dialogové okno Tisk.
Tisk pFiruc¢ky
V aplikacich Writer, Impress a Draw Ize dokument vytisknout jako pfiru¢ku (nazyvano take jako

tisk brozury). Stranky jsou usporadany tak, aby po pfelozeni vytisténych stranek na polovinu byly
stranky ve spravném poradi a tvorily pfirucku nebo brozuru.

6 Tip

Naplanujeme dokument tak, aby dobfe vypadal pfi tisku jako pfirucka. Zvolime
vhodné okraje, velikost pisma atd., protoZe stranky se obvykle tisknou v polovi¢ni
velikosti na list papiru. Experimentujme, abychom ziskali nejlepsi forméat dokumentu
odpovidajici moznostem pouZité tiskarny.

Tiskarna s jednostrannym tiskem
Tisk prirucky nebo brozury na tiskarné, kterd umoznuje pouze jednostranny tisk:
1) Otevieme dialogové okno Tisk, viz ,Rizeny tisk na strané 263.
2) Pokud je k pocitaci pfipojeno vice tiskaren, vybereme tiskarnu, ktera se méa pouzit.
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3)

4)

5)

6)
7

8)
9)

10)

11)

V sekci Tiskarna klepneme na Viastnosti a otevieme dialogové okno vlastnosti vybrané
tiskarny.

Zkontrolujeme, Ze je tiskarna nastavena na stejnou orientaci (na vysku nebo na Sirku),
jaka je uvedena v nastaveni stranky dokumentu. Kromé tisku broZury toto nastaveni
obvykle neni dilezité.

Kliknutim na tlaCitko OK zavieme dialogové okno vlastnosti a vratime se do dialogového
okna Tisk.
V sekci RozloZeni stranky vybereme moznost DalSi a poté moznost Pfirucka.

V sekci Rozsah a kopie vybereme z rozeviraciho seznamu Vybér moznost Sudé stranky
nebo Liché stranky.

Kliknutim na OK vytiskneme sudé nebo liché stranky.

VytiSténé stranky vyjmeme z tiskarny a vioZzime je zpét do tiskarny ve spravné orientaci
pro tisk na prazdnou stranu. To mizZe vyZadovat urcité testovani, abychom zjistili, jaké je
spravné usporadani pro vybranou tiskarnu.

Pokud byla vybrana moznost Sudé stranky, vybereme nyni moznost Liché stranky v sekci
Rozsah a kopie. Pokud byla vybrana moznost Liché stranky, vybereme nyni moznost
Sudé stranky v sekci Rozsah a kopie.

Kliknutim na tlacitko OK dokoncime tisk dokumentu jako pfirucky a zavieme dialogové
okno Tisk.

Oboustranna tiskarna
Tisk pfirucky nebo brozury na tiskarné, kterd umozfuje oboustranny tisk:

1)
2)
3)

4)

5)
6)
7

8)
9)

Otevieme dialogové okno Tisk, viz ,Rizeny tisk* na stran& 263.
Pokud je k pocitaci pfipojeno vice tiskaren, vybereme tiskarnu, ktera se ma pouzit.

V sekci Tiskarna klepneme na Viastnosti a otevieme dialogové okno vlastnosti vybrané
tiskarny.

7y

Zkontrolujeme, Ze je tiskarna nastavena na stejnou orientaci (na vysku nebo na Sirku),
jaké je uvedena v nastaveni stranky dokumentu. Krome tisku broZury toto nastaveni
obvykle neni dilezité.

Kliknutim na tlac¢itko OK zavieme dialogové okno vlastnosti a vratime se do dialogového
okna Tisk.

V sekci Rozsah a kopie vybereme moZznost DalSi a poté v rozeviracim seznamu Strany
papiru vybereme moznost Tisknout oboustranné (dlouhy okraj). Skute€né moznosti
oboustranného tisku zavisi na modelu tiskarny a pouzitém pocitatovém systému.

V sekci RozvrZeni stranky vybereme moznost DalSi a poté moznost Prirucka.
V sekci Rozsah a kopie vybereme moznost VSechny stranky.
Kliknutim na OK vytiskneme dokument jako pfirucku a zavieme dialogové okno Tisk.

Cernobily tisk nebo tisk ve stupnich Sedi

Nastaveni tiskarny
Tisk dokumentd v Eernobilé nebo Sedé Skale na barevné tiskarné:

1)
2)
3)
4)
5)

Otevieme dialogové okno Tisk, viz ,Rizeny tisk* na stran&é 263.

Pokud je k pocitaci pfipojeno vice tiskaren, vybereme tiskarnu, ktera se ma pouzit.
Kliknutim na LibreOffice Draw otevieme stranku moznosti tisku pro LibreOffice Draw.
V sekci Barva vybereme moznost Stupné Sedi nebo Cerna a bila.

Kliknutim na tlaCitko OK vytiskneme dokument a zavieme dialogové okno Tisk.
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o Poznamka

Nékteré barevné tiskarny mohou umoznit pouze barevny tisk bez ohledu na zvolené
nastaveni. DalSi podrobnosti nalezneme v informacich dodanych s vybranou
tiskarnou.

ﬂ Tip

Odstiny Sedé jsou nejlepSi moznosti pro tisk barevného textu nebo grafiky
v dokumentu na Cernobilé tiskarné. Barvy vytisténé v odstinech Sedé poskytuji vice
detailli. PFi Cernobilém tisku barev se nékteré z téchto detailll mohou ztratit.

LibreOffice MozZnosti stranky Tisk
Nacitani/ukladani ® Vychozi [ Nazev stranky
. \ ) N
= Je_'zykwé nastaven (O Prizptsobit rozméru stranky L1 Datum
= LibreOffice Draw O Stra ko dlazdi mle
Obecné tranky ja aZdice as
Zobrazen () Prirucka Skryté stranky
MFiFka :)F'EC ni
Zadni
LibreOffice Base 1 Zasobnik papiru z nastaveni tiskarny
G
rafy Kvalita
Internet
® Vychozi
) Stupné sedi

O Cernd a bila
Obréazek 256: MozZnosti dialogového okna Tisk LibreOffice Draw.

Nastaveni LibreOffice
Zmeéna nastaveni LibreOffice tak, aby se vSechny barevné texty a grafika tiskly ve stupnich Sedi:

1) V hlavni nabidce zvolime Nastroje > MoZnosti > LibreOffice Draw > Tisk a otevieme
dialogové okno Moznosti tisku LibreOffice Draw (obrazek 256).

2) V sekci Kvalita vybereme moznost Stupné Sedi nebo Cernd a bila.

3) Kliknutim na OK uloZime zménu a zavieme dialogové okno MozZnosti tisku LibreOffice
Draw.

4) Vytiskneme dokument jednim z vySe uvedenych postupl a dokument se vytiskne ve
stupnich Sedi nebo Cernobile.

Exportovani

LibreOffice umi exportovat dokumenty do formatu PDF (Portable Document Format). Tento
pramyslovy standard formatu souboru je idealni pro odeslani souboru k prohlizeni nékomu
jinému pomoci softwaru pro prohlizeni PDF.

Pfimo ve formatu PDF

Export celého dokumentu s pouZitim vychoziho nastaveni PDF je nasleduijici:
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1) Klepneme na Pfimy export do PDF na nastrojové listé Standardni nebo pfejdeme
v hlavni nabidce na Soubor > Exportovat jako > Pfimy export do PDF.

2) Zadame nazev a umisténi souboru PDF a kliknutim na UloZzit soubor exportujeme jako
PDF.

O Poznamka

VSimnéme si, Ze pfi vytvareni souboru PDF touto metodou neni k dispozici rozsah
stranek, komprese obrazkl ani dal$i moZnosti tisku.

Nastaveni obsahu a kvality PDF

Chceme-li mit vétsi kontrolu nad obsahem a kvalitou vysledného souboru PDF, pouzijeme
moznosti dostupné v dialogovém okné Moznosti PDF (obrazek 257). Dalsi informace
o dostupnych mozZnostech nalezneme v pfiru€ce Zaciname s LibreOffice.

1) V hlavni nabidce zvolime Soubor > Exportovat jako > Exportovat jako PDF a otevfe
se dialogové okno MoZnosti PDF.

2) Vybereme pozadované moznosti dostupné na strankach Obecné, Vychozi zobrazeni,
UzZivatelské rozhrani, Odkazy, Zabezpeceni a Elektronické podpisy.

3) Klikneme na tla¢itko Exportovat a otevie se okno prohlizece soubord.
4) Prejdeme do umisténi a zadame nazev vytvareného souboru PDF.

5) Kliknutim na UloZit exportujeme soubor do formatu PDF. Okno prohlizece soubor(
a dialogové okno Moznosti PDF se zaviou.

Obecné Vychozi zobrazeni UZivatelské rozhrani Odkazy Zabezpeceni Elektronické podpisy

Rozsah Obecné
® e [ Hybridni PDF (vioZit soubor ODF)
O Stranky: L] Archivni (PDF/A, ISO 19005)
O VWbér Verze PDF/A:
[ Zobrazit PDF po dokonéeni exportu L] Univerzalné pfistupné (PDF/UA)
[] Tagované PDF (se strukturou dokumentu)
Obrazky _ . -
Vytvoiit PDF formulai
Q Bezztratova komprese = Format odeslani:
® Komprese JPEG Kvalita: |90 % S )
L1 Povolit shodné nazvy poli
Zmensit rozlideni obrazkd 300 DPI e
Struktura
Vodoznak Exportovat osnovu
[ Podepsat vodoznakem [ Komentére jako pozndmky PDF
Exportovat automaticky vloZené prazdné stranky
O Pou#it odkazy XObject
Napovéda Exportovat Zrudit

Obrazek 257: Dialogové okno MozZnosti PDF — stranka Obecné
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DalSi formaty

LibreOffice umi exportovat soubory v réiznych forméatech, které jsou uvedeny v rozeviracim
seznamu okna prohliZzece souborl. Dal$i informace o exportu grafiky nalezneme v kapitole 6,
Upravy obrazkd.

Export souboru v jiném formatu:

1) V nabidkové listé pfejdeme na Soubor > Exportovat a otevieme okno souborového
spravce.

2) Prejdéte do adresare, do kterého bude kresba uloZena.

3) V textovém poli Nazev zaddme nézev souboru pro exportovanou kresbu.
4) V rozeviracim seznamu vybereme poZadovany forméat souboru.

5) Kliknutim na UloZit soubor uloZime a zavieme okno prohlizece soubord.

@@ Poznamka

Obsah exportovaného souboru zavisi na prvcich vybranych na vykrese. Pokud
nejsou vybrany zadné prvky, vyexportuje se cely vykres.

Pfifadit navrh
® Novy navrh
Existujici navrh
Vyberte existujici navrh nebo vytvorte nowvy Smazat vybrany navrh
Napovéda < £pét Vytvorfit Zrusit

Obrazek 258: Dialogové okno Export HTML

Webové stranky
Export vicestrdnkového dokumentu Draw jako série webovych stranek:

1) V nabidkove listé pfejdeme na Soubor > Exportovat a otevieme okno souborového
spravce.

2) Jako formét souboru vybereme Dokument HTML a kliknutim na UloZit otevieme
dialogové okno Export HTML (obrazek 258).

3) Vytvorime Novy navrh nebo vybereme EXxistujici navrh a klepneme na Dalsi.

4) Podle pokyn( vytvofime webové stranky a uloZzime vykres jako soubor HTML. Dalsi
informace o vytvafeni souboru HTML nalezneme v pfiru¢ce ZaCiname s LibreOffice.
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Odesilani dokumentu e-mailem

LibreOffice nabizi nékolik zplsobl, jak rychle a snadno odeslat dokumenty jako pfilohu e-mailu
ve formatu ODF (vychozi format LibreOffice) nebo ve formatu PDF. DalSi informace najdeme
v pfirucce Zac¢iname.

Poznamka

Dokumenty Ize odesilat z nabidky LibreOffice pouze v pfipadé, Ze byl nastaven e-
mailovy profil.

Open Document format
Zaslani aktualniho dokumentu ve formatu ODF e-mailem:

1) V hlavni nabidce zvolime Soubor > Odeslat > Odeslat dokument e-mailem. LibreOffice
otevre vychozi e-mailovy program s dokumentem pfipojenym k novému e-mailu.

2) V e-mailovém programu zadame pfijemce, pfedmét a zpravu a poté e-mail odeSleme.

Format PDF
Odeslani aktualniho dokumentu e-mailem jako souboru PDF:

1) V hlavni nabidce zvolime Soubor > Odeslat > E-mailem jako PDF. LibreOffice vytvori
soubor PDF pomoci vychoziho nastaveni PDF a poté otevie e-mailovy program
s pfipojenym souborem PDF do nového e-mailu.

2) V e-mailovém programu zadame pfijemce, pfedmét a zpravu a poté e-mail odeSleme.

Digitalni podpisy

Digitalni podpis je matematické schéma pro ovéfovani pravosti digitalnich verzi kreseb nebo
dokumentd.

K digitalnimu podpisu vykresu je zapotiebi osobni kli€, znamy také jako certifikat. Tento osobni
KIi¢ je uloZzen v pouzivaném pocitaci jako kombinace soukromého klice, ktery musi byt utajen,
a vefejného klice. Tyto KkliCe se pfidavaji k vykresu pfi pouziti digitalniho podpisu. Certifikat se
ziskava od certifikacni autority, kterou mdze byt soukroma spolecnost nebo statni instituce.

Pfi pouziti digitalniho podpisu na kresbu se z obsahu kresby a pouZitého osobniho klice vypocita
kontrolni soucet. Kontrolni soucet a vefejny kli€ jsou uloZzeny spolec¢né s kresbou.

PTi otevieni vykresu na jiném pocitaci s nejnoveéjsi verzi LibreOffice program znovu vypocita
kontrolni soucet a porovna jej s ulozenym kontrolnim souctem. Pokud jsou oba kontrolni soucty
stejné, program otevie ptvodni, nezménénou kresbu.

Kromé toho miiZe program zobrazit informace o verejném klici z certifikatu. Tyto informace Ize
nasledné porovnat s vefejnym kliem, ktery je zvefejnén na webovych strankach certifikacni
autority. Pfi kazdé zméné kresby dojde k poruseni digitalniho podpisu.

Podrobnéjsi popis ziskani, pouzivani a spravy certifikatu a ovérovani platnosti podpisu
nalezneme v pfiru¢ce Zaciname s LibreOffice a v “PouZziti digitalnich podpist“ v napovédé
LibreOffice (https://help.libreoffice.org/7.1/en-US/text/shared/guide/digitalsign_send.html?
&DbPAR=WRITER&System=UNIX).
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Odstranéni osobnich udajli

Pred odeslanim kreseb dalSim osobam nebo souborli PDF vytvorenych z kreseb miZe byt nutné
odstranit z nich veSkeré osobni udaje, verze, poznamky, skryté informace nebo zaznamenané
zmeény.

Nastaveni moznosti zabezpeceni a upozornovani
Nastaveni moznosti zabezpeceni a varovani pro kresbu:

1) V Nastroje > MozZnosti > LibreOffice > Zabezpeceni otevieme dialogové okno
Moznosti zabezpeceni LibreOffice (obrazek 259).

2) Kliknutim na MoZnosti otevieme dialogové okno MoZnosti zabezpeceni a upozoriiovani
(obrazek 260).

3) Vybérem pozadovanych moznosti povolime LibreOffice upozorfiovat na to, Ze kresby
obsahuiji urcité informace, a/nebo automaticky odstrafiovat osobni Gdaje pfi ukladani.

4) Kliknutim na tlac¢itko OK zavieme dialogové okno MoZnosti zabezpeceni a upozorfiovani
a ulozime vybér moznosti.

= LibreOffice MozZnosti zabezpeéeni a upozorfiovani

UZivatelske ddaje Upravte nastaveni zabezpeceni a upozormovani na skryty

; 5 MozZnosti...
Obecné obsah dokument. s
Zobrazeni -

Tisk Hesla pro pfipojeni k webu
Cesty [ Trvale uloZit hesla pro webova spojeni Spajent..
Pisma | Chranit hlavnim heslem (doporuceno)
._ Hesla jsou chranéna hlavnim heslem. Pokud LibreOffice :
N - z ; St : LT Hlavni heslo...
Prizpascbeni pfistupuje k heslu v chranéném seznamu hesel, budete
Barvy aplikaci jednou béhem relace poZadani o zadani hlavniho hesla.
Zprlstupnem Zal L
Pokrodilé - = T S .
MNastavte Groven zabezpefeni pro spousténi maker a urete T
OpenCL Zabezpedfeni maker...

divéryhodné zdroje maker.

[+ Nacitanifukladani
[# Jazykové nastaveni Autority casovych razitek
# LibreOffice Draw Upravte seznam adres URL pro autority €asovych razitek :
@ LibreOffice Base (TSA), které se pougiji u elektronickych podpisG pfi exportu | Autority asovyich razitek...
@ Grafy do PDF.
# Internet
Napovéda Obnovit Pouzit 0K Zrusit

Obrazek 259: Dialogové okno MoZnosti zabezpeceni LibreOffice
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Bezpecnostni upozornéni

Upozornit, pokud dokument cbsahuje zaznamenané zmény, verze, skryté informace nebo poznamky:

LIPfi ukladani nebo odesilani: Pfi podepisovani

[ Pii tisku

MoZnosti zabezpeceni

MNapovéda

U] Pii tvorbé PDF soubor

[ Odstranit pfi ukladani osobni informace

U Doporuéit pii ukldddni ochranu heslem

Pro otevieni hypertextowych odkazi vyZadovat Ctrl-kliknuti
[ Blokovat odkazy z dokumentd, které nejsou uloZeny v divéryhodnych umisténich (viz Zabezpeéeni maker)

Jol'¢ Zrusit

Obrazek 260: Dialogové okno MoZnosti zabezpecCeni a upozorriovani

Iyp:

Umisténi:

WVelikost:

Vytvofen:

Zménén;

Sablona:

Elektronicky podepsan:
Wytistén:

Celkowy ¢as Uprawv:

Cislo revize:

MNapovéda

DG7110 - Tisk, Export, E-mail.odg
Kresba OpenDocument
DAMOJE DOKUMENTY\ROZROBENE VECI\DOKUMENTACIA LIBRE OFFICE\C

911 kB (932 814 Bajtd)
28.05.2021, 20:22:42
19.07.2021, 15:35:12

Zménit heslo

Elektronické podpisy...
00:37:15
9
PouZit uZivatelské udaje ) )
) Obnovit vlastnosti
UloZit s timto dokumentem obrazek nahledu
Cbnovit OK Zrusit

Obrazek 261: Dialogové okno Vlastnosti
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Odstranéni osobnich tudaji a informaci o kresbhé

1) V hlavni nabidce zvolime Soubor > Vlastnosti a otevieme dialogové okno
Vlastnosti(obrazek 261) pro otevienou kresbu.

2) Na strance Obecné zrusime zaSkrtnuti policka PouZit uZivatelské udaje.

3) Kliknutim na Obnovit viastnosti odstranime veskeré informace v polich vytvofeno
a upraveno, odstranime data Uprav a tisku, vynulujeme €as Uprav, datum vytvorfeni
vynulujeme na aktualni datum a Cas a Cislo verze vynulujeme na 1.

4) Kliknutim na tlacitko OK uloZime zmény a zavieme dialogové okno Vlastnosti.

Odstranéni informaci o verzi
Chceme-li z vykresu odstranit informace o verzi, pouzijeme jednu z nasledujicich metod:

* V hlavni nabidce zvolime Soubor > Verze a otevieme dialogové okno pro kresbu, poté
vybereme verze ze seznamu k odstranéni a klikneme na Odstranit. Dialogové okno se
automaticky zavre.

* V hlavni nabidce zvolime Soubor > UloZit jako a ulozime kresbu pod jinym nazvem.

Redakéni uprava

Dokumenty Ize redigovat, aby se odstranily nebo skryly citlivé informace, coZ umozfiuje selektivni
zverejnéni informaci v dokumentu, zatimco ostatni ¢asti dokumentu zUstavaji tajné.

PTi exportu redigovaného dokumentu do nového dokumentu jsou vSechny redigované casti
odstranény a nahrazeny redigovanymi bloky pixelG. Tim se zabrani jakémukoli pokusu

o obnoveni nebo kopirovani plivodniho obsahu. Redigovany dokument se ¢asto exportuje do
forméatu PDF za ucelem zvefejnéni nebo sdileni.

Redakéni Gprava W X

DY E B D

Obrazek 262: Panel
nastroji Redakcni
Uprava

V8echny dokumenty redigované v aplikacich LibreOffice Writer, Calc nebo Impress se
automaticky pfenesou jako kopie do aplikace LibreOffice Draw, kde se provede redak¢ni Uprava.

Dokumenty, seSity nebo prezentace

1) Otevieme dokument, ktery chceme redakéné upravit, v LibreOffice Writer, Calc nebo
Impress, pak pfejdeme na Nastroje > Redakéné upravit v hlavni nabidce a zobrazi se
nasledujici:

— Kopie dokumentu je pripravena a prenesena do LibreOffice Draw jako soubor bez
nazvu.
— LibreOffice Draw se otevie se zobrazenym dokumentem bez nazvu.

— Automaticky se otevie nastrojova liSta Redak¢ni Uprava (obrazek 262). Pokud se
nastrojova lista Redak¢ni Uprava nezobrazuje, prfejdeme v hlavni nabidce na
Zobrazeni > Nastrojové liSty a vybereme Redakéni Gprava.

2) V hlavni nabidce pfejdeme na Nastroje > RedakEné upravit a vybereme Obdélnik nebo
Volny tvar, nebo klikneme na Uprava obdélnikem nebo Uprava od ruky na nastrojové
listé Redak&ni Uprava.
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3) Nakreslime pozadované tvary, abychom v dokumentu upravili citlivé oblasti. Redigovany
tvar je Sedy, takZe citlivé oblasti v dokumentu jsou viditelné jeSté pred jejich redigovanim.

4) V pripadé potfeby klikneme na Pfimy export do PDF, abychom vytvofili kopii dokumentu
ve forméatu PDF. Citlivé informace v redigovanych oblastech Ize pfed dokoncenim
redigovani zkontrolovat, zda jsou spravné.

5) V hlavni nabidce pfejdeme na Nastroje > Redakéné upravit a vybereme bud Export
upraveného (bild) nebo Export upraveného (¢ernd), nebo klepneme na Export
upraveného (bild) nebo Export upraveného (€ernd) na nastrojové listé Redakéni
Gprava. Otevie se okno prohlizec¢e soubor.

6) Prejdeme do sloZky, kam bude redigovany dokument uloZzen, zadame nazev dokumentu
a kliknutim na Ulozit vytvorime redigovany soubor PDF.

— Sedé redigované tvary se pfevedou na bilé nebo ¢erné tvary a dokument se exportuje
do formatu PDF.

— V souboru PDF neni zadny volitelny text a zadny redigovany obsah neexistuje.

Kreshy

Otevieme vykres v LibreOffice Draw a pomoci krok( 2) aZ 6) v ¢asti ,Dokumenty, seSity nebo
prezentace" vytvofime redigovanou kopii souboru vykresu ve formatu PDF.

Poznamka

PTi exportu redigovaného dokumentu jako nového souboru PDF jsou z nového
dokumentu odstranény vSechny redigované Casti a nahrazeny redigovanymi bloky
pixeld. Tim se zabrani jakémukoli pokusu o obnoveni nebo kopirovani plvodniho
obsahu.
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Stranky kresby

Kresba vytvorena v aplikaci Draw se mlze skladat z vice stranek. To umoZiiuje vytvorit kresbu,
kterd ma nékolik Casti a je uloZzena v pocitaci jako jeden soubor.

Panel stranek

Panel Stranky slouzi k pfidavani, pfejmenovavani a odstranovani stranek v kresbé. Ve vychozim
nastaveni se panel Stranky (obrazek 263), po otevieni kresby v aplikaci Draw, zobrazi jako
dokovany panel na levé strané Pracovni plochy. V tomto panelu jsou vSechny stranky v kresbhé
zobrazeny jako miniatury. Pokud neni Panel stranek viditelny, zvolime Zobrazit > Panel
stranek v hlavni nabidce.

* Pouze pro systémy Windows a macOS - stiskneme a podrzime klavesu Ctrl a poté
dvojitym klepnutim na zahlavi Panelu stranek vytvofime plovouci okno nebo vratime
plovouci Panel stranek do jeho dokovaci pozice na levé strané pracovni plochy.

* Klepnutim na zahlavi a pfetazenim Panelu stranek vytvofime plovouci okno nebo
vratime plovouci okno Panel stranek do jeho dokovaci polohy na levé strané Pracovni
plochy.

» Pokud chceme zavfit Panel stranek, klepneme na X na pravé strané titulkového pruhu
nebo v hlavni nabidce zvolime Zobrazit > Panel stranek.
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Obrazek 265: Karta Navigator v postranni
listé
Vybér stranek
Stranku vybereme jednim z nasledujicich zplsobd. Stranka se zobrazi na Pracovni plose
pfipravena k Gpravam:
* Klepneme na miniaturu stranky v Panelu stranek.
* Po otevieni vybereme stranku v Navigatoru.

Pokud Navigator neni otevien, otevieme jej nékterou z nasledujicich moznosti:
» Stisknutim klavesy F5 otevieme dialogové okno Navigator (obrazek 264).

* Volbou Zobrazit > Navigator v hlavni nabidce otevieme dialogové okno Navigétor.

* Klepnutim na ikonu Navigator na pravé strané v postranni listé otevieme kartu Navigator
(obrazek 265).

Navigace mezi strankami

Pokud chceme rychle vybrat stranku k Gpravam, aby se zobrazila na pracovni plose, vybereme
strAdnku v Panelu stranek nebo zvolime Stranka > Navigovat a pouZijeme jednu z moznosti
z podnabidky.

* Na prvni stranku — pfesune vybér na prvni stranku kresby.
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* Na pfedchozi stranku — presune vybér zpét na predchozi stranku kresby.
* Na nasledujici stranku — pfesune vybér dopfedu na dalSi stranku.
* Na posledni stranku — pfesune vybér na posledni stranku kresby.

Pridavani stranek

VloZeni nové stranky

Nova stranka se do kresby vklada jednou z nasledujicich moZnosti. Nova stranka se prida za
vybranou stranku v Panelu stranek nebo na konec, pokud neni vybrana zadna stranka.

* Klepneme pravym tlaCitkem mySi v Panelu stranek a z mistni nabidky vybereme Nova
stranka.

¢V hlavni nabidce zvolime Stranka > Nova stranka.

* V hlavni nabidce zvolime Stranka > VloZit stranku ze souboru a tim se otevie
dialogové okno Vlozit soubor. Pfejdeme do slozky, kde je soubor umistén, vybereme
soubor, klepneme na Otevfit a poté klepneme na OK.

Duplikovani stranek

Vybereme stranku v Panelu stranek a poté pomoci jedné z nasledujicich moznosti vloZzime za
vybranou stranku duplicitni stranku:

* Klepneme pravym tlacitkem mySi v Panelu stranek a z mistni nabidky zvolime
Duplikovat stranku.

* V hlavni nabidce zvolime Stranka > Duplikovat stranku.

Pfejmenovani stranek

Kdyz jsou stranky vlozeny do kresby, jsou v Panelu stranek a v Navigatoru automaticky
pojmenovany Stranka 1, Stranka 2 atd. Pfi zméné poradi stranek se stranky automaticky
precisluji. Pro snadnou identifikaci kazdé stranky vSak doporucujeme dat kazdé strance
zapamatovatelny nazev.

7) V Panelu stranek vybereme stranku, kterou chceme prejmenovat.
8) Vybranou stranku pfejmenujeme jednou z nasledujicich moznosti:
— V hlavni nabidce zvolime Stranka a z podnabidky vybereme Pfejmenovat stranku.

— Klepneme pravym tlacitkem my3i na vybranou stranku v Panelu stranek a z mistni
nabidky zvolime Pfejmenovat stranku.

9) V otevieném dialogovém okné Prejmenovat stranku zadame novy nazev stranky
a klepnutim na OK novy nazev ulozime.

Zmeéna poradi stranek

Pokud chceme zménit pofadi stranek v kresbé&, pouzijeme jednu z nasledujicich moznosti:

* V Panelu stranek vybereme nahled stranky a pfetazenim nahledu zmeénime poradi
stranek.

* V Panelu stranek vybereme nahled stranky, potom v hlavni nabidce zvolime Stranka >
Pfesunout a vybereme jednu z nasledujicich moznosti:

— Stranka na zacatek — presuneme vybranou stranku v poradi stranek kresby na
zacatek.

— Stranka nahoru — posune vybranou stranku o jedno misto nahoru v pofadi stranek
kresby.
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— Stranka doll — posune vybranou stranku o jedno misto dolll v pofadi stranek kresby.
— Stranka na konec — posune vybranou stranku v pofadi stranek kresby na konec.

Odstranéni stranek
1) V Panelu stranek vybereme stranku, kterou chceme odstranit.
2) Vybranou stranku mdzeme smazat jednou z nasledujicich moznosti:
— V hlavni nabidce zvolime Stranka > Smazat stranku.

— Klepneme pravym tlacitkem mySi na vybranou stranku v Panelu stranek a z mistni
nabidky vybereme Smazat stranku.

Poznamka

PTi mazani stranek z kresby nedochazi k potvrzeni smazani vybrané stranky.

Predlohy stranek

Predloha stranky je stranka, ktera slouZzi jako vychozi bod pro ostatni stranky kresby. Je podobna
stylu stranky v aplikaci Writer a fidi zakladni formatovani vSech stranek, které jsou na této
predloze zaloZeny. Kresba mdze mit vice nez jednu predlohu, takze jednotlivym strankam kresby
Ize prifadit rizny vzhled, napfiklad titulni strance, strance s obsahem a strankam kresby.

Predloha mé& definovanou sadu vlastnosti, véetné barvy pozadi, grafiky nebo pfechodu.
Napfiklad objekty (jako jsou loga, ozdobné Cary a jina grafika) na pozadi, forméatovani textu,
bloky standardniho textu a pole jako jsou Cisla stranek, datum a nazev souboru.

Zobrazeni predlohy stranky

Pokud chceme otevfit zobrazeni predlohy, zvolime Zobrazit > Pfedloha v hlavni nabidce. Tim
se také otevie nastrojova lisSta Zobrazeni predlohy (obrazek 266). Pokud se tato nastrojova lista
neotevfe, zvolime v hlavni nabidce moznost Zobrazit > Nastrojové liSty > Zobrazeni predlohy.

Zobrazeni predl... ¥
SHE ==

Obrazek 266: Nastrojova
lista Zobrazeni predlohy

Pokud se chceme vrétit do normalniho rezimu stranky, klepneme na Zavfit pfedlohu na
nastrojové listé Zobrazeni pfedlohy nebo v hlavni nabidce zvolime Zobrazit > Normalni.

Vytvoreni pfedlohy stranky
Kazda kresba mé vychozi pfedlohu. Pokud mé kresba vice stranek, Ize vytvofit pfedlohu a pfidat
ji do kresby nasledujicim zplsobem:

1) Pomoci volby Zobrazit > Pfedloha v hlavni nabidce otevieme zobrazeni pfedlohy
a nastrojovou listu Zobrazeni predlohy.

2) Vytvofime novou pfedlohu jednou z nasledujicich moznosti: Po vytvofeni se automaticky
vybere nova predloha.

— Klepneme na Nova predloha na nastrojové listé Zobrazeni predlohy.
— V hlavni nabidce zvolime Stranka > Nova predioha.

— Klepneme pravym tlacitkem mySi v Panelu stranek a z mistni nabidky vybereme
Nova predloha.
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3)
4)
5)

6)

Do vybrané predlohy pfidame poZzadované grafické objekty, loga, pole, text atd.

Kresbu ulozime.

Novou pfedlohu pfifadime ke strance kresby. DalSi informace nalezneme v ¢asti
+Prlifazeni predlohy stranky” nize.

V pfipadé potieby pfejmenujeme predlohu smysluplnym nazev, viz ,Pfejmenovani
predlohy stranky" nize.

Prejmenovani predlohy stranky
Kazda noveé vytvorena pfedloha ma vychozi ndzev Vychozi 1, Vychozi 2 atd. Doporucujeme

vvvvvv

prvnim otevieni kresby, Ize také pfejmenovat.

1)

2)

3)
4)

Pomoci volby Zobrazit > Pfedloha v hlavni nabidce otevieme zobrazeni predlohy
a nastrojovou listu Zobrazeni pfedlohy.

Otevieme dialogové okno Pfejmenovat pfedlohu snimku (obrazek 267) pomoci jedné
Z nasledujicich moznosti:

— Klepneme na ikonu Pfejmenovat predlohu na nastrojové listé Zobrazeni pfedlohy.

— Klepneme pravym tlaCitkem mysi na pfedlohu v Panelu stranek a z mistni nabidky
vybereme Pfejmenovat prediohu.

Do textového pole Nazev zadame smysluplny nazev predlohy.
Klepnutim na OK zmény uloZime a zavieme dialogové okno Pfejmenovat pfedlohu

snimku.

MNazev

Napovéda QK Zrusit

Obréazek 267: Dialogové okno
Prejmenovat predlohu snimku
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Vyberte navrh snimku
i V3
| @
Wychozi 1 W
Vymeénit stranku pozadi
[] Smazat nepouZita pozadi
Napovéda Nacist... OK Zrusit

Obrazek 268: Dialogové okno Dostupné predlohy snimku

Pfifazeni predlohy stranky

Pokud ma kresba vice nez jednu predlohu, Ize rlizné predlohy pfifadit riznym strankam.

1)
2)
3)

4)
5)

6)

7

V hlavni nabidce zvolime Zobrazit > Normalni.
V Panelu stranek vybereme stranku, které chceme pfifadit predlohu.

Klepneme pravym tlacitkem mySi na stranka na Pracovni ploSe a z mistni nabidky
zvolime Zménit pfedlohu snimku. Tim otevieme dialogové okno Dostupné predlohy
snimku (obrazek 268).

V okné Vyberte navrh snimku vybereme predlohu pro vybranou stranku.

V pfipadé potfeby vybereme moznost Vyménit stranku pozadi, abychom vybranou
predlohu pouZili pro vSechny stranky kresby.

V pfipadé potfeby vybereme mozZnost Smazat nepouzité predlohy stranek, abychom
odstranili vSechny predlohy zobrazené ve Vyberte navrh snimku, které nejsou pfifazeny
ke strance.

Klepnutim na tlacitko OK pfifadime vybranou pfedlohu a zavieme dialogové okno
Dostupné predlohy snimku.
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Smazani predlohy stranky

Vychozi predlohu vytvofenou pfi prvnim vytvoreni kresby nelze odstranit. Pokud kresba pouZzivé
pouze jednu pojmenovanou pfedlohu, nelze tuto pojmenovanou predlohu odstranit. Smazani
predlohy je mozné pouze tehdy, kdyZ je v kresbé vice nez jedna pfedioha.

1) Pomaci volby Zobrazit > Pfedloha v hlavni nabidce otevieme zobrazeni pfedlohy

a nastrojovou listu Zobrazeni pfedlohy.

2) Predlohu smaZeme jednim z nasledujicich zptsob:

— Predlohu vybereme v Panelu stranek a klepneme na ni pravym tlacitkem mysi.
Nasledné z mistni nabidky zvolime Smazat pfedlohu.

— Na nastrojové listé Zobrazeni predlohy klepneme na Smazat prediohu.
— V hlavni nabidce zvolime Stranka > Smazat pfedlohu.

Poznamka

Odstranéni stranky probéhne okamzité a neni potfeba Zadné dalSi potvrzeni.

Vkladani poli
Pokud chceme do predlohy vloZit pole, pouZijeme volbu VloZit > Pole v hlavni nabidce
a z moznosti dostupnych v podnabidce vybereme typ pole.

Datum (neménné) — vloZi do pfedlohy aktuélni datum jako pole s neménnou hodnotou.
Datum se neaktualizuje.

Datum (proménné) — vlozi do predlohy aktualni datum jako pole s proménnou hodnotou.
Datum se automaticky aktualizuje pfi kazdém otevieni souboru.

Cas (neménny) — vloZi do prediohy aktudlni ¢as jako pole s nemé&nnou hodnotou. Cas
se neaktualizuje.

Cas (proménny) — vloZi do predlohy aktualni ¢as jako pole s promé&nnou hodnotou. Cas
se automaticky aktualizuje pfi kazdém otevieni souboru.

Autor — vlozi do aktivni stranky jméno a pfijmeni uvedené v Udajich uzivatele
v LibreOffice. V hlavni nabidce zvolime Nastroje > MozZnosti > LibreOffice >
UZivatelské udaje a zadame podrobnosti o uzivateli.

Cislo stranky — vloZi &islo stranky na kaZdou stranku v kresb&. Pokud chceme zménit
format Cisla, vybereme Stranka > Vlastnosti stranky v hlavni nabidce a tim otevieme
dialogové okno Vlastnosti stranky (obrazek 269). Klepneme na kartu Stranka
a z rozeviraciho seznamu v ¢asti Nastaveni rozvrZeni vybereme format cisla.

Nazev stranky — vioZi nazev stranky. Nazev stranky vytvofime v Normalnim zobrazeni
tak, Ze v hlavni nabidce zvolime Stranka > Pfejmenovat stranku a v otevieném
dialogovém okné Pfejmenovat stranku zadame nazev do pole Nazev.

Pocet stranek — vlozi celkovy pocet stranek v kreshé.

Nazev souboru — vloZi ndzev aktivniho souboru. Nazev se zobrazi az po uloZeni
souboru.

256 | Prirucka Draw 7.1



Format:
Sitka:
Vyika:

Okraje
Vievo:
Vpravo:
MNahofe:

Dole:

Format papiru

Orientace: ) Na wyiku

Stranka Pozadi Prihlednost

Smér textu: ‘Zleva doprava (vodorovné)

Napovéda

ABC—

Zasobnik papiru:

Nastaveni rozvrZeni

Cisla stranek:

‘[E nastaveni tiskarny]

1,23 ..

[ Prizpisobit objekt formatu papiru

Obnovit

Zrusit

Obréazek 269: Dialogové okno Vlastnosti stranky

Typ pole
) Neménny

Jazyk: |Ceitina

Format

Standardni (kratky)

MNapovéda

oK

Zrusit

Uprava formatu pole

1) Klepnutim na pole jej vybereme a zobrazime Uchyty pro vybér.

2) Dvojitym klepnutim na obsah pole oznaime text.

Obrazek 270: Dialogové okno Upravit pole

3) Forméat pole upravime jednim z nasledujicich zplsob:

— Pomoci volby Upravit > Pole... v hlavni nabidce otevieme dialogové okno Upravit
pole (obrazek 270), poté vybereme moznost(i) a klepnutim na OK zmény ulozime.
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— Klepneme pravym tlaCitkem mySi na vybrany obsah pole a z mistni nabidky vybereme
poZadované moznosti.

4) Klepnutim do prazdné oblasti predlohy zruSime vybér pole.

O Poznamka

Moznosti dostupné v dialogovém okné Upravit pole se zméni podle typu pole, které
bylo vybrano k apravam.

Predlohy stranek ze Sablon

Do kresby Ize naCist a pouzit pfedlohy ze Sablon dostupnych v LibreOffice. Pokud pfedlohy ze
Sablony pouzivaji jinou velikost stranky, pfizplsobi se predlohy nahrané do kresby velikosti
stranky pouzité v kresbé. To mlze zpUsobit, Ze nékteré objekty budou pfi pfizplsobeni velikosti
stranky vykresu roztazené.

1) Pomoci volby Zobrazit > Pfedloha v hlavni nabidce otevieme zobrazeni pfedlohy
a nastrojovou listu Zobrazeni predlohy.

Kategorie Sablony

Moje Sablony

draw Weeli dl

Obchodni korespondence Modra krivka

Osobni korespondence a dokumenty Blueprint planu

Ostatni obchodni dokumenty Jasné modra

Styly DMNA

Ohnisko hd

= Nahled

Napovéda QK Lrusit

Obrazek 271: Dialogové okno Nacist predlohu snimku

2) Klepneme pravym tlacitkem mysi na pfedlohu zobrazenou v kresbé a z mistni nabidky
vybereme Zménit predlohu snimku. Tim otevieme dialogové okno Dostupné predlohy
snimku.
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3) Klepnutim na Nacist v dialogovém okné Dostupné predlohy snimku otevieme dialogové
okno Nacist pfedlohu snimku (obrazek 271).

4) Vybereme kategorii Sablony ze zobrazeného seznamu v ¢asti Kategorie.

5) Vybereme $ablonu ze seznamu zobrazeného v ¢asti Sablony. Klepnutim na Nahled
zobrazime nahled vybrané Sablony.

6) Klepnutim na tlagitko OK zavieme dialogové okno Nacist pfedlohu snimku a v otevieném
dialogovém okné se Sablona zobrazi v Vyberte navrh snimku.

7) V Casti Vyberte navrh snimku vybereme poZzadovanou predlohu.

8) V pfipadé potfeby vybereme moznost Vyménit stranku pozadi, abychom vybranou
pfedlohu pouzili pro vSechny stranky kresby.

9) V pfipadé potfeby vybereme moznost Smazat nepouzita pozadi a tim odstranime
vSechny predlohy zobrazené v poli Vyberte navrh snimku, které nebyly pfifazeny ke
strance.

10) Klepnutim na OK prfifadime predlohu ke strance v kresbé a zavieme dialogové okno
Dostupné predlohy snimku.

Sablony

Sablona je specialni typ kresby, ktery se pouZivéa jako zéklad pro vytvofeni kresby. Sablona mize
napfiklad obsahovat logo, nadzev a informace o spole€nosti na prvni strané kresby, pfiemz na
zbyvajicich stranach kresby je uvedeno pouze logo a nazev spoleénosti. Sablony mohou
obsahovat cokoliv, co mohou obsahovat bé&zné kresby, napfiklad text, grafiku, sadu styld atd.

VSechny typy dokument( vytvofené pomoci LibreOffice jsou zaloZzeny na $Sablonach. Pokud neni
pfi spusténi nového dokumentu zadana Sablona, pouzije se vychozi Sablona pro dany typ
dokumentu. Tato vychozi Sablona pouziva sadu vlastnosti, které jsou v LibreOffice pevné
zakodovany.

Specifické Sablony Ize vytvofit pro jakykoliv typ dokumentu (text, tabulka, kresba, prezentace).
Pro kresby Ize vytvofit vychozi Sablonu, vice informaci najdeme v €asti ,Vychozi Sablona" na
strané 297.

Dalsi informace o $ablonach a ziskavani Sablon z jinych zdrojd najdeme v pfiruéce Zaciname
s LibreOffice.

P¥i instalaci do po&itate nema aplikace Draw Zadné pfeddefinované Sablony. Sablony vsak Ize
vytvofit pomoci metod popsanych v nasledujicich ¢astech. Lze nainstalovat Sablony, které byly
ziskany z jinych zdrojd, vice informaci najdeme v ¢asti ,Import Sablon" na strané 300.

Tvorba Sablon z kreshy

1) Otevieme kresbu, kterou chceme pouzit jako zaklad pro Sablonu, nebo otevieme
a upravime Sablonu, kterou chceme pouZit jako zaklad pro novou Sablonu.

2) Prfidame dalSi obsah a styly nebo upravime obsah a styly v kresbé.

3) Ulozime kresbu jako Sablonu pomoci jedné z nasledujicich moznosti a otevieme
dialogové okno Ulozit jako Sablonu (obrazek 272):

— V hlavni nabidce zvolime Soubor > Sablony > Ulozit jako 3ablonu.

— Klepneme na maly trojuhelnik ¥ vpravo od ikony UloZit na Standardni nastrojové
liSté a z rozeviraci nabidky vybereme Ulozit jako Sablonu.
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4)
5)
6)

7)

Nazev sablony

Kategorie 3ablony
Moje sablony

draw

Obchodni korespondence

Osobni korespondence a dokumenty
Ostatni obchodni dokumenty

Prezentace
Styly i
[ Nastavit jako wichozi

Napovéda UloZit Zrusit

Obrazek 272: Dialogové okno UloZit jako Sablonu
Do textového pole Nazev Sablony zadame nazev Sablony.
V poli Kategorie Sablony vybereme kategorii Sablony.

Pokud mé byt Sablona pouZita jako vychozi Sablona v aplikaci Draw, vybereme moznost
Nastavit jako vychozi.

Klepnutim na UloZit ulozime Sablonu a zavieme dialogové okno.

Pfipadné mlizeme pouzit pfikaz UloZit jako a ulozime kresbu jako Sablonu pomoci nasledujiciho
postupu:

1)
2)

3)
4)
5)

Pomoci volby Soubor > Ulozit jako v hlavni nabidce otevieme dialogové okno UloZit
jako.

Prejdeme do sloZzky LibreOffice, kde jsou uloZzeny Sablony. Skute¢na slozka zavisi na
systému pocitaCe a nastaveni.

Zadame nazev souboru s pfiponou .otg.
Jako typ souboru vybereme Sablona kresby ODF (.otg).
Klepnutim na Ulozit ulozime Sablonu a zavieme dialogové okno.

O Poznamka

PFi pouziti dialogového okna Ulozit jako musi byt Sablona uloZena ve sloZce Sablon
LibreOffice, aby ji Spravce Sablon LibreOffice rozpoznal a naSel.
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Obréazek 273: Dialogové okno Sablony

Vytvoreni kresby ze Sablony

Misto pouziti vychoziho nastaveni v LibreOffice pro vytvoreni nové kresby, Ize kresbu vytvorit ze
Sablony.

Uvodni obrazovka

Spustime LibreOffice a vytvofime novou kresbu ze Sablony zobrazené na Uvodni obrazovce
pomoci jedné z nasledujicich moznosti:

+ Klepnutim na Sablony na Uvodni obrazovce zobrazime dostupné Sablony pro viechny
aplikace LibreOffice. Po klepnuti na Sablonu se otevie novy dokument zalozeny na
vybrané Sabloné.

* Klepneme na maly trojuhelnik v vpravo od ikony Sablony na Uvodni obrazovce a poté
vybereme Sablony kresby, aby se zobrazily pouze Sablony dostupné pro LibreOffice
Draw. Klepneme na Sablonu a otevie se nova kresba pomoci aplikace LibreOffice Draw.

Dialogové okno Sablony

Misto vychoziho nastaveni v LibreOffice vytvofime novou kresbu pomoci dialogoveho okna
Sablony (obrazek 273) nasledovné:

1) Dialogové okno Sablony otevieme jednim z nasledujicich zptsob(:
— V hlavni nabidce zvolime Soubor > Novy > Sablony.
— V hlavni nabidce zvolime Soubor > Sablony > Sprava $ablon.
— PouZijeme klavesovou zkratku Shift + Ctrl + N.
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2)

3)
4)

5)

V rozeviracim seznamu Filtr vybereme aplikaci a kategorii poZzadovanou pro novou
kresbu.

Z moznosti dostupnych v okné nahledu vybereme Sablonu.

Klepnutim na Otevfit nebo dvojitym klepnutim na Sablonu vytvofime novou kresbu
pomoci vybrané Sablony a zavieme dialogové okno Sablona.

V hlavni nabidce zvolime Soubor > Ulozit jako a ulozime novou kresbu jako soubor
s pfiponou .odg.

Vychozi Sablona

Pokud je novéa kresba vytvorena bez vybéru Sablony, vytvori LibreOffice kresbu pomoci sady
vlastnosti, které jsou v LibreOffice pevné zakédovéany. Jako vychozi Sablonu vSak Ize pouZit
libovolnou Sablonu kresby, ktera vSak musi byt ve sloZkach Sablon pouZzivanych pro aplikace
a kategorie LibreOffice.

Nastaveni vychozi sablony

1)
2)

3)

4)

Otevieme dialogové okno Sablona.

V rozeviracich seznamech Filtr vybereme aplikaci (Kresby) a kategorii a nasledné
vybereme Sablonu ze Sablon zobrazenych v poli nahledu.

Klepneme pravym tlacitkem mySi na Sablonu a z mistni nabidky vybereme moZznost
Nastavit jako vychozi. Neexistuje Zadné potvrzeni, Ze se vybrana Sablona stala vychozi
Sablonou pro nové kresby. Vychozi Sablona je ozna¢ena zaskrtnutim v levém hornim
rohu ikony Sablony.

Klepnutim na Zrusit zavfeme dialogové okno Sablony. Pfi p
se pouZzije nova vychozi Sablona.

~rw

Fistim vytvoreni nové kreshy

Poznamka

Pokud je nova kresba vhodna k pouziti jako vychozi Sablona, je potfeba ji nejprve
uloZit jako Sablonu a teprve poté ji pouzit jako vychozi Sablonu. Vice informaci
najdeme v Casti ,Tvorba Sablon z kresby" na strané 294.

Obnoveni vychozi Sablony

1)
2)
3)

4)

5)

Otevieme dialogové okno Sablony:
V rozeviracich seznamech Filtr vybereme aplikaci (Kresba) a kategorii.

Klepneme pravym tlagitkem mySi na vychozi Sablonu. Vychozi Sablona je oznacena
zaSkrtnutim v levém hornim rohu ikony Sablony.

Z mistni nabidky vybereme Obnovit vychozi. Neexistuje Zadné potvrzovani, Zze
v aplikaci Draw byly obnoveny vychozi vlastnosti LibreOffice pro vytvofeni nové kresby.
Z ikony Sablony se odstrani zaSkrtnuti.

Klepnutim na Zrusit zavieme dialogové okno Sablony. P¥i pfistim vytvofeni nové kresby
se pouziji vychozi vlastnosti LibreOffice.

Upravy $ablon

Styly a obsah Sablon Ize upravovat a v pfipadé potfeby znovu pouzit na kreshy, které byly
vytvofeny na zakladé dané Sablony.

Poznamka

Znovu lze pouzit pouze styly a obsah Sablon. Obsah kresby, ktery neni soucasti
Sablony, nelze znovu pouZit.
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Uprava dokumentt
1) Otevieme dialogové okno Sablony:
2) Vyhledame Sablonu k Upravé a vybereme ji.

3) Klepneme pravym tlacitkem mysi na vybranou Sablonu a z mistni nabidky vybereme
moznost Upravit. Sablona se otevie v aplikaci Draw.

4) Sablonu upravime jako jakoukoliv jinou kresbu.

5) V hlavni nabidce zvolime Soubor > Ulozit nebo pouzijeme klavesovou zkratku Ctrl +
S a tim uloZzime Sablonu.

6) Jak ulozit upravenou Sablonu jako Sablonu najdeme v Casti ,Tvorba Sablon z kresby" na
strané 294.

Aktualizace kresby z upravené sablony

Pfi pfiStim otevieni kresby vytvofené ze zménéné Sablony se otevie potvrzovaci dialogové okno
s zadosti 0 aktualizaci styll v kresbé podle formatovani pouzitého v upravené Sabloné.

* Klepnutim na tlacitko Aktualizovat styly aktualizujeme vSechny styly v kresbé, které
byly zménény v Sabloné a zavieme potvrzovaci dialogové okno.

« Klepneme na tlacitko Ponechat plivodni styly, aby se styly v kresbé&, které byly
v Sabloné zménény, neaktualizovaly. Potvrzovaci dialogové okno se zavfe a pfi dalSim
otevieni dokumentu se jiz nezobrazi.

Sprava Sablon

LibreOffice dokazZe vyhledat pouze Sablony, které jsou ve sloZzkach (kategoriich) Sablon
LibreOffice. V LibreOffice je moZné vytvorit nové kategorie Sablon a pouzit je k usporadani
Sablon. Vytvofime napfiklad samostatné kategorie pro rdizné projekty nebo klienty. Sablony Ize
také importovat a exportovat.

6 Tip

Umisténi sloZzek Sablon LibreOffice se lisi podle operacniho systému pocitace.
Pokud chceme zjistit, kde jsou v pocitaci uloZzeny sloZky Sablon, zvolime Nastroje >
MozZnosti > LibreOffice > Cesty v hlavni nabidce.

Vytvareni kategorii Sablon
1) Otevieme dialogové okno Sablony:
2) V rozeviracich seznamech Filtr vybereme Kresba jako aplikaci.
3) Klepneme na Nastaveni a z mistni nabidky vybereme Nova kategorie.

4) V otevieném dialogovém okné zadame nazev do textového pole Zadejte nazev
kategorie.

5) Klepnutim na OK uloZime novou kategorii v LibreOffice a zavieme dialogové okno.

Prejmenovani kategorii Sablon
Pomoci dialogového okna Sablony nelze pfejmenovat kategorie $ablon dodavané s balikem

LibreOffice. Pfejmenovat Ize pouze kategorie Sablon, které byly vytvofeny pomoci ,Vytvareni
kategorii Sablon".

1) Otevieme dialogové okno Sablony.
2) V rozeviracich seznamech Filtr vybereme aplikaci Kresba a kategorii pro pfejmenovani.
3) Klepneme na Nastaveni a z mistni nabidky vybereme Pfejmenovat kategorii.
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4) V otevieném dialogovém okné zadame nazev do textového pole Zadejte nazev
kategorie.

5) Klepnutim na OK uloZzime pfejmenovanou kategorii jako sloZku Sablony v LibreOffice
a zavieme dialogové okno.

@ Poznamka

PFi pokusu o pfejmenovéani zadané kategorie se zobrazi chybové hlaSeni, Ze
kategorii nelze pfejmenovat.

Smazani slozek sablon

Q Poznamka

Kategorie Sablon vytvorené pfi instalaci LibreOffice nelze odstranit. Odstranit Ize
pouze kategorie Sablon, které byly vytvorfeny po instalaci LibreOffice.

1) Otevieme dialogové okno Sablony.

2) Klepneme na Nastaveni a z mistni nabidky vybereme Smazat kategorii.

3) V otevieném dialogovém okné Smazat kategorii (obrazek 274) vybereme kategorii.
4) Klepnutim na OK smazeme vybranou kategorii a zavieme dialogové okno Smazat

kategorii.

Vybrat kategorii

Zadna A
Moje Zablony

Obchodni korespondence

Osobni korespondence a dokumenty
Ostatni obchodni dokumenty

Prezentace

Styly i

MNapovéda oK ZruEit

Obréazek 274: Dialogové okno Smazat kategorii

5) Klepnutim na Ano potvrdime odstranéni kategorie.

@ Poznamka

PTi pokusu o odstranéni kategorie vytvofené béhem instalace LibreOffice se zobrazi
chybova zprava, ze kategorii nem(zeme odstranit.

Pfesun Sablon
Sablona se pfesune z jedné kategorie $ablon do druhé néasledujicim zplisobem:
1) Otevieme dialogové okno Sablony.
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2)

3)
4)
5)

6)

V rozeviracich seznamech Filtr vybereme jako aplikaci Kresba a kategorii, ve které se
Sablona nachazi.

Vybereme Sablonu, ktera ma byt pfesunuta.
Klepneme na Pfesunout a otevieme dialogové okno Vyberte kategorii (obrazek 275).

Vybereme kategorii z Vyberte z existujici kategorie nebo zadame nazev nové kategorie
do Vytvofit novou kategorii.

Klepnutim na OK pfesuneme Sablonu do vybrané kategorie a zavieme dialogové okno
Vyberte kategorii.

Vyberte z existujici kategorie

Moje Zablony

draw

Obchodni korespondence

Osobni korespondence a dokumenty
Ostatni obchodni dokumenty
Prezentace

Styly E

nebo vytvoite novou kategorii

MNapovéda OK Zruit

Obréazek 275: Dialogové okno Vyberte kategorii

Import sablon

Sablony Ize stahnout z mnoha zdrojl, véetné oficialniho UloZzisté Sablon LibreOffice, ktere je
dostupné prostfednictvim Spravce rozsifeni. Sablonu uloZzime kamkoliv do pocitaCe a poté ji
importujeme do LibreOffice nasledujicim zplsobem:

1) Otevieme dialogové okno Sablony.

2) Klepneme na Importovat a otevieme dialogové okno Vyberte kategorii.

3) Vybereme kategorii z Vyberte z existujici kategorie nebo zaddme nazev nové kategorie
do Vytvofit novou kategorii.

4) Klepneme na OK a otevieme okno prohlizece soubor(.

5) Prejdeme do sloZky obsahujici Sablonu, Sablonu vybereme a klepneme na Otevfit.
Prohlize¢ souborl se zavie a $ablona se zobrazi ve vybrané kategorii v dialogovém okné
Sablony.

& Poznamka

Dalsi informace o pouzivani Spravce rozSifeni k importu Sablon nalezneme
v pfiru¢ce Zaciname s LibreOffice.

Sablony | 265



Export sablon
Export Sablony z kategorie Sablon do jiného umisténi v pocitaci nebo siti provedeme nasledovné:
1) Otevieme dialogové okno Sablony.

2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresba a kategorii, ve které se
Sablona nachazi.

3) Vybereme Sablonu pro export a klepnutim na Exportovat otevieme okno prohlizece
soubord.

4) Prejdeme do slozky, do které chceme Sablonu exportovat.
5) Klepneme na OK a exportovana Sablona se objevi ve vybrané slozce.
6) Klepnutim na Zrusit otevieme dialogové okno Sablony.

Poznamka

Exportovani $ablony ji neodstrani z dialogového okna Sablony. Tato akce umisti
kopii Sablony do zadaného umisténi.

Mazani Sablon
1) Otevieme dialogové okno Sablony.

2) V rozeviracich seznamech Filtr vybereme jako aplikaci Kresba a kategorii, ve které se
Sablona nachézi.

3) Klepneme pravym tlaCitkem mySi na Sablonu, kterou chceme odstranit, a z mistni
nabidky vybereme moZnost Smazat.

4) Klepnutim na Ano potvrdime smazani Sablony.
5) Klepnutim na Zrusit otevieme dialogové okno Sablony.

6 Tip

Stisknutim klavesy Delete na klavesnici smazeme v dialogovém okné Sablony
vybranou Sablonu.

Poznamka

Sablony, které byly nainstalovany pfi instalaci LibreOffice, nelze odstranit. Odstranit
Ize pouze Sablony vytvofené aZ po instalaci LibreOffice.

Dalsi zpUsoby tvorby Sablon

éablo[ly Ize vytvaret a ukladat kdekoliv v pocitaci a poté je pouZivat bez pouZiti dialogového
okna Sablony. Nékteré vysledky se vSak liSi od téch popsanych dfive v této kapitole.

Kresba z sablony

Kresby z kompatibilni Sablony vytvofime dvojitym klepnutim na Sablonu v okné prohlizece
soubor(. Vysledna kresba neni spojena se $ablonou, ze které byla vytvofena. Sablona neni
uvedena ve vlastnostech dokumentu a pfipadné zmény Sablony nelze pfimo na dokument
pouzit. Z mnoha dlvod( to mlZe byt to, co je potfeba.

Sablona z kresby

Sablonu z kresby vytvofime pomoci Soubor > UloZit jako v hlavni nabidce a jako typ souboru
vybereme Sablony kresby ODF (.otg), potom ji ulozime kamkoliv do pocitaCe, napt. do slozky
projektu.
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Vyslednéa $ablona je viditelna v dialogovém okné& Sablony, pokud ji neimportujeme nebo
nepfidame do slozky projektu na mista pro Sablony uvedené na strance LibreOffice — Cesty
v dialogovém okné Nastroje > Moznosti. Vice informaci najdeme v ¢asti ,Sprava Sablon" na
strané 298 a v Casti ,Import Sablon" na strané 300.

Vice vrstev

Vrstvy v LibreOffice Draw umozniuji sestavit prvky kresby, které spolu souviseji. Vrstvy si
predstavime jak jednotlivé pracovni plochy, které Ize skryt pfed zobrazenim, zabranit jejich tisku
nebo je uzamknout, aby v nich nebylo mozné provadét zmény.

Vrstvy neurcuji pofadi objektl v kresbé, s vyjimkou vrstvy Ovladaci prvky, ktera je vZdy pred
vSemi ostatnimi vrstvami. Poradi skladani objektll v kresbé je uréeno pofadim pridavani objektd.
Toto poradi skladani Ize zménit pomoci volby Tvary > Uspofadat v hlavni nabidce.

Vrstvy v kresbé jsou oznaceny kartami umisténymi ve spodni &asti Pracovni plochy a nad
Stavovym fadkem. Klepnutim na kartu vybereme vrstvu. Obrazek 276 ukazuje, ze byla vybrana
vrstva RozvrZeni.

Rozvrieni Ovladaci prvky Kotovaci Cary

Snimek 1z 4 Hlavni

Obréazek 276: Karty vrstev

Poznamka

Pri pridani nové vrstvy se vrstva pfida na vSechny stranky kresby. P¥i pfidani objektu
do vrstvy se vSak objekt pfida pouze na vybranou stranku kresby.

Poznamka

Pokud se ma objekt zobrazit na vSech strankach kresby (napfiklad logo spolecnosti),
pridame objekt do pfedlohy stranky tak, Ze v hlavni nabidce zvolime Zobrazit >
Predloha. Vice informaci najdeme v ¢asti ,Pfedlohy stranek" na strané 288.

Vychozi vrstvy

Normalni pohled
LibreOffice Draw poskytuje tfi vychozi vrstvy, které jsou pro uZivatele viditelné. Tyto vychozi
vrstvy neni mozné smazat ani prejmenovat.

* Rozvrzeni — je vychozi pracovni plocha, na které jsou obvykle umistény objekty.

» Ovladaci prvky — pouziva se pro ovladaci prvky formulare, kterym byla pfifazena akce.
Objekty v této vrstvé jsou vZdy pfed objekty v jinych vrstvach. Normalné se ovladaci
prvky formulafe netisknou a v dialogovém okné Upravit vrstvu je tfeba zruSit zaSkrtnuti
moznosti Tisknutelna.

+ Kétovaci €ara — je misto, kde jsou nakresleny kétovaci ¢ary. Pfepinanim vrstvy mezi
zobrazenim a skrytim se zapinaji a vypinaji kotovaci cary.

Zobrazeni predlohy

Ve vrstvé Objekty pozadi jsou umistény objekty, které se maji objevit na kazdé strance kresby,
napriklad logo spolecnosti, datum, Cislo stranky, nazev kresby atd.
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Vkladani vrstev
VloZeni vrstvy do kresby provedeme takto:

1)

2)

3)
4)

5)

6)

7

Dialogové okno VloZzit vrstvu otevieme jednim z nasledujicich zplsob( (obrazek 277):

— Klepneme pravym tlacitkem mySi na oblast karty vrstev ve spodni ¢asti pracovni
plochy a z mistni nabidky vybereme Vlozit vrstvu.

— V hlavni nabidce zvolime Vlozit > Vrstva.
Do textovych poli Nazev a Nadpis vioZzime smysluplny nazev vrstvy.

Nazev
Vrstvad
Nadpis

Popis

Viditelna
Tisknutelna

L] Uzaméena

Napovéda oK Zrusit

Obréazek 277: Dialogové okno VloZit vrstvu

V pfipadé potfeby zadame popis nové vrstvy do textového pole Popis.

Pokud chceme, aby byla vrstva v kresbé viditelna, vybereme moznost Viditelna. Pokud
neni volba Viditelné vybrana, vrstva je skryta a jeji jméno na zaloZce zméni barvu na
maodrou.

Pokud chceme, aby byla vrstva v kresbé tisknutelnd, vyberme moznost Tisknutelna.
Pokud neni vybrana moznost Tisknutelna, je nazev vrstvy na pasu karet vrstev
podtrzeny. Netisknout vrstvu je uzite¢né napfiklad v pfipadé, Ze se jedna o vrstvu navrhu
pro voditka nebo poznamky pouZité pfi tvorbé kresby, ale nechceme, aby se tato vrstva
navrhu objevila v konecném tisténém vystupu.

Vybérem volby Uzaméena zabranime mazani, Gpravam nebo presouvani objektl ve
vrstvé. Do uzamcené vrstvy neni mozné pfidavat dalSi objekty. Uzamd&eni vrstvy je
uzite€né napriklad v pripadé, ze je tfeba chranit zakladni plan a zaroven pridat novou
vrstvu s dalSimi detaily. Nazev uzamcené vrstvy se na pasu karet vrstev zmeéni na text
psany kurzivou.

Klepnutim na OK zavieme dialogové okno VloZit vrstvu a nova vrstva se automaticky
stane aktivni.

Uprava vrstev

Libovolny nebo vSechny atributy viozené vrstvy upravime nésledujicim zplsobem:
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1) Dialogové okno Upravit vrstvu otevieme jednou z téchto mozZnosti. Toto dialogové okno je
podobné dialogovému oknu VloZit vrstvu.

— Klepneme pravym tlaCitkem my3i na kartu s nazvem vrstvy v dolni ¢asti pracovni
plochy a z mistni nabidky vybereme Upravit vrstvu.

— Klepnutim na kartu vrstvy tuto vrstvu vybereme a potom zvolime Formét > Vrstva
v hlavni nabidce.

— Klepneme dvakrat na kartu vrstvy.

2) Provedeme potfebné zmény atributd vrstvy a poté klepnutim na tlagitko OK zmény
uloZzime a zavieme dialogové okno Upravit vrstvu.

Prace s vrstvami

Vybér vrstvy

Pokud chceme vybrat vrstvu, klepneme na kartu s nazvem vrstvy v dolni ¢asti Pracovni plochy.
Kdyz je vrstva vybrana, je aktivovana a vSechny objekty pfidavané do kresby jsou pfidany pouze
do této vrstvy. Ovladaci prvky formulare se automaticky pfidaji do vrstvy Ovladaci prvky

a kotovaci ¢ary se automaticky pfidaji do vrstvy Kétovaci €ary.

Pokud je v kresbé nékolik vrstev, nemusi byt karta vrstvy na pasu karet vrstev viditelna. Pomoci
navigacnich ikon na levé strané pas karet vrstev prejdeme na vrstvu, kterou chceme vybrat.

Skryti vrstvy

1) Otevieme dialogové okno Upravit vrstvu. Vice informaci najdeme vy3e v ¢asti ,Uprava
vrstev".

2) ZruSime vybér moZnosti Viditelna a klepneme na OK. Text s ndzvem vrstvy na karté
zméni barvu na modrou. Objekty umisténé ve skryté vrstve jiz nejsou v ostatnich vrstvach
kresby viditelné.

3) Pripadné mizZeme vrstvu skryt podrzenim klavesy Shift a klepnutim na kartu s nazvem
vrstvy.

Zobrazeni skrytych vrstev

1) Otevieme dialogové okno Upravit vrstvu. Vice informaci najdeme vy3e v ¢asti ,Uprava
vrstev".

2) Vybereme moznost Viditelna a klepneme na OK. Text s nazvem vrstvy na karté zmeéni
barvu na vychozi barvu textu. VSechny objekty umisténé ve skryté vrstvé jsou nyni
viditelné i v ostatnich vrstvach kresby.

3) Pripadné podrzime klavesu Shift a klepnutim na kartu s nazvem vrstvy vybranou vrstvu
zobrazime.

Zamykani vrstev

1) Otevieme dialogové okno Upravit vrstvu. Vice informaci najdeme vy3e v ¢asti ,Uprava
vrstev".

2) Vybereme moznost Uzaméena a klepneme na OK. Text s nazvem vrstvy na karté bude
podtrzeny. Uzamceni vrstvy zabrafiuje jakymkoliv Gpravam vrstvy.

3) Pfipadné mizeme vrstvu uzamknout podrZzenim klavesy Ctrl a klepnutim na kartu
S nazvem vrstvy.

Odemykani vrstev

1) Otevieme dialogové okno Upravit vrstvu. Vice informaci najdeme vy3e v ¢asti ,Uprava
vrstev".

Vice vrstev | 269



2) ZruSime vybér moznosti Uzamé&ena a klepneme na OK. Text s ndzvem vrstvy na karté jiz
neni podtrZzeny.

3) Pripadné mizeme vrstvu uzamknout podrZzenim klavesy Ctrl a klepnutim na kartu
S ndzvem vrstvy.

Poznamka

PFejmenovat nebo smazat Ize pouze vrstvy, které byly do kresby pfidany. Vychozi
vrstvy Rozvrzeni, Ovladaci prvky, Kétovaci ¢ary a Objekty pozadi nelze
pfejmenovat ani odstranit.

Pfejmenovavani vrstev

1) Otevieme dialogové okno Upravit vrstvu a do textového pole Nazev zadame novy nazev
vrstvy. Vice informaci najdeme vyse v ¢asti ,Uprava vrstev".

2) Pripadné klepneme pravym tlacitkem mySi na kartu s nazvem vrstvy a z mistni nabidky
vybereme Pfejmenovat vrstvu. Text je mozné upravovat a ménit jeho nazev. Klepnutim
mimo oblast karet vrstev zmény ulozime.

3) Pripadné podrzime klavesu Alt a klepneme na kartu s nazvem vrstvy. Text je mozné
upravovat a ménit jeho nazev. Klepnutim mimo oblast karet vrstev zmény ulozime.
Smazani vrstev

1) Klepneme pravym tlaCitkem mySi na kartu s ndzvem vrstvy a z mistni nabidky zvolime
Smazat vrstvu.

2) Potvrdime odstranéni vrstvy. Vrstva a vdechny objekty na této vrstvé se smazou.

Presouvani objekt mezi vrstvami

Pokud jsou ve vrstvé vybrany objekty, ve Stavovém Fadku vidime, kolik objektl je vybrano. Tyto
vybrané objekty prfesuneme z jedné vrstvy do jiné jednim z nasledujicich zplsobd:

* Klepneme na vybrané objekty, pfetahneme je na kartu s nazvem cilové vrstvy a uvolnime
tlacitko mySi. Poloha pfesunutych objektd se nezméni a vrstva, do které byly objekty
umistény, se zobrazi ve Stavovém fadku.

+ V hlavni nabidce zvolime Upravy > Vyjmout nebo klepneme pravym tlagitkem mysi na
vybrany objekt a z mistni nabidky zvolime Vyjmout. Vybereme cilovou vrstvu a v hlavni
nabidce zvolime Upravy > VloZit nebo klepneme pravym tlagitkem mysi na Pracovni
plochu a z mistni nabidky vybereme VloZit. Poloha presunutych objektl se nezméni
a vrstva, do které byly objekty umistény, se zobrazi ve Stavovém radku.

Koétovani

Aplikace Draw umoZziuje kétovat objekty a zobrazovat toto kétovani, aby kresba vypadala vice
jako technicky vykres. P¥i vytvareni kétovani jsou tyto hodnoty automaticky umistény do vrstvy

Koétovaci Cary.
Nastaveni kotovani

Pristup k moZnostem konfigurace kétovani je mozny dvéma zplsoby. Obé metody pouZivaji
podobné dialogové okno, ve kterém Ize ménit délku, rozméry a vodici vlastnosti kétovaci ¢ary.
Styly objektu kresby
1) Dialogové okno Grafické styly (obrazek 278) otevieme jednim z nasledujicich zplsobu:
— V hlavni nabidce zvolime Format > Styly > Upravit styl.
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— Klepnutim na Zobrazit postranni listu Styly na nastrojové list& Céara a vypli
otevieme kartu Styly v postranni list&, poté klepneme pravym tlacitkem mysi na styly
a z mistni nabidky vybereme Upravit.

— Pomoci klavesové zkratky F11 otevieme kartu Styly na postranni li5té, poté klepneme
pravym tla¢itkem mysi na styl a z mistni nabidky vybereme Upravit.

— Klepnutim na Styly v postranni listé otevieme kartu Styly, poté klepneme pravym
tlaCitkem mysi na styly a z mistni nabidky vybereme Upravit.

2) Klepnutim na Kétovani otevieme stranku Kétovani v dialogovém okné.

3) Pozadované zmény v kétovani provedeme pomoci réiznych moznosti v ¢asti Cara a ¢asti
Legenda na karté Kétovani.

4) Klepnutim na OK uloZzime zmény a zavieme dialogové okno Grafické styly.

5) Pokud chceme obnovit moznosti kétovani na vychozi vlastnosti Sablony, otevieme
dialogové okno Grafické styly podle krok({ 1 a 2 vySe a klepneme na tlacitko Standardni.

Organizator Cara Oblast Stinovani Priihlednost Pismo Efekty pro pismo Odsazeni a rozestupy

Text Animace textu Kotovani Spojnice Zarovnani Asijska typografie Tabulatory Zyyrazneni
Cara Legenda

Vzdalenost cary: ‘ =] Umisténi textu

Pievis voditka: 020em 5 b

i

Vzdélenost voditka: [0,10ecm >

[

Levé voditko: |}J.00 m = c
Pravé voditko: 0,00 cm ; Automaticky svisle
[ Méfit pod objektem Automaticky vodorovné
Desetinna mista: |2 2 [-] Rovnob&#né s carou
[] Zobrazit mémé jednotky

Automaticky ~

Napovéda ' Obnovit H Standardni oK |: Zrusit

Obréazek 278: Dialogové okno Grafické styly — karta Kétovani
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Cara Legenda
Vzdalenost ary: 1,00 cm = Umisténi textu
Previs voditka: 0,60 cm = 8 T
Vzdalenost voditka: |[-0,20cm 5 ®
Levé voditko: 0,90 cm = o .
Pravé voditko: 0,40 cm = Automaticky svisle

L] MEfit pod objektem Automaticky vodorovné

Desetinnéd mista: 2 = Rovnobéiné s carou

Zobrazit mémé jednotky

| 127.5 mm |

Obréazek 279: Dialogové okno Kotovaci ¢ara

Zachytny bod

Katovac cara previsu voditka
. */ »
Bod I 6 cm .
zakladni P rave
cary T voditko
[[] s o s o o s ; ..... ;
Leyé -y s il
tko [ Indikéator
voditko - zakladni Cary

Zachyiny bod  (nezobrazuje se)
delky voditka
Obrazek 280: Priklad kétovaci Cary

Dialogové okno Kétovaci cara

s w7

1) Nakreslime kotovaci ¢aru. Vice informaci najdeme v Casti ,Kotované objekty" na strané
3009.

2) Klepneme pravym tlacitkem mysi na kétovaci ¢aru a z mistni nabidky vybereme
Kétovani. Tim otevieme dialogové okno Kotovaci Cara (obrazek 279).

3) Pozadované zmény kétovani provedeme pomoci rliznych moznosti v dialogovém okné
Kétovaci Cara. Tyto moznosti jsou dostupné také na karté Kétovani v dialogovém okné
Grafické styly.

4)  Klepnutim na OK zmény uloZime a zavieme dialogové okno Kétovaci Cara.
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MoZzZnosti kétovani

Moznosti kétovani na karté Kétovani v dialogovém okné Grafické styly a dialogovém okné
Kétovaci ¢ara jsou nasledujici. Nahled v dialogovém okné se méni podle nasledujicich moznosti,
které ukazuji, jak se kétovaci Cara zobrazi v kresbé. Priklad kotovaci Cary je zndzornén na
obrazku 280.

s~z

« Cara — nastavuje vzdalenosti mezi kétovaci €arou a voditky viici sob& navzajem,
k zakladni Care koty a k objektu. Zakladni ¢ara neni v kresbé viditelna, ale je vyznacena
zakladnimi body na kazdém z voditek.

— Vzdélenost Cary — urCuje vzdalenost mezi kotovaci ¢arou a objektem nebo zakladni
¢arou. Do textoveho pole je mozné zadat minimalni hodnotu =10 mm a maximalni
hodnotu 10 mm. Cim niZ§i je hodnota, tim bliZe je kétovaci Cara objektu nebo

s~ s

zakladni ¢are.

— Previs voditka — je vzdalenost, o kterou voditko pfesahuje kétovaci ¢aru nebo je pod
ni. Do textoveho pole je mozné zadat minimalni hodnotu —10 mm a maximalni
hodnotu 10 mm. Kladné hodnoty zplsobi, Ze previs voditka pfesahne kétovaci ¢aru.
Zaporné hodnoty zplsobi, Ze previs voditka bude zakladni ¢arou.

— Vzdalenost voditka — urCuje délku pravého a levého voditka pod kétovaci ¢arou
smérem k objektu. Do textového pole je mozné zadat minimalni hodnotu =10 mm
a maximalni hodnotu 10 mm. Kladné hodnoty prodluZuji voditka nad zakladni ¢aru
a dale od objektu. Zaporné hodnoty prodluzuji voditka pod z&kladni linii a pfiblizuji je

k objektu.

— Levé voditko — ur€uje vzdalenost pocatku levého voditka od kétovaci ¢ary. Do
textového pole je mozné zadat minimalni hodnotu —10 mm a maximalni hodnotu 10
mm. Kladné hodnoty prodluzuji voditko pro kétovaci ¢aru smérem k objektu. Zaporné
hodnoty oddali voditko od objektu.

— Pravé voditko — uruje vzdalenost po¢atku pravého voditka od kétovaci ¢ary. Do
textového pole je mozné zadat minimalni hodnotu —10 mm a maximalni hodnotu 10
mm. Kladné hodnoty prodluZuji voditko pro kétovaci ¢aru smérem k objektu. Zaporné
hodnoty oddali voditko od objektu.

N 77

— Meéritko pod objektem — zméni polohu a délku kdtovaci ¢ary a voditek nastavenych
v moznosti Céra.

— Desetinna mista — urCuje pocet desetinnych mist pouZzitych pro zobrazeni vlastnosti
cary.
* Legenda — nastavuje vlastnosti textu kétovani.

— Umisténi textu — urCuje polohu textu kéty vzhledem ke kotovaci
ZaSkrtavaci poliCka Automaticky svisle a Automaticky vodorovn
pfifazenim pozice textu prazdna.

¢are a voditkdm.
€ musi byt pred

— Automaticky svisle — urCuje optimalni svislou polohu textu kétovani.
— Automaticky vodorovné — ur€uje optimalni vodorovnou polohu textu kétovani.

— RovnobéZné s Carou — pokud je tato vlastnost vybrana, zobrazi se text rovnobézné
s kotovaci ¢arou; pokud tato vlastnost vybrana neni, zobrazi se text pod thlem 90

v v

stupnl ke kotovaci Care.

— Zobrazit mérné jednotky — zobrazi nebo skryje mérné jednotky kétovani. Mérnou
jednotku lze vybrat z rozeviraciho seznamu.
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Poznamka

Moznosti kétovani jsou propojeny a uloZeny s aktualni pracovni strankou. VSechny
provedené zmeény se tykaji pouze této kresby. Nové kresby se spoustéji se
standardnimi vlastnostmi aplikace Draw. Pokud maji byt moznosti kGtovani pouzity
pro budouci kresby, uloZime kresbu jako Sablonu.

Uchyty vybéru voditek
Uchyty vybé&ru voditek v horni a dolni ¢asti voditek slouzi k vysunuti voditek mimo hranice —10
mm az 10 mm. S odkazem na pfiklad kétovani na obrazku 280 se Uchyty vybéru pouzivaji takto:

Horni tchyt vybéru voditka — vybereme jeden z Uchytl vybéru a tazenim za néj
zvétSime nebo zmensime presah obou voditek.

Dolni levy uchyt vybéru voditka — vybereme levy Uchyt vybér a taZzenim Gchytu
zvétSime nebo zmensime vzdalenost levého voditka.

Dolni pravy uchyt vybéru voditka — vybereme pravy Gchyt vybéru a tazenim Uchytu
zvétSime nebo zmenSime vzdalenost pravého voditka.

0 Tip

Pri kétovani objektll se doporucuje pouzivat funkce zvétSeni, vodici ¢ary a funkce
prichyceni, aby bylo mozné kotovaci Cary presné umistit na objekt. Vice informaci
nalezneme v kapitole 3, Prace s objekty a body objektd.

Koétované objekty

1) Klepnutim na maly trojdhelnik v vedle ikony Cary a Sipky na nastrojové listé Kresba
otevieme nastrojovou liStu Cary a Sipky (obrazek 281).

2) Klepneme na Kétovaci €ara a kurzor se zméni na tvar, napfiklad na kfizek. Tvar zavisi
na nastaveni pocitace.

3) Umistime kurzor do jednoho z roh(l objektu a poté klepneme a pretdhneme kurzor do
druhého rohu objektu, abychom nakreslili kotovaci ¢aru. Chceme-li omezit kresleni
kétovaci ¢ary na vodorovny nebo svisly smér, stiskneme a podrzime klavesu Shift
a zaroven tahneme kurzorem.

4) Po dosaZeni druhého rohu objektu uvolnime tlacitko mysi a nakresli se kétovaci ¢ara
s automaticky pfidanou kotou (jak je znazornéno na obrazku 282). Kétovaci Cara se také
automaticky umisti do vrstvy Kétovaci Cary.

5) Pokud chceme upravit text kéty, klepneme dvakrat na nevybranou kétovaci ¢aru, ¢imz
vstoupime do reZimu Uprav textu a provedeme potfebné zmény. Klepnutim mimo
kotovaci ¢aru zmény ulozime.

6) Informace o konfiguraci kétovaci Cary najdeme v ¢asti ,Nastaveni kotovani” na strané
305.

Poznamka

Po Upravé textu koty, zadani textu a nasledném odstranéni textu uloZzime kresbu
a znovu ji otevieme, abychom umoznili automatické mérné jednotky pro kétovani.

274 | Prirucka Draw 7.1



Obrézek 281: Diléi nastrojova lista Céry
a Sipky

4 cm

7,1 cm

Obréazek 282: Priklad kétovani objekt(

LibreOffice
MNacitani/ukladani
Jazykova nastaveni
= LibreOffice Draw
|— Obecné

Zobrazeni

MriZka

Tisk
LibreOffice Base
Grafy
Internet

Textové objekty
Povolit rychlou editaci

[ Lze vybrat pouze textovou oblast

MNastaveni

Kopirovat pfi pfesunu

PouZit mezipamé&t v pozadi
VZdy presunutelné objekty
L1 Nedeformovat objekty na kfivce

ems ot
Kroky tabulatoru: 1,25 cm E

Méfitko

Méiitko kresby:

Kompatibilita
[ K formatovéni dokumentu pouZit metriku tiskarny

Obrazek 283: Dialogové okno MoZnosti LibreOffice Draw — karta Obecné

o Poznamka

N 2

Pokud kreslime v méfitku (viz nize), budou hodnoty konfigurace kétovani
v dialogovém okné Grafické styly a dialogovém okné Koétovaci ¢ara rovnéz

e

v méfitku. Napfiklad hodnota 10 mm v dialogovém okné znamena hodnotu kéty 300

> v,

mm, pokud je méfitko nastaveno na 1:30.

Kresba v méritku

V aplikaci Draw se pfeddefinovana kreslici plocha nazyva Pracovni plocha a ma obvykle
velikost stranky Letter nebo A4 (v zavislosti na nastaveni pocitace a vychozi tiskarné pfipojené

N7
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k pocitaci). V zavislosti na skute¢né velikosti kreslenych objekt( je viak ¢asto vhodné kresbu
zmenSit nebo zvétsi pomoci méfitka (napfiklad 1:10 nebo 2:1).

i__, S5cm __i iﬁ 20 cm . iﬁ 125cm

'O ' O

= =

] E ;
ey < 5s)
™ — ol

¥ ¥ .

Méritko kreshy 1:1 Méritko kreshy 1.4 Méritko kreshy 4:1

Obréazek 284: Priklady kresleni v méritku

Hodnotu méfitka kresby ur€ime tak, Ze zvolime Nastroje > MoZnosti > LibreOffice Draw >
Obecné (obrazek 283) a z rozeviraciho seznamu Mé¥Fitko kresby vybereme hodnotu. Vychozi

nastaveni této moznosti je 1:1. Pokud je provedena zména méfitka kresby, projevi se
v pravitkach v horni a levé Casti pracovni plochy.

Jakakoliv zména méfitka kresby nema Zadny vliv na zékladni operace kresleni. Aplikace Draw
automaticky vypocita potiebné hodnoty (napfiklad kétovaci ¢ary). Vzdalenost bodd mrizky je

nezavisla na méfitku kresby, protoZe mrizka je pouze vizualni pomdcka pro kresleni nikoliv prvek
kreshy.

v,

ZvétSeni méfitka (napfiklad 1:4) umoZznuje kreslit velké objekty, které by se nevesly na velikost
papiru pro kresbu. ZmenSeni méfitka kresby (napfiklad 4:1) umoZnuje pfesné kresleni malych
objektd ve zvétSené velikosti a usnadriuje jejich pochopeni. Priklady kresleni v méfitku jsou
uvedeny na obrazku 284, kde jsou vSechny tfi obdélniky v kresbé stejné velké.

* Levy obdélnik — kresleny ve vychozim méfitku 1:1 a s kétovanim.

* Prostiedni obdélnik — méfitko kresby bylo zménéno na 1:4 a kétovani bylo programem
Draw automaticky zvétSeno, aby odrazelo zmenSeni méfitka.

* Pravy obdélnik — méfitko kresby se zménilo na 4:1 a kétovani bylo programem Draw
automaticky zmenSeno, aby odrazelo zvétSeni meéfitka.

Vice pohledli na kresbu

V LibreOffice Draw Ize otevfit a pouZivat nékolik pohled( na stejnou kresbu. Tyto pohledy se
zobrazuji v oknech, kterda mohou pouzivat rlizna nastaveni vrstev (viditeIné, tisknutelné

a uzamcéené), rlizné Grovné zvétseni, rlizné pocatky nebo mohou zobrazovat riizné stranky
kresby, a dokonce pouZzivat pfedlohu a normalni strdnku soucasné. P¥i ukladani kresby se v3ak
ujistime, Ze je aktivni spravné zobrazeni.

Pokud chceme otevfit nové okno s kresbou, zvolime v hlavni nabidce Okno > Nové okno.
Usporadani oken zavisi na operacnim systému pocitace a predvolbach zobrazeni. VSechna
oteviena okna pracuji se stejnou kresbou. Zména kresby v jednom okné se okamZzité projevi
v ostatnich oknech.

V kazdém otevieném okné je nazev souboru v zahlavi automaticky ocislovan, jak ukazuje pfiklad
na obrazku 285. Pokud jsou soucasné otevieny dalSi dokumenty LibreOffice, seznam oken
obsahuje vSechny oteviené dokumenty. Aktivni okno je v seznamu oznaceno ndzvem souboru.
Mezi okny mizeme prepinat klepnutim na ndzev v seznamu nebo klepnutim na samotné okno,
pokud je na monitoru viditelné.

Pokud chceme okno zavfit, zvolime Okno > Zavfit okno v hlavni nabidce nebo pouZijeme
klavesovou zkratku Ctrl + W nebo klepneme na Zavfit dokument v hlavni nabidce okna.
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MNové okno
Zaviit okno Ctrl+W

o H

DG7111-AdvancedDrawTechniques.odt - LibreOffice Writer
DG7111 — Pokrodilé techniky kresleni.odg - LibreOffice Draw
® Pomocny stibor DG7111.0dg - LibreOffice Draw
Obréazek 285: Priklad vice oken

Galerie

Aplikace Draw obsahuje nékolik obrazkd v Galerii. Tyto obrazky jsou seskupeny do témat
(napfiklad Sipky, Odrazky, Diagramy atd.). V karté Galerie v postranni li5té (obrdzek 286) jsou
uvedena dostupna témata. Klepneme na téma a pod seznamem témat se zobrazi obrazek tohoto
tématu.

» Pokud chceme zobrazit obrazky v tématu galerie detailngji, klepneme na Detailni pohled
v dolni Casti postranni listy.

* Pokud chceme zobrazit ikony obrazku v tématu galerie, klepneme na Pohled s ikonami
v dolni Casti postranni listy.

Pouzivani Galerie

1) Klepneme na ikonu Galerie v postranni listé nebo zvolime VloZzit > Multimédia > Galerie
v hlavni nabidce.

2) Z dostupnych moznosti vybereme téma.
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3)

4)

! Galerie x

Tvary
Viyvojovy diagram
Zvuky

o e /J AN

oo
oo o=

Mowy... &

Obrazek 286: Karta Galerie v postranni listé
K umisténi obrazku do kresby pouZijeme jednu z nasledujicich mozZnosti:
— Klepneme na obrazek v karté Galerie a pfetahneme jej do kresby.

— Klepneme pravym tlaCitkem mysi na obrazek a z mistni nabidky zvolime Vlozit.
Obréazek je umistén uprostied kresby.

— Klepneme pravym tlacitkem mySi na obrazek a z mistni nabidky vybereme
Kopirovat. VloZime obrazek do kresby. Obrazek se umisti do stfedu kresby.

Upravime obrazek galerie podle pqiadavkﬁ kresby. Vice informaci o Gpravé obrazkd
a snimkl nalezneme v kapitole 6, Upravy obrazkd.

Tvorba motivi a pridavani obrazk

1)
2)

3)
4)
5)
6)
7)

8)

V postranni listé otevieme kartu Galerie.

Klepnutim na tlaCitko Novy na karté Galerie otevieme dialogové okno Vlastnosti motivu
Novy motiv vzhledu (obrazek 287).

Do textového pole zadame nazev motivu.

Klepnutim na Soubory otevieme kartu Soubory, jak ukazuje pfiklad na obrazku 288.
Klepnutim na tlacitko Najit soubory otevieme dialogové okno Vybrat slozku.
Prejdeme do slozky, ktera obsahuje pozadované obrazky a vybereme ji.

Klepnutim na tlaCitko OK vybereme soubory obsaZzené ve sloZce a zavieme dialogové
okno Vybrat slozku. Seznam soubor(i obsaZzenych ve sloZce se nyni zobrazi na karté
Soubory, jak ukazuje priklad na obrazku 288.

Vybereme soubory poZadované pro novy motiv a klepneme na tlacitko Pfidat. VVybrané
soubory zmizi ze seznamu soubord a obrazky se objevi v Galerii.
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9) Pokud maji byt pfidany vSechny soubory ze seznamu, klepneme na tlacitko Pfidat vSe.
VSechny soubory zmizi ze seznamu a obrazky se objevi v Galerii.

10)

Po dokonéeni pridavani soubor( klepneme na OK a zavieme dialogové okno Vlastnosti

motivu Novy motiv vzhledu. Nazev nového motivu se zobrazi v karté Galerie.

Obecné Soubory

2] Novy motiv vzhledu

Typ: Galerie motivld vzhledu

Umisténi:  file:)///C/Users/Roman/AppData/Roaming/LibreOffice/4/user/gallery/novy motiv vzhledu.sdg

Obsah: 0 Objekty

Zménéno: 20.07.2021, 20:07:55

Obrazek 287: Vlastnosti motivu Novy motiv vzhledu — karta Obecné

Obecné Soubory

Typ souboru: | <Viechny soubory= (*#)

St

DAMOJE DOKUMENTY\ROZROBENE VECI\..\image 006.png
DAMOJE DOKUMENTY\ROZROBENE VECI\..\image 007.png
D:AMQJE DOKUMENTY\ROZROBENE VECI\..\image 008.png
DAMOJE DOKUMENTY\ROZROBENE VECI\..\image 009.png
D:AMOJE DOKUMENTY\ROZROBENE VECI..\image 010.png
D:AMQJE DOKUMENTY\ROZROBENE VECI\..\image 011.png
DAMOJE DOKUMENTY\ROZROBENE VECI\..\image 012.png
DAMOJE DOKUMENTY\ROZROBENE VECI\..\image 012.png

D:AMOJE DOKUMENTY\ROZROBENE VECI,..\image 014.png
DAMOJE DOKUMENTY\ROZROBENE VECI\..\image 015.png
D:AMOJE DOKUMENTY\ROZROBENE VECI\..\image 016.png
D:AMQJE DOKUMENTY\ROZROBENE VECI\..\image 017.png
DAMOJE DOKUMENTY\ROZROBENE VECI\..\image 018.png
D:AMOJE DOKUMENTY\ROZROBENE VECI..\image 019.png
D:AMQJE DOKUMENTY\ROZROBENE VECI\..\image 020.png

Najit soubary...
Pridat

Pridat vie

Nahled

Napovéda

Obnovit

oK Zrudit

Obrazek 288: Vlastnosti motivu Novy motiv vzhledu — karta Soubory

0 Poznamka

Pokud je objekt aplikace Draw pfidan do motivu, ztrati spojeni s grafickymi styly
aplikace Draw a v8echny vlastnosti jsou nastaveny jako pfimé forméatovani.
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Odstranéni galerie motivli a obrazku

1) Klepneme pravym tlaCitkem mysi na motiv nebo obrazek v Galerii a z mistni nabidky
vybereme Smazat.

2) Klepneme na Ano v potvrzovacim dialogovém okné a obrazek nebo motiv se z Galerie
odstrani.

Poznamka

Odstranit Ize pouze motivy a obrazky pfidané do aplikace Draw. Motivy a obrazky,
které byly soucasti instalace LibreOffice, nelze odstranit.

Poznamka

Obrazek je propojeny soubor a z Galerie se odstrani pouze odkaz. Plvodni soubor
s obrazkem se neodstrani.

Aktualizace Galerie

VSechny obrazky v Galerii jsou odkazy na soubory. Ob&as je vyhodné aktualizovat motiv, ktery
byl pfidan do aplikace Draw, abychom se ujistili, Ze jsou vSechny soubory stéle pfistupné.
Klepneme pravym tlacitkem mySi na motiv, ke kterému byl pfidan alespori jeden soubor,

a z mistni nabidky vybereme moZnost Aktualizovat.

PFrejmenovani motivli vzhledu

Pokud chceme prejmenovat motiv, ktery byl pfidan do aplikace Draw, klepneme pravym tlacitkem
mySi na nazev motivu a z mistni nabidky vybereme moznost Pfejmenovat.

Poznamka

Pfejmenovat Ize pouze motivy a obrazky pfidané do aplikace Draw. Motivy
a obrazky, které byly soucasti instalace LibreOffice, nelze pfejmenovat.

Barvy

~s ooz

Aplikace Draw (stejné jako vSechny soucasti LibreOffice) pouziva barvy seskupené do barevnych
palet. Barvy je mozné vytvaret podle pozadavki kresby. VSechny vytvorené vlastni barvy se
umisti do vlastni palety barev. K vytvoreni vlastni barvy Ize pouzit nasledujici barevné modely.

* RGB - zkratka pro Red (Cervena), Green (zelena), Blue (modra). Barevny model RGB je
zaloZen na aditivnim barevném modelu svételnych vin a je urCen pro elektronické
displeje a pocitaCe. To znamena, Ze ¢im vice barvy se pfidava, tim vice se barva blizi
bilé. RGB se vytvafi pomoci stupnic od 0 do 255. To znamena, Ze €erna je, kdyz R=0,
G=0 a B=0 a bil4 je, kdyZz R=255, G=255 a B=255. LibreOffice interné pouZziva barevny
model RGB pro tisk ve v3ech svych softwarovych modulech.

* CMYK - zkratka pro Cyan (azurova), Magenta (purpurova), Yellow (Zlutd), Key (Black;
¢erna). Jedna se o subtraktivni barevny model, kdy se barvy odecitaji, aby se dosahlo
bilé. Tento barevny model se pouziva pfedevsim pfi tisku, proto jsou inkoustové kazety
pro tiskarny oznaceny CMYK. CMYK pracuje se stupnici od 0 do 100. Pokud C=100,
M=100, Y=100 a K=100, vznikne ¢erna barva. Pokud C=0, M=0, Y=0 a K=0, vznikne bila
barva.

* HSB - zkratka pro Hue (odstin), Saturation (sytost), Brightness (jas). Hodnoty HSB jsou
alternativni reprezentaci barevného modelu RGB a byly navrZzeny tak, aby vice
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odpovidaly zpdsobu, jakym lidsky zrak vnima atributy barev. Pomoci hodnot HSB
mUzZeme doladit vSechny vytvorené vlastni barvy.

0 Tip

Vice informaci o barevnych modelech a hodnotach barev nalezneme na strance
http://en.wikipedia.org/wiki/Color_model.

Zmeéna barev

PFi zméneé barev v objektech se k vybéru barev pouZivaji palety barev. Tyto palety barev jsou
nainstalovany spolu s LibreOffice a pouzivaji se ve vSech modulech LibreOffice. PouZiti téchto
barevnych palet je podobné u vSech typl objekt(, ale pfistup k barevnym paletam se lidi podle
typu vybraného objektu.

Lista barev

Ackoli LibreOffice obsahuje nastroje, které umoznuji pfesné urcit barvu, obsahuje také LiStu
barev (obrazek 290), ktery umoznuje rychle ménit barvu vypiné plochy, okraje nebo Cary objektu

v kresbé.

a1 1 1 ] 1 ] ] ]
AN I O

e [ ] [ ] [ ] 1 [ ]

e [ ] [ 1 [T [ I
550 (0 S I D
5500 (0 [ (S I N R
(N0 I I I D B
g-----------

Obrazek 289: Lista barev (Barevna paleta)

O Poznamka

Barvy dostupné na Listé barev zavisi na barevné paleté, kterd byla pfedtim pouzita
pfi zméné barvy na objektu. Napfiklad obrazek 290 ukazuje Standardni paletu barey,
ktera byla dfive pouzita pfi zméné barvy objektu pomoci dialogového okna
vlastnosti.

1) Vybereme objekt v kresbé.
2) Pomoci volby Zobrazit > LiSta barev otevieme LiStu barev.

3) Klepnutim levym tlacitkem mySi na barvu zménime barvu vyplné oblasti nebo klepnutim
pravym tlaCitkem mysi na barvu zménime barvu okraje nebo ¢ary vybraného objektu.

4) Klepnutim levym tlacitkem mySi na pole X v levém dolnim rohu LiSty barev odstranime
barvu z vyplné objektu nebo klepnutim pravym tlacitkem mysi na pole X v levém dolnim
rohu LiSty barev odstranime barvu z ohrani¢eni objektu.

5) Pokud chceme LiStu barev zavfit, zvolime Zobrazit > LiSta barev v hlavni nabidce
a zruSime oznaceni LiSta barev.
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Dialogové okno Oblast

1)
2)

3)
4)
5)

6)

Vybereme objekt v kresbé.

Dialogové okno Oblast (obrazek 290) otevieme jednim z nasledujicich zplsobd:
— V hlavni nabidce vybereme Format > Oblast.

— Klepneme pravym tlaCitkem na objekt a vybereme z mistni nabidky Oblast.
Klepnutim na Barva otevieme stranku Barva.

V okné Barva vybereme z rozeviraciho seznamu Paleta barevnou paletu.

Klepneme na nékterou ze zobrazenych barev nebo vybereme barvu, ktera jiz byla dfive
pouZita v nabidce Posledni barvy.

Klepnutim na tlaCitko OK uloZzime zmény a zavieme dialogové okno Oblast. Vybrana
barva vypIné se zobrazi ve vybraném objektu.

Oblast Stin Prdhlednost

Barva Prechod Rastr Vzorek Srafovani

Barvy Aktivni

Paleta: |standard

CeeEEEEEERn
R R

114

G

<]

==}

e [ ] [T G [159
CeaEEEEEEn 5
 AeEEEEEEEEs
PEEEEEREEEEEE HTML |729fcf HTML |2ceele

SEEEEEEEEEEE Vybrat @

Posledni barvy

EEEEEEEEOEE

Vlastni paleta

159
207

| = | [=
= —
[[==]

Pridat Smazat

Napovéda Obnovit QK Zrusit

Obréazek 290: Dialogové okno Oblast — stranka Barva
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Obrézek 291: Cast Oblast na karté Vlastnosti
v postranni liSté

Cést Oblast na postranni listé

1)
2)
3)
4)

5)
6)

Vybereme objekt v kreshé.
V postranni listé na karté Vlastnosti otevieme ¢ast Oblast (obrazek 291).
V rozeviracim seznamu Vyplii vybereme moZnost Barva.

Klepnutim na maly trojuhelnik ¥ vpravo u volby Barva vyplné otevieme naposledy
pouZitou paletu.

V rozeviracim seznamu palety vybereme paletu barev, kterou chceme pouZzit.
Klepneme na jednu ze zobrazenych barev nebo vybereme barvu, ktera byla pouzita

drive, z barev zobrazenych v €asti Posledni. Barevna paleta se zavie a na objekt se
pouzije vybrana barva vyplIné.

Barva vyplné na néstrojovych listach Céra a vyplii nebo Kresba

1)
2)

3)
4)

Vybereme objekt v kresbé.

Klepnutim na maly trojahelnik v vpravo od Barva vyplné na nastrojové listé Cara
a vypln nebo na nastrojové listé Kresba vybereme naposledy pouzitou paletu.

V rozeviracim seznamu palety vybereme paletu barev, kterou chceme pouZit.

Klepneme na jednu ze zobrazenych barev nebo vybereme barvu, ktera byla pouzita
dfive, z barev zobrazenych v ¢asti Posledni. Barevna paleta se zavie a na objekt se
pouzije vybrana barva vypliné.

Dialogové okno Céra

1)

Vybereme ¢aru nebo objekt v kresbé.
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2)

Dialogové okno Cara (obrazek 294) otevieme jednim z nasledujicich zpsob:
— V hlavni nabidce zvolime Format > Céara.
— Klepneme pravym tlagitkem na aru nebo objekt a z mistni nabidky vybereme Cara.

Cara Stin Styly ¢ar Styly ipek
Vlastnosti cary Styly roha a zakon&eni
Styl: ——— Spojita v| Styl rohu: Zakulaceny ~|
Barva: |- Svétle purpurova 2 v Styl zakonéent: ‘P|0Ché & |
Sitka: |standard v
Prihlednost: EEEEEEN
FEEEEEEEN
Styly Sipek
Styl zacatku: || Styl konce: |- Zadné - v
Sitka: L LT Sifka: 065cm =
. Lo
= EEEEEEEER = ' hd
EEEEEEEEEN Na stied
FAEEEEEEEEEER
AEEEEEEEEEEER
ENEEEEEEEEER
I Posledni ] A A
EEEN EENER
& Vlastni barva...
Napovéda Obnovit OK Zrusit

Obrazek 292: Dialogové okno Céra

3)
4)

5)
6)

7)

Klepnutim na Céra otevieme stranku Cara.

Klepnutim na maly trojuhelnik ¥ vpravo od ikony Barva otevieme naposledy pouzitou
paletu.

V rozeviracim seznamu palety vybereme paletu barev, kterou chceme pouZit.

Klepneme na jednu ze zobrazenych barev nebo vybereme barvu, ktera byla pouzita
dfive, z barev zobrazenych v €asti Posledni. Barevna paleta se zavfe a vybrana barva
Cary se pouzije na ¢aru nebo okraj objektu.

Klepnutim na OK uloZime zménu barvy a zavieme dialogové okno Céra.

Cést Céra v postranni listé

1)
2)
3)

4)
5)

Vybereme €aru nebo objekt v kresbé.
V postranni li5t& na karté otevieme ¢ast Céra (obrazek 293).

Klepnutim na maly trojuhelnik v vpravo vedle ikony Barva €ary otevieme naposledy
pouzitou paletu.

V rozeviracim seznamu palety vybereme paletu barev, kterou chceme pouZit.

Klepneme na jednu ze zobrazenych barev nebo vybereme barvu, kterd byla pouZzita
drive, z barev zobrazenych v €asti Posledni. Barevna paleta se zavre a vybrana barva
Cary se pouzije na Caru nebo okraj objektu.
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Obrézek 293: Cast Céra na karté Vlastnosti
v postranni listé

Barva éary na nastrojovych listdch Cdra a vyplfi nebo Kresba
1) Vybereme Caru nebo objekt v kreshé.
2) Klepnutim na maly trojihelnik v vpravo vedle ikony Barva &ary na nastrojové listé Cara
a vypln nebo na nastrojoveé listé Kresba otevieme naposledy pouZitou paletu.
3) V rozeviracim seznamu palety vybereme paletu barev, kterou chceme pouzit.

4) Klepneme na jednu ze zobrazenych barev nebo vybereme barvu, ktera byla pouzita
drive, z barev zobrazenych v ¢asti Posledni. Barevnéa paleta se zavre a vybrana barva
¢ary se pouzije na ¢aru nebo okraj objektu.

Zmeéna barvy textu

Zména barvy textu je velmi podobna zméneé barvy vyplné oblasti, okraje objektu nebo Cary.
Nastrojova lista Formatovani textu se automaticky otevie a nahradi nastrojovou listu Céara

a vypln, pokud je v kresbé vybran text. Pokud se nastrojova liSta Formatovani textu nezobrazi,
prejdeme v hlavni nabidce do Zobrazit > Nastrojové liSty a vybereme Formatovani textu.

Dialog Znak
1) Vybereme text v textovém poli nebo objektu a ujistime se, Ze je text zvyraznén.
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2) Pomoci jedné z nasledujicich moznosti otevieme dialogové okno Znak (obrazek 294):
— V hlavni nabidce zvolime Format > Znak.

— Klepneme pravym tlaCitkem mysi na zvyraznény text a z mistni nabidky zvolime
Znak.

Pismo Efekty pro pismo Umisténi Zvyraznéni

Barva pisma

Barva pisma: ||:| Automaticka hd |

Prihlednost: ‘

Dekorace textu

MNadtrZeni: Automaticka v
Preskrtnuti:

Podtrzeni: Automaticka v

Efekty
Velikost:

Reliéf: u ys [Ostin
- ANEEEEEEEEER y

Znacka zvyraznéni:

Posledni

Umisténi: BEEEER EENEN

‘ & Vlastni barva... ‘
parevity ext

Napovéda Obnovit oK Zrusit

Obrézek 294: Dialogové okno Znak — karta Efekty pro pismo

3) Klepnutim na kartu Efekty pro pismo otevieme stranku Efekty pro pismo.

4) Klepnutim na maly trojuhelnik ¥ vpravo vedle ikony Barva pisma otevieme naposledy
pouZzitou paletu.

5) V rozeviracim seznamu palety vybereme paletu barev, kterou chceme pouzit.

6) Klepneme na jednu ze zobrazenych barev nebo vybereme barvu, ktera byla pouzita
dfive, z barev zobrazenych v ¢asti Posledni. Barevna paleta se zavie a vybrana barva se
pouZzije na vybrany text.

7) Klepnutim na OK uloZzime zménu barvy a zavieme dialogové okno Znak.

Cést Znak v postranni listé
1) Vybereme text v textovém poli nebo objektu a ujistime se, Ze je text zvyraznén.
2) V postranni listé v ¢asti Vlastnosti otevieme Cast Znak (obrazek 296).

3) Klepnutim na maly trojuhelnik ¥ vpravo vedle ikony Barva pisma otevieme naposledy
pouzitou paletu.

4) V rozeviracim seznamu palety vybereme paletu barev, kterou chceme pouzit.
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5) Klepneme na jednu ze zobrazenych barev nebo vybereme barvu, ktera byla pouzita
drive, z barev zobrazenych v €asti Posledni. Barevnéa paleta se zavie a vybrana barva se
pouZije na vybrany text.

! Vlastnosti
= Znak

il

Liberation Sans ~118pt |~
BIU-SS A A
A-®.f A x,
= 7] Automaticka
H =
standard ~

il

® g & O\

Posledni

@ Vlastni barva...

Obrézek 295: Cast Znak na karté Vlastnosti
v postranni listé
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Obrazek 296: Dialogové okno Vyberte barvu

Tvorba barev

PouZiti dialogového okna Vyberte barvu

1) Vybereme objekt nebo text a pomoci jedné z nasledujicich moznosti otevieme dialogové
okno Vyberte barvu (obrazek 296):

Otevieme dialogové okno Oblast, klepnutim na kartu Barva otevieme stranku Barva
a klepneme na Vybrat.

V postranni li5té na karté Vlastnosti otevieme Cast Oblast, klepnutim na maly
trojuhelnik v vpravo vedle ikony Barva vyplné otevieme barevnou paletu
a klepneme na moznost Vlastni barva ve spodni ¢asti barevné palety.

Otevieme dialogové okno Céara, poté otevieme barevnou paletu u volby Barva
a klepneme na Vlastni barva ve spodni ¢asti barevné palety.

V postranni listé na karté Vlastnosti otevieme ¢ast Cara, klepnutim na maly
trojuhelnik v vpravo vedle ikony Barva €ary otevieme barevnou paletu a klepneme
na volbu Vlastni barva ve spodni ¢asti barevné palety.

Otevieme dialogové okno Znak, poté otevieme barevnou paletu ve volbé Barva
pisma a klepneme na Vlastni barva ve spodni ¢asti barevné palety.
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2)

3)

4)

5)

— V postranni listé na karté Vlastnosti otevieme Cast Znak, klepnutim na maly
trojuhelnik v vpravo vedle volby Barva pisma otevieme barevnou paletu a klepneme
na Vlastni barva ve spodni ¢asti barevné palety.

Ve svislé listé barev v dialogovém okné Vyberte barvu vybereme barevny rozsah, ktery
priblizné odpovida vytvarené vlastni barvé.

Klepneme a pretahneme maly cilovy kruh v poli barvy, dokud barva nebude odpovidat
poZadované vlastni barvé. Hodnoty RGB, HSB a CMYK se méni pfi pfetahovani malého
cilového krouzku v poli barev. Tyto hodnoty pomahaiji pfi tvorbé pfesné barvy, pokud jsou
znamy.

Pokud jsou hodnoty barvy nebo hexadecimalni €islo barvy znamé, zadame je do
prislusného textového pole. Hodnoty ve vSech textovych polich se zméni tak, aby
odpovidaly novym hodnotam. Zadame napfiklad hodnoty HSB. Hodnoty RGB, CMYK

a Hex se zméni tak, aby odpovidaly zadané hodnoté HSB.

Klepnutim na OK ulozime zmény a zavieme dialogové okno Vyberte barvu.

Poznamka

Kdyz dialogové okno Vyberte barvu otevieme pomoci dialogového okna Cara nebo
Znak, nelze vytvorenou vlastni barvu uloZit do palety Vlastni barva nebo ji
prejmenovat smyslupInéjsim ndzvem. Vytvofend vlastni barva je pojmenovana
pomoci hexadecimalni hodnoty, ktera se zobrazi v dialogovém okné Vyberte barvu.
Pouze dialogové okno Oblast umoZziuje pfejmenovat viastni barvy a ulozit je do
Vlastni palety.

Poznamka

LibreOffice pouziva pro barevny tisk barevny model RGB. Hodnoty RGB vybrané
barvy se zobrazuji pod nahledovymi poli.

PouZiti dialogového okna Oblast

1)
2)

3)

4)

Otevieme dialogové okno Oblast a klepnutim na kartu Barva otevieme stranku Barva.

V Casti Nova zadame do textovych poli RGB hodnoty barvy nebo, pokud ji zname,
hexadecimalni hodnotu. Barva v ndhledovém poli se zméni tak, aby odpovidala zadanym
hodnotam.

Pripadné v ¢asti Nova pouzijeme Sipky pro hodnoty RGB a tim sniZime nebo zvySime
hodnoty. Barva v ndhledovém poli se zméni tak, aby odpovidala zadanym hodnotam.

Klepnutim na OK zménime barvu a zavieme dialogové okno Oblast.

Pridani vlastnich barev

V pfipadé potfeby pfidame vlastni barvu do palety Vlastni barva pomoci dialogového okna
Oblast nasledujicim zplsobem:

1)
2)
3)
4)
5)

6)

Ujistime se, Ze je dialogové okno Oblast otevieno na strance Barva.
Vybereme vlastni barvu, ktera je zobrazena v poli Posledni barvy.
Klepnutim na P¥idat otevieme dialogové okno Nazeuv.

Do textového pole zadame novy nazev barvy.

Klepnutim na OK zmény uloZzime a zavieme dialogové okno Nazev. Vlastni barva se
objevi ve Vlastni paleté.

Klepnutim na OK zavieme dialogové okno Oblast.
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Prfejmenovani vlastnich barev

Pomoci dialogového okna Oblast Ize pfejmenovat pouze vlastni barvu, a to nasledujicim
zplsobem:

1) Ujistime se, Ze je dialogové okno Oblast otevieno na strance Barva.
2) Vybereme vlastni barvu, ktera se zobrazi ve Vlastni barevné paleté.
3) Klepnutim na P¥idat otevieme dialogové okno Nazev.

4) Do textového pole zaddme novy nazev barvy.

5) Klepnutim na OK zmény uloZime a zavieme dialogové okno Nazev. Vlastni barva se
objevi ve Vlastni paleté.

6) Klepnutim na OK zavieme dialogové okno Oblast.

Poznamka

PFejmenovani vliastni barvy ve skute¢nosti neznamena prfejmenovani vlastni barvy,
ale pfidani vlastni barvy do Vlastni palety s novym nazvem.

Poznamka

Je dulezité pouZivat zapamatovatelné nazvy vlastnich barev, aby je bylo mozné
snadno rozpoznat na Vlastni paleté. Ve vychozim nastaveni je vlastni barvé
pfifazeno hexadecimalni Cislo, coZ stéZuje identifikaci barev, pokud existuje vice nez
jedna vlastni barva.

Mazani vlastnich barev

Pomoci dialogového okna Oblast Ize odstranit pouze vlastni barvu, a to nasledujicim zplisobem:
1) Ujistime se, Ze je dialogové okno Oblast otevieno na strance Barva.
2) Vybereme vlastni barvu, ktera se zobrazi ve Vlastni barevné paleté.

3) Klepneme na Smazat. P¥i odstrafiovani vlastnich barev neni vyZzadovano zadné
potvrzeni odstranéni.

4) Klepnutim na OK zavieme dialogové okno Oblast.

Bézierovy krivky

V LibreOffice Ize pfi kresleni pouzivat Bézierovy? krivky. Kfivka je definovana pomoci
pocatecniho bodu, koncového bodu a pfipadné Fidicich bodl. Pro body na kfivce se ¢asto
pouZzivaji terminy uzly nebo kotvy. DalSi informace a vysvétleni matematického pozadi

Bézierovych kfivek nalezneme na strance http://en.wikipedia.org/wiki/Bezier_curve.

Bézierovy kfivky jsou velmi uzite€né pfi experimentovani s tvarem a podobou kfivek. V bodovém
rezimu Ize zarovnani kiivky ménit tazenim bod0 pomoci kurzoru. V pfikladu na obrazku 297
opousti kfivka pocatecni bod PO ve sméru prvniho Fidiciho bodu P1 a do koncového bodu P3

vvvvv

nebo koncového bodu, tim mensi je zakfiveni v tomto bodé.

Kresleni Bézierovych krivek
1) Klepneme na ikonu KFivka v ¢asti Kfivky a mnohouhelniky na karté Tvary v postranni
li5té nebo na nastrojové listé Kresba.

2 Bézierovy kfivky vynalezl Pierre Bézier, inzenyr pracujici pro automobilku Renault, ktery tuto techniku
vyvinul v 60. letech 20. stoleti. Tato technologie méla usnadnit modelovani povrchu vozidel.
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2) Klepneme na pocatecni bod kfivky a pfetahneme kurzor do pfiblizné polohy koncového

bodu kfivky.

3) Uvolnime tlacitko mySi a pfetahneme koncovy bod kfivky do jeho koncového umisténi.
4) Po dosazeni koncové polohy kfivky dvakrat klepneme a kfivka se nakresli. Oblouk krivky

5)

6)

7
8)
9)

10)
11)

je uréen vzdalenosti pfetazenou k vytvofeni koncového bodu.

Pocateéni bod PO

Koncovy bod P3 Kontrolni bod P2

T T = O

Obréazek 297: Priklad Bézierovy krivky

Upravit body v X

A4 A AIC A INEA MY

Obrazek 298: Nastrojova lista Upravit body

Do rezimu bod(l se pfepneme pomoci jedné z nasledujicich moznosti:
— V hlavni nabidce zvolime Upravit > Body.

— Na Standardni nastrojové listé klepneme na Body.

— PouzZijeme klavesovou zkratku F8.

Otevieme nastrojovou liStu Upravit body (obrazek 298) pomoci jedné z nasledujicich
mozZnosti. Nastrojova liSta Upravit body se zobrazi az po vybéru bodu na kfivce.

— V hlavni nabidce pfejdeme do Zobrazit > Nastrojové liSty a zvolime Upravit body.
— Na Standardni nastrojové listé klepneme na Body.

— Pouzijeme klavesovou zkratku F8.

— Pokud je pfidan na nastrojovou liStu Kresba, klepneme na nastroj Body.

Jednim klepnutim na kfivku zobrazime pocatecni a koncovy bod. Pocatecni bod kfivky je
vétsi nez koncovy bod.

Klepnutim na po&ateéni nebo koncovy bod zobrazime fidici body. Ridici body se zobrazi

na konci pferuSované Cary spojené s vybranym bodem, jak je zndzornéno na obrazku
297.

Klepnutim na fidici bod a jeho pretazenim na novou pozici zménime tvar k¥ivky.
Kdyz je tvar kfivky spravny, uvolnime tla€itko mySi a kfivku zafixujeme.
Klepnutim kdekoliv na pracovni plose zrusime vybér kfivky a ukoncéime Upravy bodd.
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Nastroje pro Gpravu bodu

Po prvni otevieni nastrojové liSty Upravit body se po vybéru objektu, ktery byl pfeveden na k¥ivku
nebo mnohouhelnik, tato nastrojova liSta zobrazi. Nastroje dostupné na nastrojové listé Upravit
body umozZziiuji upravovat Bézierovu kfivku a meénit jeji tvar. Aby byly k dispozici vSechny nastroje
na nastrojové listé Upravit body, musi byt vybran bod na Bézieroveé kfivce.

* PFesunout body — klepnutim a tazenim na bod jej pfesuneme na jiné misto.

— Kfivka na obou stranach bodu sleduje pohyb tohoto bodu a méni tvar podle toho, jak
se méni poloha vybraného bodu.

— Klepnutim a tazenim na kfivku mezi body miZzeme celou kfivku posunout, aniz by
doslo k naruSeni tvaru kFivky.

* Vlozit body — po vybéru aktivuje rezim vioZeni a vloZi na kfivku hladké body. Rezim
vkladani zlstava aktivni i po vlozeni bodd. Vybérem nastroje Pfesunout body
deaktivujeme rezim vkladani.

— VloZeny bod Ize pfi aktivovaném reZimu vkladani presouvat.

— Pokud je poZadovan uhlovy nebo soumérny bod, viozime nejprve hladky bod a ten
prevedeme na Uhlovy nebo soumeérny bod.

¢ Smazat body — odstrani vybrané body. Pokud chceme odstranit vice bodU, podrZzime pfi
vybéru bod{ a pred klepnutim na Smazat body stisknutou klavesu Shift.

* Prevést na kFivku — prevede kfivku na pfimku nebo pfimku na kfivku, jak ukazuje
obrazek 299.

— Vybereme jeden bod a zakfivena UseCka za bodem se prevede na primku nebo se
¢ast primky (Usecka) za bodem prevede na kfivku.

— P¥i pfevodu Usecky z kfivky na pfimku se kazdy bod na kazdém konci Usecky stane
fidicim bodem podobné jako pocatecni nebo koncovy bod.

— P¥i pfevodu Usecky z pfimky na kfivku se kazdy fidici bod na kazdém konci useCky
stane hladkym bodem.

Obrazek 299: Priklad prevodu zakrivené
usecky na pfimou tsecku

* Uzavfit Beziérovu kfivku — uzavre volnou ¢aru nebo kfivku spojenim pocatecniho bodu
s bodem koncovym a vytvofi objekt s vypini plochy.

* Rozdélit kiivku — rozdéli kfivku na dvé nebo vice kfivek. Vybereme bod nebo body
a klepnutim na Rozdélit kfivku vytvofime samostatné segmenty kf¥ivky. ZruSime vybér
kfivky a poté vybereme segment, ktery chceme pfesunout nebo upravit.

. thovy bod - prevede vybrany bod na uhlovy bod, jak je znazornéno na obrazku 300.
Uhlové body maiji dva pohyblivé fidici body, které jsou na sobé nezavislé a umoznuji
vytvofit roh v kfivce.
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Obrazek 300: Priklad uhlového bodu

Plynuly pfechod —prevede Uhlovy nebo soumérny bod na hladky, jak je zndzornéno na
obrazku 301. Oba fidici body plynulého bodu pfechodu jsou zarovnany rovnobézné a lze
s nimi pohybovat pouze sou¢asné. Ridici body se mohou lisit délkou, coZ umozZiuje
ménit stupen zakfiveni.

Obréazek 301: Priklad plynulého bodu prechodu

Soumeérny prechod — pfevede uhlovy nebo hladky bod na soumérny, jak je znazornéno
na obrazku 302. Oba fidici body soumérného bodu pfechodu jsou rovnobézné a maji
stejnou délku. Tyto fidici body Ize posouvat pouze soucasné a stupen zakfiveni je v obou

smérech stejny.

Obrazek 302: Priklad soumérného pfechodu bodu

ok,
-

-
.

-\.

.

Ubrat body — umoZiiuje vybrat nékolik bod( pred pouzitim nastroje Smazat body. To je
uzite€né pfi odstrafiovani ¢asti pfimky (lsecky), aby se vytvorila Gplna kfivka.

Pridavani komentarli do kresbhy

Aplikace Draw podporuje komentare podobné jako aplikace Writer a Calc. DalSi informaci

o0 pfidavani, prochazeni a odpovidani na komentafe nalezneme v pfirucce Zaéiname

s LibreOffice. Komentafe v aplikaci Draw nelze tisknout. Pokud chceme odpovédét na komentar
v aplikaci Draw, musime pfidat novy komentar.

1)

2)
3)

4)

V hlavni nabidce pouzijeme Vlozit > Komentar a v levém hornim rohu kresby se objevi
pole pro komentaF (obrazek 303). Aplikace Draw automaticky pfida na konec komentare
jméno uzivatele a datum a umisti znacku komentére na stranku kresby.

NapiSeme nebo vloZzime komentar do textového pole pro komentar.

Pokud chceme na text pouzit zakladni formatovani, klepneme na text pravym tlaCitkem
mysi a z mistni nabidky vybereme moZnost formatovani.

Pokud chceme komentar smazat, pouzijeme jeden z nasledujicich zpUsobu:
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— Klepneme pravym tlaCitkem mySi do pole komentéfe a z mistni nabidky vybereme
moZnost smazani.

— Klepneme pravym tlacitkem my3i na znacku komentafe a z mistni nabidky vybereme
mozZnost smazani.

— Klepneme na maly trojuhelnik v v pravém dolnim rohu pole pro komentare a z mistni
nabidky vybereme moZnost smazani.

5) Pokud chceme komentar pfesunout, klepneme na znacku komentare a pfetdhneme ji na
nové misto.

TDtDje néjak B Tuéné
I Kurziva

U Podtrieng

S Preskrtnuti
Viozit

%] Gk

Smazat komentar
Smazat vSechny komentare od Roman Toman

|

Smazat vsechny komentare

Obrazek 303: Komentar v aplikaci Draw

6) Pokud chceme skryt komentar, pouzijeme jednu z nasledujicich moznosti:

— V hlavni nabidce pfejdeme do Zobrazit a zruSime vybér mozZnosti Komentéare. Tim
skryjeme komentéf a znacku komentére.

— Klepneme na kresbu mimo komentar a tim ho skryjeme. Znacka komentare zlstava
viditelna.

7) Pokud chceme komentare zobrazit, zvolime Zobrazit > Komentare v hlavni nabidce
a klepneme na znacku komentare.

4 Poznamka

Aby se jméno a inicidly uzivatele objevily v komentafi, zadame Udaje uZivatele

v dialogovém okné Nastroje > Moznosti > LibreOffice > Uzivatelské udaje. Pokud
dokument upravuje vice osob, barva pozadi komentarl automaticky odliSuje jejich
autory.

Spojovani a rozpojovani €ar

V aplikaci Draw je mozné spoijit jednotlivé prvky ¢ary do jedné Cary a prerusit ¢aru, ktera se
sklada z jednotlivych prvkd.

* Pokud chceme Cary spaijit, vybereme je a zvolime Tvar > Spojit v hlavni nabidce.

Koncové body pfimky jsou spojeny dohromady. Vysledny tvar je ¢ara od ruky, nikoliv
uzavreny tvar.

« Pokud chceme prerusit ¢aru sloZzenou ze samostatnych prvkd, vybereme ji a v hlavni
nabidce zvolime Tvar > Rozpojit. ZruSime vybér objektu a poté vybereme jednotlivé
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prvky. Kazdy samostatny prvek je oznacen pocatecnim a koncovym bodem. Klepneme
na prvek a pfetdhneme jej na nové misto.

Soufradnicovy systém

Osy XayY

Osa x je vodorovna poloha objektu a osa y je svisla poloha objektu. Pravitka nezobrazuji
znaménko minus, pokud jsou soufadnice zaporné. Znaménko minus pro zaporné soufadnice se
v8ak zobrazuje v poli polohy na stavovém fadku a v dialogovém okné Umisténi a velikost.

Pracovni plocha

Pracovni plocha v aplikaci Draw je vétSi nezZ stranka kresby. Plocha mimo stranku kresby je
Siroka jednu stranku vpravo a vievo a pil stranky nad a pod strankou kresby. Velikost stranky
kreshy je znazornéna zvyraznénymi ¢astmi vodorovnych a svislych pravitek.

Objekty aplikace Draw Ize kreslit ¢aste€né nebo zcela mimo stranku kresby. Tyto objekty se
ukladaji spolu s kresbou. P¥i tisku nebo exportu kresby vSak neni zahrnut Zadny objekt nebo ¢éast
objektu, ktery neni na strance kresby. To umozfuje, aby se pracovni plocha kolem stranky kreshy
pouzivala pro navrhy pfi vytvareni objektd.

Poloha objektu

Souradnice objektll a voditek se zobrazuji relativné vzhledem k pocatku. Vychozim pocatkem
soufadnice (pozice (0.00/0.00) je levy horni roh stranky kresby bez okrajli nebo levy horni roh
stranky kresby, kde se protinaji okraje. Pokud chceme zménit vychozi pocatek, klepneme na
prisecik pravitek v levém hornim rohu pracovni plochy a pfetdhneme jej do pozadované polohy.
Pri pfetahovani priseciku z vychoziho poéatku do nové pozice se zobrazi vodici ¢ary. Toto
nastaveni poCatku se tyka pouze aktualniho zobrazeni a neni uloZzeno v dokumentu.

Oblast uvnitf vychoziho pocatku je oblast pouzita pro mfizku, kdyZ je vybrana moznost PFichytit
k m¥iZzce a moznost Zobrazit mrizku.

Pokud chceme obnovit vychozi po¢atek do plvodniho nastaveni v levém hornim rohu stranky,
klepneme dvakrat do levého horniho rohu na pracovni ploSe, kde se setkavaji vodorovné a svislé
pravitko.

Prfesnost

Aplikace Draw pouziva interné celociselné hodnoty v 1/100 mm. Proto napfiklad neni mozné
ziskat pfesnou polohu pro 1/8 palce. Mnoho poli v dialogovych oknech je také omezeno na dvé
desetinna mista.

Pokud chceme pracovat s maximalni moznou pfesnosti, pfejdeme do Nastroje > MozZnosti >
LibreOffice Draw > Obecné a nastavime moznost Mérna jednotka na Milimetr. Po vybéru této
moznosti se v pravitkach zobrazi metrické jednotky. Pokud chceme pro pravitka pouzit jinou
mérnou jednotku, klepneme na pravitko pravym tlacitkem mysi a z mistni nabidky vybereme
mérnou jednotku. Vodorovné a svislé pravitko mohou mit rizné mérné jednotky.
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Uvod

Ve vychozim nastaveni jsou pfikazy a nastroje pouzivané v LibreOffice Draw seskupeny

v uZivatelském rozhrani, které se sklada z kaskadovych nabidek a nastrojovych list. Funkce

a pouziti téchto kaskadovych nabidek a nastrojovych liSt jsou popséany v pfedchozich kapitolach
této uzivatelské prirucky.

Tato kapitola popisuje varianty uzivatelského rozhrani, které jsou k dispozici pro LibreOffice
Draw. UZivatel ma pak moznost vybrat si uZivatelské rozhrani, které vyhovuje jeho pozadavkdm
a zplsoblm vytvareni kreseb v LibreOffice Draw.

Q Poznamka

PFi zméné uzivatelského rozhrani Ize variantu pouzit pouze pro LibreOffice Draw
nebo pro vSechny moduly LibreOffice.

Vybér uzZivatelského rozhrani

Vybér varianty uzivatelského rozhrani nebo pfepinani mezi variantami uzivatelského rozhrani:

8) V hlavni nabidce zvolime Zobrazit > UZivatelské rozhrani a otevieme dialogové okno
Vyberte upfednostiované uzivatelské rozhrani (obrazek 304).

9) V Casti Varianty rozhrani vybereme jednu z variant. Pfiklad vybrané varianty se zobrazi
v poli Nahled spolu s kratkym popisem.

10) Kliknutim na Pouzit v modulu Draw pouzijeme vybér varianty pouze v LibreOffice Draw,
nebo kliknutim na Pouzit na vSe pouzijeme variantu na vSechny moduly LibreOffice.
Okno LibreOffice se zméni podle vybrané varianty.

11) Kliknutim na Zavfit dialogové okno zavieme.

Varianty rozhrani Nahled
@ Standardni nastrojoveé listy
O Karty File Edit Insert
o Kompaktnl’ karty_ DERXDEeloc
) Kompaktni skupiny
) Kontextova lista v Styles B / U S | X2

) Jedina nastrojova lista

(2) Postranni lista _— . ) ) N .
- Standardni uZivatelské rozhrani s nabidkou, nastrojovou listou a

sbalenou postranni listou. Uréeno pro uZivatele, ktefi jsou zvykli
na klasické rozhrani.

Pougit na vie +/ PouZit v modulu Draw Zavrit

Obrazek 304: Dialogové okno Vyberte upfednostriované uZivatelské rozhrani
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0 Poznamka

Pokud byla v dialogovém okné Nastroje > MoZnosti > Upfesnit vybrana moznost
Povolit experimentalni funkce, objevi se v dialogu Varianty rozhrani nékolik
dalSich variant. ProtoZe se jedn& o experimentalni varianty, nejsou v této uzivatelské
pfirucce popsany.

Soubor  Upravy  Zobrazit  WioEt Formdl  Stranka  Twer  Nastoje  Okmo Mapovéda
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[ M Y A [ Pozadi piediohy
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< >
W (LI A Rozwrdeni Owladaci proky Kotovac Cany |
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Obrazek 305: Standardni uZivatelské rozhrani nastrojovych list v LibreOffice Draw

0 Poznamka

Ve vSech variantach uzivatelského rozhrani Ize postranni liStu skryt nebo zobrazit
kliknutim na tlaitko Skryt/zobrazit vievo od postranni listy,

Standardni uZivatelské rozhrani nastrojovych list

Uzivatelské rozhrani Standardni nastrojové listy je vychozim zobrazenim po instalaci
LibreOffice. Obrazek 305 ukazuje pfiklad vychoziho zobrazeni pracovni plochy v LibreOffice
Draw, které se obvykle sklada z nasledujicich polozek.

» Hlavni nabidka v horni €asti pracovni plochy.
» Standardni nastrojova liSta umisténa pod hlavni nabidkou.
+ Nastrojova lista Cara a vyplii umisténa pod nastrojovou listou Standardni.
* Nastrojova liSta Kresba umisténa svisle na levé strané pracovni plochy.
» Postranni liSta umisténa vpravo od pracovni plochy.
DalSi informace o pracovni ploSe Draw nalezneme v kapitole 1, Pfedstaveni aplikace Draw.

Uzivatelské rozhrani s kartami

UZivatelské rozhrani Karty poskytuje uZivatelm znamé rozhrani z proprietarnich kancelarskych
balikll, napfiklad Microsoft Office. Toto uZivatelské rozhrani je rozdéleno na karty, pficemz kazda
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karta zobrazuje sadu nastrojii seskupenych podle kontextu. Kontext se méni v zavislosti na
vybraném objektu a pouzitém modulu LibreOffice.

Obsahuije panel nabidek, panel karet a ikony nastroji seskupené v kontextu, ktery se bé&zné
pouziva v LibreOffice Draw. Pokud se ikony nastrojli na strance s kartou nevejdou na Sitku okna
Draw, zobrazi se na pravém konci fadku dvojita Sipka >>. DalSi pfikazy zobrazime kliknutim na
dvoijitou Sipku >>.

[—=]

[7 Nowy 3
(® Posledni dokumenty b
[& Zaviit

UZivatelské rozhrani
MNastrojove listy b
Piizptsobit..
ga3 MoZnosti... Alt+F12
@) Napovéda LibreOffice F1
(2] Podpoiit LibreOffice finanéné
[J 0 aplikaci LibreOffice

Obrazek 306: Moznosti rychlé nabidky

4 T iR
Obréazek 307: Panel ikon-

V operacnich systémech Windows a Linux Ize hlavni nabidku skryt nebo zobrazit kliknutim na
ikonu Hlavni nabidka na levém konci pasu karet.

Vpravo od pasu karet je k dispozici rychla nabidka (=) (obrazek 306), ktera umoZiuje pristup
k nékterym bézné pouzivanym prikaziim a odkazim. Nékteré polozky rychlé nabidky maiji
podnabidky, které jsou oznaceny malym trojuhelnikem » vpravo. Rychla nabidka je stejna pro
vSechny karty.

Vlevo od pasu karet je k dispozici panel ikon (obrazek 307), ktery umoznuje pfistup k nékterym
béZné pouzivanym nastrojim - Hlavni nabidka; Otev¥it (Ctr/ + O); UloZit (Ctrl + S); Zpét (Ctrl +
Z); Znovu (Ctrl +Y).

Uzivatelské rozhrani s kartami Ize pfizpUsobit pomoci zalozky Lista karet dialogového okna
Prizplsobit a zobrazit nebo skryt jednotlivé nastroje na rliznych kartach. Dal$i informace
o prizplsobeni LibreOffice nalezneme v pfirucce Zaciname s LibreOffice a pfirucce Writer.

Poznamka

PTi pouziti uzivatelského rozhrani s kartami jsou nastrojové liSty Draw odstranény ze
zobrazeni. V pfipadé potfeby Ize nastrojové liSty otevfit a pouzivat pomoci volby
Zobrazit > Nastrojové listy v hlavni nabidce nebo Rychla nabidka > Nastrojové
listy.
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Neménné karty

Neménné karty v uzivatelském rozhrani Karty pro aplikaci Draw jsou popsany na nasledujicich
stranké&ch. Na obrézcich jsou zobrazeny levy a pravy konec karet zvIast, aby byly dostate¢né
velké a prikazy byly lépe vidét.

Karta Soubor

Karta Soubor (obrazek 308) je pevna karta poskytujici pfikazy pro vytvareni novych dokumentd,
otevirani, ukladani, tisk a zavirani dokumentd, spravu $ablon, export do PDF a EPUB, zobrazeni
vlastnosti dokumentu, pfidani digitalniho podpisu a podepsani existujiciho PDF.

Karta Soubor ma dvé nabidky (obrazky 309 a 310): Soubor a Napovéda. Nabidka Soubor
obsahuje stejné prikazy jako nastroje dostupné na karté. Nabidka Napovéda obsahuje odkazy
na riizné zdroje.

™ E H - Soubor Domi Viozit Rozvrzeni Revize Zobrazit
m L[] 5ablony (® Posledni dokumenty ¥ | [ B Ulodit jako.. [ »
Novy EUIuiit_jakD Zablonu | Oteviit | Oteviit vedéleny Ulozit B Ulozit vzdaleny | Exportovat

Rozsiteni Nastroje =
- [ PDF ﬂ e Vytisknout primo (EPSONM LB0O) | [# Elektronicke podpisy & Soubor
[(XEPUB | Tisk [ Nahled tisku |Vlastnosti [ Podepsat existujici POF | @ Napovéda ~

Obrazek 308: UZivatelské rozhrani Karty - karta Soubor

K Soubor ¥

Nowvy »
Posledni dokumenty »
Zavrit

UloZit Ctrl+S
UloZit jako... Ctrl+Shift+S

Ulozit vzdaleny soubor...

Exportovat...
Exportovat do PDE...
Exportovat jako EPUB..

M WD BTN 23

QOdeslat dokument e-mailem...
E-mailem jako PDF...
Poslat pres Bluetooth...

Vytisknout pfimo (EPSON L800)
MNastaveni tiskarny...

s

[# Elektronické podpisy...
[1 Podepsat existujici PDF...
Vlastnosti...

@ Ukonéit LibreOffice Ctrl+Q
Obrazek 309: Nabidka Soubor
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podpisy ) Soubor ¥

istujici PDF ©| Napovéda «
1 @ Napovéda LibreOffice F1
[3: Cojeto?

UzZivatelske piirucky
& Poradit se online
=]

Odeslat zpétnou vazbu

Restartovat v nouzovém rezZimu...
Zapojte se

[*] Podpofit LibreOffice financné

Informace o licenci

[J 0 aplikaci LibreOffice

Obréazek 310: Nabidka Napovéda

Karta Dom(

Karta Domi (obrazek 311) je pevna karta poskytujici ptrikazy pro vyjmuti, kopirovani, viozeni

a formatovani textu, vkladani b&znych polozek (napfiklad obrazkd, tabulek, grafd), pouziti,
aktualizaci a Gpravu styl kresby atd. Nabidka Domu (obrazek 312) na pravém konci pasu karet
poskytuje dalsi pfikazy, které nejsou na karté.

Soubor Uprawy Zobrazit Vieiit Format Stranka Tvar Nastroje Okno Napovéda

ME H " y Soubor Domi Vlozit Rozvrzeni Revize Zobrazit
F. Y - i F-
0 Wyjmout %9 dara ————— ~000cm S ad - =] SR A
VioZit Kopirovat |Styly Oblast Barva |~ | rf HEEEEEEE - Textové pole Svislytext (3 O i3
Rozsireni Nastroje =
> . : ; .
—.=2+-L- -0~ [ BEL # E & | EEobrazek Zarovndni objektd ~| Domd ¥
Vi~ «C)« wbrat Ed La £4 Ed f3 | @ o, @~ v i - & 0
Obréazek 311: UZivatelské rozhrani Karty - karta Dom(
Domd
B vybrat vie Ctrl+A
2 Najit... Ctrl+F
S Najit a nahradit... Ctrl+H
Prejit na naposledy upraveny snimek

Obrazek 312: Nabidka Dom(
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Karta VlozZit

Karta Vlozit (obrazek 313) je pevna karta, ktera poskytuje pfikazy pro vloZzeni mnoha bézné
pouzivanych poloZek. Nabidka na karté VloZzit (obrazek 314) na pravém konci pasu karet
poskytuje nékteré stejné pfikazy.

Soubor Uprawy Zobrazit Vloit Formdt Stranka  Twar  Mastroje  Okno  Napowéda
BER-C~ Soubor Dol Vlo#it Rozvrieni Revize Zobrazit
| T Duplikovat stranku B o Graf B Galerie 5]
Movd stranka Sy Viofit strdnku ze souboru | Tabulka & Objekt OLE | Obrdzek [EFotoalbum | Multimédia
Rozéifeni Mastraje =
- o \ : [
=, O Plovoudi rémec '_5' b Bubling | = ) T vzarec VieZit «
Hypertextowy odkaz [F] Voditko Viofit pismomalbu  Viofitvrstvu | Pole Symbol GDEmod?i ~ | B4 S M -

Obréazek 313: UZivatelské rozhrani Karty — karta ViIoZit

Karta RozvrZeni

A& B B O

B 1= H[E

i
u

[#
H

Viozit ¥

Fotoalbum

Galerie
Vybrat zdroj...
Zvuk nebo video...

QObjekt OLE...
VloZit stranku ze souboru...
Vzorec..

Textové pole F2
Swisly text

Pismomalba...

Plovouci ramec...

Hypertextovy odkaz... Ctrl+K
VioZit voditko...

Cislo strénky
Pocet stranek
Zahlavi a zapati...

Obréazek 314: Nabidka karty VioZit

Karta RozvrZeni (obrdzek 315) je pevna karta, ktera poskytuje pfikazy pro vytvoreni rozvrzeni
stranky kresby. Nabidka karty Rozvrzeni (obrazek 316) poskytuje dalSi pfikazy pro vytvoreni

rozvrzeni stranky kresby.
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Soubar  Upravy Zobrazit VicEit Formit  Strénka  Twar  Nistroje Okno  Niépovéda

BEED-C - Soubor pomi WioFit RozviZeni Revize Zobrazit Rozsifeni Mistroje
= 0 I Mastavit chrizek pozadi | 21 Duplikeval sirdnku &l =] Sk snimigk 1
Formdt strdnky Zdhlawla zdpatl | Ulafit obrdzek pozadi Movd strénka 5 Smazat stednku Piejmenoval strinku [ Zobrazil saimek
} Plasunoud strénku nahory @' = Pozadi plediahy E Zarovnind objekid - Rozwigni +
= Piiesumout stidnku doll Zménit pleadlchu snimbkua Elﬂ'hjeldy pledlohy | | Qtadit [ Uspofddat - 5% Formdt strdnky

Obréazek 315: UZivatelské rozhrani Karty — karta RozvrZzeni

Rozvrieni *

Nowy snimek Ctrl+N

[ [

Duplikovat snimek

Rozvrieni snimku
Vlastnosti snimku...
MNastavit obrazek pozadi...

Zmeénit predlohu snimku...
Pozadi predlohy

Objekty predlohy

Skryt snimek
Prejmenovat snimek

o NN A&

VloZit snimek ze souboru...

Obrazek 316: Nabidka karty
RozvrZeni

Karta Revize

Karta Revize (obrazek 317) je pevna karta poskytujici pfikazy pro kontrolu pravopisu textu,
vkladani a mazani komentarl k revizim a redakéni Upravy. Nabidka karty Revize (obrazek 318)
poskytuje dalsi pfikazy pro Upravu textu. Nékteré z téchto prikazl se zobrazi pouze v pfipadé, ze
je v nabidce Nastroje > MozZnosti > Nastaveni jazyka > Jazyky vybrana moznost Asijské
rozvrZzeni nebo Komplexni rozvrZeni textu.

Soubor Upravy Zobrazit Vieifit Forméat Strdnka Tvar Nastroje Okno  Napovéda
BE B . y Soubor Domi Vlozit Rozvrzeni Revize Zobrazit
[—
EEE, b Automaticka kontrola pravopisu I:‘ Jalsi komentar
Kontrola pravopisu  Slovnik synonyr ah D&leni slov Komentar Predchozi komentar
Rozéiteni Nastroje =
> =
Sy D ! 24 [2 Revize -

Zechny komentafe | Zobrazit komentdfe | Redakéné upravit = Refim Gprav | [ Komentaf

Obrazek 317: UZivatelské rozhrani Karty — karta Revize
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Revize

ab. Kontrola pravopisu... F7
ab  Automatickd kontrola pravopisu Shift+F7

Pro cely text »
b Déleni slov

Prevod dinstiny...

Prevod hangul/handZa... Ctrl+Shift+F7

Dal3i slovniky online...

Obrazek 318: Nabidka karty Revize

Karta Zobrazit

Karta Zobrazit (obrazek 319) je pevna karta poskytujici pfikazy pro zobrazeni kresby na
obrazovce. Nabidka karty Zobrazit (obrazek 320) poskytuje dalSi prikazy tykajici se zobrazeni
kresby na obrazovce.

Soubor Upravy Zobrazit VioZit Format Stranka Tvar Nastroje Okno  Népovéda
M= RWS-C+  Soubor Domdl Viozit Rozvrzeni Revize Zobrazit  Rozsi
W @, =, Pledchozi priblifeni 2 Nasledujici priblizeni = Q,Pravﬂka-h
Mormdlni Fiedloha | PribliZeni a posun £ Celd stranka [ Sifkea stranky Postranni lista X Miizka
eni Mastroje =
»> A Hiavni nabidka r HEEBEE [d AV odstinech sedi == Zobrazit *
Panel stranek Zachytné body B 5 3 Barva [ Cemobile Mové okno | O Pfiblizend

Obréazek 319: UZivatelské rozhrani Karty — karta Zobrazit
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Zobrazit *
¥

MNormalni
Predloha

Hlavni nabidka
Postranni lista Ctrl+F5
Stavovy fadek

IR =O

Panel snimku
Lista karet se zobrazenimi
Pravitka Ctrl+5Shift+R

Zobrazovat mfiZzku
Prichytit k mfizce

A Iy Y

Zobrazit voditka
Prichytit k voditkim

Barva
V odstinech sedi

BIBT 5 [

50%
75%
T, 100%
150%
200%

(X Pfedchozi piiblizeni

Obréazek 320: Nabidka karty
Zobrazit

v rv

Karta Rozsireni
Karta RozSifeni (obrazek 321) je pevna karta obsahujici pouze pfikaz pro pfistup ke Spravci

~ v ~ v

rozSifeni, ktery umoZiuje instalaci rozSifeni kompatibilnich pro pouZiti v LibreOffice.

Rozgifeni Nastroje =

Roziifeni ¥

54 Spravce rozéiteni.. Ctrl+Alt+E

Obréazek 321: UZivatelské rozhrani Karty

— karta Rozsireni

Karta Nastroje
Karta Nastroje (obrazek 322) je pevna karta poskytujici nékolik nastrojd pro makra, nahrazeni

barev, prehrava¢ médii a vytvareni formulari. Nabidka karty Nastroje (obrazek 323) poskytuje
nékteré stejné pfikazy, a navic dalSi nastroje pro organizaci maker a dialogovych oken, mapu

obrazk(, zdroje dat, nastaveni filtr(i, spravce rozsifeni a mozZnosti.
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Soubor  Uprawy Zobrazit  Vio#it Formét Strinka Tvar  Méstroje Okno  Mipow

BleEHEH- > Soubor Domi Viogit Rozwieni Revize
_ -
Ll L} Upravit makra @ I b
Spustit makro 2 Basic Méhrada barev Pehrivad médii | Plepnout redinn ndwrhiu
ida

Zobrazit Rozéiteni Mistrope =

# Privodci oviddacimi prvky formuldfe | <3 BT[] | $0 ™ e | O B [ | B2 B ®5| Mastroje ~
| Seskupeni OER I EFHRCIEHE|EE T SMoinost

Obréazek 322: UZivatelské rozhrani Karty — karta Nastroje

Mastroje *

L? Spustit makro...

L} Upravit makra...

=7 Spravce dialogowych oken...

I'5 Spravce maker ’

[ Obrazkova mapa

¢ Nahrada barev

B2 Prehravac médii

=2 Zdroje dat Ctrl+Shift+F4

[24 Nastaveni XML filtrd...

55 Spravce roziiteni.. Ctrl+Alt+E

€2 MozZnosti... Alt+F12
Obrazek 323: Nabidka karty
Nastroje

DalSi karty

DalSi karty se zobrazi po vybéru objektu v aplikaci Draw, a jsou zobrazeny mezi kartami Pohled
a RozsSifeni. Na obrazcich jsou zobrazeny levy a pravy konec karet zvlast, aby byly dostate¢né
velké a prikazy byly lépe vidét.

Karta Kresba

Karta Kresba (obrazek 324) je k dispozici pouze tehdy, kdyZ je ve vykresu vybran objekt kreshby.
Poskytuje prikazy pro Upravy, transformaci, seskupovani, zarovnavani a distribuci objektd kresby.
Nabidka karty Kresba (obrazek 325) poskytuje podobnou sadu pfikazl pro Gpravy, transformaci
a konverzi objektl kresby.
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Cl=H . . Soubor Domd WViodit Rozwrieni Revize Zobrazit Kresig Rozdveni Mast
0 —_— = — ] - — .
<H [ITansformace - | Cira — -[00Bem  FiZ .| gy F & F | L (5 Prenestbiiz e :
Mizev 3 = & T 5 | Oblast |Barva _\_:| rl[ It piovas OO B0 o0 | & (5 Odsunout ddl | Upravit body -
oje = |
h- - "
' i fit = Upramit siupiru | B Plepnout plastidnost Il B-- B2 | Entha v
Zéchytné body Seskupit 1 Opustit skupinu - -0 -l - Viodit pismomalbu = £ » | M & L

Obréazek 324: UZivatelské rozhrani Karty — karta Kresba

Kresba

Body F8
Otodit

Swisle

Vodorovné

(= A

Transformace »

5

Rozpojit

)

Duplikovat... Shift+F3
MNa kfivku

Na mnohouhelnik

M 0

Ma obrys

94 Na 3D objekt

48 Na 3D rotaéni objekt
MNa rastr
MNa metasoubor

MNazev...

iL] &

L1 Popis..

Obrazek 325: Nabidka
karty Kresba

Karta Obrazek

Karta Obrazek (obrazek 326) je k dispozici pouze tehdy, kdyZ je ve vykresu vybran obrazek,
napriklad fotografie, dilo pisma, objekt OLE nebo kéd QR. Poskytuje pfikazy pro praci s témito
obrazky, veetné popiskd, ofezavani, styld a barev okrajll a oblasti, kotev, obtékani, umistovani
a filtry. Nabidka karty Obrazek (obrazek 327) obsahuje odkazy na dialogova okna pro praci

s obrazky.
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MEmR9~ -  Soubor Domii Vlozit Rozvrieni Revize
- =
<@ & xotizmom | Cara (000em Sl 2 S
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Nizev [J & A @ B | Oblast Zadnj |~|| O | prewsst 00 B8
Zobrazit Obrazek Rozsireni Mastroje =
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Obréazek 326: UZivatelské rozhrani Karty — karta Obrazek
Obrazek «
= Ofiznout
Upravit externim nastrojem
Nahradit...
B Komprimovat..
UloZit...
[ Obrazkova mapa
<{# Nazev..
] Popis..
Obrazek 327: Nabidka karty
Obrazek
Soubor Upravy Zobrazit Vlofit Forméat Strdnka Tvar Nastroje Okno N
FE RS- g Soubor Domu Moiit RozwrZeni Reviz
| = =
<F [3Transformace ~ Cara =000cm [Tk vt .5:'
-
povéda
e Zobrazit Objekt Rozsireni MNastroje =
> )
= @ = | O D pfenést bliz ' Objekt
of 88 ol | & 5 Odsunout dél il & 5

Obréazek 328: UZivatelské rozhrani Karty — karta Objekt

Karta Objekt

Karta Objekt (obrazek 328) je k dispozici pouze tehdy, kdyZ je vybran objekt, napfiklad graf.
Poskytuje pfikazy pro umisténi, zménu velikosti, vybér barev a ohrani¢eni vybraného objektu.
Nabidka karty Objekt (obrazek 329) poskytuje dalSi pfikazy odpovidajici typu vybraného objektu.
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Nazev...
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Popis...

Obrazek 329:
Nabidka karty Objekt

Karta Tabulka

Karta Tabulka (obradzek 330) je k dispozici pouze tehdy, kdyZ je v kresbé vybrana tabulka.
Poskytuje nastroje pro formatovani tabulky podle poZadavkl. Nabidka karty Tabulka (obrazek
331) obsahuje dalsi pfikazy pro Upravu tabulky.

Soubor Uprawy Zobrazit Vieiit Forméat Stranka Tvar Nastroje Okno Napovéda
7 - Soubor Domi Vlozit Rozvrzeni Rewize
e — -
G e BR BE Cam H-=~ Ll Barva ohramiceni = E] @
Nazev ER B EE | Oblast Bava | +| n ] Sloutit bufiky Rozdélit buiiky |
Zobrazit Text Tabulka Rozsifeni MNastroje =
|
ﬂ B vybrat sloupec B L[N g‘ Tabulka

-

Viybrat tabulku FH Vybrat fadek Optimalizovat

i A
il =

L

=  Navrh tabulky | B3 Viastnosti tabulky
Obrazek 330: UzZivatelské rozhrani Karty — karta Tabulka

Tabulka
VioZit radky
VioZit sloupce
Optimalni vyika radku
Rovnomémeé rozmistit radky

H @

E
[n§ 4’_]3

Optimalni Sitka sloupce

Pl 2=

J  Seradit...
Obrazek 331: Nabidka karty Tabulka

Karta Média

Karta Média (obrazek 332) je k dispozici pouze tehdy, kdyz je v kresbé vybran objekt média.
Poskytuje pfikazy pro umisténi a spusténi zvukového nebo video souboru. Nabidka karty Média
(obrazek 333) obsahuje dalSi pfikazy pro Upravu objektu média.
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Obrazek 332: UZivatelské rozhrani Karty — karta Multimédia

Média ¥

i

Prehravac médif

Nazev...

L] &

Obrazek 333: Nabidka
karty Multimédia

Popis...

UZivatelské rozhrani Kompaktni karty

Uzivatelské rozhrani Kompaktni karty ma stejné karty jako uzivatelské rozhrani Karty, ale
pfikazy na kazdé karté jsou usporadany jako jedna fada nastroji. N&které z téchto nastroji maji
rozeviraci nabidky s dalSimi moznostmi. Obrazek 334 ukazuje pfiklad karty Soubor

v uzivatelském rozhrani Kompaktni karty.

Nabidka karet na pravé strané uzivatelského rozhrani Kompaktni karty poskytuje stejné
moznosti jako nabidky karet v uZivatelském rozhrani Karty, dalSi informace nalezneme v Casti
,UzZivatelské rozhrani s kartami“ na strané 333.

7 BH“ -~ Soubor Domd VioZit Rozvrieni Revize Zobra

[ Nowy « [ Sablony Oteviit = 7 Oteviit vedaleny | FHUlozit « B2 Ulozit jako.. | [ Exportovat

1Zit Rozsireni Mastroje

[UPDF FlE-mail | &P Tisk @'l.l'ytislmuut piimo (EPSON L800) | [2] Vlastnosti | [2 Soubor *

Obrazek 334: UZivatelské rozhrani s kartou Kompaktni karty — karta Soubor

UZivatelské rozhrani Kompaktni skupiny

Uzivatelské rozhrani Kompaktni skupiny je rozdéleno do skupin, které obsahuiji pfikazy
usporadané jako sady nastrojli a nabidek. Dostupné nastroje a nabidky se méni podle typu
vybraného objektu. Obrazek 335 ukazuje priklad uZivatelského rozhrani Kompaktni skupiny pfi
vybéru objektu kresby.

Kliknutim na dvoijitou Sipku >> zobrazime dalSi nastroje pro Upravu objektu. Obrazek 336 ukazuje
priklad téchto nastrojl, kdyZ je vybran objekt kresby.

Nabidka Kompaktni skupiny (obrazek 337) na pravém konci tohoto rozhrani poskytuje dalSi
pfikazy pro praci s LibreOffice Draw, véetné pohodinych zplisobl zmény uZivatelského rozhrani
a pfistupu k nastrojovym listam.
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Obrazek 335: Priklad uZivatelského rozhrani Kompaktni skupiny s vybranym objektem draw
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Obréazek 336: Priklad dalsich nastroji s vybranym objektem kresby

Mabidka

Hlavni nabidka

[ Postranni lista Ctrl+F5

[ UZivatelské rozhrani »

MNastrojové listy »

£2  MoZnosti... Alt+F12

54 Spravce rozsiteni.. Ctrl+Alt+E

L3 Spustit makro...

o Spravce maker »

@) Napovéda LibreOffice F1

(3 0O aplikaci LibreOffice

Obrézek 337: Nabidka
Kompaktni skupiny

Uzivatelské rozhrani Kontextova lista

UzZivatelské rozhrani Kontextova lista zobrazuje jeden panel nastroji odpovidajici typu
vybraného objektu. Obrdzek 338 ukazuje pfiklad uzivatelského rozhrani Kontextova lista pfi
vybéru objektu kresby.

Kliknutim na dvoijitou Sipku >> zobrazime dalSi nastroje pro Upravu objektu. Obrazek 339 ukazuje
priklad téchto nastrojll, kdyZ je vybran objekt kresby.

Soubor Upravy Zobrazit Vlo#it Format Strénka Tvar Néstroje Okno  Népovéda

S -5 - |IF @\|Oblast¢-‘ﬂ -0 G L ——— <[00 Bl B @A i
Obrazek 338: Priklad uZivatelského rozhrani Kontextova lista s vybranym objektem kresby

s-&830elo | -0 &P o Vychozi styl kresby R il il -
Obrazek 339: Priklad dalsich nastrojii s vybranym objektem kresby

UZivatelské rozhrani Jedina nastrojova liSta a Postranni liSta

Pokud je vybrana moznost Jedina nastrojova liSta a Postranni liSta, zobrazi se pouze hlavni
nabidky bez nastrojovych list. Nastrojové listy vSak Ize pfidat do kteréhokoli z téchto
uzivatelskych rozhrani tak, Ze na v hlavni nabidce zvolime Zobrazeni > Nastrojové listy

a z dostupnych moZznosti vybereme poZadovanou nastrojovou liStu. Dalsi informace

o0 néastrojovych listach nalezneme v Dodatku B, Nastrojové liSty v této pfiruce a v prficce
Zaciname s LibreOffice.
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Y LibreOffice §1.%8

Dodatek A,
Klavesove zkratky



Uvod

LibreOffice je mozné pouzivat i bez pouziti polohovacich zafizeni, jako je myS nebo trackball,
pomoci klavesovych zkratek. Pomoci téchto klavesovych zkratek Ize provadét tak rozmanité

a slozité ulohy, jak je dokovani a odkryvani nastrojovych list a oken nebo zména velikosti Ci
polohy objektd. Prestoze LibreOffice obsahuje rozsahlou sadu klavesovych zkratek, kazdy modul
LibreOffice méa klavesové zkratky, které jsou pro dany modul specifické.

Vice informaci o klavesovych zkratkach LibreOffice nebo o pouziti LibreOffice pouze pomoci
klavesnice najdeme v ndpovédeé LibreOffice pomoci kliCovych slov "klavesova zkratka" nebo
"zpfistupnéni".

Kromeé pouziti klavesovych zkratek, které jsou uvedeny v této pfiloze, Ize definovat dalSi
klavesové zkratky. Standardnim funkcim nebo makriim aplikace Draw mlizeme pfifadit zkratky
a ulozit je pro pouziti pouze v aplikaci Draw nebo v ostatnich modulech LibreOffice. Vice
informaci o pfizplsobeni klavesovych zkratek nalezneme v pfiruce Zac¢iname s LibreOffice.

Poznamka

Neékteré klavesové zkratky nejsou pro pocitaCe se systémem macOS k dispozici
a v nasledujicich tabulk&ch jsou oznaceny prazdnou burikou.

Funkéni klavesy a klavesové zkratky aplikace Draw

Funkénich klavesy aplikace Draw

"'('"d°""s macOS Akce
Linux
F1 F1 Otevre napovédu LibreOffice Draw.
PFepne do rezimu Uprav textu a otevie nastrojovou
F2 F2 o AT
liStu Forméatovani textu.
F3 F3 Umozni editovat objekty ve skupiné objektd.
Shift + F3 Shift + F3 Otevira dialogové okno Duplikovat vybraného objektu.
Ctrl + F3 ¥ +F3 Opusténi skupiny objektd.
Otevira dialogové okno Umisténi a velikost vybraného
F4 F4 i
objektu.
F5 F5 Otevira Navigator.
F6 F6 Posunuti ddirazu dopfedu v ramci prvk({ na obrazovce.
Shift + F6 Shift + F6 Posunuti ddrazu vzad v rdmci prvki na obrazovce.
Spusti kontrolu pravopisu. K dispozici pouze v reZzimu
F7 F7 -
uprav textu.
Shift + E7 Shift + E7 Zaplna n_epo vypina alj_toma,tlckou kontrolu pravopisu.
K dispozici pouze v reZimu Uprav textu.
Ctrl + E7 8 + F7 Ote.vre d!a_logove oknq _Tezayrus pro pouzivany jazyk.
K dispozici pouze v reZzimu Uprav textu.
F8 F8 Otevfe nastrojovou liStu Upravit body.
Ctrl + Shift + F8 ¥ + Shift + F8 Prizplsobi text rimecku vybraného objektu.
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Windows

. macOS Akce
Linux
Shift + F10 Shift + F10 Otevfe mistni nabidku vybraného objektu.
F11 #+T Otevfe kartu Styly v postranni liSté.

Klavesové zkratky aplikace Draw

M{mdows macOS Akce

Linux

Plus (+) Priblizeni.

Minus (-) Oddaleni.

Znak nasobeni v o . . .
(x) na numerické Prlzpusqbllzoﬁrazem kreshy tak, aby vyplnila celou
Klavesnici pracovni plochu.

Znak déleni (+)

na numerické Priblizeni vybraného objektu.

klavesnici

Ctrl + Shift + G 3 + Shift + G Seskupi vybrané objekty.

Shift + Ctrl + Alt % + Shift Zrusi seskupeni vybrané skupin

+G + Option + G pent vy piny.

Ctrl + klepnuti

¥ + klepnuti

Vstoupi do skupiny a umoZzni Upravu jednotlivych
objektl ve skupiné. Klepnutim mimo skupinu se
vratime do normalniho pohledu.

Ctrl + Shift + K ¥ + Shift + K Zkombinuje vybrané objekty.

Ctrl + Shift + Alt ¥ + Shift Oddeli vybrany objekt ze skupiny, ktera vznikla

+ K + Option + K spojenim dvou a vice objekt(.

Ctrl + + 3} ++ Pfenese aktualni vybér dopfedu.

Ctrl +Shift + + 3 + Shift + + Pfenese aktualni vybér do popredi.

Ctrl + - ¥ + - Odsune aktualni vybér dal.

Ctrl + Shift + - 3 + Shift + - Odsune aktualni vybér dozadu.

Page Up f’repne na prgdch02| stranku. Na prvni strAnce nema
Zadnou funkci.

p PFfepne na dalSi strdnku. Na posledni strAnce nema

age Down <4 .

Zadnou funkci.

Ctrl + Page Up PFfepne na pfedchozi vrstvu.

Ctrl + Page Pfepne na dalSi vrstvu.

Down

Sipka Sipka Posune vybrany objekt ve sméru Sipky.

Ctri+Sipka Ctrli+Sipka PFfesune zobrazeni stranky ve sméru Sipky.

Sipka doleva Sipka doleva Pfi vybraném Panelu stranek prfepne na pfedchozi

stranku kresby. Na prvni strance nema zadnou funkci.
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Windows
Linux

macOS

Akce

Sipka doprava

Sipka doprava

PFi vybraném Panelu stranek pfepne na dalSi stranku
kresby. Na posledni strAnce nemé& zadnou funkci.

Shift

Shift

PTi vybéru objektd pridava objekt do vybéru objektd
nebo odebira objekt vybéru objektd.

Shift

Shift

PFi zméné velikosti objektu podrzime klavesu Shift
a poté klepneme a pfetahneme Uchyt vybéru, abychom
zachovali proporce objektu.

Shift

Shift

Podrzenim klavesy Shift pfi pohybu vybranym
objektem omezime pohyb na nasobky 45 stupiid.

Shift

Shift

Pred vybérem nékolika sousednich objektd nebo
znak{ podrzime klavesu Shift. Klepneme na zacatek
vybéru a pfesuneme se na jeho konec.

Ctrl

Podrzime klavesu Ctrl (36), poté klepneme

a pfetaZzenim vytvofime kopii vybraného objektu.
VSimneme si, Ze tato klavesova zkratka funguje pouze
v pfipadé, Ze je povolena moznost Kopirovat pfri
pfesunu v LibreOffice > MoZnosti > LibreOffice
Draw > Obecné (tato mozZnost je ve vychozim
nastaveni povolena).

Alt

MozZnost

Podrzime klavesu Alt (Option) a nakreslime nebo
zmeénime velikost objektu ze stfedu objektu.

Alt

MoZnost

P¥i vybéru objektu, ktery je za aktualné vybranym
objektem, podrzime stisknutou klavesu Alt (Option).

Alt+ Shift

Option + Shift

P¥i vybéru objektu, ktery je pfed aktualné vybranym
objektem, podrzime stisknuté klavesy Alt (Option) +
Shift.

Tabulator

Tabulator

Vybira objekty v poradi, v jakém byly vytvoreny.

Shift + Tab

Shift + Tab

Vybira objekty v obraceném poradi, nez ve kterém byly
vytvoreny.

Esc

Esc

Ukon¢i aktualni rezim.

Enter

Enter

Pfejde do textového rezimu, pokud je v kreshé vybran
textovy objekt.

Ctrl + Enter

8 + Enter

Vlozi novou stranku za vybranou stranku v kresbé.

Home/End

Vybereme prvni/posledni stranku v kresbé.

Klavesové zkratky pro tpravu textu

Windows

Linux macOS Akce

Cirl + - 8 4 - Vlozi do textu na pozici kurzoru vlastni rozdéleni textu
(volitelné rozdéleni).

Ctrl + Shift + - 38 + Shift + - Vlozit do textu na pozici kurzoru nezlomitelny

spojovnik.
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Windows

. macOS Akce
Linux
Ctrl + Shift + 38 + Shift + Vlozi nezlomitelnou mezeru, ktera se nepouziva jako
mezernik mezernik spojovnik a neni rozSifena, pokud je text zarovnan.
Shift + Enter Shift + Enter Vlozi zalomeni fadku bez zmény odstavce.

Sipka doleva

Sipka doleva

Pfesune kurzor o jeden znak doleva.

Shift + Sipka Shift + Sipka Pfesune kurzor o jeden znak doleva a znak vybere.
doleva doleva

Clri + Sipka Option + Sipka Pfesune kurzor na zaCatek predchoziho slova.
doleva doleva

Ctrl + Shift + Option + Shift +

Sipka doleva

Sipka doleva

Presune kurzor doleva a vybere slovo vlevo.

Sipka doprava Sipka doprava Pfesune kurzor o jeden znak doprava.

ghlft + Sipka Shift + Sipka Pfesune kurzor o jeden znak doprava a znak vybere.
oprava doprava

Ctrl + Sipka Option + Sipka Pfesune kurzor na zacatek dalSiho slova.

doprava doprava

Ctrl + Shift + Option + Shift +

Sipka doprava

Sipka doprava

Pfesunout kurzor doprava a vybere slovo vpravo.

Sipka nahoru

Sipka nahoru

PFresune kurzor o jeden fadek nahoru.

Shift + Sipka Shift + Sipka PFesune kurzor o jeden fadek v textu nahoru a vybere
nahoru nahoru fadky.

Ctrl + Sipka Option + Sipka Pfesune kurzor na zaCatek odstavce.

nahoru nahoru

Ctrl + Shift + Option + Shift + Pfesune kurzor na zaCétek odstavce. Vybere text
Sipka nahoru Sipka nahoru v odstavci od pozice kurzoru po zacatek odstavce.
Sipka dolti Sipka dolti PFesune kurzor o jeden fadek dold.

Shift + Sipka doli Shift + Sipka doli Presune kurzor o jeden fadek v textu dolu a vybere

fadky textu.

Ctrl + Sipka doldi

38 + Sipka dolti

Pfesune kurzor na konec odstavce.

Ctrl + Shift + Opt + Shift + Pfesune kurzor na konec odstavce. Vybere text
Sipka doldi Sipka dold v odstavci od pozice kurzoru po konec odstavce.
Home Pfesune kurzor na zaCatek fadku.

Shift + Home

Pfesune kurzor na zaCatek fadku a vybere text od
pozice kurzoru po zacatek fadku.

Ctrl + Home PFesune kurzor na zaCatek textového bloku na snimku.
End PFfesune kurzor na konec fadku.

Shift + End Ecr)iiscueniukr;gzrarpnoakltjonneeccfzjdkkue B wberetext od

Ctrl + End PFesune kurzor na konec textového bloku na snimku.
Ctrl + Del Odstrani text od pozice kurzoru po konec slova.
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Windows

A macOS
Linux

Akce

Ctrl + Shift + Del

Odstrani text od pozice kurzoru po konec véty.

Ctrl + Backspace ¥ + Backspace

Odstrani text od pozice kurzoru po zacatek slova.

3 + Shift +
Backspace

Ctrl + Shift +
Backspace

Odstrani text od pozice kurzoru po zaCatek veéty.

Funkéni klavesy a klavesové zkratky nabidky

Funke¢ni klavesy a klavesové zkratky uvedené v nasledujicich tabulkach jsou k dispozici
v kategoriich nabidek v hlavni nabidce. Tabulky uvadéji poloZku nebo podpoloZku, operacni
systém a Ucinek nebo Ucel klavesové zkratky.

Poznamka

Nabidky uvedené nize jsou ve stejném poradi, v jakém jsou zobrazeny v hlavni

nabidce zleva doprava.

Nabidka Soubor

PolozZka nebo Windows

podpolozka Linux macOS Akce

nabidky
Otevre dialogové okno Otevfit

Otevrit Ctrl + O ¥+0 umoznujici navigaci do slozky a vybér
souboru.

Ulozit Ctrl+S ¥ +S UloZi otevienou kresbu.
Otevfe dialogové okno UloZit jako,

UlozZit jako Ctrl + Shift + S 3 + Shift + S které umozni pfejit do slozky a ulozit
otevienou kresbu jako novy soubor.

Tisk Crl + P 5+ p Otevie dl::llogov_e okno Tisk umoZznujici
vybrat zpusob tisku kresby.

Nabidka Upravit
PoloZka nebo .
podpolozka lli|{mdows macOS Akce
A inux

nabidky

Zpét Ctrl+Z ¥ +Z Vréti pfedchozi akci Gprav.

Znovu Ctrl+ Y € 4y Qpnow akci rvlaposledy vracenou
pfikazem Zpét.

Vyjmout Cirl + X 8 + X Smage vybrany objekt a umisti jej do
schranky.

Kopirovat Ctrl + C ¥ +C Zkopiruje vybrany objekt do schranky.

Vlozit Ctrl+V ¥} +V Umisti objekt ve schrance do kresby.
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PoloZka nebo

podpolozka r{mdows macOS Akce
; inux
nabidky
Vioit iinak > Vlozi obsah schranky na pozici kurzoru
" Ctrl + Shift + vV 3 + Shift + vV ve forméatu zadaném pomoci
Vlozit jinak ) . v
dialogového okna VloZit jinak.
Vybrat vSe Ctrl+ A ¥} +A Vybere vSechny objekty v kresbé.
Otevfe nastrojovou liStu Upravit body,
Body F8 F8 pokud je v kresbé objekt, ktery pouziva
upravitelné body, napfiklad volna Cara.
Nabidka Zobrazit
PoloZka nebo Windows
podpolozka Linux macOS Akce
nabidky
Pravitka Ctrl + Shift + R | % + Shift + R :)’I%pé'ga a zapina pravitka na Pracovni
Postranni lista Ctrl + F5 Otevfe nebo zavfe postranni listu.
Styly F11 4T Otevre ngps) zavre kartu Styly na
postranni listé.
Navigator F5 F5 Otevira Navigator.
Nabidka Vlozit
Polozka nebo Windows
podpolozka Li macOS Akce
5 inux
nabidky
Textové pole E2 E2 Pfepnt_—:‘ do rezimu Uprav textu a otevre
nastrojovou liStu Formatovani textu.
Karta o ) .
Hypertextovy Ctrl + K 8 + K Otevre dialogové okno Hypertextovy
odkaz.
odkaz
KomentaF Cirl + Alt + C 3 + Option + Vlozi na vyt}rvanou stranku nové pole
C pro komentar.
Forméatovaci
znacCka > Vlozit | Ctrl + Shift + 3 + Shift + VloZi nezlomitelnou mezeru na pozici
nezlomitelnou mezernik mezernik kurzoru.
mezeru
Formatovaci
Egigﬁa > Viozit Alt + Shift + Alt + Shift + Vlozi na pozici kurzoru Uzkou
mezernik mezernik nezlomitelnou mezeru.

nezlomitelnou
mezeru
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PoloZka nebo

podpolozka lli|l(:1nuc)l(ows macOS Akce
nabidky
Formatovaci
znackg > Vlozi na pozici kurzoru nulovou
Nulova Ctrl +/ ¥ +/ :
zlomitelnou mezeru.
mezera,
zlomitelna
Nabidka Format
PoloZka nebo Windows
podpolozka Linux macOS Akce
nabidky
Text > Tu€né Ctrl +B ¥ +B Aplikuje format Tuéné na vybrany text.
Text > Kurziva Ctrl + 1 ¥ +/ Aplikuje format Kurziva na vybrany text.
Text > Horni Zmensi velikost pisma vybraného textu
index Ctrl + Shift + P 3 + Shift + P a posune text nad zakladni ¢aru (horni
index).
Text > Dolni Zmensi velikost pisma vybraného textu
index Ctrl + Shift + B 3 + Shift + B a posune text pod zakladni ¢aru (dolni
index).
Text> Zvesit | oy 4 g % +] Zv&tsi velikost vybraného textu.
velikost
Text > Zmensit Ctrl + [ ®+/ Zmen§i velikost vybraného textu.
velikost
Rozestupy > Nastavi FAdkovéani v odstavci na
Radkovani 1 Ctrl+ 1 #+1 jednoduché fadkovani.
Radkovani 5 Cirl+ 5 45 gl?)%tlarvéldrsgkovanl v odstavci na jeden
Rozestupy > Ctrl + 2 € 42 Nastavi fadkovani v odstavci na dva
Radkovani 2 fadky.
zarovnani textu Ctrl+L ¥} +L Nastavi zarovnani odstavce doleva.
> Vlevo
Zarovnzjml texty Ctrl+ E ¥} +E Nastavi zarovnani odstavce na stfed.
> Na stfed
Zarovnani textu Ctrl+R #+R Nastavi zarovnani odstavce doprava.
> Vpravo
Zarovnani textu Ctrl+J ¥ +J Nastavi zarovnani odstavce do bloku.
> Do bloku
Vymazat pfimé Cirl + M Cirl + M Odebere pfimé formatovani, které bylo
formatovani pouzito bez styll.
Styly > 11 4T Otevre net_)o zavie kartu Styly na
Spravovat styly postranni listé.
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PoloZka nebo

Windows

podpolozka Linux macOS Akce
nabidky
Umisténi E4 E4 Otevira dialogové okno Umisténi
a velikost a velikost vybraného objektu.
Nabidka Tvar
Polozka nebo Windows
podpolozka Linux macOS Akce
nabidky
Usporadat > . Lo . “
Prenést do Ctrl + Shift ++ | % +Shift++ | "resunevybrany objekt pred vsechny
Y ostatni objekty.
popredi
Usporadat > Crl + + 8 4+ PFesune vybrany objekt pfed objekt,
Pfenést bliz ktery je o Uroven bliz.
Usporadat > i i Odsune vybrany objekt za objekt, ktery
Odsunout dal crl + %+ je o uroven dal.
Usporadat > - “
Odsunoutdo | Ctrl+ Shift+- | 38 + Shift + - Odsune vybrany objekt za vsechny
. ostatni objekty.
pozadi
Seskupit > . ) . -
Seskupit Ctrl + Shift + G ¥ + Shift + G Seskupi vybrané objekty.
Seskupit > Ctrl + Alt + 38+ Option + Zru&{ seskupen( vwhrané skupin
Zruit skupinu | Shift + G Shift + G pentvy piny.
Seskupit > E3 E3 Umozni editovat objekty ve skupiné
Upravit skupinu objektd.
Seskupit > cex : o
Opustit skupinu Ctrl + F3 ¥ +F3 Opusténi skupiny objektu.
KdyZ je objekt vybran, otevie se
Duplikovat Shift + F3 Shift + F3 dialogove okno Duplikovat, kieré nabizi
moznosti duplikovani vybraného
objektu.
Nabidka Nastroje
PoloZka nebo .
podpolozka llill{;nuo)l(ows macOS Akce
nabidky
Kontrola £7 Spusti kontrolu pravopisu. K dispozici
pravopisu pouze v rezimu Uprav textu.
Automaticka Zapina nebo vypina automatickou
kontrola Shift + F7 Shift + F7 kontrolu pravopisu. K dispozici pouze
pravopisu v rezimu Uprav textu.
Slovnik Otevre dialogové okno slovniku
synonym Ctrl + F7 ¥ +F7 synonym pro pouzity jazyk. K dispozici

pouze v rezimu Uprav textu.
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PoloZka nebo

podpolozka lli|l{:1nuc)l(ows macOS Akce
nabidky
Sprg\vlce’ Ctrl + Alt + E 8+ Alf+E Otevae d,lalogove okno Spravce
rozSifeni rozsSifeni.
Mo3nosti Al + F12 O_tevre o_llalogove okno Moznosti
LibreOffice.
Nabidka Okno
PolozZka Uebo Windows
podpolozka Linux macOS Akce
nabidky
Zavre aktivni okno. Pokud je otevieno
Zavrit okno Ctrl+ W ¥ +W pouze jedno okno, zavie se aplikace
Draw.
Nabidka Napovéda
PoloZka nebo .
podpolozka m:’nuciows macOS Akce
nabidky
Napovéda = = Otevre internetovy prohlize€ se
LibreOffice strankami Napovédy LibreOffice.

Obecné funkéni klavesy a klavesové zkratky

Otevirani nabidky a polozek nabidky

Windows
Linux

macOS

Akce

Alt + <?>

Nejprve stiskneme klavesu Alt a poté vybereme podtrzeny
znak nabidky, kterou chceme otevfit. <?> je podtrzeny
znak v nabidce. Napfriklad Alt+S otevie nabidku Soubor.

PFi oteviené nabidce jsou polozky nabidky podtrzené.
Pokud chceme k témto poloZzkdm nabidky pfistupovat
primo, stiskneme klavesu s podtrzenym znakem. Pokud
tentyZz podtrzeny znak ma dvé polozky, stiskneme ho
dvakrét, €imZ se pfesuneme na druhou polozku.

Pokud polozka v nabidce nema podtrzeny znak, musime
na ni klepnout mysi.

Esc

Esc

Zavre se oteviena nabidka.

F6

F6

Opakovanym stisknutim klavesy F6 cyklicky aktivuje

néasledujici objekty:

Hlavni nabidka (pouze operacni systémy Windows a Linux)
KaZda nastrojova lista shora dold a zleva doprava
Kazdé volné okno zleva doprava

Kresba
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M{mdows macOS Akce

Linux

Shift + £6 Shift + £6 Opakoyanym st|skvnu,t|m kli'slvgs Shift+F6 aktivuje cyklicky
tyto objekty v opacném poradi.

Ctrl + F6 Ctrl + F6 Aktivuje zpét kresbu.

F10 Zapne nebo vypne pfistup k hlavni nabidce.

Pristup k pFikaziim hlavni nabidky

Stisknutim klavesy F6 vybereme prvni poloZku v hlavni nabidce (nabidka Soubor).
Stisknutim Sipky doprava vybereme dalSi nabidku vpravo.

Stisknutim Sipky doleva vybereme predchozi nabidku vlevo.

Stisknutim klaves Home a End vybereme prvni nebo posledni poloZzku hlavni nabidky.

Stisknutim Sipky doll otevieme vybranou nabidku. Dal$im stisknutim Sipky dol{ nebo
Sipky nahoru se vybér pfesune mezi prikazy nabidky.

Stisknutim Sipky doprava otevieme vSechny podnabidky vybrané nabidky. Podnabidky
jsou oznaceny trojuhelnikem » vedle polozky nabidky.

Stisknutim Enter se vybrany pfikaz provede.

Pristup k pfikaziim nastrojové listy

Opakované stiskneme klavesu F6, dokud neni vybran prvni nastroj na nastrojoveé listé.

Pomoci Sipek doprava a doleva vybereme nastroj na vodorovné nastrojové listé. Pomoci
Sipek nahoru a dolll vybereme néastroj na svislé nastrojové listé.

Stisknutim klavesy Home vybereme prvni nastroj na nastrojové listé. Stisknutim klavesy
End vybereme posledni nastroj na nastrojoveé listé.

Stisknutim klavesy Enter aktivujeme vybrany nastro;.

Stisknutim Sipky doprava otevieme libovolnou dil¢i nastrojovou listu na vybrané
nastrojové listé. Dilci nastrojova lista je oznacena trojuhelnikem v vedle nastroje.

Dal3im stisknutim Sipky doprava vybereme nastroj na dil¢i nastrojové listé.

Stisknutim Ctrl+Enter vloZime vybrany objekt kresby. Objekt kresby je umistén do stfedu
kresby s pfedem definovanou velikosti.

Ovladani dialogovych oken

Pfi otevieni jakéhokoliv dialogového okna je jeden z prvkd (napfiklad tladitko nebo moznost)
oznacen zvyraznénim, zaSkrtnutim nebo teckovanym rameckem kolem nazvu pole nebo tlacitka.

Windows
. Akce

Linux
Aktivuje vybranou moznost. Pokud neni vybrana Zadna moznost,

Enter AP ] ;
odpovida stisknuti Enter klepnuti na OK.

Esc Zavie dialogové okno bez uloZeni zmén provedenych v dobé, kdy
bylo toto okno oteviené, coz je ekvivalentni volbé Cancel.
Presune zamérfeni v seznamu nahoru a dol(.

Klavesy Sipka nahoru ZvySuje nebo snizuje hodnotu proménné.

a Sipka dolu V ramci ¢asti dialogového okna se zamé&feni presouva ve svislém
sSmeéru.
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Windows
i Akce
Linux
Klavesy se Sipkou doleva V rdmci Casti dialogového okna se zaméfeni pfesouva ve
a doprava vodorovném smeéru.
. Zameéreni se pfesune na nasledujici ¢ast nebo prvek dialogového
Tabulator
okna.
. PFesune zameérfeni v dialogovém okné do pfedchozi sekce nebo na
Shift + Tab . .
predchozi prvek.
Alt + Sipka dol(i Zobrazi moznosti dostupné v rozeviracim seznamu.
. Oznaci nebo vybere prazdné zaskrtavaci policko.
Mezernik o e lx . g o
Odznaci nebo zrusi vybér zaskrtnutého zaskrtavaciho pole.

Funkéni klavesy a klavesové zkratky nastrojové listy

Aplikace Draw nabizi nékolik nastrojovych list pro tvorbu a Upravu kreseb. Nékteré nastroje na
nastrojovych listach aplikace Draw |ze aktivovat pomoci funkéni klavesy nebo klavesové zkratky.

Poznamka

Nastrojové listy aplikace Draw jsou uvedeny ve stejném porfadi jako v mistni
nabidce, kterou otevieme pomoci volby Zobrazit > Nastrojové liSty v hlavni

nabidce.
Kresha
Nazev Windows
ndstroie Linux Akce
J macOS
Vlozit textové E2 PFepne do rezimu Uprav textu a otevfe nastrojovou listu
pole Forméatovani textu.
) Otevre nastrojovou listu Upravit body, pokud je v kresbé
Uprava bod F8 objekt, ktery pouziva upravitelné body, napfiklad volna
cara.
Najit
Néazev Windows
nastroje Linux Race AL
Najit a nahradit ctrl + H 3 + Option + Vyhleda a nabrad| v3echny vyskyty
H textu v kreshé.
Navrh formulare
N:itzev . M{' el macOS Akce
nastroje Linux
Prerjesi[ do Ctrl + Shift + + 38 + Shift + + Presur)e v_ybrany objekt pfed vSechny
popfedi ostatni objekty.
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N:itzev . Al LI macOS Akce

nastroje Linux

Odsunput do Ctrl + Shift + - 38 + Shift + - Odsuqe vybrany objekt za vSechny

pozadi ostatni objekty.

Seskupit Ctrl + Shift + G 3 + Shift + G Seskupi vybrané objekty.

- . Ctrl + Alt + 36+ Option + . . . .

ZrusSit skupinu Shift + G Shift + G ZruSi seskupeni vybrané skupiny.

Upravit skupinu | F3 E3 Umozr;n editovat objekty ve skupiné
objektu.

Zrusit skupinu Ctrl + F3 ¥ +F3 Opusténi skupiny objektd.

Obrazek

N:iizev . M{mdows macOS Akce

nastroje Linux

Umisténi E4 E4 Otevira dialogové okno Umisténi

a velikost a velikost vybraného objektu.

Prerjes:c do Ctrl + Shift + + 38 + Shiff + + Presur)e v_ybrany objekt pfed vSechny

popredi ostatni objekty.

PFenést bliz Ctrl + + ¥+ + Pres,u'ne vybran}/ ol,)lekt pred objekt,
ktery je o uroven bliz.

Odsunout dl Crl + - 8 4. _Odsgne v¥bra}ny objekt za objekt, ktery
je o uroven dal.

Odsunput do Ctrl + Shift + - 38 + Shiff + - Odsuqe vybrany objekt za vSechny

pozadi ostatni objekty.

Cara a Vypli

N:?zev . M{' e macOS Akce

nastroje Linux

Umisténi E4 E4 Otevira dialogové okno Umisténi

a velikost a velikost vybraného objektu.

Prerjes:[ do Ctrl + Shift + + 38 + Shiff + + Presurje \{ybrany objekt pfed vSechny

popredi ostatni objekty.

PFenést bliz Ctrl + + ¥+ + Presiu_ne vybran}/ Ot,)lekt pred objekt,
ktery je o Uroven bliz.

Odsunout dl Crl + - 8 4 - _Odsgne v;ibra,my objekt za objekt, ktery
je o uroven dal.

Odsuqout do Ctrl + Shift + - 38 + Shiff + - Odsuqe vybrany objekt za vSechny

pozadi ostatni objekty.

Styly F11 #*+T Otevre kartu Styly v postranni listé.
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Standardni

Néazev Windows

nastroje Linux (TR ALGE

Novy Ctrl + N ¥k +N Otevfe novou kresbu.

Sablony Ctrl + Shift + N 3 + Shift + N Otevre thalogove okno Sablonyv
a vytvori novou kresbu pomoci Sablony.
Otevre dialogové okno Otevfit a umozni

Otevrit Ctrl + O ¥ +0 navigaci do slozky a vybér kresby pro
otevieni.

Ulozit Ctrl+ S ¥} +S Ulozi otevieny dokument.
Otevre dialogové okno Ulozit jako

UloZit jako Ctrl + Shift + S 3 + Shift+ S a umozni uloZit otevienou kresbu jako
novou kresbu.

ReZim Gprav Ctrl + Shift + M | % + Shift+m | £2pne rezim Uprav, kdyz je kresba
Vv rezimu pouze pro cteni.

Tisk Ctrl + P €+ p Otevre dlaloggve oI_<no Tisk, ve kterém
vybereme zpusob tisku kresby.

Wyjmout Crl + X 8 + X Sma;e vybrany objekt a umisti jej do
schranky.

Kopirovat Ctrl + C ¥ +C Zkopiruje vybrany objekt do schranky.

Vlozit Ctrl +Vv ¥ +V Umisti objekt do schranky dokumentu.

Vymazat Ctrl + M Ctrl + M Odevt?ere pfimeé Eormatovanl, které bylo
pouzito bez stylu.

Zpét Ctrl+Z ¥ +Z Vrati pfedchozi akci Gprav.

Znovu Ctrl + Y 1y OPnow akci rJaposIedy vracenou
pfikazem Zpét.

Kontrola £7 £7 Spusti kontrolu pravopisu. K dispozici

pravopisu pouze v reZzimu Uprav textu.

Automaticka Zapina nebo vypina automatickou

kontrola Shift + F7 Shift + F7 kontrolu pravopisu. K dispozici pouze

pravopisu VvV reZzimu Uprav textu.

Textové pole £2 £2 P[epng do rezimu Gprav textu a otevie
nastrojovou liStu Forméatovani textu.

Viozit o , .

hypertextovy Cirl + K 8 + K Otevre dialogové okno Hypertextovy
odkaz.

odkaz

Umisténi E4 E4 Otevira dialogové okno Umisténi

a velikost a velikost vybraného objektu.

] Otevfe nastrojovou liStu Upravit body;,

Uprava bod F8 F8 pokud je v kresbé objekt, ktery pouziva

upravitelné body, napfiklad volna ¢ara.
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Standardni (reZzim prohlizeni)

Néazev Windows
nastroje Linux B0 LD
Otevre prohlize¢ soubord UloZit jako,
Ulozit jako Ctrl + Shift + S 3 + Shift+ S abychom mohli uloZit otevieny
dokument jako novy dokument.
ReZim Gprav Ctrl + Shift + M | $ + Shift+m | 22Pne rezim Uprav, kdyZ je dokument
Vv rezimu pouze pro cteni.
Otevre dialogové okno Tisk, abychom si
Tisk Ctrl + P #+P mohli vybrat nastaveni tisku
dokumentu.
Kopirovat Ctrl + C ¥ +C Zkopiruje vybrany objekt do schranky.
Najit a nahradit | Ctrl + H 3 + Option + F | Otevie dialogové okno Najit a nahradit.
Formatovani textu
Na'tzev . Win woi macOS Akce
nastroje Linux
Zvetsit Ctrl +] 3 +] Zvétsi velikost vybraného textu.
Zmensit Ctrl + [ ¥ +[ ZmenSi velikost vybraného textu.
Tucné Ctrl+B ¥ +B Aplikuje format Tuéné na vybrany text.
Kurziva Ctrl + 1 3 +1 Aplikuje format Kurziva na vybrany text.
Zmensi velikost pisma vybraného textu
Horni index Ctrl + Shift + P Ctrl + Shift + P a posune text nad zékladni ¢aru (horni
index).
Zmensi velikost pisma vybraného textu
Dolni index Ctrl + Shift + B Ctrl + Shift + B a posune text pod z&kladni ¢aru (dolni
index).
Vymazat Ctrl + M Ctrl + M Odevb'ere pfimé Eormatovanl, které bylo
pouzito bez stylu.
Vlevo Ctrl + L ¥d®+L Nastavi zarovnani odstavce doleva.
Stfed Ctrl+ E ¥ +E Nastavi zarovnani odstavce na stfed.
Vpravo Ctrl+ R ¥} +R Nastavi zarovnani odstavce doprava.
Do bloku Ctrl+J ¥ +J Nastavi zarovnani odstavce do bloku.
Vybrat vSe Ctrl + A ¥ +A Vybere vSechen text v textovém poli.
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Community

Y LibreOffice . §38

Dodatek B,
Nastrojove listy



Uvod

Aplikace Draw nabizi nékolik nastrojovych list, které pomahaiji pfi tvorbé kresby. Kazda
nastrojova lista ma vychozi sadu nastrojii a moznost pridat dalSi nastroje.

"/ Poznamka

Ikony zobrazené na nastrojovych listach aplikace Draw vyobrazenych v této pfiloze
se mohou liit od ikon zobrazenych na obrazovce pocitace. Ikony na nastrojovych
liStach zavisi na pouzitém operacnim systému pocitae a na nastaveni LibreOffice.

Pouziti nastrojovych list

Zobrazeni nastrojovych list

Pokud chceme zobrazit nastrojovou liStu a aktivovat ji, zvolime Zobrazeni > Nastrojové listy

v hlavni nabidce. Otevie se podnabidka se seznamem nastrojovych list dostupnych pro aplikaci
Draw. Kliknutim na nazev nastrojové liSty tuto liStu aktivujeme. Aktivni nastrojové listy jsou
oznacCeny zvyraznénim nebo zaskrtnutim vedle nazvu, jak je vidét na obrazku 340.

3D nastaveni Pismomalba

3D objekty Prehravani medii
" Cara a wpld Piiblizeni

Diivéjai kruhy a ovaly Eedakéni Uprava

Drivé)5i obdélniky Rozmistit vybér

Formatovani textu " Standardni

Komentare Standardni (reZim prohliZzeni)
"  Kresba Tabulka

MoZnosti Transformace

Nayjit Upravit body

Navigace ve formulafi VioZit

MNavrh formulafe fachytné body

Obrazek Zarovnat objekty

Ovladaci prvky formulafe Zobrazeni pfedlohy

Obrazek 340: Nastrojové listy aplikace Draw

"/ Poznamka

Nékteré nastrojoveé listy, pfestozZe jsou vybrany v poloZce Zobrazit > Nastrojové
listy v hlavni nabidce, se nezobrazi, dokud neni v kresbé vybran objekt spravného
typu. Napfiklad nastrojova lista Obrdzek se zobrazi pouze tehdy, kdyZ je vybran
obrazek.

Zavreni nastrojovych list
Pokud chceme zavfit nastrojovou liStu, pouzijeme jednu z nasledujicich metod:

* Prejdeme do Zobrazit > Nastrojové liSty v hlavni nabidce a nastrojovou listu
odznacCime.

* Klepneme pravym tlacitkem mySi na nastroj na nastrojové listé a z mistni nabidky
zvolime Zavfit listu.

328 | Pfirucka Draw 7.1



* Klepneme na X v pravém rohu zahlavi plovouci nastrojové listy.
Pohybujeme nastrojovymi liStami

Ukotveni nastrojovych list
Ve vychozim nastaveni jsou nékteré nastrojové listy v hlavnim okné aplikace Draw ukotveny.

Napfiklad nastrojova liSta Standardni je ukotvena v horni €asti hlavniho okna. Ukotvenym
nastrojovym listam lIze zruSit ukotveni a prfesunout je na nové misto v hlavnim okné, kde je
mozné je opét ukotvit, nebo je moZné je nechat jako plovouci nastrojové listy. Pfed pfesunutim

nastrojové listy musi byt této nastrojové listé zruseno ukotveni.

1) Kurzor mySi pfesuneme na maly svisly Gchyt na levém konci nastrojové listy. Kurzor mysi
se zméni na kurzor pohybu dany systémem pocitaCe a nastavenim.

2) Klepneme a podrzime tlaitko mysi a pfetahneme nastrojovou liStu na nové misto. Tim
mUZe byt nové misto pro ukotveni nastrojové listy nebo misto pro plovouci nastrojovou
liStu. Pfi pfetahovani se kolem nastrojové listy zobrazi Srafované ohrani¢eni oznadujici
pozici nastrojove listy.

3) Po dosazeni poZzadované polohy uvolnime tlacitko mysi.

Plovouci nastrojové listy

Pokud chceme plovouci nastrojovou listu pfesunout, klepneme na jeji zahlavi a pretahneme ji na
nové misto. Jakmile je nastrojova liSta v pozadované poloze, uvolnime tlacitko mySi. Plovouci
nastrojova lista nemusi byt umisténa v hlavnim okné aplikace Draw, aby byla funkéni.

Ukotvené a plovouci nastrojové listy
Pokud chceme ukotvit plovouci nastrojovou listu, pouZijeme jednu z nasledujicich moznosti:

* Klepneme na zahlavi a pfetahneme ji na horni, dolni, levou nebo pravou stranu hlavniho
okna. Kdyz nastrojova lista dosadhne dokovaci pozice, na ukotveném misté se zobrazi
¢arkované ohraniceni. Uvolnime tlagitko mySi a nastrojova liSta je ukotvena.

* Klepneme pravym tlacitkem mysSi na néstrojovou liStu a z mistni nabidky zvolime Ukotvit
liStu. Nastrojova liSta se pfesune na pozici ukotveni. Pokud nam pozice nevyhovuije,
presuneme nastrojovou listu do nové pozice ukotveni.

» Pokud chceme ukotvit v8echny aktivni plovouci nastrojové liSty, klepneme na néstrojovou
liStu pravym tlacitkem mySi a z mistni nabidky vybereme moznost Ukotvit vSechny
listy.

Uzamceni nastrojovych list
Ukotvenou nastrojovou liStu Ize také uzamknout na jeji pozici v hlavnim okné aplikace Draw.

* Pokud chceme uzamknout nastrojovou listu v jeji pozici, klepneme pravym tlaCitkem mysi
do prazdné oblasti na nastrojové listé a v mistni nabidce klepneme na Zamknout
umisténi liSty. U této moznosti se zobrazi znacka zaSkrtnuti oznacujici, Ze nastrojova
liSta je nyni uzamcena.

* Pokud chceme nastrojovou listu odemknout, klepneme pravym tlacitkem mysi do
prazdné oblasti na nastrojové listé a v mistni nabidce klepneme na Zamknout umisténi
liSty. Znacka zasSkrtnuti vedle této moznosti zmizi, coz znamen4, Ze nastrojova lista je
nyni odemcena. Na levém konci nastrojové liSty se také objevi svisla ¢ara, ktera se
pouziva k pfesouvani nastrojové listy.
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Poznamka

Nékteré néstrojové liSty nelze v jejich umisténi ukotvit ani uzamknout. To je
naznaceno tim, Ze moznosti Ukotvit liStu a/nebo Zamknout umisténi liSty jsou
Sedé a nejsou k dispozici.

Uprava nastrojovych list
Po instalaci do pocitaCe obsahuje LibreOffice sadu nastrojovych list vhodnych pro jednotlivé

aplikace LibreOffice. Kazda nastrojova lista ma vychozi sadu viditelnych nastroji. MiZzeme
pridavat nastroje, odebirat nastroje a pfizplisobovat nastrojové listy.

Pridani nastrojovych list
1) Klepneme pravym tlaCitkem mysSi do prazdné oblasti nebo klepneme na maly trojuhelnik
v vpravo vedle titulku nastrojove listy.

2) Pokud chceme zobrazit seznam dostupnych nastrojd, vybereme v mistni nabidce
moznost Viditelna tladitka.

3) Klepneme na pozadovany nastroj a nastroj se zobrazi na nastrojove liSté. Seznam
dostupnych nastrojd se automaticky zavie. Zvyraznéni nebo zaskrtnuti vedle nastroje
oznacuje, Ze nastroj je jiz nainstalovan na nastrojové listé.

Poznamka

Pfi pfidavani nastrojd pomoci volby Viditelna tlacitka je nastroj pfidan na
nastrojovou liStu na stejnou pozici, v jaké se objevi v seznamu Viditelna tla€itka. To
tedy znamena4, Ze nastroj uvedeny v seznamu Viditelna tlac¢itka UpIné nahore se
zobrazi na levé strané nastrojové listy; nastroj uvedeny v seznamu Viditelna tla€itka
UpIné dole se zobrazi na pravé strané nastrojové listy. Pomoci volby Viditelna
tlacitka nelze ménit umisténi nastroje.

Odstranéni nastrojovych list

1) Klepneme pravym tlaCitkem mysSi do prazdné oblasti nebo klepneme na maly trojuhelnik
v vpravo vedle titulku nastrojové listy.

2) Pokud chceme zobrazit seznam dostupnych nastrojli, vybereme v mistni nabidce
moznost Viditelna tladitka.

3) Klepneme na nastroj, ktery jiz neni potfeba, a nastroj se z nastrojove liSty odstrani.
Odstrani se také zvyraznéni nebo znacka zaskrtnuti vedle nastroje. Seznam dostupnych
nastrojli se automaticky zavre.

Prizplisobujeme si nastrojové listy

DalSi nastroje a pfikazy, které nejsou k dispozici ve volbé Viditelna tladitka Ize na nastrojovou
liStu pridat pomoci prizplsobeni. Pfizplsobeni také umoZiiuje vytvaret nové nastrojové listy,
pokud je pro urcity Ukol vyzadovana specificka sada nastrojll. Informace o prizplisobeni
nastrojovych list najdeme v pfiru¢ce Zac¢iname s LibreOffice.

Nastrojové listy

Poznamka

Nastroje instalované na nastrojové listé jsou obvykle oznaceny ve volbé Viditelna
tlacitka bud zvyraznénou ikonou nastroj, nebo zaskrtnutim. Tato indikace instalace
zavisi na nastaveni pocitace a pouzitém operacnim systému pocitacCe.
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@% Poznamka

Na nékterych nastrojovych listach maji ikony na sveé pravé strané maly trojuhelnik
sméfujici dold v . Klepnutim na tento trojuhelnik otevieme dal$i moZnosti, které jsou
k dispozici.

@%& Poznamka

Né&které z nastrojli na nastrojovych listach maji také moznost pouzit klavesovou
zkratku misto klepnuti na nastroj. Uplny seznam klavesovych zkratek, které jsou
k dispozici v aplikace Draw, najdeme v dodatku A, Klavesové zkratky.

3D objekty

Nastrojova lista 3D objekty (obrazek 341) poskytuje nastroje pro vytvareni 3D objektll v kresbé.
Aktivuje se bud volbou Zobrazit > Nastrojové listy > 3D objekty v hlavni nabidce nebo
klepnutim na ikonu 3D objekty na nastrojové listé Kresba.

3D objekty v X
PORCLELOCCO®

Krychle
Koule
Valec

Kuzel

Jehlan
Torus
Plast
Polokoule

Obrazek 341: Nastrojova lista 3D
objekty

900 pRON

3D nastaveni v X
D A-F-o -0 -

3¢ Ptepnout plasti¢nost

Naklonit dold
Maklonit nahoru
Maklonit doleva
Maklonit doprava

Hloubka
Smér

QR £ G|

Qsvétleni
Povrch
Barva 2D

Obrazek 342: Nastrojova lista 3D nastaveni

Ig !l o
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3D nastaveni

Nastrojova lista 3D nastaveni (obrazek 342) a jeji nastroje jsou aktivni pouze tehdy, kdyZ byl
objekt pfeveden do 3D pomoci nastroje Pfepnout plastiénost a pfevedeny objekt je poté
vybran. Nasledujici nastroje na této nastrojove listé maji vpravo od ikony maly trojuhelnik v .
Klepnutim na tento trojihelnik otevieme rozeviraci nabidku, kterd umoziuje pfistup k riznym
moznostem:

* Hloubka — Hloubka 3D vytlaeni — Ocm; 1cm; 2.5cm; 5cm; 10cm; Nekonecno; Vlastni.

Mérna jednotka zavisi na nastaveni Nastroje > MoZnosti > LibreOffice Draw >
Obecné.

*  Smér— Smeér a typ 3D vytlaCovani — Bez perspektivy; S perspektivou.

* Osvétleni — smér a troven osvétleni 3D vytlaceni — Jasné; Normalni; Tlumené.

* Povrch —typ povrchu 3D vytlaCeni — Dratovy model; Matny; Plasticky; Kovovy.

* Barva 3D - barva 3D vytlaceni. Vybereme barvu z jedné z dostupnych barevnych palet.

Zarovnani objektu

Nastrojova lista Zarovnani objektl (obrazek 343) poskytuje nastroje pro zarovnani nékolika
objektll v kresbé, aby se zlepsil jeji vizualni dojem.

Zarovnat objekty w X
£ & = o fer ol

o Vlevo
& Na stred
o Vpravo

O] MNahoru
Bl Stred
ol Dold

Obrazek 343: Nastrojova
lista Zarovnani objekt(

Komentare

Nastrojova liSta Komentéafe (obrazek 344) poskytuje nastroje pro pfidavani, mazani a navigaci
v komentafich v kresbé. Pokud chceme pouzivat komentare, je doporuceno pfidat své jméno

a inicialy v nastaveni Nastroje > MoZnosti > LibreOffice > UZivatelské udaje, aby bylo mozné
komentafe snadno identifikovat.
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Komentare

v X
BERp A

35 7 S s

Komentar Ctrl+AR+C

Predchozi komentar
Dalsi komentar

Smazat komentar
Smazat viechny komentare

Obréazek 344: Nastrojova lista Komentare

Rozmistit vybér

Nastrojova lista Rozmistit vybér (obrazek 345) poskytuje nastroje pro rovhomérné rozlozeni tfi
nebo vice vybranych objektll podél vodorovné nebo svislé osy. Vzdalenosti mezi objekty mohou

byt také rozprostfeny.

iy

Rozmistit vybér

0o dh dd =* 52 & o2

v X

L [ =

Rozmistit vodorovné vievo
Rozmistit vodorovné na stied
Rozmistit vodorovné mezery
Rozmistit vodorovné vpravo

Rozmistit svisle nahoru

Rozmistit svisle na stied
Rozmistit svisle mezery
Rozmistit svisle dold

Obrazek 345: Nastrojova lista Rozmistit

vybér

Kresba

Nastrojova lista Kresba (obrazek 346) obsahuje vétSinu nastroji, které se obvykle pouzivaji
k vytvareni grafickych objektd v kresbé.
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Kresba

NP ENEPIES

v X

O-Q B v - L

O0raN 2@KN “mEEE 05 A

Vybrat

PfibliZeni a posun

PribliZit objekt

Priblizeni

Textové pole F2
Svisly text

Obrazek

VloZit

VloZit pismomalbu

Barva Cary

Barva vyplné
Styl/vyplf oblasti
Cara

Cara od ruky
Krivka

Obdélnik

Elipsa

» B U0 A&l

® R

= B e

Cary a sipky
Kfivky a mnoholhelniky
Spojnice

Zakladni tvary

Tvary symboli

Tvary Sipek

Tvary vyvojovych diagrami
Tvary bublin

Tvary hvézd

3D objekty

Upravit body F8
Zachytne body

Ma kfivku

Ma mnohouhelnik

MNa 3D objekt

Ma 3D rotaéni objekt

Ovladaci prvky

Prepnout plasti€énost

Obréazek 346: Nastrojova lista Kresba

Neékteré nastroje tvar(l na nastrojové listé Kresba se méni v zavislosti na poslednim vybraném

a pouZzitém nastroji.

« Klepnutim na maly trojihelnik sméfujici dolli ¥ vpravo od nastroje otevieme

vyskakovaci nastrojovou listu. Vybereme pozadovany tvar, ktery chceme pfidat do

kreshy.

* Pokud chceme vytvorit dil¢i nastrojovou listu, klepneme na horni €ast vyskakovaci
nastrojové listy a prfetdhneme ji do prazdné oblasti v hlavnim okné. Dil€i nastrojové listy
pro jednotlivé typy objektd a réizné dostupné tvary jsou zobrazeny na obrazcich 347 az

356.
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Cary a Sipky w X

—  Céra konéi dipkou
Céra s kruznicifSipkou
Cara se ¢tvercem/sipkou

o]

Cara se sipkami

Céra zacina Sipkou

Céra se Sipkou/kruZnicr
Cara se sipkou/¢tvercem
Cara

Kotovaci Eara

Céra (45°)

Obrézek 347: Diléi nastrojova lista Céry
a Sipky

NE N

Krivky a mnohothelniky v X
OULBHNALY

Kiivka, vyplnéna

Mnohoudhelnik, vyplnény
Mnohouhelnik (45°), vwwplnény
Céra od ruky, vwplnéna

Kivka

Mnohouhelnik
Mnohouhelnik (45%)

Céra od ruky

Obrazek 348: Dilci nastrojova
lista Krivky a mnohouhelniky

SR 8fRe
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Spojnice

LNa\LVLNaLWwLNa\

v X

Spojnice konci Sipkou
Pfima spojnice konéi Sipkou

Carova spojnice konéi dipkou
Spojnice

Pfima spojnice

Zakfivena spojnice

Carovéa spojnice

Spaojnice se Sipkami

Pfima spojnice se Sipkou
Zakfivena spojnice se Sipkou
Carova spaojnice 3ipky

Spojnice zacina Sipkou

/- ENEE EEEE EmEE

Pfima spojnice zacina Sipkou

Zakfivena spojnice konéi sipkou

AUy s A0

NS A

SN2

Zakrivena spojnice zacina Sipkou
Carova spojnice zacina sipkou
Spojnice konéi kruZnici

Pfima spojnice kondi kruZnici
Zakrivena spojnice konci kruZnici
Carova spojnice konéi kruZnici
Spojnice zacing kruZnici

Pfima spaojnice zadina kruznici
Zakfivena spojnice zacina kruZnici
Carova spojnice zacina kruZnici
Spojnice s kruZnicemi

Pfima spaojnice s kruZnici
Zakfivena spojnice s kruZnici
Carova spojnice s kruZnici

Obrazek 349: Dilci nastrojova liSta Spojnice

Zakladni tvary

v)('
OO0O0O00JdUOOGOCAaANSCOOOBS8ON OO

Obdélnik
Zakulaceny obdélnik
Ctverec

Zakulaceny ctverec
RovnobéZnik
LichobéZnik

Elipsa
Kruh

Q0 S L ICH
LA AL RN CA s

Kruhova wyseé
Kruhova useé
Oblouk
Oblouk

Rovnoramenny trojuhelnik

Kosoétverec

Pravidelny pétidhelnik

Pravouhly trojihelnik

Sestitihelnik
Osmidhelnik

Valec
Krychle
Ohnuty roh
Kfiz

Ramec

ool OO

Prsten

Obréazek 350: Dil¢i nastrojova lisSta Zakladni tvary
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Tvary symboli w X
OV IO 7O0Qw B[ [ 1 {t { }
Smajlik © Kvétina [] Dvojita zavorka
(/ Srdce () Zakaz [ | Leva zavorka
& Slunce ar Puzzle | Prava zavorka
D Mésic [0 Zkoseny ctverec {} Dvojita sloena zavorka
(] Oblak €9 Zkoseny osmithelnik | { Levéa sloZena zavorka
& Blesk € Zkoseny kosoctverec | Prava sloZena zévorka

Obrézek 351: DIl¢i nastrojova lista Tvary symboli

Blokové 3ipky w X
>l eoellarVreLbppDwhro>tDdlOesdn
=> Sipka doprava 1) TvarV
&= Sipka doleva [ Pétidhelnik
I Sipka dold > Pruhovana dipka doprava
1 Sipka nahoru & Sipka nahoru, doprava a dold
<> Sipka doleva a doprava => Sipka doprava se zifezem
it Sipka nahoru a dold ity Sipka nahoru a doprava
“  Kruhova sipka [ Sipka doprava s bublinou
7 Vinita gipka 4] Sipka doleva s bublinou
N Rozdélena dipka L7 Sipka doll s bublinou
P Sipka doleva nebo doprava &4 Sipka nahoru s bublinou
45 Ctyfsmérova Sipka b Sipka doleva a doprava s bublinou
I, Rohova Sipka doprava == Sipka nahoru a doli s bublinou
Y TvarV 4y Ctyfsmérova gipka s bublinou
[ Pétidhelnik % Sipka nahoru a doprava s bublinou

Obréazek 352: Dil¢i nastrojova lista Blokové Sipky

Nastrojové listy | 337



leojuvjdiagram
OO0 MMBlFOocOOvVOUldan®@8XeAVUUDQASWOO

v X

L]
L
<
[
I

0=
(1w}

Ao dRvo O

Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:

Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:

Vyvojovy diagram:

Vyvojovy diagram

Proces

Alternativni proces
Rozhodnuti

Data

Predem definovany proces
Interni UloZisté

Dokument
Multidokument
Terminator
Pfiprava

Manualni vstup
Manualni operace

Konektor
: Vnéjsi konektor

Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:

Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:

Vyvojovy diagram:
Vyvojovy diagram:
Vyvojovy diagram:

OB 00 URKIE®R MK S8 S 0

Karta

Dérna paska
Sjednoceni
Nebo

Sbér

Razen(
Extrakce
Spojeni
UloZena data

Vyvojovy diagram: ZpoZdéni

Sekvenéni pristup
Magneticky disk
Piimy pfistup

Vyvojovy diagram: Zobrazeni

Obréazek 353: Dil¢i nastrojova lista Vyvojovy diagram

Bubliny

L) g b f ]

v X

s

'

I

Sesticipa hvézda

{3 Osmicipa hvézda
3£ 12cipa hvézda
{3 24cipa hvézda

& @2

[] Obdélnikova bublina
D Zakulacend obdélnikova bublina
(2 Kulata bublina
% Oblak
it Bublina s linkou 1
i~ Bublina s linkou 2
I/ Bublina s linkou 3
Obrazek 354: Diléi nastrojova lista
Bubliny
Hvézdy a cedule w X
WO R
<> Ctyfcipa hvézda Vybuch
1% Péticipa hvézda Svisla role

Vodorovna role
Pecet’
Jmenovka

Sesticipa hvézda, konkavni

Obréazek 355: Dil¢i nastrojova lista Hvézdy a cedule
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3D objekty v X
POCLEILOCCO®

Krychle
Koule
Valec

KuzZel

Jehlan
Torus
Plast
Polokoule

900 >RON

Obrazek 356: Dilci nastrojova lista
3D objekty

Upravit body

Nastrojova lista Upravit body (obrazek 357) poskytuje nastroje pro Upravu bodu kfivky nebo
objektu prevedeného na kfivku. Nastrojova liSta je aktivni pouze tehdy, kdyz je vybran objekt
a k jeho otevfeni je pouzita jedna z nasledujicich moznosti:
» Klepneme na Upravit body na nastrojové listé Kresba nebo Standardni nastrojové listé.
* Pouzijeme klavesovou zkratku F8.

Upravit body v X
AlA AL CIlATIIENTY

Upravit body F8

Pfesunout body
VloZit body
Smazat body

Prevést na kfivku

Uzavfit Beziérovu kffivku
Rozdélit kiivku

Uhlovy bod
Plynuly pfechod
Soumérny prechod

ke EDE Dy D Rk

Ubrat body
Obréazek 357: Nastrojova lista Upravit body

Najit

Nastrojova lista Najit (Obrazek 358) se ve vychozim nastaveni otevira v levém dolnim rohu
hlavniho okna aplikace Draw. Tato nastrojova lista je obvykle umisténa v levém dolnim rohu
hlavniho okna aplikace Draw nad stavovym fadkem. Lze ji vSak uvolnit a vytvofit z ni plovouci
néstrojovou listu.
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Najit w X

O Majit ] Najit vie [ Rozliovat velikost ,@j

Zavfit vyhledavaci li5tu
Najit text

Najit pfedchozi

Majit dalsi

Najit vie

Rozlisovat velikost

MNajit a nahradit Ctrl+H

LSS abSo

[zdstupny Znak za zpravu]

Obrazek 358: Nastrojova lista Nayjit

Pismomalba

Nastrojova lista Pismomalba (obrazek 359) slouzi k vytvareni grafickych textovych objektl

v kresbé a poskytuje nastroje pro upravu grafického textového objektu. Tato nastrojova lista je
aktivni pouze tehdy, kdyz je v kresbé vybran graficky textovy objekt Pismomalby.

Neékteré nastroje na nastrojové listé Pismomalba maji vpravo od nastroje maly trojihelnik
sméfujici doll v . Klepnutim na trojahelnik otevieme vyskakovaci nastrojovou listu nebo
rozeviraci seznam moznosti.

* Tvar pismomalby — z dostupnych moznosti vybereme pozadovany tvar pro graficky
textovy objekt Pismomalby.
e Zarovnani pismomalby — z dostupnych moznosti vybereme zarovnani odstavce.

* Rozestup znakl pismomalby — z dostupnych moZnosti vybereme poZadovany rozestup
znakd.

Pismomalba w X
FiP--Ral =AY .|

[F VloZit pismomalbu

Y

Tvar pismomalby
Stejna vyika pismen pismomalby

=
()

Zarovnani pismomalby
Rozestup znak pismomalby

o= 12

Pfepnout plastiénost

Obrazek 359: Nastrojova lista
Pismomalba

Ovladaci prvky formulare

Nastrojova liSta Ovladaci prvky formulafe (obrazek 360) poskytuje nastroje potfebné k vytvoreni
interaktivniho formulare. Tato nastrojova lista umoznuje pfidat ovladaci prvky do formulare
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v textovém nebo tabulkovém dokumentu, kresbé, v prezentaci nebo v HTML dokumentu
(napriklad tlacitko, které spusti makro).

Ovladaci prvky formulare w X
FTIMZECRAVOEELWEARNOOC=ABEN[HR B B
[> Vybrat @ Tlacitko volby (B Pole pro ¢as
b Prepnout reZzim navrhu Seznam [3] Ménove pole
V4 PrE,ldemgvlanvamml prvky formulare EH Pole se seznamem Ad Pole vzorku
EZ Navrh formulare = Tiaditko Fl Ovladaci prvek tabulky
m - - - - -
o Vlastnost! D\"|Edaf|uh0 prvku L Obrazkové tlatitko Pl Lista navigace
E& Vlastnosti formulaie T —— [ Ovladaci pole obrazku
e PoplseI:: Pole pro datum [ Vybér souboru
[AIl Textové pole §0 Ciselné pole  Rolovaci tlagitko
Zaskrtavaci pole ™ Seskupent =] Posuvnik
Obréazek 360: Nastrojova lista Oviladaci prvky formulare
Navrh formulare v X

NEIEENEEEIEE

[ Eid

57

WO U5 2 m El Rl [ 5l LS

|

T B B W

Vybrat

Vlastnosti ovladaciho prvku
Vlastnosti formulare
Umisténi a velikost F4

Navigator formulafem

Poradi aktivace

Pfidat pole

Automaticky zaméfit ovladaci prvek

Pienest do popfedi Ctrl+5hift++
Odsunout do pozadi  Ctrl+5Shift+-

Seskupit Ctrl+5Shift+G
Zrusit skupinu Ctrl+Alt+5Shift+G
Upravit skupinu F3
Opustit skupinu Ctrl+F3

Zarovnani objektd

Oteviit v rezimu navrhu
MiiZka
Prichytit k miiZzce

Voditka pfi presouvani

Obrazek 361: Nastrojova lista Navrh formulare
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Navrh formulare

Nastrojova lista Navrh formulafe (obrazek 361) otevie formular v ReZimu navrhu, aby jej bylo
mozné upravovat. V ReZimu navrhu nelze aktivovat ovladaci prvky formulafe ani upravovat jeho
obsah. V ReZimu navrhu véak miizeme ménit polohu a velikost ovladacich prvkd, upravovat dalsi
vlastnosti a pfidavat nebo odstranovat ovladaci prvky.

Navigace ve formulafri

Nastrojova liSta Navigace ve formuléfi (obrazek 362) poskytuje nastroje pro Upravu tabulky
databaze nebo ovladani zobrazeni dat. Nastrojova liSta se obvykle zobrazuje v dolni ¢éasti
dokumentu, ktery obsahuje pole spojena s databazi. Tato nastrojova lista je aktivni pouze tehdy,
kdyz jsou formulare pfipojeny k databazi; neaktivni nastrojova liSta je znazornéna na obrazku
362.

Nastrojova lista Navigace ve formulafi umoziiuje také pohyb v rdmci zaznamd a vkladani

a mazani zaznamd(. Pokud jsou data ve formulafi uloZzena, pfenesou se zmény do databaze. Tato
nastrojova lista také poskytuje pro zdznamy dat nastroje zajidtujici funkce fazeni, filtrovani

a vyhledavani.

Navigace ve formulafi w X
£ \zazmam 2z 5|4 4 D Dl » Py | O BE 21 &1 N W g Em

L Majit zAznam <) Zpét polozka

o Zazmam Py Smazat zaznam

P Absolutni zAznam 10 Obnovit

w  Text - Zaznam ®2  Obnovit oviddaci prvky

w*  Celkovy pocet zaznami %2 Sefadit

[4 PrvnizAznam  Ctrl+Alt+Home Bl fadit vzestupné

{ Pfedchozi zaznam Ctrl+Alt+Left Z] Radit sestupné

P | Daldizaznam  Ctrl+Alt+Right -

P| Posledni ziznam  Ctrl+Alt+End )7 Automaticky filtr

B Novy zamam NZ Poutit filtr

: ) 52 Formuléfove filtry  Ctrl+Shift+L

UloZit zaznam N#  Odstranit filtr/fazeni

[E Zdroj dat jako tabulka

Obréazek 362: Nastrojova lista Navigace ve formulari

Zachytné body w X

| = B4

VloZit zachytny bod Zachytny bod horizontalné vievo
Zachytny bod horizontalné uprostred

F
Vystup doleva
Zachytny bod horizontalné vpravo

Wystup nahoru
Vystup doprava Zachytny bod vertikalné nahofe
Zachytny bod vertikalné uprostred

Zachytny bod vertikalné dole

NHEE ©

Wystup dold

[

% Relativni zachytny bod
Obrazek 363: Nastrojova lista Zachytné body
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Zachytné body

Nastrojova lista Zachytné body (obrazek 363) obsahuje nastroje pro vloZeni zachytného bodu
nebo Upravu vlastnosti zachytného bodu. Zachytny bod je bod, ve kterém je spojnice pfipojena
k objektu. Ve vychozim nastaveni LibreOffice pro kazdy vytvoreny objekt automaticky umisti
zachytny bod do stfedu kazdé strany ohranicujiciho obdélniku.

Obrazek

Nastrojova liSta Obrazek (obrazek 364) poskytuje nastroje pro Upravu, zarovnani, zménu polohy
a velikosti obrazki. Nastrojova lista je aktivni a dostupna pouze tehdy, kdyz je v kresbé vybran
obrazek. Nastrojova lista Obrdzek automaticky nahradi nastrojovou listu Cara a vypln.

Obrazek

% |;':" r_.ﬁl

O
E OF of &~ 0O

= |

»

v X

rOom— - O ¢ v vchozi [v| B S A [d-@ox 5 &

[
O

[
5

Umisténi a velikost F4
Zarovnani objektd

Vievo
Na stfed
Vpravo

Mahoru
Stfed
Dold

Uspofadat

Ctrl+Shift++
Pfenést bliz Ctrl++
QOdsunout dal Ctrl+-
Odsunout do pozadi Ctrl+Shift+-

Pfenést do popfedi

Pfed objekt
Za objekt

Prohodit

& Ll

& NEBEA B S L2 3

2K &

Styl Eary
Sitka cary
Barva &ary

Styl/wvyplf oblasti
Barva vyplné
Stin

Filtr
ReZim obrazku
Ofiznout

Svisle
\Vodorovné
Transformace

Prihlednost
Barva

Cara

Oblast

Obréazek 364:

Nastrojova lista Obrazek
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Viozit
Nastrojova lista VloZit (obrazek 365) poskytuje nastroje pro vkladani rliznych typl objektl do
kreshy.

Viozit v X
= 3 TT e
+J Mova stranka Ctrl+N
0 Plovouci ramec

By VloZit stranku ze souboru
A Tabulka

La] Obrazek

e Multimédia

JU Vzorec

lls Graf

@ Objekt OLE
Obréazek 365: Nastrojova lista
Viozit

DfivéjSi kruhy a ovaly

kruznic a ovald do kresby.

Diivéji kruhy a ovaly v X
OCO0OGCGLoOoosto U

Elipsa
Kruh
Elipticka wyset

Kruhova vysed

Elipticka dsel

Kruhova ased

Elipsa, nevyplnéna

Kruh, nevyplnény

Elipticky kolac, nevyplnény
Kruhovy kolac, nevyplnény
Elipticka Usec, nevyplnéna

Kruhova ased, nevyplnéna

Oblouk

Kruhowy oblouk

AT e

@CCPEREeS QOEIROI0
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DfivéjSi obdélniky

vvvvvv

obdélnikd a étvercl do kresby.

Diivéjii obdélniky w X
OO0
1 Obdélnik Obdélnik, nevyplnény
[ ] Ctverec Ctverec, nevyplnény
() Zakulaceny obdélnik Zakulaceny obdélnik, nevyplnény
[ ] Zaobleny étverec Zakulaceny ctverec, nevyplnény

vz

Cara a Vyplh
Nastrojova lista Cara a vyplii (obrazek 368) obsahuje nastroje a rozeviraci seznamy pro Gpravu
¢ar, Sipek a okrajli objektl. Dostupné nastroje se lidi v zavislosti na typu objektu vybraného

k apravam.

N 4

Céra a wyplii

LB &

R
058 & 09

«~000cm =

’Barva v | rf

v X

- D:'%ﬂhm'é‘fﬁ

g

[j.
5
i

Umisténi a velikost F4
Zarovnani objektl

Vlevo
Na stied
Vpravo

Mahoru
Stired
Dold

Uspofadat

Ctrl+Shift++
Prenést bliZ Ctrl++
Odsunout dal Ctrl+-
Odsunout do pozadi Ctrl+Shift+-

Prenést do popredi

Pied objekt
Za objekt

Prohodit

Styl cary
Sitka cary

& Ll

Barva cary

Styl/vypln oblasti
Barva wyplné

Stin

Styl Zipky

Svisle

Vodorovné
Transformace

Cara

Oblast

3D efekty

Obrazkova mapa

Styly F11
Miizka

Voditka pfi pfesouvani

TE EHG 2K M I U223

Obréazek 368: Nastrojova lista Cara a vyplri
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Zobrazeni predlohy

Nastrojova lista Zobrazeni pfedlohy (obrazek 369) obsahuje nastroje pro vytvofené nové
predlohy, pfejmenovani pfedlohy, smazani predlohy a zavieni zobrazeni pfedlohy. Tato
nastrojova lista je aktivni pouze pfi zobrazeni predlohy v aplikaci Draw.

Zobrazeni piedl.. ™
= E & B

MNova predioha

Smazat predlohu

o |Ea

Piejmenovat pfedlohu

&l

Zavrit predlohu

Obrazek 369: Nastrojova
lista Zobrazeni predlohy

Prehravani médii
Nastrojova lista Pfehravani médii (obrazek 370) poskytuje standardni nastroje potfebné pro
vkladani, prohlizeni, pfehravani a poslech zvukovych a video soubori. Nastrojova lista je aktivni
pouze tehdy, kdyz je vybran zvukovy nebo video soubor. Aplikace Draw podporuje mnoho
rlznych formatd médii v zavislosti na pouZitém operacnim systému pocitace. Na nastrojové listé
jsou zleva doprava k dispozici tyto nastroje:

* Oteviit — otevie filmovy nebo zvukovy soubor.

» Prehrat — prehraje aktualni soubor.

* Pozastavit — pozastavi nebo obnovi pfehravani aktualniho souboru.

» Zastavit — zastavi pfehravani aktualniho souboru.

* Opakovat — prehraje soubor opakované.

* Pozice — umoZiiuje pfesun na jinou pozici v souboru.

e Ztlumit — vypne a zapne zvuk.

* Hlasitost — nastaveni Urovné hlasitosti.

» Zobrazit — upravuje velikost pfehravaného videa.

Prehravani médii

™ one s | 00:00:4 a | ;""_‘

v X
Cesta k multimeédiu: vnd.sun.star.Package:Media/Angelo Badalamenti-Twin Peaks Theme.mp3

Obrazek 370: Nastrojova liSta Pfehravani médii

Moznosti

Nastrojova liSta MoZnosti (obrazek 371) poskytuje nastroje pro Gpravu rliznych nastaveni nové
vytvorenych kreseb, napfiklad zptsobu prichyceni objektd k mfiZce pfi pfesunu nebo zméné
velikosti.
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[ Kliknutim vstoupite do rezimu otacenf {4 Prichytit k ohrani¢eni objektu
Mit3ka L:d Prichytit k boddm objektu
| | Zobrazit voditka [# Povolit rychlou editaci
- Voditka pfi presouvani 36 Vybrat pouze textovou oblast
Ed Prichytit k mifsce Y Dvojitym kliknutim upravite text
| n Prichytit k voditkdm & Upravit objekt s atributy
[ Prichytit k okrajim stranky & Opustit viechny skupiny

Obréazek 371: Nastrojova lista MoZnosti

Redakc€ni uprava

Nastrojova lista Redakéni Uprava (obrazek 372) slouzi k blokovani ¢asti kresby z ddivodu
ochrany citlivych informaci a pomaha podniklim a organizacim dodrZovat predpisy o dlvérnosti
nebo ochrané osobnich Gdajl.

PFi exportu upravené kresby do nové kresby se z nové kresby odstrani vSechny upravené Casti
a nahradi se upravenymi bloky pixeld. Tim se zabrani jakémukoli pokusu o obnoveni nebo
kopirovani pdvodniho obsahu. Upravena kresba se ¢asto exportuje do formatu PDF za Gcelem
zverejnéni nebo sdileni.

Redakéni Uprava W X

;&D;

Obdélnik
Od ruky

Export upraveneho (bila)
Export upravengho (€erna)
4| PDF

Obrazek 372: Nastrojova lista
Redak¢ni dprava

T

Standardni

Standardni nastrojova lista (obrdzek 373) je spoleCn& pro viechny soucésti LibreOffice
a poskytuje nejbéznéjsi nastroje pfi vytvareni a Upravach dokumentt pomoci LibreOffice.
Standardni nastrojova lista se v jednotlivych souc€astech LibreOffice liSi, aby umoznila pouziti

rlznych sad nastrojl pfi vytvareni rliznych typl dokumentd.

Nastrojové listy | 347



Standardni
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Obréazek 373: Standardni nastrojova lista
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Standardni (reZim prohliZeni)
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Obréazek 374: Nastrojova lista Standardni (reZim prohliZzeni)

Standardni (reZzim prohlizeni)

Nastrojova lista Standardni (rezim prohlizeni) (obrazek 374) obsahuje nastroje pro ukladani,
Upravy a distribuci kresby.

Tabulka

Nastrojova lista Tabulka (obrazek 375) poskytuje nastroje a moznosti pro Upravu a formatovani
tabulky umisténé v kresbé. Tato nastrojova lista je aktivni pouze v pfipadé, Ze je vybrana tabulka.

Tabulka
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MNavrh tabulky
Vlastnosti tabulky

Obrazek 375: Nastrojova lista Tabulka
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Formatovani textu

Nastrojova lista Formatovani textu (obrédzek 376) obsahuje nastroje pro forméatovani textu
a pfikazy pro zarovnani textu. Tato nastrojova liSta se stane aktivni, pokud byl vybran text
v textovém poli nebo grafickém objektu, a automaticky nahradi nastrojovou liStu Cara a vypln.

5
i

Odrazky

Formatovani textu
R Tl 2 A A >
Liberation Sans vigpt (VA" A B I U S X x; § A A A~
v X
"& = 1= = === =X J t=_=t =t A |A
I ZTEYE E = =T T = LET = = —>lw—ﬁq.T<—
A Nazev pisma i=| Cislovani
1=
Al Velikost pisma = LI
A Zvetsit Ctrl+] | = Vlevo Ctrl+L
A" Zmensit Ctrl+[ = Na stied Ctrl+E
B Tutne Cirl+B =| Vpravo Ctri+R
U Podtrzené T MNahofe
U  Dvojité podtrzeni = Na stied
S Preskrtnuté L Dole
O MNadtrzeni B Radkovan
¥ Horni index Ctrl+Shift+P A Rozestup znaki
¥z | Dolniindex Ctrl+Shift+B = Zvetsit
8| stin =f  Zmeniit
A Obrys A Smér textu zleva doprava
J) Vymazat Ctrl+M B Smér textu shora dold
ali mals pismena A Zleva doprava
Al VELKA PISMENA S Zprava doleva
7 o
A Kapitalky BB wybrat vie Ctrl+A
A Barva pisma £ Znak
42 Barva zvyraznéni %% Odstavec

Obréazek 376: Nastrojova lista Formatovani textu
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Obréazek 377: Nastrojova lista
Transformace

Nastrojova lista Transformace (obrazek 377) poskytuje nastroje pro Upravu tvaru, orientace nebo

vypIné vybranych objekt(.

Priblizeni

Nastrojova lista Priblizeni (obrazek 378) poskytuje nastroje pro zmenseni nebo zvétSeni
zobrazeni aktualni kresby na obrazovce.
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L RE 0B
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PribliZit objekt
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w3
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PribliZeni a posun

38 PN
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Obrazek 378: Nastrojova lista Priblizeni
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LibreOffice Documentation Team

Priavodce aplikaci Draw
Prace s vektorovou grafikou

O této knize:

Tato kniha se zabyva hlavnimi funkcemi programu Draw, vektorové grafické komponenty systému
LibreOffice. Pomoci Draw lze vytvaret Sirokou Skalu grafickych obrazki. Vektorova grafika uklada a zobrazuje
obrazek jako jednoduché geometrické prvky, napf. cary, kruznice a mnohothelniky, a nikoli jako soubor pixel
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